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Storytelling 01:

Seeing Red
Facilitator: Skawennati

Population:
This lesson was created for young adults (18+) at the Skins 5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Monday July 17, 10:00 AM
30 Minutes
Instructor Prerequisites:
Watch “Native Representations in Video Games” film (8 min)
Student Prerequisites:
Participation in introduction.
Equipment, Software Materials:
A presentation screen on which to show “Native Representations in Video Games” film.
Black or white board with pens or chalk available.
Objectives:
Discuss Indigenous representations in video games and media and why self-representation is so
important.
Show examples of of stereotypes depicted by non-Indigenous, and characters created by Indigenous
people.
Vocabulary:
Indigenous self-representation, identity, sovereignty, aesthetics, Future Imaginary, Indigenous Futurism
WEB RESOURCES & BOOKS:
Native Americans In Comic Books: A Critical Study by Michael A. Sheyahshe
Procedure:
1. Introduction
Students should have previously introduced themselves. Introduce yourself and the “Native
Representations in Video Games” film.
2. Play “Native Representations in Video Games” Film
Indigenous representations in video games have been present across game genres and platforms since
the 1980’s. Arguably, most of these representations are drawn from stereotypes found in film. In Fighting
games, Native characters are often the “Keeper of His People” or “Protector of His People” without any
idea who exactly his people are (as in band, nation, or tribe). Usually, in Adventure games, the lead hero is
mixed blood rather than completely Native. In most games, Natives fill the role of the non-player
character (enemy) to be killed for points.
3. Discussion
Write key responses to the following questions: What is your favorite game genre? How could you make
that genre’s gameplay different (e.g. making a hybrid between a role playing game and a simulation
game). Relate back to their favorite games mentioned during their introduction. Once a rapport is
established, get into deeper questions such as: What kind of representation of your culture do you want
to see in a game? What kind of game do you want to play (and thus make)?
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4. Conclusion
Close by exciting them with the idea that they are getting a chance to make their own game and
determine their own identity within video games. Ask them to think about these points and their own
interests while keeping in mind working with a team to develop a game.
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Storytelling 02:

Interactive Emotions
How do games generate meaning?
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins 5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Monday, July 17, 2:30 PM
1 Hour 30 Minutes
Instructor Prerequisites:
Access (login/password) to hosting server
Completed an update, add and commit on the server test prior to lesson and set up folder structures for
the projects already discussed
Student Prerequisites:
Access (login/password) to hosting server
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Individual computers for each student with Plastic SCM installed
Objectives:
Explore how videogames generate meaning through rules and behaviour.
Vocabulary:
mechanics; dynamics; aesthetics
WEB RESOURCES & BOOKS:
Dynamics: The State of the Art – Clint Hocking (link)
MDA: A Formal Approach to Game Design and Game Research – Robin Hunicke, Marc LeBlanc, Robert
Zubek (link)
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Meijin: A Dynamic Story
I would like to start this module with a particular game: Go
● More precisely, I’d like to talk about a Go match that happened in Japan in 1938.
It’s a match between a Go master, named Honinbo Shusai who faces in what should be the last match of
his career the rising star Minoru Kitani.
The match was covered by the Japanese press, by a guy named Yasunari Kawabata,
● Who would later win the nobel prize for literature
● And be recognized by one of the greatest Japanese authors.
● From his coverage of the match, he published a book named Meijin that is about the match.
At the center of the story, he describes the personality of the two players
● He describes the two players as the symbol of a profound transition in Japanese culture.
● A transition between conservative and honorific Japan with its classical art culture
● To a pragmatic, progressive and industrial Japan.
● A transition between imperial Japan and modern Japan.
–
Go is a simple game. It only has 9 rules
At a high level, a Go match can last for a dozen of hours
● Because of the large amount of strategies and thinking involved
This bring another rule: timed turns
● When the day is over and the match is still going
● There is a sealed move
● Which means no one can safely think about the game for two days
● This is very important to remember for the story
So from these simple mechanics, these simple rules, how did we come to a major cultural shift in 20th
century Japan?
● There is an answer to this question, but we need to observe the match more closely
● We need to observe the match during its runtime
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We are approximately at the middle of the game. 120th move.
● White is the master. Black is the young challenger.
● It’s now white’s turn.
White does this move.
● Now I am not a very good Go player, but from what I can see from this move of white stones
○ threatens this black stones formation
● It’s a very aggressive, and thus defensively weak move
● And this move sets the tone for a very intense skirmish that’s about to happen in the middle
This move is basically the master saying
● We are now about to enter the final battle of the match
● It’s a very important move, and the challenger’s answer to it is even more important
But nothing happens right away.
● The challenger thinks for an hour and a half
● Until the session is adjourned.
● And will resume in the next two days.
● The challenger seals his move, and two days pass
When the match is resumed, and there is a huge surprise
● While everyone was waiting for a climactic move at the center
The challenger plays here.
● At first glance, it’s a bit of a strange move, because it’s sort of a housekeeping move.
Here, the 8 white stones that belong to the master are technically not protected by black’s capture
Which makes this move automatically answered by another house-keeping move from the master
The challenger forced this answer from the master
● And by doing so, he bought himself two days to think about his move in the center
Nowadays, we look at that, and we see ruse, and pragmatism.
● We say nice move, dude
The master, however, was not happy.
● He reportedly said this after the match [...]
● From the master’s perspective, the move was ugly
● According to the master’s values, and consequently the way that he expresses himself reflect
these ideals
○ Conservative, classical ideals
● He sees the game not only as a competition, but as an art piece that two player create together
○ Like two dancers, or two musicians
Kawabata saw it differently.
He wrote this about the match [...]
We could describe this as the first cheese of e-sport in Asia
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The challenger, progressive, industrial, made a move that, effectively, gave a lot of sense to this problem.
● He didn’t felt bad about doing this move.
So that’s it. The nature of what is good or what is bad (from a Japanese point of view)
● is at stakes in this match
● The values of the challenger as a person,
● and the way that those values defined his perception, his style,
● are different than the master’s values
If we look at the mechanics of Go, it’s a conflict between white stones and black stones.
● But if we look at the dynamic of this particular match,
● it is a conflict between two perspectives on Japanese identity
Oh yeah and also, the master loses the match and dies the year after.
The book of Meijin is a great reading, for anyone that’s curious to learn more about the game
● And is a prime example for understanding dynamic storytelling in videogames
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The MDA Framework
I’m going to focus this module on a specific question that I heard several years ago.
● From Chris Hecker at the Montreal International Games Summit
● He basically asked: How do games mean?
● How do we really express ourselves in a game?
● With a script? With cutscenes? With gameplay?
If the answer is gameplay… then how do we look at games?
● What is the storytelling of Go? Does it comes from its mechanics?
● If we look back at TLOU. It’s is it the relationship between Joel and Ellie?
○ Or a dude shooting other dudes in the face?
● Is Splinter Cell a game about fragility, and proximity?
○ Or a game about a geopolitical conflict?
● Is Thief a game about being Garret, the anarchist thief?
○ Or a game about territory control, and looting
If we want to understand what a game is about in a more sophisticated way
● We need to understand how do games mean.
● To understand how do games mean, we need to understand it at its most profound level.
What do you think is the most profound way for a game to express itself?
I can give you a comparison with another medium so you better understand.
Lev Kuleshov, a filmmaker from the 20th century, asked himself the question
● How do film mean?
He made a test: an actor looking intensely at three object, giving us three different emotions
What is the most interesting thing from the test?
● We use the same footage of the actor.
● The actor doesn’t look at any of the items.
● But when the audience connects the two
● This is when we have an emotional response
Montage is the foundation on which the meaning of a movie, its story, its characters, are built.
● It was understood to be the most profound level on which we can make a film.
Now let’s go back to games
● I would like to show you a small game that could be seen as the equivalent in games
● [PLAY THE MARRIAGE]
In 2005, Robin Hunicke, Marc LeBlanc and Robert Zubek published a paper titled
● MDA: A formal Approach to Game Design and Game Research.
● With the aim to unite designers, critics and researchers around one universal vocabulary for
games

It is centered around three keywords
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●
●
●

[list MDA]
[definitions]
[synonyms]

These three aspects of a game are a bit like a set of lenses with which you can analyse a game.
–
[Spelunky]
This is Steven Lavelle, also known as increpare, who had this to say about Spelunky [...]
Considering this, we could say that Spelunky is about deliberation and premeditation
If we go back at this question, the aesthetics are the output
● But where does the aesthetics come from?
○ Does it come from the rules of the whip?
○ Or the way the player uses the whip?
● Does the aesthetics of The Marriage come from the rules that the author made?
○ Or the way the player play the rules?
Do a game express itself with the mechanics, or dynamic?
I think it is a difficult question because the term interaction has a lot of significations.
● Montage only has one meaning. Interaction is ambiguous.
–
Let me give you another example.
● This is a mechanical keyboard.
The mechanical keyboard was in 1905 what Guitar Hero was in 2005.
● The piano will play notes while the player follow the melody and plays along.
To get back to MDA, the piano’s melody composer has a very important choice.
He can choose to compose a very specific melody
○ So the player only plays a few notes.
● It’s like designing a game like Call of Duty. Or Zelda.
Conversely, the composer can make a melody with very few notes
● Leaving a lot of space for the player to come up with his or her own interpretation
○ Like designing a game with no story, in which everything is player generated
○ Like Minecraft. Or DayZ.
Let me give you comparison with games from my ex-studio.
● Who know Splinter Cell ? I worked on two of the games.
● We applied in Splinter Cell a very fixed meaning.
In Splinter Cell 1 – you had one way to open a locked door (thermal vision)
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●
●
●

Because this is a very specific situation,
we could say that the mechanics force a very specific dynamic
This dynamic make sure that the game has a very specific meaning

In Splinter Cell 3 – the player had much more choice.
● you could hack, interrogate, use visions, follow the guard
● By having a higher quantity of mechanics, the game’s meaning was more varied
Now let’s use another example. The Far Cry series, which has a more open meaning
I remember someone in the team telling me that the game’s premiss is that [...]
● a group of little girls can sometimes be more cruel than p
 redators from the bush
● they coded the message in the game with mechanics like
○ shoot to only harm someone, rather than kill
○ killing someone in cold blood
○ literally euthanize your friends
This is Tom Bissel, an author who writes about games.
● He tells the story where he execute a dying man in the bush.
● He writes that he threw a molotov cocktail over a hill and only heard his enemy screaming in pain
● He then described his experience as such [...]
● Tom described the game as horrible, intimate, and shameful
This is Ben Abraham, a game critic.
● Ben played the game in a much different way
● He said he’ll play the game with permadeath
○ if he dies, he stops playing
○ He played for hours like that. He described the experience as [...]
● In the end, he described his experience as reserved, secure and boring
In conclusion, the more you abdicate your authorship
● the more your message becomes a toolbox of meanings
● the more your game becomes a buffet of different interpretations.
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MDA Applied To Tetris
I want to use another example so that you understand better what MDA is.
Let’s talk about storytelling in Tetris
● Who here has played Tetris?
● Who here has played Tetris so much they can close their eyes, sing the music and play in their
head
● Tetris is a straightforward game.

What are the core mechanics of Tetris?
What is the dynamic of Tetris?
● Precision: Putting the right piece at the right place
● Anticipation: We need to we strategic and consider the random piece factor
● Opportunism: We need to regularly eliminate simple rows
○ and at the same time, keep free space to make bigger combos
–
Tetris is this a lot of things, but the interesting thing about it is that it’s an abstract game.
● And because of its abstract nature, it’s hard to tell if Tetris actually has a message on the reality
of this world
○ or on people and their emotional reality
● It’s hard to imagine how Tetris informs us on our perspective of the world
Tetris is a game about itself.
● And it’s not bad! We love Tetris as it is.
● And I want to talk about this game precisely because of its abstract nature.
–
I’d like to quickly come back to the Marriage.
● We could say that the game is about these themes as well
● But it’s also because of a marriage
● Because of the title, because of the colors, because of the nature of the decisions
So if we come back to Tetris, I’m asking you, would it be possible to add a fictional layer?
● I’m not asking for ways to make the game better
I am asking you this question to see how, without changing the mechanics,
● you could alter the meaning of the game
How by changing the fiction of the game, you can change the dynamic
● which will ultimately change the meaning of the game
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Let me propose my version of Tetris
The layout of the game is actually a train station, adjacent to the ghetto of Warsaw, in Poland
The goal of the game is to pack people into wagons and ship them in camps
● As the wagons get filled, you can see scared families grasping to each other
● We ask you to fill the trains wagons to a maximum so that they can leave the station
● If you leave too many incomplete wagons, the station will fill up and slow down the nazi war
effort
● So imagine each line to be a wagon full of innocent civilians sent in a camp
How would that fictive layer would influence the dynamic of the game?
● If you close your eyes and play Tetris in your head, what would happen?
I can imagine a few options
Classic – Adolf Eichmann – the loyal servant of the Reich that optimises all of his moves
Double-Agent – Oskar Schindler – optimise his defeat by playing the system
Saboteur – Claus von Stauffenberg – plays in an aggressive way to break the system
–
What is the goal of that exercise ? By changing the fictional layer, the game found a new meaning
● Meaning didn’t came from the mechanics
● Meaning arose from the player’s behavior.
● And that behavior was heavily influenced by the fictional layer.
The player’s behavior, interacting with the game’s systems is the dynamic.
● And the dynamic might just be the most profound level of expression in a game
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Hemingway & Player-Generated Meaning
I want to use one last example. Who have read any book by Hemingway?
In 1927 he wrote a short story called Hills Like White Elephants
● It’s the story of a man and a woman sitting at a table in a train station in Spain.
● They’re ordering drinks and having smalltalk
● And that’s it. Nothing is resolved, nothing happens.
And no, there are no elephants in it. Like Ben Abraham would say, it’s kinda boring, really.
–
But if we take a closer look at the story, we can see the elephant in the room
● We can see that the girl is somewhat angry, and scared
● We can feel that the man is conciliant, and disappointed
Eventually, the picture becomes quite clear. [...]
● He never wrote about abortion. But we can piece it together while reading the story.
We have no time to read the short story together, but here’s another, way shorter example.
● In this one, everything have been stripped.
● Nothing is left aside from the sad realization of what happened
On one side, the meaning of the story is undeniable. On the other, Hemingway didn’t have to write
anything about it.
● It is the reader who brings the meaning
● Hemingway let go of a 100% of the message to the audience
● We could rewrite the story in a different way, but it would hardly be about anything else
It would be incomplete to describe these examples as ‘minimalistic’
● Because it is not the art of removing the unnecessary parts
● It is the art of showing your audience that they, too, are the artists
So that concludes my lectures on the storytelling modules.
● I think that the dynamic of the game forces us to rethink how storytelling work in a game.
● And think about how much authorship we want to put in the message of our games
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Storytelling 03:

Sharing Stories: Tell and discuss stories, noting most popular characters
types, action, morals, unique cultural elements, etc.

Facilitator: Skawennati

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday July 18, 10:00AM
1 Hour, 30 Minutes
Instructor Prerequisites:
Access (login/password) to hosting server
Completed an update, add and commit on the server test prior to lesson and set up folder structures for
the projects already discussed
Student Prerequisites:
Have a story (traditional or modern, real or imaginary) to bring to the group.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Individual computers for each student with Plastic SCM installed
Objectives:
Tell and discuss stories to generate ideas for use in the game.
Vocabulary:
Action, morals, character tropes, story structure
WEB RESOURCES & BOOKS:
Preparation:

[To Be Completed Post-Publication]
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Storytelling 04:

Translating Your Story:
How do we craft metaphors through gameplay?
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday, July 18th, 11:30AM
1 Hour
Instructor Prerequisites:
Access (login/password) to hosting server
Completed an update, add and commit on the server test prior to lesson and set up folder structures for
the projects already discussed
Student Prerequisites:
Access (login/password) to hosting server
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Individual computers for each student with Plastic SCM installed
Objectives:
Take an abstract concepts and translate it into concrete gameplay.
Vocabulary:
ludonarrative dissonance; game/story conflict; metaphor; allegory; source system
WEB RESOURCES & BOOKS:
Ludonarrative Dissonance in Bioshock: The problem of what the game is about – Clint Hocking (link)
Making Deep Games: Designing Games with Meaning and Purpose – Doris C. Rusch (link)

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Introduction: Story / Game Conflict
Let’s look at The Last of Us [1 :34 :30][1 :58 :50]
[5-10m discussion on TLOU’s gameplay and story]
The Last of Us offers two different contracts
● The first is the narrative contract
● The other is the gameplay contract
These conflicts exist everywhere, in every genre that we can imagine.
● Clint Hocking coined the term ludonarrative dissonance  to describe it.
● We could also simply say story/game conflict. Or simply conflict.
It signifies that something’s wrong at the intersection between gameplay and story
● In some games (if not most games), story and gameplay will be segregated
● You enjoy the cutscene, then you go back to shooting or whatever, then another cutscene
It’s a complex issue, because narrative games have innate conflicts
I meet a lot of young students who told me they had this incredible and epic 80-pages long script.
● Usually that script ignores the game behind.
● It’s written as if it was a movie script.
But creating drama in a movie requires a very much calculated delivery
● Let me give you an example. I’m a big fan of LOTR.
I like many scenes, but Boromir’s death in the first movie still give me shivers every time I watch it
● [slides: Boromir dying]
● In a game, whenever an important character dies during the runtime,
○ [slide: ragdoll in Counterstrike]
This is a goofy example, but considering that important characters can die in a game:
● We never know how it’s really going to happen
● Where the player will be looking at that moment
● How the corpse is going to react
● If the timing will be optimal, etc.
It would be quite hard to reproduce the intensity and timing of a scene
● like Boromir’s death in a game
● without removing control from the player
○ so that he or she can fully appreciate the moment.

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

This is the issue when we compare static stories to dynamic stories.
● A lot of classic cinema techniques
○ foreshadowing, pacing, tone adjusting, voice emphasis, body language
● all of these things become much, much more complicated and unpredictable in a game
Mainstream design culture is still not so much oriented around dynamic meaning.
● Rather than that, they will be concentrated on the story itself
● And fun gameplay mechanics
But story and fun gameplay often have different meaning
● and can enter a dichotomy
● the game says something, the story says something else
For games to mature as an art form, and to reach a broader audience
● and fulfill their potential as communicative and expressive media,
● I believe they need to tackle more personal themes
● through the gameplay experience; through the dynamic
I don’t believe that all games should be like that
But what I am arguing for is an expansion of the repertoire of games
● to include profound, thought-provoking, and emotionally diverse experiences,
● not to extinguish or ban existing gameplay pleasure
–
During the time of this workshop, we want you to be authors
● we want you to persuade players and change their behavior, or perception
● instead of just aiming to make something fun
I personally want you to express ideas, and emotions, not through scriptwriting, but through gameplay
This is why I want us to explore the concept of deep games.
● aka alt games, art games, serious games, notgames
Deep games are built on metaphors, and allegories.
Allegory : a story that has a deeper or more general meaning in addition to its surface meaning.
● Allegories are composed of several symbols or metaphors
● include characters and events that stand for abstract ideas
The Ant and the Grasshopper illustrates the virtues of hard work and planning for the future
The Fox and the Crow is used as a warning against listening to flattery
The Lion and the Mouse demonstrate mutual dependence regardless of size or status
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Why deep games?
● They make inner processes tangible
○ provides inside view into someone’s emotional landscape
● Create a magic door to a deeper theme
○ metaphors provide a magic door to topics that are otherwise hard to swallow
○ or unappealing
● The theme is everything
○ a literal approach can distract from the core theme (essence of the experience)
○ metaphors enable insightful abstraction from reality (no distracting details)
○ not bound by expectations of how it works in real life
● Allegories makes you think
○ allegories engage over curiosity because they are about something else
○ than what they present on the fictional surface
Allegories take many shapes
● Some are explicit. Some are obscure.
● Some have a message. Some are open-ended.
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1.The Experience
Some games don’t exactly need an allegory to be an accurate representation of something
● Like Diner Dash, or Papers Please
● They’re easy to understand because they represent some very concrete concepts
Yet some other aspects of our experiences can be much more difficult to translate
● Our perspective on life, or the weight of death, or how we feel and think about something
● They’re especially hard to grasp because they’re abstract concepts
● Like Papo & Yo (alcoholism), or Elude (depression)
An abstract concept is any experience or idea that cannot be immediately observed
● or derived directly from physical reality.
It’s easier to make a Call of Duty game about aiming and shooting at other people,
● than actually making a game about duty.
Medal of Honor is about reflexes, and agility, not about honor
Honor, duty, these are abstract concepts.
● Love is an abstract idea
● Anger, loyalty are abstract ideas
● All of our inner emotional processes are abstract
It’s hard to wrap our heads around something we can’t see, touch, smell, or taste.
● But if you want to make a game about anything abstract,
● you will need to understand the source system well
● The source system is the concept the game is based on
● Mechanics are made from the source system
To grasp these concepts in order to translate them into a game,
● we need to practice understanding them as a system
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2. The Source System
There are many ways to understand an experience
● One of them is to break it down to its individual parts
The result is called the source system
● it’s an ensemble of recurrent patterns, shapes or regularities
● If you understand well the source system well enough, then you can make rules about it
The source system is divided in five
● For now, you can just note them down, we’ll look at a few examples soon
Participants
● Actor distinguishable from the self
● Many kinds: people, animals, objects
Parts
●
●

We experienced ourselves as having parts that we can control independently
○ (arms, legs, hands)
Events / activities are also segmented in parts

Stages
● Where we are / what position we are in (initial conditions)
● Start moving (beginning), carrying out (middle), stopping (end)
Linear Sequence
● our simplest motor function (stages) require to be put in the right linear sequence
Purpose
● From birth, we have needs and desires,
● and we realize very early that we can perform actions to satisfy them
○ by crying, by moving, by manipulating objects
[MISSING EXAMPLE: DESCRIBE “CLEANING UP MY HOUSE” AS EXAMPLE]
The source system can be physical
● Because it can be observed
● the translation of their elements & relationships into game rules is straightforward
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The Metaphor
Still, the question remains,
● What is love?
● how do we understand and express this complex, abstract idea?
● this is where the metaphor becomes handy
Because certain concepts can be almost entirely described as metaphors
● Love is a journey / a patient / a physical force / madness / war / blindness / an open door
● Making sense of abstract ideas means understanding them in terms of something concrete
● We use metaphors to understand one kind of thing in terms of another
Metaphors are thus not reserved for poets or romantics
● Metaphors are everywhere. A tool actually.
An idea is an abstract concept,
● but we think of it as an object when we say we’re playing with an idea
● or dropped an idea
Only a small part directly stems from actual physical experience
● of our understanding of the world
● The rest is metaphorical projection
● From the physical to explain the abstract
To refer back to the cleaning example, a messy life could be pictured as a messy apartment
‘’life is a mess’’ is easy to picture
● Everybody’s mess is different but they all share the same structure
● participants, parts, sages, sequence, purpose
● purpose: clean it! or the desire for change vs resistance to do so
Let’s consider the following: life is a maze
● using a source system, and metaphors
I could argue that we’re all living in some sort of internal maze
● but everybody’s mazes would be different
● although, they would all share the same basic structure [SHOW PERSONAL MAZE PROTOTYPE]
○ purpose: get to the end ? the feeling that we’re lost, and progressing blindly ?
In the end, the mapping between the source system and the metaphor is not arbitrary or vague
● Structural metaphors are no imaginative flight of fancy
They constrain the meaning of abstract experience in a very precise and coherent manner
● If you felt skepticism with metaphors, blame it on the poet or the teacher,
○ not the tool
● Metaphors are tools of cognition and understanding
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Storytelling 05:

Deciding on a Story: Through healthy debate and using newfound
learning, team officially chooses preferred, general story concept &
character(s)

Facilitator: Skawennati and Owisokon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 19, 9:15AM
1 hour, 45 minutes
Instructor Prerequisites:
Knowledge of previously discussed stories, characters, cultural elements from previous lesson.
Student Prerequisites:
Have a story (traditional or modern, real or imaginary) to bring to the group.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Objectives:
Decide on a final story for video game production.
Vocabulary:
Debate, team decisions, group discussion, story, concept, character, design
WEB RESOURCES & BOOKS:
N/A
Preparation:

[To Be Completed Post-Publication]
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Storytelling 06:

Scriptwriting & Storyboarding: How to covert group ideas into properly
formatted dialogue scripts and storyboards for cutscenes.

Facilitator: Skawennati

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Friday July 20, 10:30AM
1 hour
Instructor Prerequisites:
Final story chosen for video game production.
Student Prerequisites:
Final story chosen for video game production.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Pencils and paper for storyboard drawing.
Objectives:
Convert ideas into properly formatted scripts and map out scene with storyboards for cutscenes
Vocabulary:
Storyboard, script, cut, format
WEB RESOURCES & BOOKS:
Mass Effect 1 (Bioware) Script:
https://butterflywindow.files.wordpress.com/2012/05/masseffect11_19_2011.pdf
Breakdown and structure of quests in World of Warcraft (Not Official):
https://docs.google.com/file/d/0B-vZf3N5I_8NYWFVVFpQT1pWZEU/edit
Birdman (2014) Script:
http://d97a3ad6c1b09e180027-5c35be6f174b10f62347680d094e609a.r46.cf2.rackcdn.com/film_scripts/
FSP3823_BiRDMAN_MINI_SCRIPT_BOOK_C5.pdf
Quests and Worldbuilding in The Witcher 3 (CD Projekt Red):
http://www.makinggames.biz/feature/quest-design-in-the-witcher-3-wild-hunt,6896.html
Movie script database (lots of official hollywood movie scripts)
http://www.imsdb.com/
Another movie screenplay database
https://sfy.ru/
Article on designing game narrative (with examples):
http://hitboxteam.com/designing-game-narrative
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Interesting article on writing for video games:
https://www.polygon.com/2016/8/15/12455728/how-to-get-a-job-writing-games-maybe
Interview with a narrative designer for video games:
https://www.ceros.com/blog/narrative-design-video-game
Free collaborative screenwriting software with automatic formatting:
https://www.writerduet.com/

Preparation:

[To Be Completed Post-Publication]
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GAME DESIGN
01
02
03
04
05
06
07

What’s In A Game?
Game Development Process
Level Design 101 - Environmental Storytelling
Level Design 102 - Puzzle Making
Deciding On Gameplay
Hands-On Map, Puzzle, & Level Design
Level Design 103 - Compositing

Game Design 01:

What’s in a Game: Introduction to Elements in Games and Genres

Facilitator: Pippin Barr

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Monday July 17, 11:30 AM
1 hour
Instructor Prerequisites:
Access (login/password) to server hosting Skins 5.0 Template Game and Skins 5.0 Course Material
Student Prerequisites:
Access to local versions of Skins 5.0 Template Game and Skins 5.0 Course Material from the hosting server
Equipment, Software Materials:
A presentation screen on which to show the slides
Black or white board with pens or chalk available
Objectives:
1. An introduction to the centrality of player experience
2. A rapid introduction to the diversity of games (via genre)
3. A set of key concepts and questions for breaking games into parts
Vocabulary:
Player experience, player, objective, procedure, rule, resource, conflict, boundaries, outcomes, challenge,
play, premise, character, story
WEB RESOURCES & BOOKS:
Fullerton, Tracey. Game Design Workshop.
Preparation:
Procedure:
Refers to “Skins 5.0 | Game Design 01 | What’s in a Game (slides)”
Slide: Title slide
Slide: Today
Warm up
The player experience
Genres
Breaking down games
Formal elements
Dramatic elements
Technical elements
Final thoughts
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Slide: Warm up
Slide: What are some examples of games?
Collect answers and write them up
Just a few examples, enough to get different ideas
Slide: How do we know when something is a game?
Use the list of games we have as examples
Collect ideas and write them up
Just a few ideas, enough to get at the diversity of what games involve
Slide: Our game is whatever we want it to be
We don't have to be constrained by what we think is expected, or what people tell us games have to be
like
This is especially important when we're trying to make a game representing Hawaiian culture and
mo'olelo because it simply hasn't been done much before

Slide: The Player Experience
This is the central concern for a game designer
Games are about creating a specific kind of experience
When I'm designing and making games I often think about the idea of a 'central truth' for design
The core spirit of the game, the point I'm trying to get across, the thing the game is truly about
That key player experience goal can change over time, but it always needs to guide us
Slide: Tracking the player experience
We need to keep the experience in mind throughout all the facets of making a game
From concept to design to prototype to testing to development to art to release
This is why it's so important to test our ideas in order to see if our play experience is working
Slide: Using the player experience
One of the most helpful things about the player experience goal is that it helps us to make decisions
Everything we decide in making our game, from the colour of a character's hair to how the player controls
movement to the shape of a house contributes to the player experience
So when we're deciding anything, we need to ask ourselves: "Does this support the player experience?"

Slide: Videogame Genres
Slide: Genres are like traditional categories of player experiences
People often think about videogames in terms of specific genres
Videogame genres tend to refer more to the style of gameplay than to the content
Though of course like any media it's very possible to blur the lines
And remember you don't have to follow the rules or genres - they're just a starting point
Slide: First Person Shooter (Half-Life 2)
You see the world through your avatar's eyes (explain avatar)
Usually you have one or more weapons and your main objective is killing people in your way
Can be single-player or multiplayer
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Slide: Walking Simulator (Firewatch)
You see the world through your avatar's eyes
You tend to walk around the world and see things, interact with them
Sometimes you need to solve puzzles in order to keep moving through the world
Slide: Strategy (Civilization V)
You make decisions about how an empire should act
Fight wars, make trades, capture territory
Super colonialist genre!
Strategy games can be turn-based or real-time
Slide: Puzzle (Tetris)
You have to figure out some kind of puzzle!
Often revolve around moving pieces around in a defined space
Slide: Adventure (Machinarium)
You move around a world, usually in third-person
You solve puzzles in the environment
Often about collecting items and using them in different places
Slide: Open-world action-Adventure (Grand Theft Auto)
A big world you move around in third-person
Often your key activity is getting from point A to point B
And often killing people
Slide: Platformer (Braid)
Usually in 2D
Objective is to move through an environment (usually left to right) and get to the end
Often collecting things
Popular to make these with a "twist" of some kind (like time reversal in Braid)
Slide: Sport (Madden)
Games that simulate a sport to some degree of realism (some are cartoony, some realistic)
Madden represents American football
The aim of of the game is to be skillful at the sport
Often you play as everyone on the team
Slide: Simulation (Euro Truck Simulator)
There's a whole market for really specific simulation games
Like driving a transport truck in Europe!
The appeal is probably about doing a job well, relaxation, the realism
Slide: Role-playing Game (RPG) (Skyrim)
Games that put you in a big world with an epic story to play through
They use the idea of your character having "stats" from table-top role-playing games - your character has
statistics that determine how good they are at doing things (fighting, running, thinking, etc.)
Part of the pleasure is your character growing more powerful over time
Slide: Massively Multiplayer Online Game (MMOG) (World of Warcraft)
Big world, but the other people in it are real other people!
Team work, competition among players, trading items, social life
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Slide: Sandbox (Minecraft)
A big world that you can actually modify
Shape terrain, build castles, stay away from zombies
Play with other people, build things together, wage war
Slide: Fighting (Street Fighter)
Usually two players
Confront each other in some kind of arena and kick and punch each other into submission
Presented more like a sport than violence
Slide: Casual (Candy Crush)
Often on mobile devices
Fairly simple and repetitive task that is very rewarding visually and in terms of audio
Often "addictive" and hard to put down
Slide: Music (Guitar hero)
You play music and the game judges how good you are at it
Special interface design to communicate which notes to play when
Visuals are often fantasy of rock stardom
Slide: Party (Nintendo Land)
Sets of smaller games to be played by people in the same room
Focus on simple activities that encourage social interaction between people
Often have "cute" graphics and sounds
Slide: Serious Games (September 12th)
Games that are used to present and think about a serious issue or idea
September 12th tells us a story about using missile strikes as a way to combat terrorism
Whenever we try to kill terrorists, we inevitably kill innocents, which turns people to terrorism
Slide: Art / Experimental (Problem Attic)
Often use existing genres in an artistic and unusual way
Problem Attic uses the platformer genre as a metaphor for a personal story
Uses players' expectations against them to express ideas about helplessness or difficulty in life
Slide: Educational (The Oregon Trail)
Games that are used to teach players about a subject, like the Oregon Trail
Often allow you to experience the subject matter as a participant
Tell you things about the subject by letting you encounter them and deal with them yourself
Note the focus on the pioneer experience of America, however - this presence of rhetoric in games is vital
to be aware of both when playing and designing
Slide: ... and many more

Slide: Breaking it down
Making games is a complicated job with lots of different moving parts
While we can and do work from intuition, it can help to have some vocabulary talking about the
experience and how we plan to realise it
We'll work from Tracey Fullerton's Game Design Workshop
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We don't need to deeply understand or remember all this, just get a feeling for the many moving parts
involved in creating a game and the kinds of concerns we need to think about
Importantly it's good to be able to ask questions that help us to think about specific parts of a game
Depending on how we treat/work with these elements, we get different kinds of games
Slide: Formal, Dramatic, Technical
We’re going to talk about
● Formal elements
● Dramatic elements
● Technical elements
Slide: Monopoly
Slide: Minecraft
Slide: Machinarium
Minecraft - a sandbox creativity and survival game
Monopoly - a board game
Machinarium - an adventure game
(Presenter note)
The presenter should go through with examples they are comfortable with but that are diverse
For each of the questions identified, give a quick answer for each of the example games

Slide: Formal elements
Game design has been around for long enough that people have established specific parts of what makes
up the design of a game
We'll look at a set of ideas and questions we can ask ourselves when we're figuring out the formal
structure of our game
Slide: Players
Who is playing this game?
They are a real human being with a personality, specific interests, social and cultural background, ...
They are also a player Focused on achievement? Aggression? Socialising? Exploring?
You probably can't make a game for everyone, so it can be a good idea to have a target audience in mind
(could just be yourself!)
How many of them are there?
Single player? Two players? A thousand players?
What are their relationships?
Cooperative? Competitive? Independent? Single player against the game?
Slide: Objectives
What is the player trying to do?
This is a key difference from other things like TV, film, books.
Capturing, chasing, racing, arranging/tidying, rescuing, escaping, forbidden act, construction, exploration,
solution, outwitting, ... anything you can think of!
Slide: Procedures
What does the player do to pursue their objective?
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Move through space, shoot a gun, move objects around, build things, ...

Slide: Rules
What are the rules?
Define what is possible, leads to the procedures
Often the rules are hidden from the player as being the nature of the world they're in
Slide: Resources
What does the player use to pursue their objectives?
Items, weapons, soldiers, maps, lives, health, money, time, emotions, ...
Slide: Conflict
What makes it difficult for the player to pursue their objectives?
Much of the time in the game we make it *difficult* the player to reach their objective
But at the same time we usually want it to be *possible*
Navigating space/obstacles, fighting enemies, ethical decisions, puzzles, ...
Slide: Boundaries
What separates the game from everything else?
A court, a room, a board, ...
For videogames it's usually a screen
Slide: Outcome
When does the game end? How do you evaluate what happened?
This is about winning and losing, points, etc.
But also about the ending of a story or a journey for example

Slide: Dramatic elements
The dramatic elements of a game can be used to think more specifically about the kinds of experiences a
player might have when they encounter the formal elements
This includes styles of playing a game as well as ideas like stories
Slide: Challenge
What are the challenges in the game?
One of the major motivations for players is to understand challenges and to try to defeat them
Related to conflicts and objectives especially
Slide: Play
How can the player explore or experiment with the game?
A different key motivation for players is to explore the game both in terms of space and possibilities
Exploration, experimentation, creativity, with the formal elements
e.g. What happens if you choose not to fight?
Slide: Premise
Why is the player here in this game world?
The world or setting of the game, the underlying reason things are happening
Gives a core emotional reason for the player's actions and gives us something to build character and story
on

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Slide: Character
Who is the player?
Who else is there?
The player is often represented as one or more characters
Chance for motivation, reasons for actions, empathy
Slide: Story
What happens?
We can think of the player's progress through a game as telling a story
Outcome may still need to be uncertain (so it's not obvious what will happen)
A powerful driver is to "find out what happens", can have different endings

Slide: Technical Elements
The dramatic elements of a game can be used to think more specifically about the kinds of experiences a
player might have when they encounter the formal elements
This includes styles of playing a game as well as ideas like stories
Slide: Games are shaped by technology
The tools you use to make your game change the kind of game you make and the player experience that
comes from it
A card game, a board game, and a videogame could all be about the same story, but they would be very
different games
There is a board game of Minecraft, a card game of Minecraft, an adventure game of Minecraft, Minecraft
itself, …
While it's often enough of a battle just to use technology at all, it's important to think about what kinds of
things the technology you're using is good at

Slide: You are shaped by technology
Think about whether the technology is shaping your ideas too much
Unity is great at making 3D worlds you move around in and interact with, for example, but this might
prevent you from easily thinking about something more abstract or emotional...

Slide: Final thoughts
Player experience is the main thing we should be thinking about, everything is in service of that
Genres are a helpful way to get broad ideas about the kind of game we're making and the kinds of things
we might use in it
Formal elements are useful for thinking about specific components we may use in our game
Dramatic elements help us to think about what the game will be like as an experience, what story it will
tell
Technical elements limit what we can do, but also can allow us to be very creative
Game design involves creating a player experience through formal, dramatic, and technical parts.
Always remember, though, that in the end, you get to choose what your game is going to be like
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Game Design 02:

Game Development Process: Prototyping and Playtesting

Facilitator: Pippin Barr

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday July 18, 1:30PM
1 hour, 30 minutes
Instructor Prerequisites:
Access (login/password) to server hosting Skins 5.0 Template Game and Skins 5.0 Course Material
Student Prerequisites:
Access to local versions of Skins 5.0 Template Game and Skins 5.0 Course Material from the hosting server
Equipment, Software Materials:
A presentation screen on which to show the slides
Black or white board with pens or chalk available
Prototyping materials
● Ideally video-capable cellphones (students will likely already have these)
● Paper prototyping materials (paper, card, scissors, markers, etc.)
Objectives:
1. An introduction to the process of prototyping and playtesting
2. An introduction to forms of prototyping and prototyping objectives
3. An introduction to basic playtesting philosophy and approach
4. Experiencing prototyping and playtesting live
Vocabulary:
Prototype, playtest
WEB RESOURCES & BOOKS:
Fullerton, Tracey. Game Design Workshop.
Procedure:
Refers to “Skins 5.0 | Game Design 02 | Prototyping and Playtesting (slides)”
Slide: Title slide
Slide: Today
Getting started
What is a prototype?
Prototypes are specific
Prototypes are strategic
Prototypes are showable
Let’s make a prototype!

Slide: Getting started
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Slide: Player Experience is the Key
Remembering from our first session that the player experience is the key thing we care about
But that games are made up of many different parts that together create that experience
Slide: Is it working? Will this work?
A big question is how we know whether the experience we care about is actually working
The overall process of making a game is very time-consuming and labour intensive
It's easy to become immersed in the moment-to-moment tasks and forget about what we're working
toward
We don't want to get all the way to the end just to find out it doesn't work!
Slide: The solution: Prototyping and Playtesting
Part of how we answer this in game design (and also design more generally) is to create prototypes that
allow us to playtest our ideas.
Prototyping and playtesting are linked, two sides of the same coin.
Slide: Less talk, more do.
Our main objective for this session is to try some prototyping rather than just talking about it.
However, in order to do some doing, we'll go through the basic ideas of prototypes and playtests so that
we can try them out

Slide: What is a prototype?
Slide: Prototypes are a piece of our game
In essence a prototype tends to be a version of part of our game
It might be playable, it might just be visual
We make it so that we can test out whether this part of the game contributes to our player experience
Useful because it's speedy and specific and strategic and showable
Slide: Prototypes are speedy
Because we're only making a little piece of the game, it doesn't take as long
The key to prototypes is to make them quickly and test them so we get feedback fast
Slide: Prototypes are specific
This also means we can make prototypes of just a particular aspect of our game, rather than the whole
thing
Slide: Prototypes are strategic
It's also the case that the prototype we make doesn't have to look like the final game at all, it's just there
to help us think about the game
There are different kinds of prototypes we can make depending on the specific idea we want to evaluate
Slide: Prototypes are showable
Ultimately the point of a prototype tends to be to show it to someone (even if its just ourselves!)
This is where playtesting comes in
Let's run over these ideas one by one with a focus on the idea of an adventure game
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Slide: Prototypes are specific
Prototypes are generally only mean to test out a particular part of our game
Most obviously, something we're trying to thinking about, make a decision about, test out with real
people
Here the question is what aspect of the user experience do we want to test?
Slide: Prototyping mechanics
We may want to test out how a specific mechanic works
Whether it's fun, satisfying, interesting, intelligible
For an adventure game we might want to test out how moving our character in the world works
In this case we can make a small prototype that only has the movement in it
Slide: Prototyping gameplay
We may want to test out how the overall flow of a game works in terms of solving different challenges
and making progress
In an adventure game this would be moving through different spaces, solving puzzles, collecting items,
and reaching the end...
But of course we want to be able to test this without building the whole game
Slide: Prototyping story
We may want a prototype that conveys our story to see how people react to it, whether they understand
In this case we may not need visuals or even interactivity
Just the ability to communicate the story
Slide: Prototyping visual aesthetics
We may want a prototype that shows a player how the game will look
To test whether they like it, whether they understand what they're seeing, whether the emotions and
story elements are clear, etc
We may also want to test aspects of visual layout
Can the player understand what they are seeing on the screen? Can they tell which things they can click
on?
Slide: Prototyping audio aesthetics
Do our sounds make sense to the player? Are they exciting enough? Do they convey the right emotions?
To test this we may only need to play the sounds to the player
Or we could play them while showing a picture, or during a role-playing session
Slide: Prototyping interfaces
Does our user interface make sense?
For example, can players work out how to use our inventory system?
Slide: … and more!
There are many other things we might decide we need to test
The important thing is to realise that things need testing
And then to figure out a specific way to test them

Slide: Prototypes are strategic
Prototypes are most useful when they are able to strategically capture our specific idea
It's always possible to just invent some kind of prototype, but there are a few tried-and-true methods
worth hearing about
The question is always what aspects of our user experience we can test with this strategy?
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Slide: Visual prototyping
We can make visual representations of parts of our game to test out how they look and how players will
understand them
Drawings, collage, photos can be used to represent ideas about our game's appearance
Photoshop can be used to paint ideas for how scenes may look
Blender can be used to create ideas for specific objects to show to people
For example, we might draw a scene from the game in Photoshop and ask a player to tell us what they
think they would be able to do in that scene
Slide: Role-play as prototyping
One way to make a prototype is just to act it out or tell it like a roleplaying game
Might not need any equipment at all, or could have props to play with
For example, we might have a person who is the game and tells the playtester where they are, what they
can see, and then asks them what they want to do, responding as the game each time, like a game master
in role-playing
Or we could have fun and actually make a version of a scene in our game with objects as props and
actually have the playtester walk around and interact with them (with the creators telling them what's
possible and what isn't)
Slide: Paper prototyping
A more game-oriented form of prototyping is to make paper prototypes of our game
We can construct a representation of our game and then try out ideas on it
For example, we might map out our scenes in bird's-eye view and have a game piece representing the
player and game pieces representing inventory items - then we could move the player around in the
scene picking things up and solving the puzzles
Slide: Video prototyping
We can make a video that could show us how the game works
For example, we could film actors acting out a scene from our game or use stop motion
This could help us visualise how the game will look in terms of specific camera angles, or what kinds of
animations might be needed in the game
Slide: Digital prototyping
There are various tools that we can use to make prototypes of parts of our game
Twine could be used to help represent our story if it has decisions with consequences
PowerPoint could be used to pretend we're playing the game by putting different scenes or events on
different slides and switching between them as the playtester tries different ideas
Unity could be used to make smaller parts of our game to test them out (such as a single scene or
moment)
Slide: … and more!
Again it's important not to be limited
The most important thing is to think of a way to represent the specific idea you want to test
And then get it in front of people to see how well it works

Slide: Prototypes are showable (and showing them to people is called playtesting)
The ultimate point of making a prototype is to show it to someone, and this is playtesting
Slide: Who?
One option is to test the prototypes ourselves and to use them to think about issues with our
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design/aesthetics/story/etc. by working through them - you learn a lot when you actually try to play
rather than just imagining
The other important option is to test the prototypes with actual players by explaining how the prototype
works to them and then having them experience it
Slide: What?
When playtesting we need a specific goal that we're testing - this is the same as the 'specifics' we talked
about earlier - if we don't know what we're trying to find out, it will be harder to learn
And always remember we're ultimately testing relative to our player experience goal - is the aspect we're
testing contributing to our overall experience goal?
Slide: How?
In all cases we want to present our prototype to our testers, explain what they need to do, and then set
them in motion and support them
It can be important not to jump in and try to help people or explain things while they're playing (instead,
take notes and ask questions later)
Think aloud involves asking our playtesters to talk about what they're thinking while they play with the
prototype (can be a bit distracting, and not always easy for the testers)
Observation involves us watching players play the prototype and taking notes when we see anything that
might be a problem or a surprise so that we can follow up
Post-playtest interview involves us asking a set of questions of our playtesters after they're finished
playing our prototype (less distracting, but of course needs more time)
Slide: How should we feel?
The most important thing is to try not to take playtesting personally
it's a weird feeling to see someone encountering something you've made and usually seeing the thing
you've made not work properly, be incomprehensible, but all that is just there to help us do better
Slide: Then what?
Assuming we take good notes and ask good questions, we'll end up with a big list of problems, new ideas,
and thoughts that we can then put back into our design and development, making the game better!
And then we test it again!

Slide: Let’s make a prototype!
Let's break into groups and actually make a prototype of a part of an adventure game
Slide: The brief
We have a specific puzzle in our adventure game we want to prototype and playtest:
The player is in an alleyway and there is a door they want to get through. When they knock, someone asks
for the password, but the player doesn’t know it. They have to leave the alleyway and search in the
marketplace outside to find the password.
(You can decide how the password is found, maybe it’s overheard, written somewhere unusual, tied to a
cat, …)
We want to make different kinds of prototypes that will help us to think about this particular part of our
game
We might have different kinds of objectives we want to think about such as
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- The visual look of the alleyway and marketplace
- The sounds we might use to communicate the password in an interesting way (if we choose that way)
- The experience of solving the puzzle in terms of the storytelling
- etc.
We will need to choose our prototyping approach depending on what we are interested in testing...
Slide: Possible prototypes
A visual prototype to capture the way the alleyway and marketplace are laid out, including how the
password is embedded in the environment of the marketplace.
A video prototype to show the avatar going through the steps needed to solve the puzzle, as well as other
possible interactions that would be fun along the way.
A roleplay/storytelling prototype to let a playtester interactively try to solve the puzzle by talking to a
storyteller or acting out the steps they would take.
A paper prototype that presents the scene as a 3D diorama to experiment with camera angles and allow a
playtester to move a little avatar around the scenes, interacting.
You can also come up with a different kind of prototype if you want to!
Slide: Let’s do this!
Form teams of 4-5 people.
Choose a style of prototype that suits what you are interested in testing out for making a successful and
interesting puzzle.
Make a prototype that can either be playtested by others or that you can use to explain your ideas about
how to make the scene work.
We will work for 30 minutes, then come back together to playtest the things we make.
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Game Design 03:

Level Design 101 – Environmental Storytelling
How do we tell stories through spaces?
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday, July 18th, 3:30 PM
1 Hour 20 Minutes
Instructor Prerequisites:
Access (login/password) to hosting server
Completed an update, add and commit on the server test prior to lesson and set up folder structures for
the projects already discussed
Student Prerequisites:
Access (login/password) to hosting server
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Individual computers for each student with Tortoise SVN installed
Objectives:
Explain how the environment can be a powerful and evocative tool for storytelling.
Vocabulary:
evocative narrative; enacted narrative; embedded narratives; emergent narratives
WEB RESOURCES & BOOKS:
Game Design as Narrative Architecture – Henry Jenkins (link)
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Introduction
As we saw earlier today, storytelling in games can be complex.
● We talked about the power of the metaphor. Now I want us to think about spaces.
My main profession is level design
● I never really learned to write scripts, or cutscenes
● But it was still expected of me to convey the story
● Storytelling through level design is approached differently
Very often, we’re compared to a director on a film set, but I don’t agree with that
● My work will actually resembles more the work of a metteur-en-scène (set dresser? )
Game designers don’t just tell stories; they design worlds and sculpt spaces
● The notion of space is everywhere in games
● And have been there for as long as you can remember
●

Monopoly is a game about how fortunes are lost and won,
○ but ultimately the core of the experience of moving around the board and someone
else’s property
● If any of you played D&D, you’d see that the rôle of the gamemaster is first and foremost to
design the space
● Text-based games like Zork told stories centered around making players move through spaces
If we consider the first Mario, considered as a ‘’side-scroller’’, comes from a much older tradition of
spatial storytelling
● Like Japanese scroll paintings map
It’s been a central notion in many other mediums, like litterature
● Tolkien’s Middle Earth
● Jules Vernes and the Undersea
● Homer’s Iliad
● Frank Baum and the Wizard of Oz
● Tolstoy's War & Peace
● Science-fiction is often referred to as a genre focused on world-making
● Even Disneyland is seen as a pioneer of environmental storytelling
This course is thus about environmental storytelling
● And how it creates preconditions for an immersive narrative experience
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I. Evocative Spaces
Spatial stories can evoke pre-existing narrative associations
Concerning evocating spaces, a game critic once wrote
● ‘’you clearly can’t deduct the story of Star Wars from Star Wars: The Game’’
● By that, he means that usually, a film version of a novel with at least give the board outline of the
plot
But the relationship between film and game is rather through the environment
● through the creative manipulation of environment details
Considering the new trend of transmedia storytelling
● which is having a franchise divided into different mediums
●
●
●

we could argue that books can convey better characters or better dialogue,
or that film can pace a story better and fit it in a 3-hours format
but games would surely give the richest understanding of the story world

Because game spaces contain immersive environments we can wander in, and interact with
They gain the ability to give concrete shape to our memories and imagining of the storyworld
STAR WARS
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II. Enacted Stories
Spatial stories can provide a staging ground where narrative events are enacted
Spatial stories enters videogames on two levels
● On the macro-scale – broadly defined goals
● Or on the micro scale – localized incidents
Macro-scale
Spatial stories are very different from traditional stories
● Whereas a story is a controlled experience consciously crafted,
● A spatial story is looser; less linear, more episodic
● by that I mean that its scenes are independent from one another
○ Because you never know exactly in which order you will discover them
○ or at what pace, etc.
● Each scene becomes a bit less significant for the main plot development
But that doesn’t mean that spatial stories aren’t badly constructed stories
● They’re just a different aesthetic
● The focus is on spatial exploration over plot development
The writing of the plot thus becomes a matter of designing the geography of imaginary worlds.
DEAR ESTHER
● Dear Esther is built on melodrama principles
○ which is, by definition, the external projection of internal states
Micro-scale
Spatial stories can also be seen as micro narrative
These setups are usually places in which a small event may occur
● These events sometimes last only a few seconds
● They’re often stumbled upon
● And their role is simply to reinforce the world’s setting
● And bring the player back to the main themes
Big open-world games that don’t have crucial main plot often depend on these
FALLOUT 3
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III. Embedded Narratives
Spatial stories may embed narrative information within their mise-en-scène (scenography)
When we analyse the vast majority of films
● we can see that they are rarely linear
● the flashback or flashforward is very, very much used with the use of editing
● the plot is very much based on the careful organization of the chronology
● Detective stories are the classic illustration of that
Game spaces work differently
The interesting thing about them is that they’re not a temporal structure
● It does not go from A to Z
● Rather, it should be seen as a body of information
Whereas the author of a film or a book has a high degree of control over details
● like when exactly will the audience receive this detail, and that plot twist
The LD will rather control the story by distributing the information across the environment.
● The structure is open-ended
● The game world becomes a kind of information space
GONE HOME
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IV. Emergent Narratives
Spatial stories provide resources for emergent narratives
Tu aspect is very much unique to games, because they require an input that is set by the author
● but but created by someone else: the player
Emergent narratives are not pre-structured
● The level designer don’t know what shape the environment will take
● Because it’ll come to life during gameplay
A timeless classic would be The Sims
● known as a sandbox game
● these games can be understood as authoring environments
The designer creates the framework
● then it’s up to the player to infuse meaning
Emergent stories aren't just about crafting a house from scratch
● This is actually a much-discussed subject in urban planning
Some designers actually argue that urban planners should not attempt to totally predetermine the uses
and meanings of the spaces they create
“A landscape whose every rock tells a story may make difficult the creation of fresh stories”
Rather, they propose an aesthetic of urban design which give each space ‘’poetic and symbolic’’ potential.
The same could be applied to games so they can support player-generated narratives
● Spaces that have a potential for meaning
● rather than a set story

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Conclusion
So this is the four ways of organizing and designing spatial stories.
Evocative spaces
● You can either enhance the immersion within a familiar world
● And show a fresh perspective on it through wandering and interaction
Enacted stories
● The story is structured around the character’s movement through a space
● And the environment itself is designed to make the plot progress
Embedded narratives
● The game space is a memory palace
● Its content must be deciphered as the player tries to reconstruct the plot
Emergent narratives
● The game space is design to be rich with potential for stories
● instead of set stories
Henry Jenkins: “in each case, it makes sense to think of game designers less as storytellers than as
narrative architects”
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Game Design 04:

Level Design 102 – Puzzle-Making
What is the DNA of a puzzle?
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday, July 19th, 3:30 PM
1 Hour 20 Minutes
Instructor Prerequisites:
Access (login/password) to hosting server
Completed an update, add and commit on the server test prior to lesson and set up folder structures for
the projects already discussed
Student Prerequisites:
Access (login/password) to hosting server
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Individual computers for each student with Tortoise SVN installed
Objectives:
Lay down basic principles for puzzle design.
Vocabulary:
puzzle; environment; goal; progress; solvability; parallelism; interest; perception
WEB RESOURCES & BOOKS:
The Art of Game Design: A Book of Lenses (chapter 12) – Jess Schell (link)
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Introduction
Since we’re making a puzzle game, I want to approach this aspect as well.
Puzzles are a set of mechanics that form the major, if not entire part of a game
● They invite the player to stop, and think
● You can never really rush through one
○ You always need to slow down
● And because of that they can bring a significant new mental dimension in a game
What is a puzzle ? Let’s first talk about problems. The puzzle genre has not always been an accepted
genre.
Legitimacy
A long time ago, there once was a lot of debate about whether puzzles were games or not
● A puzzle is a part of a game. But is the puzzle the game?
● I’m talking about jigsaw puzzles, crosswords, rubik’s cube
Some people, like Chris Crawford, argued that a puzzle wasn’t really interactive,
● because they were not actively answering the player
Replayability
Scott Kim, famous puzzle designer, suggested a very simple definition
● A puzzle is fun, and has a good answer
● The irony is that a puzzle ceases to be fun once it’s done
● Dickinson said that as well.
○ That we’re quickly bored by things that are easy to find or already heard
Dominant strategy
That’s the name that we give to a strategy that will beat the game every time
● Whenever a game has a dominant strategy, it quickly ceases to become interesting
● Whenever we’re kids, we will play tic-tac-toe until we find the dominant strategy
We could then say that it’s wrong to have a dominant strategy in a game
● Unless the point of the game is to find the dominant strategy.
● That leads to an interesting definition of a puzzle
● From that point of view, puzzle games are not so replayable
With time, puzzles changed
● they became less explicit
● more embedded in the gameplay
● Instead of stopping the player, they became natural parts of the environment
This brings us to modern puzzle games.
● games that have puzzles that are essentially environmental
● and since we lack time to explore puzzle-making in depth
● I want to give you 10 questions to ask yourselves while making puzzles
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I. Make the Goal Easily Understood
What is the goal of that puzzle? Now what is the goal of that one?
To interest the player with the enigma we’re proposing
● We need to make sure theyhe or she knows what to do
This is Nemesis Factor, by Habsto
● It had some sort of cult following, but it flopped.
● Most believe it was because the goal wasn’t clear
Fans loved it, but the general audience wasn’t attracted
● It was an open problem that gave little to no feedback

II. Make It Easy to Get Started
Once the goal is understood, the player needs some insight about where to actually start
Where should we start with this enigma?
Where should we start with this one?
We usually jump head first into a puzzle, without really knowing the starting point
● And will get into it by trial-and-error
● We’ll play with the puzzle; experiment with it.
● Trial and error in P&C can be tiresome
Another quote from Scott Kim: to design a good puzzle, first design a good toy.
● That way, trial-and-error doesn’t feel tedious at all.
● Accessibility invites manipulation

III. Give A Sense of Progress
What is the difference between an enigma and a puzzle?
● A puzzle in a game implies some sort of manipulation, some experimentation
● An enigma only ask the player to think, or take guesses
We can turn a riddle into a puzzle
● 20 questions
● Rubik’s cube – sense of progress
Giving feedback on the progress keeps the interest up
● And lets him or her understand that the answer is approaching
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IV. Give A Sense of Solvability
Without giving it, a solution has to seem possible
Again, this is part of the rubik’s cube fascination
● We can rage as much as we want against it, we know it’s possible
Whenever you think the puzzle is impossible can give the feeling you’re losing your time.

V. Increase Difficulty Gradually
A puzzle don’t need to instantly transition from ‘’unresolved’’ to ‘’resolved’’
A lot of jigsaw puzzles actually have a chain of actions that gradually increase in difficulty
● You first classify the pieces, flip them on the right side
● You then find the four corners
● You then move on to the borders
● You then connect the borders to the corners to create a frame
● You then keep up with the similar colors, or specific details
● You then add the sections to one another
● And then you fill the remaining gaps
That jigsaw puzzle is actually made to break the traditional steps of jigsaw puzzles
● Giving the player control over the steps helps the difficulty to be better-adjusted

VI. Parallelism Lets the Player Rest
One of the biggest dangers of a puzzle is that whenever a player is unable to find the solution
● He or she will feel blocked, even if they want to keep playing, and will eventually quit
● One very useful is to offer different puzzles at a time
● While you’re thinking about that previous puzzle, you enter a new one
○ that might actually shift your perspective
A lot of games now do that. Antichamber (teleport). The Witness (walking).
● Parallel puzzles give space for rest
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VII. Pyramid Structure Extends Interest
This is usually what having puzzles in parallel lead to
● This means a series of small puzzles can each give some kind of clue to a larger puzzle
A classic example is Jumble
This interesting thing about this principle is that it combines short- and long-term goals
VIII. Hints Extend Interest
Some people might not agree with this,
● because what is the point of a puzzle is you’re going to give hints?
We could argue that it remove some of the puzzle’s value
● but to solve it with a hint is better than not solving it at all.
● In some games, it also add some very interesting value
Like the hints in shadow of the colossus.
● A good clue will renew the player’s interest and investment
IX. Perceptual Shifts Are Risky
Let’s consider this puzzle:
● You have to arrange six pens so that they form four equilateral triangles
● Don’t tell the answer if you know it.
I’m guessing one of four things happened
● A: you already knew it, so you didn’t really felt compelled or anything
● B: you changed your perspective
○ you made a jump in your assumptions
○ you got the right answer and felt exhilarated
● C: Someone gave you the answer. It felt good, but not as much if you found out yourself
● D: You stayed clueless and gave up. Felt frustration, or even shame
Perspective shifts are a double-edged sword. The perception shift is elating, but it’s all or nothing.
● There is not much progress in the puzzle itself
● We stare at it, and nothing comes
● Almost like a riddle
The Witness is based on that moment. And constantly shifting your perspective.
X. Give The Answer
Seriously. What is it that is so pleasurable about solving puzzles?
Of course it’s better if you find the answer yourself, but
● if you gave them problem enough consideration
● seeing the answer can bring the same excitement
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Game Design 05:

Deciding on Gameplay: Encourage group to decide on the gameplay
basics / style together now that story is settled

Facilitator: Simon-Albert Boudreault and Pippin Barr

Population:
This lesson was created for young adults (18+) at the Skins 5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 19, 3:30PM
1 hour, 20 minutes
Instructor Prerequisites:
Access (login/password) to server hosting Skins 5.0 Template Game and Skins 5.0 Course Material
Student Prerequisites:
Access to local versions of Skins 5.0 Template Game and Skins 5.0 Course Material from the hosting server
Equipment, Software Materials:
A presentation screen on which to show the slides
Black or white board with pens or chalk available
Scrap paper and pens for students
WEB RESOURCES & BOOKS:
Preparation:
Procedure:
Refers to “SKINS 5.0 | Game Design 04 | Deciding on Gameplay”
Slide: Title Slide
Slide: Today
Design constraints
Design approach
Design!
Document
The idea for this session is to settle on the basic design of our game. We have some basic constraints for
our game design that are defined by the story chosen and the particular genre we're working with (an
adventure game). But in working out the design we're also allowed to push back on the story and
technology if we think we can make things more interesting/engaging

Slide: Constraints
In order to design our game and its gameplay, we need to remember that we’re naturally constrained by
the story we want to tell and the technology we’re using to make our game
Slide: Narrative
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(As needed) Recap the narrative as we understand it
This is what we need to make work as a game, a bit like the dramatic part of our game
Remember that we're allowed to push back on the story if it helps the design - it's all give and take
Slide: Technology
(As needed) Recap the constraints involved in the technical elements
An adventure game with a fixed camera where you point and click to move a character through different
spaces/locations, solve puzzles, collect elements, talk to other characters, etc.
As with the narrative, remember that we can push back on the technology if we see an opportunity for a
better design - the technical team will be able to change aspects of how the game works
Slide: Design Approach
Adventure games tend to have various common elements we should consider in our design
Let's run through those quickly so we know the kinds of things to work on
Slide: Locations/Scenes
Adventure games usually involve a series of locations that character visits and interacts with
This will depend heavily on the locations in the story of course
We need to remember that all the places we ask for will have to be made by us, so there is work involved
Will most likely be the thing that gives a structure to how our game works
Don't forget we can be creative - e.g. the spaces could be metaphors, could be in other worlds, etc...
This can include characters that we interact and talk with
Slide: Inventory
Adventure games usually involve the player character collecting items they need to get through the story
(often to solve puzzles)
This will again depend on the kinds of items that appear in the story
We need to remember that all the items we ask for will have to be made by us, so there is work involved
But again we can be creative with this
items could be ideas or feelings that the character carries with them and perhaps gives to or tells to other
characters...
there's no reason the character couldn't 'pick up' an entire room if we wanted
Slide: Interactions
In adventure games the player character usually interacts with things in the scenes they are in
Generally you click on something, the player character walks over to it, and something happens - we need
to design those 'somethings'
Often this will be things like picking something up, talking to someone, giving something to someone,
operating some kind of machine, etc.
But again, we can be creative with this too
Our character could lick some things to taste them
Our character could hide inside something they click on
Our character could eat things they click on
Any new interactions we come up with might require new animations and programming

Slide: Puzzles
One of the key aspects of most adventure games is solving puzzles
Often you have to solve a puzzle in order to be able to move between different places, like opening a door
or buying a ticket for a bus

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Often the puzzles are solved by finding the right items in the world (which might be hidden!), or by
learning a secret piece of information (perhaps by talking to someone or overhearing them), or even by
some kind of test of skill
As always, we can (and should) try to be creative with our puzzles
Perhaps the player has to wait in a particular place for something to happen
Perhaps the player has to play the game at a specific time of day for something to happen
New puzzles might require new objects, animations, and programming!
Slide: Design!
Slide: The Player Experience
What is our player experience? What do we want the player to feel and remember when they play this
game? Can we come up with a single sentence that captures what our game is?
Slide: Designing from the story
Let's go through the story and map out the places, interactions, items, and potential places for puzzles
Slide: Designing from the technology
Let’s think about the technology we have and how we can use what it does in this context
Remember that we can also think of ideas that our technology doesn’t immediately support and try to
make the game do this too
Slide: Remembering the experience
Let’s do another pass through what we have and specifically think about our player experience
Think about whether there are things we need to change, add, or remove to enhance this experience
Slide: Document
At a specific point in time we'll need to stop being creative and agree on our basic design (obviously it can
change later)
We should be able to agree such that a design document can be written with all our decisions in it
(Have a template design document ready to show them, but probably the best thing is to try to reach a
consensus and then have the instructors actually write up the document based on the session - it can then
be sent to the students to review and edit/make comments on as a Google Doc)
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Game Design 06:

Paper Prototyping
Facilitator: Simon-Albert Boudreault and Pippin Barr

Population:
This lesson was created for young adults (18+) at the Skins 5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Friday July 21, 10:30AM
1 hour
Instructor Prerequisites:
Having previously seen or made a paper prototype
Student Prerequisites:
A concept of their game environment, mechanics and story via a filled out Game Design Document
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Craft materials and supplies (paper, scissors, glue, colored markers, pipe cleaners, tape, etc.)
Objectives:
Showcase other paper prototypes and how they helped to plan the puzzle details of the game (option of
SKINS 2.0 documentary). Help students design and build their paper prototype for testing
Vocabulary:
Prototype, playtesting
WEB RESOURCES & BOOKS:
Fullerton, Tracy. Game Design Workshop. Burlington, MA: Elsevier Inc. 2008.
Procedure:
Refers to “Game Design 3.Paper Prototyping.pptx”

Slide: Title Slide
Slide: Today
Remembering the design
Deciding on prototypes
Prototyping!
Playtesting!
Slide: Remembering the design
Slide: The game design
Recapping the game design we made and the story (and their relationship)
Refer to the game design document that should exist by now

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Slide: The technology
Recapping the technical constraints of the technology
Focus on the specifics of what the technology is inclined towards:
Individual scenes which are 3D spaces representing places in the story
Ability to pick up and use different items
Ability to move through space and interact with different things in the scene
Slide: Prototyping and playtesting
Recapping the prototyping and playtesting session
Emphasise the idea of prototyping kinds of interaction rather than the whole game (e.g. one particular
scene/interaction may be representative of a whole bunch in terms of seeing how it works)
Slide: What kinds of prototypes would be helpful?
Group discussion of what would be helpful to prototype and what kinds of prototypes (refer to GD02)
might be helpful ways to test them out.
Build a list of things that would be good to prototype - most likely either specific scenes/locations, specific
puzzles, or specific kinds of interaction, but could also be user interface or audio for example
Perhaps a leaning toward prototypes that let us model one or more scenes with gameplay
Add notes to list of things with the kind of prototype that might help (e.g. role play, paper, video, ...)
Slide: Prototyping!
Break into smaller groups if necessary/possible
Choose one of the prototypes identified and make it!
Slide: Playtesting!
Come back together (if in groups)
Run a playtest of the prototype (if we have available playtesters, good, if not, no problem)
Discuss the results of playtesting
What have we learned?
What changes might we need to make to our design?
In an ideal world we can make more than one prototype and test it
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Game Design 07:

Level Design 103 – Composition
How do we create compelling spaces?
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday, July 25th, 11:00 AM
1 Hour 20 Minutes
Instructor Prerequisites:
Access (login/password) to hosting server
Completed an update, add and commit on the server test prior to lesson and set up folder structures for
the projects already discussed
Student Prerequisites:
Access (login/password) to hosting server
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Individual computers for each student with Tortoise SVN installed
Objectives:
Expand on the different techniques used to create interesting and dynamic compositions.
Vocabulary:
composition; layers; foreground; background; dominant; counterpoint; positioning; symmetry; asymmetry
WEB RESOURCES & BOOKS:
Composition in Level Design – Mateusz Piaskiewicz (link)
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Introduction
There is still a popular belief that level designers are the “ones creating the gameplay”
● which vaguely means that they design empty grey boxes
● design puzzles, or shooting events in them
● and then wait for specialized level artist to come in and make it all beautiful
● Level Designers are in fact responsible for a lot of the visual of their environments
Whenever we design a level, we should be able to freely compose the environment with the objects that
we want.
●
●

This is mostly what distinguish landscape photographers and level designers
We get to compose the staging grounds

From that perspective, the level designer’s work can be compared to illustration
● the level can actually considered like a canvas
● which is especially relevant in point and click games
● we let the player go from a composition to another
[EXAMPLES]

Composition Basics
Composition is an arrangement of scene elements
● These elements are manipulated in order to influence the player’s attention
● Which is far from only making pretty pictures
● Good composition guide the player’s eyes through the environment
● and likely put forward what the player has to do, or where to go
These environments should present an interesting and clear idea that is easy to understand
● and isn’t confusing to the observer
To achieve that, all the components of a scene should be taken into consideration
● emphasis can be given or removed
● with color, lighting, proportions, direction, and position
● in other words, you showcase what’s important and you put aside what is not
The opposite of composition is chaos
● on chaotic images it’s hard to determine which elements are dominant
Nature, for instance, is chaotic
● and there is a thin line between imitating nature and natural mess

Layers
Foreground
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The elements which are the closest to the camera
● they’re usually what is directly in relationship with the player, or the avatar
They can be a prelude to what waiting ahead
● or act as a frame to the center of interest
This layer is very sensitive to lighting.
Brightening foreground objects can separate this layer from the others
● which can give an effect of isolation
Darkening them, on the contrary can give the feeling of space
● because the contrast is enhanced in regard to the other layers
● very often the front layer is only made of silhouettes
[DKC2 – Inside]
Center of Interest
This is where the attention is mainly drawn to
● this is usually where the dominant (or landmark) is placed
The dominant is a focal point in the composition
● it can’t merge with the rest of the scene’s elements
● but it still needs to stay consistent with them
● Dedicated lighting and the positioning will make it stand out
● The dominant can be reminiscent of the objective, or the theme
A center of interest can contain more than one dominant
● And is called a counterpoint
● which balances the player’s attention
[Rage – SCB]
Background
This is the closing layer
● most of them consist of the horizon, or the sky
● it can be useful to use a more somber tone, with neutral colors and less details
● so that the eye stay focused on the center layer
● or bring out the dominant’s silhouette
● or impress with the scale of the scene
○ by putting other elements in perspective and creating depth
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Observation Parameters
So the composition might be static
● but some parameters might modify that
● because the player’s position (and camera) will most likely be dynamic
Low angle
● the dominant is seen from a higher standpoint
● this image create depth and perspective
● the angle also gives good visibility on the rest of the level
● useful for letting the player create his or her own tactics
● or tracing a path to the objective
Flat angle
● here, the dominant is seen without having to move the camera
● with a flat terrain, the scene can seem uninteresting
○ unless it has a big dominant
○ or if perspective is faked
● here, the terrain between the player and the dominant has been lowered to create depth
High angle
● here the dominant is seen from down below and takes a lot of place in the composition
● it shrinks the surrounding elements

Composition Angle
Front angle
● this angle works well when the layers of composition are far from the player
● these compositions can be more dangerous with a facing angle
○ because they can become boring and monotonous
○ this is due to barely seen perspective
Half-side angle
● usually the most used angle because perspective is very much visible
● it’s dynamic, but not too eccentric
Side angle
● this angle will stretch the perspective to the distance
○ and is useful to show any pattern running along with the distance
● without a good dominant, this type of composition can become confusing, or monotonous
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Observation Spots
Building composition can be very simple when the observer is not able to move
● or if the camera is fixed, or if the planer is funneled through a single entry point
● things get complicated when the camera travels through the scene
Funnel
● we often see funnel techniques to frame the dominant
● like a tunnel leading to the exterior
● this method is much used in linear levels
Multiple points
● a large open world will bring a lot of additional angles
○ and compromises on the composition will need to be done
○ trying to make the environment look perfect from all angles will turn into a mess
● in these cases, just having a strong and well-visible dominant is enough
Dominant Positioning
The position of the dominant will have an important effect on the composition
Symmetric position
● the dominant is centered
○ and might need the camera to be fixed or funneled
● the composition can feel synthetic, built, and (maybe) too clean
● again, it is useful if the goal is to showcase patterns or architecture
Asymmetric position
● the dominant is not the central object in the frame
● it feels more organic, or more natural
Balance
● Placement of elements in the scene are determined by balance
○ in other words, the attractiveness of each element in the scene
● too many attractive things will dilute the attention
○ and not enough might just do the same thing
Heavy visual weight
● large scale, detailed, dark color, intensive color, heavy contrast
Light visual weight
● small scale, mundane appearance, light color, soft color, light contrast
With this, you can make sure your dominant element has the highest weight in the mix
● It is then a matter of positioning to get the desired balance
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VIRTUAL PROJECT
MANAGEMENT
01
02
03
04
05
06
07

Tech Intro
Game Project Pipeline, Roles, & Case for Game Cinematics
Versioning, Folder Structures, & Naming Conventions
Project Management Tools & The Game FSO
Team Roles
Roles & Team Review
Production Plan

Virtual Project Management 01:

Tech Intro: Introduce logging into computer, accounts, Google drive &
chat, blog to access lesson plans and past games

Facilitator: Nancy Townsend

Population:
This lesson was created for young adults (18+) at the Skins 5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Monday July 17, 4:15PM
35 minutes
Instructor Prerequisites:
Comfortable and familiar with all software being used
Explore game library
Student Prerequisites:
Equipment, Software Materials:
Individual participant stations with pre-set Google accounts
Objectives:
Students log onto computers for the first time and become comfortable with tools being used
WEB RESOURCES & BOOKS:
“Papo & Yo” Wired Article, 2012
Review: Autobiographical Story of Child Abuse Papo & Yo Pushes Games Forward, Awkwardly
Preparation:
● GOOGLE VS. OTHER ACCOUNTS!
○ Info on the backside of nametags
○ All forwards to same gmail inbox, so keep organized.
○ Google group created so that one email address can reach everyone
●

OPEN CHROME FOR BLOG
○ Find blog at skins.abtec.org/skins5.0/ → add to bookmarks bar
○ All lesson plans accessible with password skinsabtec
■ as an “open source” workshop, we encourage these lesson plans to be shared.

●

GOOGLE DRIVE
○ Go to drive.google.com → add to bookmarks bar
○ Login using skins.abtec.org email
○ See shared drive files, everyone has access
○ Test writing in new gdoc. All can work on same doc at once!
○ We will be using to often for prototyping!

●

JING + GOOGLE DRIVE FOR ARCHIVING/SHARING IMAGES:
○ Versioning system will be used for Game Project files, but we can have simple image and
file sharing via Google Drive or if you want to troubleshoot with each other or just
document a funny error
○ Exercise:
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■
■
■
■
■

Open “Jing” to take a screenshot
Save image to desktop
Upload to Google Drive “Images” Folder.
Everyone can now see it!
See test Game SFO, to explore in detail later

●

GOOGLE HANGOUT
○ Go to hangout.google.com → add to bookmarks bar
○ See how to start a group chat with one another. Especially useful for quick questions
between team members.

●

OPEN STEAM
○ Use account details on nametag
○ If for any reason you need to reset, validation email will go to your @skins.abtec.org
gmail account.
○ Games for individuals and many more on Steam Obx (presentation computer) to play
during breaks.

●

●

INTRO TO “NEVER ALONE”
○ Donated by Upper One Games, also known as Kisima Inŋitchuŋa ("I am not
alone") based on traditional Indigenous Alaskan tale "Kunuuksaayuka".
○ First recorded by master storyteller, Robert Nasruk Cleveland
○ Complete puzzles as a girl named Nuna and her Arctic Fox companion.
○ MADE WITH UNITY ENGINE
○ View Cinematic Trailer (1:55)

●

INTRO TO “PAPO & YO”
○ Donated by small indie studio, Minority Media (where Nancy used to work as
Project Manager)
○ Created by Vander Caballero of Brazil
○ Award winning example of a personal experience being translated into
fantastical and interactive.
○ MADE WITH UNREAL ENGINE
○ View cinematic trailer (4:12)

INTRO TO PREVIOUS SKINS GAMES
○ Skins 3.0. S kahiòn:hati: Rise of the Kanien'keha:ka Legends
■ MADE WITH UNITY ENGINE
○ Skins 4.0. I enién:te and The Peacemaker's Wampum
■ MADE WITH CONSTRUCT
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Virtual Project Management 02:

Game Project Pipeline/Roles: Introduction to the process and roles of
professional game development team. Explain workshop teams/roles and
have them think about what they’d like to work on

Facilitator: Nancy Townsend

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday July 18, 4:15PM
45 minutes
Instructor Prerequisites:
Ideally, project management experience to best answer any questions
Student Prerequisites:
N/A
Equipment, Software Materials:
Presentation computer and screen for slides
Objectives:
Students Become Familiar with the typical roles on a game development team
Vocabulary:
WEB RESOURCES & BOOKS:
Preparation:
JOBS IN THE GAME INDUSTRY
1.

2.

3.

4.

ADMINISTRATORS/EXECUTIVE BRANCH: This branch is in place usually before anyone else and
have the most power but also most pressure. Balance of ensure a project has a content staff but
is also profitable, sometimes at the risk of a terrible product.
a. Producer (get funding and arrange team to get projects started and afloat)
b. Director (usually a link between business and creatives. Has power to make final,
creative decisions based upon decision made by Producer, who listens to marketers)
PRE-PRODUCTION / PROTOTYPING:
a. Writer
b. Game Designer
c. Concept Artist
PRODUCTION - TECH
a. Software Developer (can use a pre-built engine or work from scratch)
b. Programmer
c. Level Editor
PRODUCTION - ART
a. Modeling / Texturing
b. Animator
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5.

c. 2D Designer
d. Audio Engineer
POST-PRODUCTION
a. Marketing
b. Tester / Quality Assurance

SKINS SIMPLIFIED, GROUP-OWNERSHIP VENTURE (see poster)
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CASE FOR GAME CINEMATICS:
● What are in-game cinematics?
○ Any time the gameplay action stops, sometimes with little or no character control, with
a pre-set “scene”. May or may not have dialog. Can also be “Quick Time Events”
pre-animated with little to no user input to do a “finishing move”.
● Why do we have them?
○ Based on older generation game consoles that could not handle the real-time rendering
now possible. “Cinematic” scenes we pre-rendered to add to the significant story
moments.
○ No longer necessary and in fact, arguable, detrimental to “player immersion”
○ Still used, though? Why?
■ Reward for players!
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■
■
■
■

A break for players
In RPGs especially, helps forge a relationship with the character
Real-time rendering is still not completely up to par with cinematic rendering.
Large war scenes, for example, with millions of models need to be
pre-rendered and help build a sense of urgency.
For marketing purposes (WoW)
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Virtual Project Manangement 03

Versioning, Folder Structures and Naming Convention
Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday 19 July 10:45AM
30 minutes
Instructor Prerequisites:
▪ Access (login/password) to server hosting Skins 5.0 Template Game and Skins 5.0 Course Material
▪ Completed a workspace update on both repositories, tested connection and ensured proper
functionality and project structure
Student Prerequisites:
▪ Access to hosting server (login user and password)
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Plastic Gluon (synced to the project repository)
Objectives:
1. Teach the tools for keeping organized in order to keep production efficient and with minimal hiccups
2. Have them access the Plastic Gluon server and go through the workflow
Vocabulary:
Checkout, Checkin, Add, Configure, Changeset
Web Resources:
Plastic Gluon
Procedure:
Refers to “Skins 5.0 | Virtual Project Management 03 | Versioning, Folder Structures and Naming
Convention.slides”

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Slide 02: Staying Organized – Overview
Begin by stressing how important it is to keep folders and files organized. When working in large groups with
everybody sharing files, things can inevitably get a little messy. To ensure that everything is easily findable,
every file should have a specific LOCATION and a specific NAME.
Slide 3. Folder Structures
Explain how in-progress art work files and completed, exported game assets are kept in different
folder sets. Include screen shots of this exact structure from the test project SVN. The setup should be as so:
MASTER PROJECT
1. Animation
a. Animation Clips
i.
Characters
ii.
Environment
iii.
Props
b. Animator Controllers
i.
Characters
ii.
Environment
iii.
Props
2. Art Assets
a. 2D Art
i.
Textures
1. Characters
2. Environment
3. Props
ii.
Sprites
iii.
User Interface
b. 3D Art
i.
Characters
ii.
Environment
iii.
Props
3. Audio
a. Dialogue
b. Music
c. SoundFX
4. Prefabs
a. Characters
b. Environment
c. Props
5. Resources
a. Script Assets
6. Scripts
a. Game Scripts
b. Scriptable Objects
c. Utilities
7. Third Party Assets

WORK IN PROGRESS ART ASSETS
1. Concept
a. Concept Art
i.
Characters
ii.
Environment
iii.
Props
b. Documentation
c. References
2. 2D Art
a. Textures
i.
Characters
ii.
Environment
iii.
Props
b. Sprites
c. User Interface
3. 3D Art
a. Characters
b. Environment
c. Props
4. Audio
a. Dialogue
b. Music
c. SoundFX

*Note: only finished exported assets (.png, .fbx, .wav, .mp4, etc) should be in the Master Project (no raw file
such as .psd, .aup, or .blend). All in progress assets should be in the Work In Progress Art Assets. The only
exceptions are scripts which should always be created and worked on in the Master Project.
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Slide 4. Naming Conventions – Rules
In order to ensure that our files move easily between operating systems and servers, there are some
basic rules we need to follow.
1. General Rule: a descriptive title
<ObjectTitle>_<ObjectDetail>
2. All files with multiple words must be written using one capital letter at the beginning of each work
(called Pascal Case convention).
ThisIsPascalCase
3. Since we are using a version control software, we don’t need to keep local versions of our files. So for
that, we want to avoid giving our work in progress version numbers in their names. We can fetch
previous versions within the version control software
4. Assets must only use alpha numeric values (a,b,c,…123…underscores). NO SPACES. NO
PUNCTUATION (e.g. $#%@&^).

GOOD EXAMPLES

BAD EXAMPLES

Arrow.blend

object1.blend

MagicianBoy_Hat.blend

magician boy hat.blend

BowAndArrow.blend

Bow&Arrow.blend

Slide 5. Naming Conventions – Linked Files
Every item created should be already named in the asset list. This name is what you use to refer to
that object from then on, changing the convention based on what it is or where it is placed. The idea is to have
separate parts of an object have the same name so that we know they are linked.
For example, a character model in her second outfit would be called “Eve_Possessed.blend”.
Therefore, all the files associated with her would be called “Eve_Posessed_eye.psd” and
“Eve_Possessed_cloak.png”.
Or, if you have one model that has many different materials, it could be named as:
FoldingChair_Metal
FoldingChair_Plastic
Remember, these items are going to be listed numerically and alphabetically. Similar items should be listed as
close together as possible.
Slide 6. What is Plastic Gluon?
Plastic Gluon is a version control repository tool used to give commands to an outside server where
we store and share all our files. A tool like this is used by most professional game companies in order to
ensure easy sharing, backups, avoid bottlenecks, avoiding overlaps and all around efficiency when hundreds of
people are working on one single project. How?
Easy Sharing: In a nutshell, repositories basically allow hundreds of people to save onto one server. Almost as
if you were all connected and working from the same computer. No more passing around possibly outdated
files on USB keys, as everyone in the group can open and access everything as it is being updated.
Backing Up: We’ve all had one of those painful moments when something goes wrong with our computers.
Perhaps a piece of hardware breaks, perhaps you just decided to fiddle with your file to the point where it
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doesn’t work anymore. Repositories allow you to revert back to the file from the last time you checked in
from. Even if you completely lost your file, it is still there on the server for you to bring back to life on a new
machine.
Avoiding Bottlenecks: Bottlenecks occur when several people are waiting on one or two resources in order to
move forward. Basically, employees sometimes get stuck twiddling their thumbs because they want to check
on so-and-so’s old concept art and that person is on vacation. Since everyone has access to everything on
repositories, such a thing rarely becomes as issue (assuming the production pipeline is scheduled correctly).
Avoiding Overlaps: the bottleneck issue does however cause worry that maybe more than one person could
be working on the same file, and all hell breaks loose! But working off of a repository is not the same as
working directly off a server. The same files that are out there on our working server hard drives are also on
your local computer and need to be checked out, updated and checked back in. So people can freely check out
and PLAY with files, and then choose to not check those changes back in.
Altogether, this equals EFFICIENCY!
SVN Vocabulary: Checkout, Update, Add, Check in, Rename, Delete, Changeset, Locked, Undo Checkout
revert to previous changeset.
Slide 7. How to use Plastic Gluon: Setting Up Network
We will be using a locally hosted server to host our game project and the tool Plastic Gluon in order
to control things. We have already set up Repositories for your individual projects based on the same folder
structures as before. We will also be showing you our demo game and how our files are set up.
All the files are already on the server, but we now want to transfer them to your local computer. Everyone is
copying a mirror of what is on the server. And if you make any changes on your end, you’ll have to checkin to
reflect back to the server and update to mirror back. To expand upon later.
Have the server address available for them to copy and paste from the front page of the asset list!
There are 4 steps to setting up the repository on your computer:
1. you have to enter the location of your server, you can find the server address on the front page of the
asset list. You can also hit the Scan Network button and you should find the server if you are
connected to its network. Hit connect when you have the server selected.
2. Once connected, you can login with your user information. Input your account name, followed by
your password (both found on your name tags) and hit Check. If you input the information properly,
you should get a confirmation message appear next to the Check button
3. Next you need to choose the repo you want to clone. It is possible to create new repos however, all
you need to do is select one of the already created ones for this workshop. Select the Template Game
Repo
4. Now we need to tell the client where to store the repo. The repo is simply a smart directory so we
just need to give it a location much like any other folder on a computer. Put it somewhere you will
remember (create a folder in the desktop or keep it in the default location)
The we hit apply and we have our first repo setup locally.
Slide 8. How to use Plastic Gluon: Selecting Which Files to Clone From the Repo
The beauty of Plastic Gluon, unlike most other version control systems, is that you can choose which
files to clone from the repo. Artists no longer need to have all of the Unity and programming files cluttering
their computer. You can select the individual files you want to have local access to. To do this, you need to
select configure. This will show you all of the folders and files that are on the repo. Then all you need to do is
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select the files you want by checking the check box on the left. Then hit apply and you’re good to go.
Slide 9. How to use Plastic Gluon: Adding Files or Folders
Creating a file or folder inside the repository directory is not enough for it to be part of the actual
repository. Meaning that unless you add it to the repo and check it in, your teammates won’t be able to access
it from their workstations. In order to add a file or folder to the repo, you need to select it, then right click on
it, and select Add to source control. Once that is done, you can then check in those files and/or folders by
going to the Checkin changes section, writing a descriptive comment of what this check in represents and then
hit checkin.
Slide 10. How to use Plastic Gluon: Checking-Out Files
Whenever you want to start working on a file that already exists within the repo, MAKE SURE YOU
ALWAYS CHECK IT OUT FIRST. This is extremely important because once a file is checkout, it cannot be
overwritten by anyone else until it is checked back in. This reduces the risk of more than one person modifying
a file at the same time, which would cause conflicts within the versioning system.
Slide 11. How to use Plastic Gluon: Checking in Changes
Once a file is checked out, it is no longer available to be overwritten by anyone else. People can still
open it and look at it, but it becomes read only until it is checked back in. To check in a file, one must select
the file, then right click it and select checkin. This will bring you to the checkin section where you can write a
descriptive comment of what this checkin represents and then hit checkin.
Explain how you can turn the repo folder upside down, feel free to make terrible mistakes. But as long as you
don't CHECKIN those errors, they will never get to the server and thus never to your teammates. When you
make any significant change or addition, checkin the files. Consider it as saving.
CHECKIN = SAVING
Slide 12. How to use Plastic Gluon: Updating
Explain that the update Workspace action brings files that your teammates have edited or added
onto your computer. Do this every time you start working, for other people may have already touched the file
you intend to work on. Green check marks mean everything is good.
Slide 13. How to use Plastic Gluon: Commenting on Checkins
ALWAYS comment on your checkins so that teammates can see why you decided to change things.
Also for your own personal reference if you made a mistake and need to revert. If your checkin is successful,
your new folders and changed files become green check marks.
Slide 14. Viewing Changesets
You know those notes you should be writing every time you checkin? Well they are all stored in the
changesets and are viewable at any time. You can see all the additions, commits and updates that your entire
team made. Here you can find at what revision number each checkin is at.
Slide 15. Reverting files
FINALLY, in the end the primary point of a repository is not just so you guys can easily SHARE and
backup files in multiple places, but so that VERSIONS are automatically saved as you work. That means that if
your file explodes for whatever reason, you can roll it back to the last time you committed it to the server. A
quick and easy “undo” button allows you to revert to the last checked in version. However, it is possible to
revert to older versions by selecting the specific file chageset on the right of the Gluon interface when the file
is selected. Here you can see all previous versions with the specific changeset number, the person who
checked in that version and the date. Right below that, is a text box that displays the comment for each
changeset. To revert to a previous version, simply right click on the version you wish to revert to and select
revert to this revision.
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Slide 16. ALWAYS REMEMBER TO CHECKIN AND UPDATE OFTEN
You shouldn’t wait to accumulate 10 files that are checkout before checking in. You never know when
someone may need to go into a file to make small changes so if you are not using it, MAKE SURE TO CHECK IN
A CHECKED OUT FILE. Don’t bogart files.
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Virtual Project Management 04:

Project Management Tools & the Game FSO: Show how the Game
FSO will work. By end of day, basic roles will be assigned once everyone is
familiar with software capabilities.

Facilitator: Nancy Townsend

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Thursday July 20, 9:15AM
20 minutes
Instructor Prerequisites:
Familiarity with project management tools
Access to Google Drive Game SFO Example
Student Prerequisites:
Plastic Gluon
Naming Conventions
Equipment, Software Materials:
Individual computer stations with access to Plastic Gluon and Google Drive
Objectives:
All participants become familiar with and comfortable with filling in and updating the game SFO
Vocabulary:
Game SFO
WEB RESOURCES & BOOKS:
Preparation:
OTHER, PROFESSIONAL PROJECT MANAGEMENT TOOLS:
1. OLD SCHOOL

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

2.

TRELLO

3. ASANA

We will be using GOOGLE SHEETS
WHAT IS A GAME FSO?
● FSO Stands for “Feature Sign Off”. Is it a project management tools, of which all game developer
teams need to use in some form, to list all required project assets and see who is working on
what.

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

●

●

May also be referred to as an “Asset List”. An item is a game, such as the “pulley” in our demo,
may require several “features” before it is functional. For example:
○ Pulley Model + Texture
○ Pulley break animation
○ Pulley Break sound
This allows large teams to flow together and know the status of each item, practically without
having the speak face-to-face (though this is encouraged). If you see that a modeler has
completed a model, an animator knows that it will be up on the versioning system and can now
be animated. After animation, level designers know it can be placed in the scene and
programmers can add interactivity, etc.

DISCIPLINES:
● Code
● Modeling
● Animation
● Sound
● Graphics
PRODUCTION STATUS:
● Pending
● In progress
● Prototyped
● Revisions Needed
● Complete
● Cut
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Virtual Project Management 05:

Team Roles [Prototyping & Production]: Review of the production

Pipeline and Roles. Now that we have touched upon all software and asset
creation, roles can be assigned and students can plan their learning routes
based upon what they want to learn / what they already know.
Facilitator: Nancy

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Thursday July 20, 4:00PM
50 minutes
Instructor Prerequisites:
Familiarity with Game FSO
Student Prerequisites:
Previous “Virtual Project Management” Lessons
Equipment, Software Materials:
N/A
Objectives:
Discussion as a team to decide how participants what to engage with the project
WEB RESOURCES & BOOKS:
Preparation:
OPEN DISCUSS
Review the “Game Development Workflow” Poster. Reminder of team splits. Individual participants can
choose their preferred route and IIF staff tried to encourage an even split.
PROTOTYPING TEAMS
● Story
● Art
● Level Design
PRODUCTION TEAMS:
● DIGITAL IMAGING
○ 3D Animation
○ 3D/2D Cinematics
● GAME ENGINEERING
○ Game Soundscapes
○ Game Programming
Prepare to split into teams for following day prototyping.
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DIGITAL IMAGING
01
02
03
04
05
06
07
08
09
10
11

Into to Photoshop
Intro to Blender
Concept Art & Style Design
Drawing & Photoshop Inking
Technical Drawing for Blender
Intro to Modelling in Blender
Character Modelling
UV Mapping
Textures & Materials
Principles of Animation
Rendering Images in Blender

Digital Imaging 01:

Intro to Photoshop: Teach the basics tools, layers and saving. Show off a
more complex projects & wacom tablet use to show what could be done
with the software, including quick gifs!

Facilitator: Jasmine Eladas

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 19, 11:30AM
1 hour
Instructor Prerequisites:
Access (login/password) to hosting server
Completed an update, add and commit on the server test prior to lesson and set up folder structures for
the projects already discussed
Student Prerequisites:
Access (login/password) to hosting server
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Individual computers for each student with Photoshop installed
Objectives:
Teach the students the tools of using Photoshop, keeping organized to keep production efficient and with
minimal hiccups. Basic tools, layers, and saving. How Photoshop can be used in game production.
Vocabulary:
Layers, Crop, Clone Tool, Blending Modes, Filters
WEB RESOURCES & BOOKS:
Photoshop Tutorials:
www.photoshoptutorials.ws/
http://www.photoshopessentials.com/
http://www.photoshop.com/tutorials
https://design.tutsplus.com/series/learn-adobe-photoshop--cms-1098
http://abduzeedo.com/tags/photoshop
http://www.digitalartsonline.co.uk/features/illustration/86-best-photoshop-tutorials-updated/
Procedure:
Refers to “Introduction to Photoshop.Powerpoint.pptx”
What is Photoshop–Overview
Photoshop is a software used to create new or modify existing 2D images. Often used to professionally
edit photos or create new images from scratch. As well as editing photos, Photoshop is widely used to
create digital art, using the advanced brush tools. A combination of both the photo editing and drawing
tools will be used to create game assets and concept art.
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Getting Started
To Make a new File choose File> New
In the “New” dialog box that appears you can set different settings for the new file.
Name: defines the name of the file (remember your naming conventions)
Width and Height: specify the size of the canvas
Resolution: “crispness” of the file in dpi (digital pixels/inch). Higher resolutions increase file size
Web is usually 72 dpi , Print is usually 150 or 300 dpi
Large digital paintings (like concept art or promo materials) should be 300 dpi or higher
Resolution can always be downscaled but is very hard to scale up
Color Mode: RGB colour for digital, CMYK for print
Background: White or transparent, can be changed later
Leave the advanced options as they are.
Introduction to Layers
Photoshop works with Layers to display images. A new document always starts with only a Background
Layer. All important elements in a single file should be on separate layers. This allows for non-destructive
editing and enhances the workflow and adjustment of different elements.
Layers are also great if you are unsure of a modification you would like to make to your design. Simply
create a new layer and try your idea out. If it doesn’t look good you can simply delete the new layer and
all of your previous work will be unaffected.
There are a lot of other options in the layers panel (see .ppt). You can link layers to move/resize them
together as well as group them for better organization. You can add special effects, masks, and
adjustment layers as well as change how the layers “blend” together (blending modes).
Blending modes determine how layers should blend together. Each setting performs a different set of
calculations on the pixels to “mix” them. The blending mode can be accessed in the layer panel. Cycle
through the options with the arrow keys once the blend mode options are open. Experimentation is key!
Also try changing the opacity of the blend mode since at 100% the effect is usually too strong.
Some helpful shortcuts for this panel:
CTRL + E: merge selected layers
CTRL + SHIFT + N: new layer
CTRL + J: duplicate layer
Introduction to Tools
Photoshop features many tools with diverse functions. However, in this lesson we will only focus on the
most essential tools to us.
Marquee Tool:
The Marquee tool is used to select an area for editing. You can select with a rectangle or ellipse
selection and is useful for selecting perfect geometric shapes. Once the selection is made, edits
can only be made inside the selected area. To invert the selection, right click and select “Select
Inverse”.(edits can only be made OUTSIDE the selected area) and CTRL + D will deselect any
selection.
Lasso Tool (L):
The Lasso tool allows for freeform selection. The Magnetic Lasso tool will adhere to sharp
contrasts in colour, “guiding” the selection. Hold ALT to subtract areas from the selection and
hold SHIFT to add areas.
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Magic Wand (W):
With the Magic Wand, you can select areas that have a common colour. This is especially useful if
you would like to change the colour of a relatively solid area of colour but it has an uncommon
shape. Ex. The sky behind the leaves of a tree, dirt between pebbles on the ground.
Once the Magic Wand is selected, in the toolbar, there is a setting called Tolerance. The
Tolerance determines how strict the Magic Wand will be when it selects pixels of a similar colour.
For example, if you click on the whitest area in a black to white gradient, a tolerance of 0 will
select only the white pixels you clicked on. A tolerance of 20 or 30 will select some of the grey
areas. Higher tolerance values make the Magic Wand less “picky.” The maximum value for
Tolerance is 100.
Crop Tool (C):
The crop tool adjusts the canvas size of your image. You can make a new crop selection, or enter
the exact size in the crop tool bar at the top of the screen (only active when the crop tool is
selected). Hold SHIFT while resizing the crop box to keep the same aspect ratio for the new area.
In the toolbar, you can also set a new aspect ratio to crop to.
Move Tool (V):
The move tool allows you to move and transform the currently selected layer. If a selection is
active, it will only move and transform that selection instead. The move tool will only move the
current layer, no matter where you click. To be able to select and move directly from the canvas
instead of in the layers, check the Auto-Select box in the toolbar.
Transform (CTRL + T):
To transform the selection, use CTRL + T. From here, you can move, rotate, and resize the
selection. Right click to see more options as well. Hold SHIFT while resizing to keep the
proportions. Use the arrow buttons to move more precisely. Press ESC to cancel the
transformation or ENTER to confirm it.
Brush Tool (B):
Used to draw! There are lots of brush settings that can be adjusted to mimic different kinds of
traditional brushes or to create patterns. (ex. pencil, inking, pastel, watercolour) You can also
download brushes from the internet. Working with a drawing tablet greatly enhances the use of
this tool.
Hold SHIFT to draw perfect horizontal and vertical lines.
Use the { or } keys to adjust the size the of the brush.
Right click to quickly access your brushes and some brush settings
Clone Tool (S):
The clone tool is very important with working with textures. It allows you to “clone” one area of
an image to duplicate it elsewhere. To select the cloning source, hold ALT and click. Then you can
use source to edit another area.
Right click to change brush settings like size and hardness. Soft brushes can help make the brush
look more natural.
Eraser Tool (E):
The eraser tool works exactly like the brush tool, except it erases! Different brushes can create
different effects, and the eraser brush settings can be edited just like the Brush tool.
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Adjustment Layers
Adjustment layers are non-destructive layers that can be used to adjust the colour and tonal
quality of the image. To create a new adjustment layer, simply click on the respective icon and
you will be prompted with the type of adjustment layer you would like to make.
There are many types of adjustment layers:
Brightness and Contrast: adjusts the tonal range of the image
Levels: adjusts the shadows, midtones, and highlights of the image
Curves: can adjust the tonal range of the image very precisely
Hue/Saturation: adjusts the hue and saturation of the entire image or specific colours
Color Balance: changes the mixture of colours, brings out or lessens certain colours
Gradient Map: converts the grayscale range of the image to have a gradient fill
Be careful when applying Adjustments, it is often tempting to overuse these layers. Subtlety is
often key, and if they are too strong, the adjustments can make an image look “synthetic”.
Experiment with the settings and even the blend modes of the adjustment layers to achieve
the most successful image. A useful tip is to flick the adjustment layer visibility on and off to
see if your image has improved or not.

Filters
Photoshop filters can be accessed from the top menu bar. From there, you can pick from many kinds of
filters such as Blur, Distort, Stylize, etc. Each filter also has multiple settings to adjust. Experiment is key!
Finally, filters can be applied more than once to strengthen their effect.
Some common filters:
Gaussian Blur: blurs the image by an adjustable amount
Add Noise: applies random pixels to an image, can simulate a more realistic look
Sharpen: improves a selections clarity
Mask Layers
A mask layer is a layer that modifies the visibility of the layer it is attached to. To create a mask make sure
you are on the layer you wish to mask, then click the mask icon in the dialog box. Notice that when the
mask layer is selected, the foreground and background colours automatically switch to black and white.
The mask layer only reads in grayscale, white = visible, black = invisible, 50% white = 50% visible. Using
this feature, you can finely tune where exactly you want your layer applied to the image.
Ex. if you are editing a mask applied to an adjustment layer, you will be editing what parts of the image
the adjustment layer affects. If you paint in black on the adjustment layer, those parts of the image won’t
be affected, and if you paint in white, the adjustment layer will apply. This is useful if you only need to
edit parts of an image, like making a ground texture brighter but keeping the sky the same colour.

Exercise: Collage Self-Portrait
1. Find 5-10 photos you could use in your self-portrait. Be creative! Find images of people, animals,
nature, etc.
2. Create a new file(File > New)
a. start with a 1920 x 1080 canvas, you can always crop it later
b. 72dpi
3. Import all your photos (File > Place)
a. Click on the eye icon in the layers panel to hide the photo layers
4. Open a picture of yourself if you want for reference, or just use your imagination!
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5.
6.
7.
8.
9.

Use the selection tools (marquee, lasso, magic wand) to “rip up” the photos to get the parts you
want
Use the move tool (V) to move the pieces around
Once you are finished, save your photoshop file as a .psd so you can edit it later
Then, go to File > Save As.. and pick .png
Done!

Import Photoshop Document into After Effects
Photoshop documents can be imported into After Effects while retaining the layers from the .psd file. This
allows you to animate layers separately. For example, if you have created a scene of a car driving on a
road in photoshop, since the car is on a separate layer from the rest of the image, in After Effects you can
simply animate the car moving across the image. As well, the layers can retain the blending modes and
layer styles from Photoshop, so the image will remain unchanged when importing into After Effects.
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Digital Imaging 02:

Intro to Blender: Basic interface, navigation and selection. Show off
complex models and project made with the FREE software

Facilitator: Jasmine Eladas

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 20, 10:00AM
1 hour
Instructors Prerequisites:
The instructor should be comfortable using Blender (using version 2.78), enough to foresee wrong
keystrokes that the students might make. The instructor should also be familiar with the basics of
modelling techniques in Blender.
OPTIONAL: The instructors might want to download a Blender add-on or a third party software showing
the pressed keyboard keys on the screen, and enable it for the duration of the workshop. Blender’s
add-on is called Screencast Key Status Tool and can be found here.
https://wiki.blender.org/index.php/Extensions:2.6/Py/Scripts/3D_interaction/Screencast_Key_Status_T
ool
To install, right-click the link in the “Current version download” box and select “Save Link As…” This
should save the script as a python file (.py) which can then be accessed from Blender in the Blender
User Preferences (Ctrl+Alt+U) under the Add-ons tab, by clicking “Install from file”.
Once the script has been added to Blender, it needs to be enabled by clicking the checkmark next to
“3d View: Screencast Keys”. Back in the viewport, hit Shift+Alt+C to enable or disable the screencast
keys at the bottom of the Tools shelf.

Students Prerequisites:
The students should have very little knowledge of the interface (camera controls, 3D cursor, nurbs vs.
polygons, T-pose)
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Individual computers for each student with Plastic Gluon and Blender installed
Objectives:
Learn the Blender tools and be able to model a very basic object for their games. Understand the Blender
interface, navigation, and selection.
Vocabulary:
Mesh, vertex, edge, face, normal, move, rotate, scale, selection, extrusion, mirror, subdivision surface,
front view, top view, side view, modifier, 3D cursor, X, Y, Z axis, snapping, d.
Open source, polygons, orthographic/perspective view.
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WEB RESOURCES & BOOKS:
Blender website:
http://www.blender.org/
https://www.blender.org/support/
https://docs.blender.org/manual/en/dev/
Blender Tutorials :
http://skins.abtec.org/skins5.0/software-games/
https://www.blender.org/support/tutorials/
Beginner Blender Tutorial:
https://www.blenderguru.com/tutorials/blender-beginner-tutorial-series
Preparation:
Prepare a PowerPoint with all the steps so that students can refer to it afterwards.
Prepare a sheet with all the shortcuts to be used in the class and write some on the board.

Procedure:
Refers to “Art Module 5. Intro to Modelling in Blender.Powerpoint.ppt”
Intro to Software: Blender 3D
The production of a character requires several steps: concept, modeling, UV mapping, texturing, rigging,
animating, and rendering.
All these steps can be done using the free and open source 3D software Blender.
Introduce this product's website, hardware requirements and community.
Some useful websites:
The Blender Reference Manual for 2.78
https://docs.blender.org/manual/en/dev/
Support and free tutorials:
https://www.blender.org/support/
https://www.blender.org/support/tutorials/
Forums for Blender artists (for help, motivation and feedback)
https://blenderartists.org/forum/
Additionally, a plethora of tutorials of this exist at http://skins.abtec.org/skins5.0/software-games/ for
those students who are interested in self-learning.

Show some examples of films and images made in blender: photo real, stylized and abstract.
Other examples of common software used in the industry: Maya and 3DS Max. The interface we will set
up will have a similar navigation to those and to Unity, the game engine we’ll be using, to ease your way
into learning those if you ever were interested.

The Interface
Splash screen –shows version, last update, etc. (Check to be sure is latest…)
- Release Log
- Presets—Blender/Maya (we will be using Maya presets which are closer to industry standard)
- Recent—shows most recently saved files

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Viewport (main area)
- Grid
- Mesh
- Light
- Camera
- 3D Cursor
- Not important now, but is used mainly as a generic marker/placeholder, when you need to
use specific coordinates in the 3D viewport.
- Toolbar Panel (left) (T to hide/show this panel)
- Properties Panel (right) –display options are in properties panel (N to hide/show this panel)
- X, Y, Z axes: X and Y are like the familiar Cartesian plane we’ve all seen in math class. X and Y
represent horizontal and vertical directions. In 3D however, there is a third axis: depth. The Z
axis completes the third dimension, which goes up and down, perpendicular to the Cartesian
plane.
IMPORTANT: Unity’s axes are different than Blender’s in the fact that Y is up and down, while Z
goes into depth.
- Tab to toggle between object and edit mode. Object is to move around the whole mesh as is,
while edit is to move selected parts of it; to change the mesh itself. For now, we remain in
Object mode.

Setting up Unity/Maya-style navigation
Setting up our 3D navigation for it to match Unity and Autodesk Maya, one of the most used 3D
imaging softwares in the videogame industry, without conflict with the Blender shortcuts.
The workshop leaders may want to do this in advance, or explain it to the students so they can set it up
the same way at home.
In the Blender User Preferences (Ctrl+Alt+U), under the Input tab, the Interaction presets (on the left)
can be changed to Maya. This will change the selection behaviour, like selecting with the left-mouse
button rather than the right.
The Key Configuration presets (on the right) should be left untouched as the Blender preset, to be able
to refer to them when watching tutorials for instance. To be able to navigate in the Viewport the same
way you would in Unity or Maya, while maintaining the typical Blender shortcuts, we need to change
the camera view settings manually.
Under 3D View > 3D View (Global);
Alt + Left mouse button: rotate view
Alt + Middle mouse button: move view
Alt + Right mouse button: dolly view
Careful! While scrolling the mouse wheel dollies (zooms) in and out, Alt+Mouse wheel scrubs the
animation timeline.
Then, to avoid conflict with the other typical shortcuts (shortcut assigned twice):
Under 3D View > Mesh;
Click the arrow next to the first Loop Select m
 enu and change Press to Double-Click.
Similarly, under 3D View > W
 eight Paint, the first Weight Gradient menu must be changed from Press
to Double-Click.
Similar action should be done if there is another conflict of shortcuts in another editing menu.
Remember that these changes will remain during all mesh editing operations.
Remember to SAVE your User Settings at the bottom of the page when you’re all done.
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These instructions can be followed and further explained with this video by Marco Neumann.
http://lesterbanks.com/2014/02/setting-maya-style-viewport-navigation-blender/

Timeline
- For animation
- Show scrubbing back and forth
- To revisit later, when learning about animation (not too detailed here!)
Outliner
- Shows you everything in the scene
- Quick selection of various elements
- Shows hierarchy, layers of elements
View (manipulation of object in next module):
Perspective and orthographic views
On Numpad, or if no numpad, on main 1-0 keys:
- 1 : Front View
- 3 : Right View
- 5 : TOGGLE between Orthographic and Perspective view
- 7 : Top View
- 9 : Bottom View
Note: check the top-left corner of your window for the view you’re in!
As well, the keys 2, 4, 6 and 8 help to rotate the view around in increments. With this you can achieve a
Left view easily if needed, starting from the front view.

What is the Orthographic view? As explained on the Blender Wiki…
Our eye is used to perspective viewing because distant objects appear smaller. Orthographic projection
often seems a bit odd at first, because objects stay the same size independent of their distance. It is like
viewing the scene from an infinitely distant point. Nevertheless, orthographic viewing is very useful (it i
the default in Blender and most other 3D applications), because it provides a more “technical” insight
into the scene, making it easier to draw and judge proportions.
https://wiki.blender.org/index.php/Doc:2.4/Manual/3D_interaction/Navigating/3D_View
User Preferences
Try out standard settings, and see how they work for you. It is best to try and keep them
standard for the sake of this workshop, in order to be able to help other students at their stations or for
them to help at yours. In case you need to change anything, here’s how, along with a few suggestions.
CTRL + ALT + U = User Preferences.
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Optional interface and manipulation changes in the Blender User Preferences
Emulate Numpad
If the instructor or students are using laptops that do not have a Numpad, it should be pointed out that
under the Input tab, you can check the option Emulate Numpad, which will move the camera controls
to the main 1 to 0 keys. Usually those keys are used for switching in between layers in the editor, but
the layers can be accessed in a clickable menu the header.
Rotate Around Selection
In the Interface tab, under View Manipulation, you can check Rotate Around Selection. This places the
selected object as the pivot point for the camera rotation. It helps with not getting lost rotating around
the scene when you’re not too accustomed to the interface yet.
Continuous Grab
Under Input, you can check Continuous Grab, which lets your mouse loop around the screen while
doing certain manipulations. To try it, in object mode, scale an object to an enormous size, sliding the
mouse across the screen. You should see the mouse reappear on the other side of the screen, letting
you continue to scale without interruption.
Auto-Saving
It is good to know that Blender automatically saves temporary files every 2 minutes. This can be
modified under the File tab. Although, those automatic saves are not active in edit or sculpt mode, so
it’s good to remember to save manually! If needed, you can even set up to have multiple save versions,
in case you save over a file by accident.
Region Overlap
Under the System tab, near the center of the page, you can check Region Overlap. This gives some
transparency to the Tool Shelf (T) and Properties Region (N) and the viewport’s perspective doesn’t
then change if you make those menus appear or disappear, giving you a larger view of your workspace.
DPI/Virtual Pixel Mode
If you need to adjust the size of the fonts on the interface, on the top left of the System tab you can
find the Dots Per Inch (DPI) and Virtual Pixel Mode fields, which can be modified to your taste.
!!! Remember to SAVE your User Settings at the bottom of the page when you’re all done !!!
These settings can be changed at anytime to accommodate your workflow.

Splitting/Joining Views:
This will become more useful when you are doing things which require you to see more than one view.
For example, when we get into UV mapping, you’ll want to see your model and the UV Editor.
Split:
- Grab the little arrowed bottom-left hand corner of your window and drag it upwards.
- You can split as many times as you need, but don’t split it too many times or you
might get confused!
Join:
- If you’ve split too many times or simply don’t need the extra windows anymore, Grab
that same corner and drag it towards the other window.
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- An arrow will appear; Blender would like to know which way you want to collapse the
window. It points to the one you will be taking away. Move your mouse in the other
direction to change the direction of the arrow.
- Let go of the left mouse button and you have joined your windows.
Another way to do this is to hover the mouse at the intersection of two views and select
Split Area or Join Area, then move the mouse to choose which way to split or join,
and confirm by left-clicking.
Other Screen Layouts
Blender also has a lot of screen layouts built in that you can choose from depending on what kind
of task you are working on. Those layouts are also customizable, and you can make some new ones of
your own, so once you get a bit more comfortable with the software it might be something to try out.
Main Manipulators
Scale, Rotate, Translate
- Scale: make something bigger or smaller by pressing S (Scale)
- Rotate: rotate objects by pressing R (Rotate)
- Translate or Move: move something by pressing G (Grab)
These three tools have easy-to-use visual manipulators (or widgets) that can be found on the header,
traditionally at the bottom of the viewport. Those are the little arrows on the object that are color-coded
the same as the axes.
Alternatively, if you would like to learn how to move objects around without the help of widgets, you can
press G and then type the letter of the axis you would like the transform to follow (X, Y or Z). You can
then either move the mouse around and confirm with left-click, or even move the object precisely by
entering a numerical value before left-clicking to confirm. The same kind of logic can be transferred to the
Scale (S) and Rotate (R) manipulators. These kinds of shortcut-based manipulations, while initially harder
to get a hang of, are part of why many 3D artists choose to use Blender professionally.
In the following exercise, we will explore both ways of manipulating objects in the scene; you can pick
which one you’re most comfortable with.
As we are about to start working, here is a reminder: 3D software is prone to crashing.
Save often! SAVE. SAVE. SAVE!
Even better is to have a good naming scheme, understandable by you and by others
on your team.
When working at home on your own projects, make sure to make regular backups to another machine, a
USB key or an external hard-drive in case of a power failure or some other technical problem that might
corrupt your files.
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Make a Snowman
1.

Shift + A to add an object. All sorts of objects are there, some simpler than others.

2.

Hover the mouse on Mesh; Choose UV Sphere

3.

Go into Front View (1)

4.

By default, the translation (or grab) manipulator should be shown. Move the sphere where you
like with the help of those arrows.
Note: If the widget is not showing, you can make it appear by clicking on its designated
enable/disable icon on the header (traditionally under the viewport).

5.

WITH WIDGET: Duplicate the sphere (Shift + D) and instantly left-click to confirm. This places the
sphere down at the same place at the first, and lets the translation manipulator appear. Use the
arrows to move the sphere on top of the first one.
WITHOUT WIDGET: Duplicate the sphere (Shift + D) and instantly press the Z key. This should
lock its translation into moving up and down, for the moment. Left-click to confirm the height at
which you’d like it to be, on top of the first sphere.

6.

Scale it down a little bit (S) and adjust its position again with the translation widget, or by
pressing G for grab, then the Z key to lock the translation in that direction, and confirm by
left-clicking.

7.

Duplicate it once more (Shift + D), doing the same manipulations as in step 5 and 6 to place the
third sphere on top of the two others.

8.

Check side views (3) and top views (7)

9.

Orbit around to see it better (Alt+Left Click and drag).

10. DONE!
11. Save scene: Save as snowman.blend to your USB key or desktop folder.
Note: To deselect after making a selection, press A! A is used for selecting/deselecting everything.
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Digital Imaging 03:

Concept Art & Style Design: To inspire students to create, have local

artists show tips and tricks to creating well rounded, deep characters both
in text and visually
Facilitator: Jasmine Eladas

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Friday July 21, 9:15AM
1 hour
Instructor Prerequisites:
The instructor should have some experience with 2D illustration, focused in entertainment design.
Knowledge of basic design language and general art fundamentals.
Student Prerequisites:
The students should have some experience in drawing or an interest in learning to draw.
Equipment, Software Materials:
Presentation screen to show Powerpoint.
Black or white board with pens or chalk available
Pens and paper for students
Objectives:
Learn basics of what makes good design for games. Covers shape language and colours, and goes through
the concept art process.
Vocabulary:
Shape language, mood, colour, silhouette, turnaround
WEB RESOURCES & BOOKS:
Drawing Fundamentals: https://androidarts.com/art_tut.htm
Anatomy: http://www.alexhays.com/loomis/
Concept Art Tutorials: https://www.youtube.com/user/FZDSCHOOL
What is Concept Art?: http://howtonotsuckatgamedesign.com/2014/02/lets-get-real-concept-art/
Technical Drawing & Design: https://www.youtube.com/user/scottrobertsondesign
Colour in storytelling: https://www.youtube.com/watch?v=aXgFcNUWqX0
Composition in storytelling: https://www.youtube.com/watch?v=CvLQJReDhic
Digital Art Podcast: https://www.youtube.com/channel/UCyGGrJ-wQlvcWujLKHzB42w/featured
Preparation:
Prepare powerpoint for slides and images

Note: This is a theoretical lesson on Concept Art and Style design. The more hands-on drawing
exercises are featured in the next Digital Imaging classes, Drawing and Photoshop Inking and Technical
Drawing for Blender.
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What is Concept Art?
Concept art, or visual development, is a core part of what we call the pre-production of a videogame
project, or all the steps needed to organize and plan a project before actually getting into the production
of it. The process of creating concept art is not only limited to videogames, it’s actually central to the
conceptualization of many projects requiring an artistic aspect, for instance
-

Cinema and Television, whether it be traditional, CG or elsewise animated, in terms of set design,
creation of environments, character design, costume design;
Theater, Stage Design and concept of other spaces for performance arts;
Comic books, visual novels, and other printed art...

It serves to establish
Similarly, concept design is a task shared by numerous fields of work, from architects to apparel design,
from tech to transportation. Its purpose is not merely to create cool images; it’s to figure out where the
project is headed, establish goals, and plan ahead. Therefore it’s only natural that this step occurs at the
beginning of a project.
When it comes to videogames, concept artists usually work alongside game designers to establish the
aesthetics and the mood of a game, traditionally through its characters and environment. This goes
from establishing the broad strokes of what the game should look and feel like overall, to deciding the
details of this or that object inside the game, while keeping in mind its function as a part of the whole.
So, how do we do that?
Well, how do you communicate ideas to others visually? Anything goes. Some of the techniques
professionals use include...
- Drawing/Painting, traditionally or digitally;
- Photo-collage/Photobashing;
- Sculpting, traditionally or digitally;
- Non-traditionally, lego blocks (like Christoph Niemann does)
For this workshop, we will use drawing (on paper) and digital painting (with Photoshop) as techniques,
considering its great accessibility in terms of skills and resources.

The Basics: Shape Language

This style sheet of characters from Disney’s Aladdin illustrates character design pretty well.
“All the shapes are pretty much different and contrast each other really nicely giving all the character a
unique feel and make them all that much more interesting to look at. A general rule for character design is
that softer rounder shapes feel friendlier, and angular and straight shapes feel not as friendly. This is not
always the case, but in this example it is for the most part. Genie and The Sultan are round and squishy, it
feels like they're soft and they can't hurt us because they don't have any sharp parts on them. Aladdin and
Jasmine have soft curves but they needed to be stronger characters and so they're a little more bold.
Jafar's shoulders are almost like blades, they feel more aggressive than all the others. They are all solid
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structured shapes.” - Sheridan Portfolio Tips blog

http://sheridanportfoliotips.blogspot.ca/p/character-design.html

Common shapes
Additionally, you can see some shapes reappear as a pattern; squares, circles and triangles.

What do these shapes mean? It’s pretty straightforward, and rather universal. Circles are bouncy and
friendly, squares are solid and stable, and triangles are sharp and can be stable (when pointing up) or
unstable (when pointing down), which can put us at unease.

Think about the Genie in comparison Jafar, in terms of shapes. The Genie is round, friendly, and on top of
it he floats around. It’s a very playful, happy shape. In contrast, Jafar is pointy, with shoulders that shape
an inverted triangle pointing down. He’s stable, but the shoulderpads counterbalance it for an uneasy,
sharp shape.
Thinking about movement and interaction is also an interesting way to figure out these shapes: Jafar’s
long, ominous strides versus the Sultan’s bouncing and the Genie’s disappearing acts.

Some other mainstream, well-known examples.
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Optional:
Think about function

In The Legend of Zelda: The Wind Waker, the normally peaceful dragon Valoo sits atop the volcano of
Dragon Roost Island, his tail stuck inside the opening, held by a monster inside the mountain. Upon
approaching the island, the first idea the player has of Valoo is that he is unmovable, thanks to his
large, stable bottom. The artists gave him a very long, snake-like neck, an interesting and unusual shape
reminding the player of his reptilian nature.
During the fight against the monster inside the volcano, Valoo’s tail sometimes gets caught in the
crossfire. For comedic effect, the cutscenes show Valoo react, his long neck flopping around wildly as
he’s spitting fire all around. For a child playing the game, it makes this gigantic beast a little less
threatening, and makes you feel bad for him, making you want to help by defeating the volcano
monster.

Don’t let these notions limit you

Knowing the effect these pointed, stable and rounded shapes have should not limit you in your creative
process. Sometimes, combinations of them really define a character, and other times, going against a type
can be pretty surprising. You don’t have to stick to these standards, but you should know WHY you’re
going against them!
The Importance of Colour
While we don’t have much time here to talk about the meaning and uses of colour in media, keep in mind
that it can drastically help enhance the feelings and meaning you are trying to imbue in your designs, and
in your game.
In Pan’s Labyrinth, the cold and dark reality versus the warm, bright fantasy world of Ophelia’s mind.
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Giving pure, symbolic colours to objects of importance like in The Sixth Sense

ABSOLUTELY WATCH: https://www.youtube.com/watch?v=aXgFcNUWqX0
See more at: http://www.robertmills.me/colour-and-storytelling-in-films/
Planning out colors for a scene, a level, or a location in a game like in a film.
Pixar uses colour scripts.
“The colour script is an early attempt to map out the colour, lighting, emotion and moods in a film. It’s not
about making a single pretty piece of art; the color script evolves throughout the early stages of the film,
hand in hand with story development.” - Pixar Animation blog by Joshua Vardanega
Similarly, you can plan the colours of an object, a person, or a location in a game as a whole in
pre-production if you feel it’s something you want to explore for storytelling, instead of only focusing the
functionality of colour for gameplay.
What about games?

Firewatch is a narrative game that uses colour to emphasize certain feelings throughout the game, while
enhancing its natural environment, and making stark contrasts between different moments of the day. It
also uses it to emphasize story elements.

Abzu, a game which mostly uses its environment to tell its story, uses colour not only to differentiate
between different environments and story arcs, but also a large difference between the mystical “magic”
world and reality.
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Inside uses sharp contrasts of light and shadow to emphasize the loneliness of its environment, and the
feeling of paranoia. Its world is almost entirely devoid of colour, except for a few elements, like bright
yellow chicks that follow you around at some point, maybe to show the player the beauty and innocence
that was once in that world, or to emphasize the youth of the main character.
The process, step-by-step.
Each artist and designer has their own approach when it comes to drawing and design, but here’s a
suggested process broken down to help you begin creating your own pieces.
1.

Find out what the goals are.
Are we making a static object, far away in the distance? An important quest item? The main
character? What’s the object or character’s function, or how should the player feel about it?

2.

Find inspiration.
The best way to feed a creative brain is not to stare at a blank page, it’s gathering inspiration! By
researching, you will have a better idea of what you might WANT or NOT want to make. A
suggestion is to build a mood board, or a collection of images that inspires your new creation,
whether they be of people, animals, other fictional characters, a screenshot from a movie
scene... It doesn’t have to be pictures directly related to what you’re about to create, but it has to
bring a new interesting aspect to it that will make you think further about it. Think about
different styles, colours, shapes...

3.

Find references.
Are you going to draw a car? Then how about finding pictures of cars that look like what you’re
going to try to build? Maybe that car’s window is broken and has been patched over with some
plastic wrap- what would you want that to look like? Reference pictures differ from inspiration
pictures in the fact that they bring you more ideas about the specific object you’re trying to
make. You may know how to draw A car, but how are you going to draw THIS car? This will help
make it your own. Many artists say that “you are only as good as your references”. The more
research you do, the more ideas you’ll have at your disposal to pick and choose from.
As much as possible, try not to copy over from other creations other people made; this was left
in the “inspiration” process. Inspiring yourself from life will help you decide on the level of detail
you want to push rather than limit yourself to the creative decisions someone else made before
you.
Note: Some things are harder to draw than others. For example, human anatomy is something
many people struggle with drawing, especially since we see and interact with other humans all
day and have a keen eye for what would look off about it. Don’t be shy to look up extra
references of poses, body types, and practice drawing them; we call this life drawing. Many
free online resources offer tips on drawing anatomy, dynamic posing, perspective, etc.

4.

Start sketching!
You’ve gathered inspiration and references, but you can’t get stuck there! The real work happens
now, as you start drawing your piece. Don’t commit to anything yet, just doodle many versions of
the same thing; throw things at the wall and see what sticks. No one created a masterpiece with
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their first 5 brush strokes, so don’t limit yourself, explore and have FUN! Try different styles and
shapes, colours too if you wish, but don’t get caught up in details. You’ll be able to edit all of this
later once you have a better idea of what you want it to be.
A good way to start out is by creating thumbnails, representing the basic shapes of your design.
This is basically working with the silhouette, which will ensure that your piece will communicate
well, since you would be able to read it from afar.
If you feel like something is missing, don’t be afraid to go back to look for more references. Just
make sure that most of your time here is spent drawing. The more iterations you make in this
exploration, the more chances you might end up with something you like that also works with its
function in the project.
5.

Gather feedback.
Once you have a few drawings that might fit the bill, find a few people with whom you can share
the pictures and who understand the function of your design for the project and ask them to
critique your work. Then, using that feedback, go back to the drawing board and improve what
you’ve worked on! This step is especially important because it helps to ensure that your design is
understood by others around you. You may think that your design is undeniably X, but then
another person would interpret it as Y, and you’d have to make a few adjustments.
About feedback
What we’re looking for here is constructive criticism. This is neither positive nor negative
feedback, simply a way to give an opinion that is about the work (not about the artist) that
explains clearly what parts are appropriate or not in relation to the project, and why.
Bad feedback:
“Well this design is stupid and I hate it.”
(Not very helpful)
Good feedback:
“This design is the one I like best because it really shows how stable the mayor is as a
character, he’s really grounded, but I think you should make the mustache even longer on the
sides, since in the story all he does is talk about it. It should be the focal point!”
(Is precise, helpful and prompts a conversation)
Remember that in the end, your piece is your own, and you get to decide which feedback
you want to follow and which one you want to discard. Just be careful not to get too
attached to a piece just because you’ve worked longer on it!

6.

Decide on your final image and finish it.
In the scope of this workshop, this will not be a fully rendered and coloured picture but rather a
detailed sketch to help us build in 3D... unless of course those are designs for 2D assets in the
game!
If what you’re making is a character or a complex object which we’d see many sides of, you might
want to do a model sheet of it, detailing all of its different sides for modeling in Blender. This is
something we’ll introduce in the Technical Drawing for Blender class.
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Digital Imaging 04:

Drawing & Photoshop Inking: Start with drawing basics pencil & paper,
ink, scans and then wacom tablet techniques to enhance sketch art

Facilitator: Jasmine Eladas

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Friday July 21, 10:30AM
1 hour
Instructor Prerequisites:
Instructor should have experience drawing traditionally and digitally with a wacom tablet. Should also be
comfortable working with Photoshop.
Student Prerequisites:
The students should have some experience in drawing or an interest in learning to draw. As well, students
should have had an introduction to Photoshop
Equipment, Software Materials:
Coloured animation pencils
Pencils, pens, paper
Wacom drawing tablets
Objectives:
Learn how to take a hand drawn sketch to a more refined piece using Photoshop for use as reference or
game assets.
Vocabulary:
Silhouette, brush tool, crop, levels, blending modes
WEB RESOURCES & BOOKS:
Photoshop Levels: http://www.cambridgeincolour.com/tutorials/levels.htm
Drawing Fundamentals: https://androidarts.com/art_tut.htm
Anatomy: http://www.alexhays.com/loomis/
Concept Art Tutorials: https://www.youtube.com/user/FZDSCHOOL
What is Concept Art?http://howtonotsuckatgamedesign.com/2014/02/lets-get-real-concept-art/
Technical Drawing & Design: https://www.youtube.com/user/scottrobertsondesign
Drawing Basics: http://drawabox.com/
Digital & Traditional Drawing: https://www.ctrlpaint.com/library
Fantasy Art: http://muddycolors.blogspot.ca/
Digital Art Magazine: ImagineFX Magazine
Preparation:
PowerPoint slides
Samples projects at different steps to support students
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Exercise: Shape drawing game on Photoshop (15 minutes)
This exercise not only helps you see how creative you can be with shapes, but playing around with it
helps get creative! It’s a great exercise to loosen up and get inspired before drawing more seriously.
Step 1: Draw 10 shapes. Make them weird, make them unusual, make them flowy, make them sharp…
Step 2: Draw over them to transform them into something else. An animal? A person? An object? Do as
many as you can within the time limit.
Don’t try to make the drawings beautiful, and don’t hesitate to add to the shape! Just explore, and try
to think in different ways that you normally do.

My example:

Let’s make a character!
For the sake of this exercise, let’s make a human. Not sure what to do? Here are some prompts to get you
started!
1.
2.
3.
4.
5.
6.

A friend or relative wearing something important to them
A masked person
An adventurer
Animal turned person (no physical animal characteristics)
An athlete
The exact opposite of who you are

Or go to www.artprompts.org and find one you like!
Creating your human! Remember the steps?
7. Find goals (Keep it simple)
8. Find inspiration (5 pictures)
9. Find references (As many as you need)
10. Start sketching!
11. Gather feedback
12. Commit and finish
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Some tips and constraints for this workshop
13. Don’t go too realistic or detail-focused. Keep it simple, because we will model your drawing
later!
14. Considering our time constraints for this lesson, don’t use colour on your drawings yet; focus on
the shapes!
15. As much as possible, keep your character’s clothes close to the body, so we can see the arms
and legs. This is because we will animate it later, and we have a standard rig for you to use!
16. Things to avoid for now:
a. Capes
b. Long skirts
c. Things that move around independently of the body. (For example, a ponytail will
remain static)

WORK TIME!
1h
Now that you’ve scanned your finished drawing…
Note: The workshop leader should take care of the scanning for this lesson: scanners are not all
standard and their use can differ.The students can do this exercise either with their human character or
with one of their smaller shape creatures, depending on how much time there is for the work.
For our example we’re gonna use the Magician Boy! The idea is that this boy wants to become a magician,
but can’t practice card tricks yet because he broke his arm.
Cleaning up in Photoshop
Scan your drawing, and open the file in Photoshop
Save it as a Photoshop file (extension .psd).
Rotating the image
Is the drawing right side up? If not, go Image -> Image rotation ->... And choose whichever one is
appropriate.
Navigating
Zoom in and out with Alt+Mouse Wheel
Move around with Spacebar + Click, or H
Cropping the image
Crop tool. (C) - Use this to resize the picture inside a rectangle of the dimensions of your choosing.
Double-click on the layer to unlock and rename it. This transforms it into a standard photoshop layer.
A suggestion is to duplicate the scanned image layer, and lock the original one, to be able to compare
the changes as you go by hiding the new layer.
Right click on the layer -> Duplicate Layer
Name that one however you like, then rename the first one with the suffix “original” (or an equivalent) to
differentiate it, and lock the layer.
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Levels
Select your top layer again. We will now explore the Levels.
Image> Adjustments > Layers, or C
 trl+L
What we want to focus on is the little arrows right underneath the Input Levels box. They help to adjust
the contrast of the image, and the way the highlights, shadows, and midtones are adjusted.
The arrow on the left shows the DARKEST point in the picture. If we move it right, it makes the range of
darks a little smaller, making all the darks pixels of the image darker.
It’s the same with the arrow on the right and the bright pixels of the image. The more we move it to the
left, the less range there will be for bright pixels, and the white pixels will be whiter.
The arrow in the center shows the midtones, or the most perfect 50% gray in the image.
We can press Alt when clicking on those and moving them around to have a preview of which pixels in
the image will be affected. It shows which RGB channel is affected by colorizing those pixels
accordingly. If playing with the arrow on the left, and that some pixels turn completely black, then on
the image, those pixels will have become pure black as well. Same goes for the white pixels.
Adjust it so that your drawing is clean enough to work with for what you’re going to do, be it a base
sketch for in-game art, or a model sheet. In this example I used a model sheet, so these steps would be
enough cleanup, as this would never be seen in the game; it’s only information for the 3D modeler, who in
this case will be yourself. We will make one of those in the Technical Drawing for Blender lesson.
Making 2D assets with transparency
If your drawing was to be used in game, you might want to ink it on Photoshop, and have it be separated
from its white sheet! For this example we will use another drawing of the Magician Boy, one that could
appear let’s say if the boy was to come talk to the player in a dialogue sequence, Fire Emblem-style.
Same as with the other picture, I have rotated it upright, cropped it, and adjusted its levels. I have also
renamed it appropriately.
I lowered its Opacity for it to be less visible (50%), locked the layer, and added a new white Solid Color
layer under it. Now it will be pale enough to draw over it without getting too distracted by its lines.
Let’s save this as a Photoshop (.psd) file.
Drawing Line art
From here, I can draw over it in Photoshop; we’re going to do it’s line art! This will be the base to our
future coloured picture.
Make a new layer! Lock the other ones just in case, to not get confused.
We will use…
Brush tool (B): Let’s use the hard, round brush (2nd one on the default list).
Adjust the size on the side menu, or with Alt+Right click and drag.
Thinner lines are cleaner, more precise, but also less forgiving.
Eraser tool (B): Same principle as the Brush tool.
Choose the color with the Colour picker (black or near-black gray is good) and start drawing!
Draw with fast, steady lines - no chicken scratch! With some practice, you’ll get the hang of it!
As much as possible, try to complete the external lines, it will help you colour it in later.
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Remember your best friend, Ctrl+Z. Do it again and the line comes back.
To go back further, Ctrl+Alt+Z.
Pro tips:
Rotate the workspace with R.
Rotate with 15 degree increments with Shift+R

Don’t forget to save!
Fill-in and Values
Once the lineart is done, we start filling in the drawing.
Make a new layer and rename it “Values 1”. Make sure it’s u
 nder the line art layer, and lock the line art
layer so we don’t accidentally draw over it. You can also now hide the original scan layer.
Let’s make 4 value blobs, a makeshift palette. Let’s open the colour picker.
The 4 colors we want to use are B=20, B=40, B=60, B=90.
Why just four? Having a limited palette helps to create without getting cluttered with infinite choice. It’s
also easier to start with flat colours, and by having them on the side, we can use the Eyedropper tool (I)
to go pick and use them again, without going back into the colour picker.
Additionally, we avoid pure black and pure white, first because they are harder to edit, and second
because they’re not colours we ever really see in real life, it’ll keep our art looking natural.
Pick one of these values of gray and fill in the shape!
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Don’t forget to save!
Value Structures
Let’s lock the transparency on our Values layer. Now we can’t accidentally draw out of the established
fill-in.
Let’s use our four predetermined values to explore value structures; a good trick is to separate those
values by shape!

An easy tip for having a good balance of interesting values and contrast is to have one MAIN value
(big), one SUPPORTING one (medium) and one for DETAILS (small). It’s not always going to be easy,
and it’s not always necessary, but keep it in mind because it helps to have better contrast.
What’s contrast? For example, if a piece has mostly pale values, and then one smaller very dark shape
next to it, that darker shape will stand out a lot more because it’s right next to white.
Some examples:

Garnet’s pale visor stands out against the dark mass of her hair and the medium-dark values of her
body.

The Joker’s white makeup brings attention to his face, and makes a huge contrast against the dark
circles around his eyes and his red lips. The contrast around the eyes being much harder (white inside
black inside white), this is the part that stands out most.
Make a few value structures by Duplicating your Value layer (Right-click on the layer, then click
“Duplicate Layer”) and making new versions. You can rename those Value 2, Value 3, and so on, for
clarity.
After you’ve made a few, pick your favourite one and we’ll continue with colour!
Don’t forget to save!

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Colour
Make new layer, rename it “Colour”.
Now we can’t simply lock the transparency, because this is a new layer. So what do we do?
We make a mask.
CTRL + click the picture appearing on the value layer; this will make a selection out of all of its pixels.
Select your Colour layer and click the MASK icon at the bottom of the layer box.
Now if you draw on the Colour layer, the lines will remain within the frames of the values we just drew.
Change the Colour layer’s blend mode to Soft Light. This will mix the colours we’ll draw with the values
we’ve just created, to stay harmonious with one another.
If you want to make a palette of colours out of colour blobs that you could use with the Eyedropper tool,
the same as we’ve done with the values, you can, but you’ll have to do so on a separate layer. Don’t
worry, you can still access the colour with the Eyedropper tool from the layer you’re drawing on.
(The reason why we can’t make the palette on the current layer is that the blend mode we chose only lets
the colour pixels appear if they’re on top of the pixels of another layer)
This is almost the last step, so at this point you could try playing with other blending modes (but this
one helps keep the values mostly intact), with brush size, brush type (soft, hard), with adding layers to
draw on top of other layers without losing their information… just enjoy and have fun!
You can always go back to change something on other layers, like adding details to the line art, you
might just need to unlock them first.
Pro tip:
When using the Brush and Eraser tools, you can change their opacity with the numbers 1 (10%) to 0
(100%) on the keyboard.

About Colour:
HUE
Refers to which wavelength of light you’re looking at when you see it, or “colour” as we usually mean
it.
SATURATION
How intense that color is or, basically, how far it is from grey/black/white.
VALUE
The relative degree of lightness or darkness of a particular color.
When all done and happy, SAVE AGAIN.
Exporting
Make sure that your image is all finished!
Go and erase the palette from the Value layer, you won’t need it anymore.
Hide all but the layers you want to export, to make sure there’s no lines from the scanned drawing.
Hide the white Solid Colour layer that should be at the bottom. The background behind your character
should now be a grey checkerboard. This symbolizes transparency.
We’ll turn this image into a .png file with File > Save As...
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Save as PNG, then double-check that your file has transparency; you can just drag-and-drop the image
into the same photoshop file you made it in to make sure it has no white background, then delete that
layer.
You’re all done! Good job!

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Digital Imaging 05:

Technical Drawing for Blender
Facilitator: Jasmine Eladas

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Friday July 21, 3:50PM
1 hour
Instructor Prerequisites:
The instructor should be comfortable using Blender and Photoshop, and must understand placement and
use of the images to be created, including knowledge of orthographic (direct) views.
Student Prerequisites:
Students should have a good idea of what their character/object should look like in 3D space (should
already have thought about the character’s front, back, and sides). There has also been a 3D production
pipeline lesson, where they will understand the importance of clarity in terms of each part of the process
(handing something off to the next person in the assembly line, so to speak.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Various drawing tools (with Col-Erase animation pencils), paper, tracing paper, rulers
Scanner (for this lesson, instructor will be scanning the images after the lesson for reasons of time
constraints).
Objectives:
Understand technical drawing for 3D models, and its relation to Blender.
Vocabulary:
T-pose, Orthographic (direct: front, back, side) views
WEB RESOURCES & BOOKS:
T-Pose sketching tutorial:
http://www.youtube.com/watch?v=pcy5Gdidxv0
Blender community:
http://www.blender.org/
Blender Tutorials:
http://skins.abtec.org/skins2.0/Tutorials
Preparation:
PowerPoint presentation for future referral.
Students should all have some concept drawings done from previous lesson.
Technical drawings for characters:
When making your technical drawings, it is important for you to know what your character is going to look
like at all angles.
Once you have the concept down, if you haven’t already: start imagining what goes on around the areas
you aren’t able to see from your initial sketch-up view. You must think of how clothing will look around
the contour of the body, from the back, how the hair style falls, what the profile of the face will be, etc.
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Technical drawings bridge character 2D concepts with 3D models; they must fully describe your character
in a way that a 3D modeler can understand. You must leave the least amount of gray area possible, so
that you minimize guessing by the modeler, and possible misinterpretation. One view is not enough to
make a 3D representation of a character, seen as we will be able to see it from all sides.
Orthographic / Direct Views
A typical set of technical drawings consists of a front view, a back view and a side view. Only one side view
drawing is necessary if the character is completely symmetrical; two if not.
These direct views are generally called orthographic in 3D space as they are straight-on, flat views, and
the drawings themselves will only be visible in the orthographic views when imported into Blender.
T-Pose
It’s easiest to start with the front view, since it’s instinctive to think of your character/object that way.
First, let’s think about our drawing in terms of modelling and animation.
You must draw your character in what is called a T-Pose, with arms and legs separated from the body and
each other, respectively. Think of the Vitruvian Man…
T-Poses allow limbs to be animated freely. If the arms were modeled as if glued to her sides, the animator
would not be able to move them at all. If the legs were glued together, the character would have to hop
around rather than walk. In this way, a 3D model is just like a puppet or action figure.
Decide to which degree you must separate the limbs. They don’t necessarily have to form a perfect “T”.
Since my character will not be putting her hands really high in the air, nor doing much besides running and
walking, I chose to leave her arms and legs in a more relaxed state. If she were to hang from monkey bars
or do the splits for example, I would have to have them much more open for easier animation later.
Guidelines
Next, you’ll be making the other views. Keep in mind those things which wrap around the body—they will
have to match up!
There are ways to edit them later, or work around them if detail isn’t extremely important in the problem
area. A good trick is to have all horizontals in line with each other. This means shoulders are at the same
height, ears are at the same height, hands are the same length, etc.
The best way to do this is to section off major landmarks in your model. If you’re designing a character,
draw a horizontal line just under the head, at the waist, at the knees, and under the feet. When you’re
drawing the side view/back view, use these lines as a guideline. You can draw those on paper, and make
sure they line up properly in Photoshop later on; there are tools to fix it there too.
Again, they do not match up perfectly, just do your best. You’ll be the modeler for this character/object,
so you will be making final decisions in 3D.
Character accessories
If the character has important accessories that they carry around at all times but that do not wrap around
their body (like a briefcase or a staff for example), it is worth making a separate front and side view for
that object so you can model it later.
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To make your job easier:
• Use graph paper or loose leaf paper to sketch out your views. Tracing paper works wonders,
too, for more complicated designs. Use tracing paper to make modifications on
asymmetrical objects/characters.
• Trace over the front view to get the general shape for the back view. Flip the first side view
and trace over to get the basic shape for the other side.
• Use a ruler to mark the guidelines.
Technical drawings for buildings/environmental objects:
Architectural elements and environmental objects follow the same general rules for technical drawings as
characters, but with a few key differences.
Scale
When modelling very big or very small objects, it’s important to indicate a scale. Since the human being
often refers to himself to gauge the size of things, drawing a small human figure next to an object usually
does the trick. This is especially true for very big objects. However, you don’t need to be super precise, as
you can always tweak the final result in 3D.
In fact, for smaller objects it is often easier to determine the size that way. Put the object next to a
character model and scale accordingly.

Selective views
As opposed to characters, which can almost always be seen from all sides, architectural objects and
natural elements sometimes have sides that remain hidden from the player at all times. It is worth
thinking about this beforehand as to avoid drawing or modeling useless views for your objects. This will
also save you a lot of precious 3D modeling time!

Organic elements
Some organic elements (trees, rocks, other natural elements) are actually easier to visualize in a
perspective view than to try and understand how they would look like in orthographic mode. For these
objects, it is often more useful to draw only the front view (to indicate the scale of the element) and a
rough perspective, before jumping in and modelling directly in 3D.
After cleaning up the drawing
After a pass in Photoshop to clean the scanned model sheet, as seen in our last lesson Drawing and
Photoshop Inking, we are ready to put the drawing in Blender. How? Let’s focus on our Magician Boy once
again.
First, let’s make sure our drawing guidelines are set up well.
In Photoshop, on the top menu, click View > Rulers, or press Ctrl+R
Click the horizontal ruler at the top, and drag it down to reveal a pale blue horizontal line. Slide it down
over the guidelines you had drawn on the drawing and make sure it’s a match.
Repeat for all other guidelines.
If you accidentally place the ruler line at the wrong place, you can move it with the Move tool (V). To
discard a ruler line, simply slide it back into the ruler at the top.
If your drawn guidelines were converging in a certain angle and you wanted to fix it fast, you could
select the layer’s drawing and go in Edit > Transform and have a look at the tools there. The most
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convenient one for us right now is the Perspective tool, which lets you shrink only one side of the
drawing from its corners.
Exporting the three different views
Using the Crop tool , adjust the view to include only one side. Try and make sure that the character is in
the center of that crop. Don’t touch the top and bottom sliders, as we want the height of those three views
to be exactly the same.
Confirm with the Enter key, and reach File > Save As… (Shift+Ctrl+S) Let’s export this first drawing as a
PNG, and name it MagicianBoy_RefFront.png .
Do NOT save over your .psd Photoshop file! We want to keep it intact, as we’re coming back to it.
Once the drawing is saved, you’ll find yourself back in Photoshop. Press Ctrl+Z or Ctrl+Shift+Z to Undo
until you’re back to seeing the three views, and repeat the same steps for the other views, renaming them
MagicianBoy_RefSide.png and MagicianBoy_RefBack.png.
You’ll be able to add these drawings to your Blender file as background images.
Exercise: Make technical drawings for the Snowman, or for the Character.
If the students don’t have time to finish them in time for the next lesson, use the handouts for the
Snowman and the Magician Boy.
If the students desire, they may design their character to model and make its model sheet as
homework, in anticipation for the Character Modeling lesson.
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Digital Imaging 06:

Introduction to Modeling in Blender
Facilitator: Jasmine Eladas

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Monday, July 24th, 9:15 AM
1 hour
Instructors Prerequisites:
The instructor should be comfortable using Blender (using version 2.78), enough to foresee wrong
keystrokes that the students might make. The instructor should also be familiar with the basics of
modelling techniques in Blender.
Students Prerequisites:
The students should have very little knowledge of the interface (camera controls, 3D cursor, nurbs vs.
polygons, T-pose)
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Individual computers for each student with Plastic SCM and Blender installed
Objectives:
Learn the Blender tools and be able to model a very basic object for their games.
Vocabulary:
Mesh, vertex, edge, face, normal, move, rotate, scale, selection, extrusion, mirror, subdivision surface,
front view, top view, side view, modifier, 3D cursor, X, Y, Z axis, snapping, d.
WEB RESOURCES & BOOKS:
Blender website:
http://www.blender.org/
Blender Tutorials :
http://skins.abtec.org/skins2.0/Tutorials/
Modelling Tutorials:
https://www.youtube.com/watch?v=guu2UuM4-Go
https://www.youtube.com/watch?v=Dut5qb3KR74
Tips for Modelling in Blender:
http://www.3dartistonline.com/news/2015/04/12-pro-tips-for-modelling-in-blender/
Preparation:
● Prepare a PowerPoint with all the steps so that students can refer to it afterwards.
● Prepare a sheet with all the shortcuts to be used in the class and write some on the board.
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Procedure:
Refers to “Intro to Modeling in Blender.Powerpoint.ppt”
In this lesson, we will be looking at how to select objects in Blender, and how to transform them. We will
also very briefly be introducing some modifiers. Modifiers are useful built-in tools that help us modify our
meshes easily.
What is a mesh?
The term mesh, here polygon mesh, is applied to a collection of vertices, edges and faces that shape an
object in a 3D environment. It’s the most common way to make 3D assets for games. We will learn about
vertices, edges, and faces, and their purpose in 3D modeling. Finally, we will be modeling a more
advanced version of the Snowman from the previous Blender lesson.
Mode menu
In the header, you can access a menu to different editing modes in Blender.
Click on the “Object Mode” menu to see different options: Edit mode, Sculpt mode, Weight paint mode…
Toggle between those modes with Tab, specifically between the two last used modes.
Edit Mode
Let’s go explore the Edit mode. This is the mode that allows us to view and edit vertices, edges and faces,
amongst other things. Think of vertices as coordinates, edges as vectors, and faces the representation of
flat planes connected by those vectors.
In the Edit mode, you can select individual faces, for instance, and translate, rotate and scale them at will
to shape your object. You can do that with the same hotkeys we’ve been using before;
G for Grab (Translate)
R for Rotate
S for Scale
Alternatively, you can access those in the Tools panel (T)
As you might guess, since it’s standard for software nowadays, you can use Ctrl+Z to undo.
Selecting
Left click to select vertices, edges or faces
Shift + Left click to select them one at a time, for a selection of multiple
A to select all/deselect all
B for the Box selection. Click and drag to create a box which will select everything inside of it.
C for Circle selection. Click and drag to “paint” what you want to be selected.
Vertices, Edges and Faces
Vertex (plural vertices): A point, or position in 2D or 3D space. It’s each angular point of a polygon.
Edge: Two connected vertices make an edge, similarly to a vector.
Face: A closed set of edges form a face. Selecting 4 adjacent vertices will select the face that connects
them. A face with three edges is a Triangle and a face with four edges is a Quad (Quadrilateral).
Faces with five or more (so-called N-gons) should not be created in Blender; try to create objects with
Quads (4 sides) as much as possible, since objects made only with quads are much easier to edit and
shape into other shapes.
Multiple mesh selection methods
Multiple selection tools are provided in Blender to select parts of the mesh. The simplest of these tools
can be found in the viewport header. By default it's set to selecting the vertices. You can use this menu to
switch to edge or face select mode.
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Now, you might want to have all of these modes or some of them available to you... You can do that by
Shift-clicking 2 or all the modes. Avoid this as you’re starting out; generally speaking, you should be able
to work with only one mode at a time, and it’s going to be much less confusing.
Learn your Hotkeys! It allows you to perform simple tasks much faster.
Tab: Toggle between Object and Edit mode, or between the two last used modes.
Ctrl+Tab → switch between selection method (vertex, edge or face selection) by clicking or with 1, 2, 3
When in doubt, check your cheat sheet!
Transformation
In this part, we will be looking at different tools that help us transform our meshes into new shapes and
objects.
Scale, Rotate and Grab
Either through the mesh tools part of the Toolbar (T) or just like in object mode, with G for grab/translate,
R for rotate and S for scale.
Snapping
Shift+Tab enables snapping (by default in increments, following the grid)
Or click on the header’s magnet icon to switch snapping off and on.
Snapping helps with accurate transformation on the grid. Try “front view”, Left click inside the little white
circle that connects the translation arrows and move the object around. You will see that it moves and
snaps to the grid
Snapping is NOT only limited to the grid!
On the snap menu, choose Increment for the grid, Vertex to snap to one vertex, Edges, Faces or Volume
for the entire object.
Example: Enable Vertex snapping. Select one vertex and press G to grab it. You’ll see how it immediately
snaps to other vertices, even if locked to an axis (snapping to that vertex’s position to that axis). This can
be very helpful for precise modeling.
Ctrl+Shift+Tab is the hotkey to switch between these modes of snapping.
Even when snapping is off, you can always hold Ctrl when moving an edge or vertex and activate snapping
for that specific move.
Duplicating and deleting
Duplicating different parts of a mesh is the exact same process as duplicating in Object mode. You can
duplicate either from the Toolbar (T) or hit Shift+D.
Careful that you are selecting the ENTIRE mesh (with A  for the entire object or L for linked polygons), else
you will duplicate only your selection.
Deleting is done by hitting X, or Delete, and then confirming. Unlike Object mode in which you only have
the option of deleting the object, in Edit mode you are given the option to delete vertices, edges, faces…
or even dissolving them, which removes that part of the geometry without leaving a hole in the mesh.
Adding objects to a mesh
Shift+A to add a mesh, same as in Object mode.
Immediately after adding an object, you're given the option to edit that object on the left hand side menu.
This menu is only available immediately after adding the object! If you click away accidentally, you can
access it again with F6, which brings up the specific options of the last used tool. Suppose you hit S, you
can hit F6 again and bring up the scale menu and fine tune your object more!
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The difference between adding a mesh in Edit mode in comparison to Object mode, is that now those new
polygons are part of the same object. If I go back in Object mode, the two shapes will be manipulated at
the same time; scaling, rotating and translating together. This is a way to combine (join) m
 ultiple objects.
Now you have separate meshes inside of one “object”. if you press A, you will select everything. How to
select only one of the two? click a vertex/edge/face and press L for Linked.
Extrusion
The extrusion tool allows you to extend parts of your object to create new forms. It's available through
the toolbar, Extrude region or Extrude individual, or you can use the hotkey E.
Should you extrude by region or individual?
Let’s say you select 4 faces that are next to one another. If you extrude per region, they will all extrude
together, as one extension of the object. If you extrude individual, they each will extrude a face
surrounded by other faces, and point in separate directions.
As always hit Ctrl+Z to Undo.
Modifier
Modifiers can be found in the Modifiers tab of the Properties window, typically located on the right.
Its menu is indicated by the little wrench icon. Those are powerful tools for creating objects fast.
Adding a Modifier
By clicking Add Modifier, we find many options categorized under 3 groups: Generate, Deform and
Simulate. For this lesson, we'll explore only three useful modifiers: Mirror, Subdivision Surface and Array.
Mirror
Hit Tab to switch to Edit mode. Right now, we only have a cube. For now our modifier doesn’t seem to
have done anything, but if we move our cube, we can see the mirrored object as well. Because X is
checked on the mirror options, it is perfectly mirrored along the X axis. We can try checking all 3 axes. We
start seeing the mirrors of our object along all axes.
If you click the Clipping option (especially for a human face) it allows you to restrict the transform past the
central axis. This allows you to keep things locked and prevent having holes in the center of your model.
Note: If you're working with the clipping option enabled, remember to remove the face that is in the
middle of the model, because we do not want any interior faces separating the inside of our model.
Careful! Blender forgets what the shape was like once the transform is confirmed and clipped on the
center axis. You won’t be able to pull the shape out!
Array
This modifier creates instances placed at an offset from one another. Instances are different than
duplicates in the fact that they are not separate objects from the original mesh; they inherit all of its
transformations.
Count: How many instances of the mesh are generated
Constant offset: Offset as calculated by the grid
Relative offset: Offset as calculated by the object
Subdivision
The Subdivision Surface Modifier is used to split the faces of a mesh into smaller faces, giving it a smooth
appearance. This modifier is applied to entire object; it might not be what you want to use for smoothing
only a section of your mesh, depending on what you are modeling.
View: The number of subdivision levels shown in the 3D View.
Render: The number of subdivision levels shown in renders.
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You might want the subdivision level to appear as different in the Viewport than in Rendering for
optimization purposes.

Modifiers can be deactivated/hidden with the eye icon on top of them, and can be deleted by clicking the
X located at the top right of their individual windows. They are never fully confirmed and applied until you
click Apply, after which the changes are permanently part of the model.
Now get back to Object mode by pressing Tab and delete your object. To Delete an object in object mode
press Delete or X and press Enter to confirm.
Let’s get to work
Now that we have some basic information about modeling in Blender, we will be modeling an advanced
version of the Snowman done as an exercise for the previous lesson.
This exercise will simulate the procedure for creating objects from our Technical drawings. You will learn
how to import and set up technical drawings as well as how to model basic shapes from them.
Setting up Technical Drawings
In order to be able to model easier in blender from our technical drawings, we have to bring them into
Blender first and set them up as background images to use as a reference. We have the concept, as well
as the front and the side view. We will be loading these images up into Blender and setting them up to be
view specific. What it means is that you will set up each view to a specific background image, so that each
time you toggle into a specific view, the background image will also change.
-

Switch to front view (hit 1 on Numpad) and get out of perspective mode (hit 5 on Numpad).
Hit N to bring up the properties panel and go to the Background Images section.
Click the box beside it to activate it and toggle down the arrow.
Click Add Image. A small box appears underneath.
Toggle down the new arrow and click open to load a new image. (Try to keep your blender files
and images near each other on your computer, and named clearly with our convention)

Select the Snowman_RefFront.png from the directory and click open. It immediately appears in the front
view. If you switch to other views like side view (press 3) or the camera view (press 0), you will still see it.
Go back to the Front view by pressing 1.
Let’s look at some of the options that are available to us through the Screen Properties panel (N) to
modify our background image.
First option is Opacity that by default is at 0.5. Lowering the opacity helps to better view the grid. You can
use it as a slider, or enter a numerical value. The number that you choose for transparency is based on
personal preference.
Next option is Size. For now we will leave it at 10, the default number.
Next are X and Y values. Again, you can change their number by sliding or entering a new number. Let’s
increase the value in Y to approximately 4.6, so that the bottom guideline on the picture matches the
bottom of the grid, with our snowman sitting on top of the grid.
The next thing we’ll be looking at is the Axis option which by default is set to All Views. Change the Axis to
Front for the Front view. In order to change the axis for the Right view, first we have to click on Add
Image to upload our side view image to Blender. Add the other image, Snowman_RefSide.png, and go
through these steps again.
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After uploading this image we could also split the workspace into 2 parts (Front and Side view) as this is
the logical way to work with technical drawings.
The Size of a model has to be decided based on where it will be used. In the case of making video games,
it is very important that everyone agrees on a scale that will be used everywhere. You will use this to
approximately set the size of your technical drawing on Blender.
For example, 1 Blender unit = 10 cm.
Make a new save file out of it. IMPORTANT to SAVE SAVE SAVE all the time!
Initial Setup
Since we’ve already seen how to add and move sphere meshes, and because we have a lot of things to
cover in this lesson, we will provide you with the base to work on for the following steps.
Here we have the basic file that we are going to use in this lesson. The workspace is already subdivided in
2 views (front and side), the technical drawings are already in place, and they are aligned with the base of
the model (the 3 spheres).
Snowman: Nose
First, we are going to make some facial features for our snowman. Let’s start with the nose. In our case,
the nose is simply a cone. Before creating a cone, we want to make sure it will be created outside the
existing meshes so it is easier for us to see and manipulate. We will do this with the 3D cursor, as the
workspace is currently made so that new meshes appear where that 3D cursor is.
To place the 3D cursor in Blender, simply Right click where you want the cursor to be.
Note: Remember that the space is in 3 dimensions! If you ever want to place it precisely, you should do
that in an orthographic view, so to not lose it in the depths of the viewport.
Next, press Shift + A to add a new mesh and choose Mesh > Cone.
As you can see, our cone needs to be rotated to be in the same orientation as our nose. Press R to rotate
the cone. For this manipulation, we want to rotate the cone 90 around the X axis - the red line. To do this,
press R to rotate, press X to lock the rotation on the X axis, and enter 90 on the numpad. The cone is now
pointing in the right direction.
We now need to move the nose into place and to resize it. Switch to the Right view by hovering your
mouse over it and move (G) the base of the nose to the edge of the face. Afterwards, switch back to the
Front view and center the nose on the face of the snowman.
Our nose is in the right place, but it’s still too big, so we’ll need to resize it. Let’s scale it with S. In front
view we want to modify only the base of the cone which is now on the XZ plane. To scale only the XZ
plane, start scaling either the X or Z axis (red or blue line) and press shift+Y once. This will lock the Y axis
and allow you to scale only the XZ plane, which is what we want. Scale the nose to the appropriate size.
The base of the nose is the right size now, but we still need to make the nose slightly shorter. To do this,
switch back to Right view, press S and drag the green line (Y axis). Place it into the right position (G).
Save the document with Ctrl+S.
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Snowman: Eyes
We will start by creating one eye, and mirroring it to create the other.
To create the first eye press Shift + A and choose UV sphere. The sphere is the shape that we want,
however it is too detailed for our needs. In video games it is a priority to avoid unnecessary polygons. To
lower the polygon count (or poly count) go to the mesh creation menu appearing under the T menu as
you created the sphere, and lower the segments to 6 and rings to 10.
Scale (S) first, then move (G) the first eye to the desired location. To scale the object proportionally in all
directions, click inside the white circle when scaling.
Press Z to enable/disable seeing the object in Wireframe, in transparence with the background image
behind it. You can also do that from the header.
We have now created the first eye. However we still need the second one. To mirror the first eye, go to
the Modifiers menu (wrench icon), click on Add Modifier and choose Mirror. In the properties, choose X

as the axis, and in Mirror Object put Cone. This will mirror our eye to the other side of the nose, which is
exactly what we want. Click Apply to apply the modifier.
Now that we have all of the facial features, we want to group them into a single convenient mesh, so they
move and transform together. To do this, Shift+Select all of the objects (Eyes + Nose) and hit Ctrl +J (Join).
Snowman: Arms
Now that our snowman has eyes and a nose, we will create his arms. To avoid creating unnecessary
meshes, we will do this by modifying our existing torso mesh. Select the torso and press Tab to go to Edit
mode. Pick Face as the selection mode and select 4 faces closest to the arm hole in the side view.
Note: You’ll notice that in Blender, only one object at a time can be edited in Edit mode. Keep this in mind
as you’re modeling, you might have to go back to Object mode to switch object selection, or select it
through the Scene Graph or Outliner.
As they are still selected, switch to front view and hit E to Extrude these faces as a region (extruded as a
group). Next, move those faces into the approximate position of the arm’s end, where the hand would be.
You can change the angle of the faces by rotating them, and you can also scale them if you want.
Now that we have a rough shape of the arms in position, we need to create the elbow bend. To do this,
we first need to add an Edge Loop. An edge loop is basically a contour line (a set of edges) that goes
around a shape, through two other edge loops, and often reconnects with itself.
To create an edge loop hit Ctrl+R and hover your cursor over the region where you want to create it,
between the shoulder and the end of the arm. Notice the purple line. This is where the edge loop will be
created. By default, it is at the center of your shape, and stays there until you move the mouse and/or
confirm it by left-clicking. You can change the number of edge loops by scrolling with the middle mouse
button, however in our case we only need 1. Left-click to confirm.
Notice that Blender automatically selects the newly created edge loop. You can always reselect an edge
loop by holding Alt and double-clicking on one of the edges forming the loop (This is a custom shortcut
considering the Maya-style navigation we set up. Normally, the shortcut is Alt+Single Left click). Move the
edge loop into position to form the elbow.
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Now select all of the faces forming the forearm. To do this fast, press the button on the header to turn off
Limit Selection to Visible and press B for the Box selection tool, with which you can click and drag to
make a box selection.
Once selected, add a Mirror modifier. The faces will by default mirrored as compared to the center of the
sphere, which is what we need. Alternatively, you can also create the other arm manually, but then it
might not be identical. Hit Tab to come back to Object mode.
We have now finished modeling the snowman!
Tip:  A neat trick when navigating around the viewport is to refocus on objects before zooming in on
them. This helps not getting lost in the 3D view, and might be useful especially if you haven’t activated
Rotate Around Selection in the Blender User Preferences, as suggested in the Intro to Blender class. To do
this in Object mode, either press the period key (.) on the numpad, or position your cursor on the object
or place you want to focus on and press Alt+F.
Optional Exercise: the briefcase
Note: This exercise is meant to further practice using the tools learnt above, but the instructor may
choose to skip it if there is not enough time for the students to finish it in class.
As an additional exercise, we will create a briefcase for our snowman.
Create a cube mesh with Shift+A (Mesh>Cube) and resize it to fit the dimensions of the briefcase as
indicated in the technical drawings. It’s important to resize the mesh in Object mode for this stage, in
order to keep the center point at the center of the mesh.
Scale it in X and in Y. (S to Scale then hit X or Y to lock it in that axis. Move it around, again, with G)
Now that we have the basic shape of the briefcase, we are going to create the handle. In order for the
handle to be perfectly symmetrical, we are going to cut the briefcase in two, create half of the handle
and apply a mirror modifier.
First, in your Right view, go into Edit mode (Tab). Next, add an Edge Loop (Ctrl+R) that divides the
briefcase in two, and delete one of the halves. To delete something in Edit mode, select the objects you
want to delete (here, the faces of one side of that briefcase) and press X or Delete. Once pressed,
Blender will offer you the option to delete Vertices, Edges or Faces. Since we want to delete the half
completely choose Faces.
Why Delete Faces, and not Dissolve Faces? Dissolve will remove the geometry and fill in the
surrounding geometry, to keep the model closed. For this operation, we want the briefcase to be
empty, with no face cutting through the two halves we’ll get by mirroring the object. This is why we
want to delete.

In order to create the handle, we first need to switch to top view (7 on numpad). Afterwards, we will
need to Inset (I) the top face to create the base of the handle. Once you pressed I, move the mouse to
decide the size you want the inner face to be. You can also resize it after confirming by scaling it the
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way we usually do, by selecting and pressing S. You can also resize the newly created face by selecting
the different edges and moving them with G to fit the position on the technical drawing.
Now, select the newly created face, and switch to the Right view. We will Extrude the face so it stops
exactly in the middle of the briefcase, where it would connect with the other side. To do this, we first
need to activate snapping. Turn on snapping (Shift+Tab) and set it to Vertices. Next, extrude the face
(E), confirm the extrude, rotate it -90 degrees, and snap it to the middle of the briefcase by hovering
over one of the vertices of the middle of the briefcase. After this is completed, you can move around
the viewport out of Side view and Delete the face by hitting Delete>Face.
We now need to make sure the handle is flat, so to be able to hold it. Back to the Right side view,
create an edge loop (Ctrl + R) to divide the handle and move that loop to give that 90 degrees angle we
want.
We now have half of our briefcase. To create the other half, select all of the contents of the mesh by
selecting one face and hitting L (linked), and add a Mirror modifier with the axis set to Y.
Exit Edit mode (Tab), and move the briefcase under the snowman’s arm (G). Press Alt+Left click to
rotate the view and admire the results of your work!
You’ve done it!
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Digital Imaging 07:

Character Modelling: Using character technical drawings, learning

proper placement methods for modelling on top of a background image
Facilitator: Jasmine Eladas

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Monday, July 24, 10:15-11:15 AM, 11:30-12:30 PM
2 hours
Instructor Prerequisites:
The instructor should be comfortable using Blender (using version 2.78), enough to foresee wrong
keystrokes that the students might make. The instructor should also be familiar with the basics of
modelling techniques in Blender.
Student Prerequisites:
Students should have basic knowledge of modelling in Blender and experience modelling simple objects.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Black or white board with pens or chalk available
Individual computers for each student with Plastic SCM and Blender installed
Objectives:
Model a simple character that can be animated for game. Introduce topology concepts and strategies, and
more advanced modelling techniques.
Vocabulary:
Edge loops, mirror modifier, extrude, 3D cursor
WEB RESOURCES & BOOKS:
Topology
http://thilakanathanstudios.com/2016/09/why-do-we-need-topology-in-3d-modeling/
http://forums.newtek.com/showthread.php?98754-Polygon-Table-Help-Building-One
Character Modelling:
https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-1--cms-19723
https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-2--cms-19914
https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-3--cms-20358
https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-4--cms-20547
https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-5--cms-21211
https://cgi.tutsplus.com/tutorials/female-character-modeling-in-blender-part-6--cms-21357
Procedure
Set up technical drawings as we’ve done before.
Have them be centered, locked on the appropriate axis, with the feet sitting on top of the grid.
If you wish, you may set your workspace to be in split into two windows, for Front and Side view.
I personally like to switch in between both of them manually, as it keeps me on my toes looking at my
mesh in Perspective view more often.
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Let’s make a new save file.
WHEN WORKING AT HOME ON YOUR OWN PROJECTS:
As much as possible, make a new save file with a different name (a new version) if you:
1. Are coming back to working on the file for the first time that day.
2. Have just finished a big chunk of progress. For instance, here we’ll make a new save file after
finishing each major part of the body.
Many people have their own way of naming their files. The way I usually do it, for my private “work in
progress” files, is like this…
ObjectName_Version#_LastStepDone.blend
Object Name: The file or scene name. Here, it’s Magician Boy.
Version#: To be safe, make sure your number padding lets you keep this organised. For instance, if I
think there will be many iterations to the file, instead of numbering my file 1 (only one digit, goes from
0 to 9), I’ll name it 01 (two digits, going from 00 to 99) or 001 (three digits, goes from 000 to 999).
LastStepDone: Let’s say I’ve just modeled the feet, I’ll name that part Feet, or ModelFeet.
From that example, to start ourselves up this time you could name it something like…
MagicianBoy_00_SceneSetUp.blend
Why do we do that? It’s because you want to have a backup of your work as you’re working, so that if
you make a big mistake, that your computer crashes or that your file becomes corrupted, you haven’t
lost ALL your work. At home, you might also want to periodically backup your files onto another
computer, a USB memory key, an online server or an external hard drive.
FOR THE WORKSHOP:
The logic is very similar to what was just explained. The difference is that our files are all saved together
on the repository of Plastic SCM/Gluon, which handles the version control (which would have been our
version number). Therefore all you need to think about to check the file into the repository is the
Object Name and the Last Step Done.
To name your file, all you need to know is the Object name.
Our current file needs only to be called MagicianBoy.blend
When you’re going to check the file into Gluon, the software will log the file in as a version under your
name, timestamping it with the date and time.
Finally, you use the comments section to write what the last step you’ve done is, along with any other
important changes since the last version.
Something like “Feet modeling done, started modeling hands”.

To start with a scene where the background images are already set up, use the
MagicianBoy_Phase01.blend file found in the Course Materials repository.
The Torso
Move the standard box mesh to the center of the body.
Cut it perfectly in two vertically with the Edge Loop tool.
Select the faces on the left hand side.
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Delete them.
Select the rest of the mesh.
Add Mirror modifier in X; you can enable Clipping if you like
Go in Front view
Start shaping the box at the hips by moving its edges at the side.
Add an Edge loop in the middle, near the center, for the crotch space.
Extrude all of the top faces to shape the torso.
Extrude the face of the leg that will make the leg, leaving alone the inner face created by the Edge loop.
Don’t create the arm yet! We’ll get there. Starting with only the torso and leg will help us shape the body
in Side view first, before adding more detail.
Add horizontal Edge loops to shape the leg and torso.
Go onto the Side view to help shape the loops to the body.
Add an Edge loop to the torso, going vertically across the side of the body.
Grab the outer vertical Edge loops with Alt+Double click and shape the body into a softer, less boxy
shape.
Add another Edge loop going through the front of the leg.
Now you can soften the inside of the leg without messing up its shape.
Don’t limit yourself to only the side and front view.
Remember that your character will be seen in 3D, from all angles. It might feel safer to stick to the
original drawn design for details, but you can change the shape a little bit in Perspective view as you
work to make place for a more organic design instead of something boxy.

Neat trick:
Ctrl+E for Edge tools
In the last section of the menu, there is Edge slide.
Similarly,
Ctrl+V is Vertex tools
Ctrl+F is Face tools
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Notice how the G of Edge Slide is underlined? That’s because once you’ve pressed Ctrl+E to reach this
menu, you can press G to access this tool.
Its shortcut is underlined, and is usually the first letter of the word that has not been taken for the
shortcuts of the tools above it in the menu.
You can also notice that if, after using the tool, you press Ctrl+E again, the menu will be placed so that
your mouse will hover over your last used tool.

The Arms
Similarly to how we modeled the legs by extruding certain faces at the bottom of the hips, you can model
the arms by Extruding (as a region) the 4 faces closest to where the arm would be, and moving and
rotating those new faces to where the wrist would be.
You can then add horizontal edge loops for the elbow to be able to bend, for the shoulder to have enough
geometry to move around as well, and for the detailing of the rolled up sleeves.
Do not model the cast of his left arm (our right side), we’ll do that once we apply the mirror modifier at
the end. For now let’s keep the model symmetrical by modeling it without the cast.
The Head
Let’s Extrude from the neck up in Side View, first to the top of the neck/bottom of jaw, then Extrude
again, making our new faces reach the very top of the head.
Let’s add some Edge loops in between the neck and the top of the head.
Press Ctrl+R and hover where you’d like the loops to be placed. Scroll your mouse wheel as the loops are
still Pink; more loops should appear. Let’s put 3 loops down now.
When you click, they should be formed, and you can still move your mouse around to set exactly where
they should be placed on the model. Click again to confirm.

Let’s add an Edge loop across the arm from the wrist going to the neck, to give us more quads for
modeling the head.
From here, let’s grab our vertices and start shaping the profile.
Once you’ve shaped the profile, look at the Front view. It’s still very boxy! Let’s grab the faces on the side
of the head and move them outwards, and start shaping the head manually.
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Use the vertices that we selected in Side View to shape the nose, and use them to shape the nose in front
view as well. Do the same with the neck.
Don’t forget to go back in Perspective view once in a while to adjust things as needed.
Eventually your character is going to start looking like a human! Keep it up!

Note: For this character, we won’t need to model the ears, as they will be hidden by his hair. If you
wanted to make ears, do as we usually do and extrude from the faces on the side of the head, adding
horizontal edge loops if needed, shaping the ear as you go.
For the sake of this exercise, and to keep things simple, we’re not going to model the face; only the
basic shape of the nose. The rest of the face will be painted on with the textures.
And easy way to make facial features is to either Inset or Extrude the polygon faces inwards to make
them cave in to the head, but this method is not very conductive to facial animation, so only consider it
for basic models.

If you couldn’t keep up, you can reach the current modeling progress with MagicianBoy_Phase02.blend

The Feet
For the feet, do exactly as we’ve been doing, and extrude from the bottom of the leg in Side view while
rotating the extrude forwards as you go. Once the initial rotation is done, bring the tip of your next
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extrude to the end of the foot as seen in the Side view, rotating those faces upwards as happens with
most shoes.
Once that is done, have a look at the edges located at the bottom of the foot. Only the center edge loop
touches the grid. Let’s fix that.
First, make sure that your Snap tool is set to V
 ertex. One by one, select the vertices that should be
touching the grid, press G to enter the Grab/Translation tool, press Z to lock the translation vertically, and
while holding Ctrl to snap this one manipulation, hover your mouse over one of the vertices that is
currently placed on the “floor” or right at Grid level, and click to confirm. This should have set your
selected vertex to the same height as the other one, placing it on the “floor”.
Now, let’s add some edge loops in between the heel and the tip of the toes, to give us a better chance to
shape the foot into something organic-looking.
Press Ctrl+R and hover where you’d like the loops to be placed. Scroll your mouse wheel as the loops are
still Pink; more loops should appear. Let’s put 3 loops down now. When you click, they should be formed,
and you can still move your mouse around to set exactly where they should be placed on the model. Click
again to confirm.

This is where it’s important to keep your loops clean; while rotating the extrudes we made as we were
initially forming the foot, it was important to look at the loops and keep them tight. You can do that by
manually moving the vertices, or by scaling as you’re placing the loops to flatten them. This way, as you
create new loops, those will stay clean too, and the flow of your topology will stay clean and easy to
edit. We call this having good edge flow; it’s basically having a mesh that’s made in a clean way, where
the structure can be understood at a glance.
“The word topology refers to the geometric surface characteristics of a 3D object.
Modelers strive for "clean" topology, typically illustrated by a 3D mesh with efficient polygon
distribution, proper placement of polygonal edge-loops, few or no triangular faces (as opposed to
4-sided "quads"), and clean precise creases that minimize stretching and distortion.”
https://www.lifewire.com/topology-in-3d-animation-2181

Note: More resources on good (functional, optimised) and b
 ad (messy, disorganised) topology can be
found linked at the top of this file.
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http://thilakanathanstudios.com/wp-content/uploads/2016/04/topology1.jpg
https://blenderartists.org/forum/attachment.php?attachmentid=296473&d=1390165903

Looking good! But if you look at the foot in Front view, it definitely does not look like a foot. Go in
Perspective view and adjust the vertices for the foot to look more like it should.
Before continuing with the hands, add extra Edge loops around the knees, and elbows; more also around
the shoulders and hips. Articulations need more topology to bend properly without deforming the body.
For the students who have more ease with Blender, here’s something to consider.
When you’re done modeling the entire shape of the body, and want to ensure that the geometry bends
properly once the character is to be animated, you can consider adding in your own triangles to the
mesh, splitting the quads in two.
Don’t use triangles unless you know WHY you’re using them, and are comfortable with the software.
The most common places to put them are at the knees and elbows, to have more precise control on
how the mesh is going to bend. More resources can be found linked at the top of this document.

https://sites.google.com/site/facaelectrica/_/rsrc/1386790335380/topology-1/joints/ex4.jpg
http://68.media.tumblr.com/fec2b8d3a5e7a696ba36b98a9f431129/tumblr_inline_oj0sy2wzf01qb9x1g_500.gif

Take the time to adjust your model’s vertices to more closely match the shape of the body and clothing.
For example, the fold at the bottom of the pants, the fold of the shirt tucked into the pants, or the collar
of the shirt…
Don’t worry about adding a few horizontal Edge loops if you need them for detail; just be careful about
vertical edge loops, as they will change the number of polygons we’ll have for the hands, and we want
good control over that. On a model like this, vertical edge loops will change the amount of polygons on
the entire body; we want the number of polygons to be balanced all over, and for detail to be relevant.
Most of it will be done in Texturing, so don’t worry.
At this point, don’t only use the technical drawings as reference, trust your own judgement for how things
should look in 3D space.
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Getting closer! At this point, all that’s missing is the hands and hair. Those will be the trickiest parts, which
is why we’ve kept them for last.
If you couldn’t keep up, you can reach the current modeling progress with MagicianBoy_Phase03.blend

The Hands - Set up
Because the hands are much more difficult geometry to handle, and because we want to be able to
model them upright, we will use a different method of separating the mesh by duplicating the edge loop
of the wrist, setting that loop down to the bottom of the grid, and once we’re done modeling, combining
the mesh to one piece once more. For the sake of clarity, we will also work on the hands on a separate
layer.
There are many other methods to do this, but we’re going to go through that one since it’s a much
different and very efficient process which is unique to Blender. If the students prefer to model the hand
directly off of the body, they may do so, and the instructor can teach them how to do it using Empties
for Image References.
The first thing we’re going to want to do is add a new reference picture for the hands.
Go into the scene properties menu (N) and disable the visibility of our two last technical drawings by
clicking on the Eye icon at the top-right. You may also want to collapse them by clicking on the arrow on
the top left.
Let’s add a new technical drawings of the hands, as we’ve done with the other ones before. This time, you
only need to add one image. We’ll keep the axis of this new image as All Views, and simply model place
the hand in a way that will still allow for modeling with them as reference.
The next step is very different from what we’ve done until now.
Go into Edit mode, and delete the faces at the end of the arm. Make sure the vertices are in a shape that
looks kind of like a wrist, a bit flatter in one direction than the other.
Select the Edge Loop of the wrist.
Press P for Separate, and choose Selection.
What we’ve now created is a separate object, consisting solely of the Edge loop of the wrist.
You should now be in Object mode. Stay there.
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Remove or Disable the Mirror Modifier on the new wrist loop.

With the Loop still selected, press M for Move, and select the 2nd layer (on the right of the darkest box,
second from the top-left).
As you might have guessed, we have just moved that loop to the 2nd layer. Let’s go to it.
With the loop still selected and in Object mode, press Ctrl+Alt+Shift+C and select Origin to Geometry.
This sets the Origin or Pivot Point to the center of the geometry, in the middle of the edge loop.
Now let’s press Shift+S, then Cursor to Selected. This brings our 3D cursor to the same place as our loop’s
Origin point.
With Shift+A, create a cube. This will ensure that we have an object with the 3D cursor’s current position
as its origin, so we can snap our 3D cursor back there in case we accidentally move it away.
Select the new wrist curve, press Ctrl+A and select Location. This will tell Blender that the position of our
curve is its 0,0,0, basically resetting it in 3D space.
Now let’s go to Edit Mode.
Extrude the Loop in the direction of the hand, then extrude one edge in the direction that the thumb
would be, towards the front of the 3D space, in the direction that our character was facing. This will give
us a visual idea of the direction of our hand as we’re going to move it to the grid.

EXTREMELY IMPORTANT! Go back to Object mode before moving the wrist to the grid!
Go in Front view, and move the hand to the bottom of the grid where we’ve placed the background
image.
Rotate it while locking the rotation to Z so that our extruded edge is in the same direction as the thumb.
You can also scale it up to the size of the hand in the image.
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DO NOT APPLY THE LOCATION/ROTATION/SCALE IN THE CTRL+A MENU. This would remove the possibility
of resetting the hand’s location to where it was in comparison to the body.

In Edit mode, you may now delete the face we had extruded for the thumb position.

The Hands - Modeling
Let’s start modeling the hands.
Remember not to touch the bottom (wrist) loop for now.
We can fix it later once it’s positioned against the body again.
Note: The technical drawing provided includes the shape of the hand, and the shape of the cast around
the hand in a different colour. For now, only focus on the shape of the hand itself.
Extrude to the top of the palm, before the fingers.
If you want to flatten a loop that’s got vertex going everywhere, just Scale it (S) in Z.
Select the Edge loop > Ctrl+F > Fill Grid
Oops! If we continued like this we would only have 4 fingers including the thumb, because we only have 3
sets of faces to extrude from.
This is not what we want. There are multiple ways that we could get around that problem and fix it, but
for now let’s keep it simple and just add an edge loop vertically to add another space for the fingers.
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Remember: As much as possible, don’t move the vertices and edges at wrist level! We’ll take care of this
later once the hand is attached to the body again.
If you want to equalize the space at the top of the fingers, you can go ahead by sliding those edges.

If at any point some of your faces look much darker than the rest, it’s probably that their Normals are
flipped. Select the whole thing with A, and then either press Ctrl+N or press Ctrl+F (Faces menu) and
then click Recalculate Normals. This will make Blender understand that you want all of those faces to
point outwards of the object, not inwards.
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What are Normals?
“The normal vector, often simply called the "normal," to a surface is a vector which is perpendicular to
the surface at a given point.”
http://mathworld.wolfram.com/NormalVector.html

For our purposes, consider it a vector perpendicular to a vertex, edge or face that indicates where it
should be pointing/facing (inwards/outwards of the object) and therefore how it should be shaded in
3D space.
And now, just as we’ve repeated it so many times before, we’ll extrude the fingers out of the hand.
But first, let’s manually create some polygons which will be the space in between the fingers.
For this step, we will use the Knife Tool (K).
The Knife Tool works by clicking where you want there to be a new vertex, creating edges at will. You
have to be VERY CAREFUL when using it, to not create random polygons.
It’s easier to do this if you turn off Limit Selection to Visible.

As you click, little green boxes will appear, with a red rim to indicate if you are connecting your new edge
to an existing vertex, and turning red once it is placed down so you can click ahead to the next.
Confirm by pressing the Enter key.
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You can now select sets of faces and get ready to extrude them.

If you couldn’t keep up, you can reach the current modeling progress with MagicianBoy_Phase04.blend
Starting to look like a hand.
Before adding edge loops for the fingers, try and make sure your model is of a good shape. Do that by
rotating and translating pieces of the model. Try and start making those fingers a little rounder, less boxy.
If it helps, disable Limit Selection to Visible.
Remember not to touch the base of the model at the wrist! That lower edge loop must stay intact.
Reminder of your selection tools:
B: Box Selection
C: Circle Selection
Alt+Double Click: Select an edge/face loop
A to Select/Deselect (Use only to deselect right now! So to note move the wrist vertices)
Don’t worry if the side view doesn’t match up, because the drawing was drawn too rotated. Since I am the
modeler and the artist who drew the model, I can make the decision to keep the hand straight when I’m
working in 3D.
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Once the hand is looking good, Add Edge Loops for the joint separations of the fingers, place those the
way you need them to be, and then add two more edge loops framing the first to help with deformation.
You may also add one extra edge loop at the base of the fingers to make sure they bend properly.

The hand is done!

The Hands - Joining it back to the body
Go back to Object mode.
With the hand selected, press M (Move) and bring it back to the first layer. Go to the first layer, where
your character and their hand are supposed to be.
Make sure the hand is selected.
Press Alt+R to reset its rotation.
Press Alt+S to reset its scale
Press Alt+G to reset its location.
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>
Now we have to bring the hand back to its original position. Gladly, we have the cube set where our 3D
cursor should be.
Select the cube.
Press Shift+S and pick Cursor To Selected. The 3D cursor will now be at the center of the box.
Select the hand.
Press Shift+S and pick Selection to Cursor. The hand will now be back where it initially was.
Delete the box.
Chances are your character will now have a monstrously big hand. (Don’t worry we can fix it soon)
What’s important is that now, the two wrist loops are perfectly placed one against the other.

Before joining them back together, you might remember that we had added an edge loop to the hand
that was not part of the arm. Let’s add an edge loop at the same place on the body, to match the hand.
You can see where the loop is missing from Edit mode, or just visually by looking at the model.
Note: Because we had removed the faces at the interior of the wrist, the loop we’ll make won’t follow
from over the arm to the side of the body. We’ll need to create two loops on each side of the arm.

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Making sure that your Snap tool is set to Vertex mode, select the final vertex of your new edge loops,
press Ctrl to activate the snap, and snap it to the vertex of the hand.

Go back to Edit mode.
Select the hand, then the Body. (To connect the hand to the body, not the other way around, to preserve
the mirror modifier)
Press Ctrl+J for Join.
Go in Edit Mode and select the entire model (A), and either go in the T menu to find Remove Doubles
under the Tools tab, or press Space a nd write Remove Doubles and select it.
This will ensure that the vertices we just snapped together are combined as one, and that you can keep
modeling as you see fit.

The body is now in one piece again!
Re-enable the body technical drawings in the N menu.
Go in Edit mode.
Rotate and resize the hands the way they need to be. (Trust your own judgement in 3D space)
Try to align the vertices of the wrist with the hands.
If you need, you can explore the different rotation modes (global, local, normal, gimbal, view).
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If the students need, they are explained here.
https://wiki.blender.org/index.php/User:Rking/Doc:2.6/Manual/3D_interaction/Transform_Control/Transform_Orientations

All that we need to finish the Magician Boy is the hair!

If you couldn’t keep up, you can reach the current modeling progress with MagicianBoy_Phase05.blend

The Hair
We kept the hair for last since it’s a little bit easier than the hands. It’s the second to last step to modeling
our character.
Select the faces at the top of the head.
Press Shift+D to duplicate them, and G then Z to move them up on the Z axis.
Press P and pick Selection to separate it as another object.
Go to Object Mode to pick our new hair object.

Let’s shape it into hair by extruding and shaping it the way we want it to be.
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For our purposes, since the hair will be immobile and glued to the head, you don’t need to worry too
much about topology.
What we want to do, basically, is shape it like a helmet.
Switch from front to side view often, making sure you’re encircling the head.
You can extrude individual edges to make strands of hair if you like.

Once you are satisfied with the shape, you can apply the mirror modifier and start working
asymmetrically.

When you’re all done, you’ll want to make the hair 3D instead of entirely flat.
Remaining in Edit mode, select the entire object with A, and press Shift+D, and instantly press S to scale it
down.
If you want to see what you’re doing a little better, just press A to select everything and move the entire
object upwards.
Select a piece of the inner hair helmet and press L to select it all.
Press Ctrl+F to access the Faces menu and click the first option, Flip Normals. This will make it so the inner
layer points inside, towards the head. It will allow us to connect both parts of the helmet.
Grab matching segments of the outline of both helmets, and with Ctrl+E (Edge menu), select Bridge Edge
Loop. This will create geometry connecting both halves of the helmet. Do so until the entire helmet is
connected.
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Note: After you’ve started, you might not be able to use Alt+Double Click as we’ve been using it before,
because this would select one single loop, connected by the parts you’ve already bridged.
The hair is done! You may now select it all and pull it back down over the head. Just make sure to check all
of its sides so that the skull doesn’t poke through.

If you couldn’t keep up, you can reach the current modeling progress with MagicianBoy_Phase06.blend
The Cast
All that remains is to join the body together, join the hair to the body and edit the two arms to make them
separate.
Let’s start by joining the body together.
Apply the mirror modifier. Since the Clipping option was enabled, we don’t need to Remove Doubles as
would normally be done to make sure both halves are sewn shut.
Now let’s join the hair to the body.
In Object Mode, select the hair, then select the body, and press Ctrl+J.
That’s it! In the Scene Graph/Outliner, you can go and rename the object to MagicianBoy by
double-clicking it.

The Bowtie
While it is not covered in this lesson, you can create the bowtie either as part of the same model, or as
a separate object which you can then join in with the main model with Ctrl+J.
(On the Course Material blend files, it has not been added until later)

You can now work asymmetrically.
As we’ve done in the past, add edge loops horizontally to the arms and use that new geometry to create
the shapes of the two different arms; the character’s right hand will have a long sleeve, and his left hand
will have a rolled-up sleeve and a cast.
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Just make sure to keep enough topology at the wrist and at the elbow to allow for bending and
deforming while animating.

Before we’re done, let’s set the pivot point or Origin of our object to be at the grid center.
Press Shift+S (Snap) and select Cursor to Center. This should snap our cursor to the perfect center of the
grid, at 0,0,0.
With our character selected and placed at the center of the grid, press Shift+Ctrl+Alt+C and select Origin
to 3D cursor. Alternatively, you can find the origin settings at the bottom of the Tools tab of the T menu.
That’s it!
We are done!!!

Giving the mesh a smooth finish
If we wanted a smoother finish for our character, we could simply click Smooth under the Shading
option in the T menu, but then as you might notice, the entire character is smoothed, which does not
look natural.

vs.
How then do we preserve sharp edges?
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First, activate the modifier Edge Split under the Generate column.
Deactivate the Edge Angle checkbox.
In Edit mode, select the edges you need, press Ctrl+E for the Edge menu, and select Mark Sharp. This
will turn our edge Blue. If you go back to Object mode, you’ll see its rendering will have changed.

Place those sharp edges wherever you want them to be.

The resulting model from this lesson can be found on the file MagicianBoy_Phase07.blend
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Digital Imaging 08:

UV-Mapping: Learn about the process of unwrapping a 3D model in
preparation for texturing

Facilitator: Jasmine Eladas

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday July 25, 9:15AM
1 hour
Instructor Prerequisites:
The instructor should be comfortable using Blender (using version 2.78) and Photoshop, as well as had
experience unwrapping complex models for proper seam placement.
Student Prerequisites:
Students must have an idea of what kinds of textures they will be using (they will gather textures in their
next lesson. They will get a more detailed lesson on Photoshop, which will be introduced during Art
Module 9: Introduction to Photoshop.
Equipment, Software Materials:
A small stuffed animal (teddy bear or other is fine)
Objectives:
Understand the concept and process of UV mapping, and apply it to models. Unwrap models efficiently to
create usable UV maps.
Vocabulary:
UV Map, UV Editor,  Seams (Make Seam/Clear Seam), U
 nwrap, Weld, Stretching/Compression,
Normals/Flipped Normals,  P
 in
WEB RESOURCES & BOOKS:
Blender community:
http://www.blender.org/
Blender Tutorials:
https://docs.blender.org/manual/ko/dev/editors/uv_image/uv_editing/index.html
https://docs.blender.org/manual/ko/dev/editors/uv_image/uv_editing/layout_editing.html
http://wiki.blender.org/index.php/Doc:Manual/Textures/UV/Editing_the_Layout
http://www.blender.org/development/release-logs/blender-246/uv-editing/
http://www.photoshoptextures.com/texture-tutorials/seamless-textures.htm
http://www.chocofur.com/uv-mapping-tutorial-in-blender.html

Preparation:
● Blender file Log_exercise_begin.blend open on computer.
● PowerPoint presentation for future referral.
● Students should all have models done from previous lesson.
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Procedure:
About UV Mapping
UV mapping is the 3D modeling process of projecting a 2D image to a 3D model's surface for texture
mapping.
https://en.wikipedia.org/wiki/UV_mapping

Think of the UV map the same way you think of wrapping paper, or sewing clothing. Just like you need to
sew flat fabric pieces together to make a shirt that will wrap over your torso, in 3D you must define how a
2D image will be placed onto the 3D object so that you can paint its textures properly.
In short, UVs are not the colours and materials that you put down, but the canvas you stretch over your
model to be able to paint on it.
UV maps have seams in specific areas to minimize stretching and compressing of the textures you put on
your model; a bit like with a stuffed animal or a piece of clothing, we want to avoid to see those seams to
be too obvious.
UVs are the coordinates, exactly like vertices on your model, which tell the UV map where things go. The
letters "U" and "V" denote the axes of the 2D texture because "X", "Y" and "Z" are already used to denote
the axes of the 3D object in model space.

Cutting apart an object to illustrate texture projection (10min)
In this exercise, we will demonstrate flattening 3D creations by taking apart clothing and laying the pieces
flat on a table. We may also use a stuffed animal, to show the same process on a “character”.
See the difference between two identical stuffed animals; one already taken apart and flattened out, and
one whole and untouched, to compare.

Fetch the resulting model from the Character Modeling class, MagicianBoy_Phase07.blend
UV Editor
In Blender, change an interface area to UV Editor by either splitting your view in two as we’ve done
before, or changing the animation timeline to UV Editor. Adjust the views so you can see both the 3D
View and the UV Editor clearly as you’re working.
This is where you will be able to watch your UV map develop. Anything you unwrap will appear here.
Navigate by panning around by pressing the Middle Mouse button, and zoom in and out with the mouse
wheel.

Unwrapping a Model
Use FileName.blend for this exercise.
Have a look at what the current UV Map of our object looks like. To do this, select the entire model in Edit
mode with A, press U and choose Unwrap.
Your UV map will be displayed inside the shaded grid area in the UV Editor. As is usually the case, it looks
pretty bad! Meaning, it is pretty hard to tell what you’re looking at. This is because Blender is trying to
show you the flattened version of a UV map where every polygon is still connected together.
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You will need to put in seams, which allow the UV map to be as flat and as even as possible, while
describing the model in a way that makes texturing easier. Remember, your UV map is a perfectly flat, 2D
representation of your 3D model.
UV mapping essentials:
- No overlapping UVs;
- No twisted faces: as much as possible, try to keep the representation of a polygon
similar to what it actually is;
- Good size ratio: it’s good to have relatively even spacing of UVs throughout your model,
except in areas which don’t really show (more stretch is allowed) or where you need to
add extra detail (tighter UVs than other areas). Moreover, make sure that an
unimportant object, like a ring on a finger, does not get bigger than an important part of
the model, like the face.
Something else to keep in mind as you’re unwrapping is that you don’t want to put seams in areas that
are highly visible. The face, for instance, should be one solid piece. This is because it will be very hard to
match textures so that you can’t see the seams; you want to be sure you put these in the least noticeable
places, like under the arms or at the base of the neck, for example.
Go into the 3D view of your mesh.
Select vertices along the seam you’d like to make (Alt+Double click to select an edge loop), and choose
Mark Seam in the Shading/UVs tab of the Object Tools menu (T). Alternatively, you can go to the Edges
menu with Ctrl+E and select Mark Seam.
You can keep creating seams if you have a good idea of where they should be, or delete them (Clear
Seam), as you see fit.
Press U and pick Unwrap to see the UV map you’ve just created in the UV Editor, split by the seams you
just defined.
The great thing about Blender UV mapping in comparison to some other 3D programs is that you can
check how your seams are affecting the UV map as you go along by unwrapping each time you make a
change. The seams will be evident, as they are bright red and stay visible on the model as you work.
If you’d like to see which UVs correspond to which vertices, try turning on the Keep UV and Edit mode
Mesh Selection in Sync option, which is located in the header of the UV Editor window. (

Note: Considering our Magician Boy model, you might want to separate the hair off of the body, map
both object separately, and combine them later.
Elsewise, any seams we would want to add to the skull would not show as red, because another set of
polygons is sitting on top of it. It would also be much more difficult to work in that area, in transparence
with many layers one on top of the other.
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If your model was symmetrical both in shape and in textures, you could use some of the mirror UV tools
to make the UVs identical on both sides of the model. UVs can be mirrored in X or Y.
Stretching
Next you will want to check for stretching, as it will affect your texture’s placement. You don’t want to
stretch the UVs too much, as it will make your texture less detailed, causing a blurring on the surface of
the model. This is especially bad around the face, where we need a lot of small elements to be clear.
A great way to do this is by applying a checkerboard texture to the model. Visually, you will be able to see
if there is stretching on your model’s UVs by verifying that the squares displayed are equal between their
height and width.
●
●
●
●
●
●
●
●
●

Click the New + icon, located in the header menu of the UV Editor.
A menu will pop up, where you will name the image you will be using (Checkerboard), as well as
choose the resolution by pixel count (4096 x 4096 is the highest). For now we can stick to
1024x1024.
For Generated Type select “UV Grid” to create the checkerboard pattern.
Press Ok.
Make sure all your faces are selected in the 3D View (A) and select the Checkerboard image you
just created from the drop down menu in the UV editor’s header, to the left of where we just
created the pattern. This will apply the checkerboard on the 3D model, but you won’t see it yet.
Save the scene.
Save the image; an asterisk has appeared next to Image in the header of the UV editor view. Click
on Image and choose Save As.
To make the checkerboard appear on the model, go into the Properties panel (N). Under
Shading, check Textured Solid.
If you would like to display your model’s material again later, for instance if you’ve applied a
material to selected faces, uncheck Textured Solid.

Flipped Normals
Once checkerboard is on, you will be able to see if there are any normals flipped. As we’ve seen in the
Character modeling class, normals control the direction in which Blender views the faces head-on. If they
are flipped, the texture will not display properly; it will darken the mesh.
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How do you flip them back in the same direction?
Select the faces without texture on them, then in the header select Mesh>Normals>Flip Normals, or
press Ctrl+F to access the Faces menu and click Flip Normals.
Alternatively, select the entire model, and and press Ctrl+N for Recalculate Normals, which can also be
found in the Faces menu (Ctrl+F), which does the job automatically.
Editing the map
Sometimes your UV’s get a little messy, so you may have to tweak your map by hand, or at least discover
where to add new seams. I suggest trying to avoid moving the UVs by hand, as it’s a painstakingly long
process that can be achieved using other tools.
If you’re not sure where the problem is, hit the Keep UV and edit mode mesh selection in sync button,
and select the problem area in the UV editor. This way you can see exactly where on the model the issues
are. That way you can target the rogue vertices and edit the map to suit the model better.
When manipulating the UV islands by hand to move them around the image space, you…
Select them in Face selection mode by hovering your mouse over them and pressing L.
Move them around with G as usual. Initially, you might be in soft selection mode, selecting vertices
through a gradient. Adjust this with the mouse wheel until you only select the linked vertices of the island
you selected by pressing L.
You may also want to put sets of objects together, like the shoes, the legs, the arms, etc, to understand
the shapes in Photoshop easier.

Some Useful Tools
Stretch Display
You may prefer to work with the Stretch Display on in the UV editor, as it’s easier on the eyes than the
dots and lines over a checkerboard pattern. It helps keep track of which areas need to have more or less
seams, by keeping an eye on the stretching.
Blue signifies no stretching is occurring; red signifies a lot of stretching.
To access this, access the N menu of the UV Editor, and under Display, check Stretch.
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Pinning and Unpinning - P and Alt+P
You can pin UV islands with P, and unpin them with Alt+P. Pinning them will lock them in place as you
continue with other Unwrap operations. Each time you Unwrap, you start with a new UV map and will
lose all your previous edits, unless the UVs are pinned down.
Pack Islands - Ctrl+P
The Pack Islands tool generates a optimized UV layout with non overlapping islands that tries to efficiently
fill the texture space.
Try to keep some space between the separate UV islands, to avoid bleeding when applying the
textures. Bleeding is what happens when two textures are too close to one another, and the 3D
software or game engine considers that they share coloured pixels. While this can be fixed by using
larger image files, for the sake of optimization we’d rather make it so the UVs have more space in
between them. Tools like Pack Islands, while great for creating a nice layout of our UV islands, can
sometimes bring them too close together as in the image below, forcing you to move them by hand to
give them a bit of padding.

While you might want to move them out of the image box for editing, make sure to bring back all of the
UVs inside the box before you’re done!
The checkerboard image repeats seamlessly on the sides, which keeps the pattern on the faces in the
3D view, but ultimately that also means that the UVs outside the box would overlap with the ones
inside the box, sharing their texture, which is not what we want unless they are perfectly mirrored
pieces.
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Minimize Stretch
As the name implies, this tool helps minimize the stretching of the UV islands you’re working with, to
space them out and fix the areas of distortion. We call this relaxing the UVs.
Select the island you want to perform this action on by hovering your mouse over it and pressing L
(Linked).
Go to UVs and select Minimize Stretch, or press Ctrl+V.
Scroll the mouse wheel to relax the UVs and minimize their stretch.
Average Islands - Ctrl+A
Using the Average Island Scale tool will scale each UV island so that they are all approximately the same
scale, by averaging out their size and spacing. Select the UV islands you’d like to be affected.
A complete list of the UV editing tools can be found here:
https://docs.blender.org/manual/ko/dev/editors/uv_image/uv_editing/layout_editing.html

Keep playing around with these tools until you have a good result.
Don’t forget to save!
If you need to do any changes to the model, try to do so before doing its UVs, as the UVs do not update
automatically to the changes you do on the mesh.
Save the blender file each time you make a major change, until you are ready to export the image for use
in Photoshop.
Export your map, and you’re ready to bring it into Photoshop.
● Go into UVs in the UV Editor’s toolbar and choose Export UV Layout.
● Choose the appropriate folder, and export as .png as something descriptive, like cube_uvs.png
You should now be ready to texture the model!
The resulting model from this lesson can be found on the file MagicianBoy_Phase08.blend
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Digital Imaging 09:

Textures & Materials
Facilitator: Jasmine Eladas

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday July 25, 1:30 PM
2 hours
Instructor Prerequisites:
The instructor should be comfortable using Blender (using version 2.5) and Photoshop, as well as have
experience using materials. They should also have extensive knowledge of Photoshop material layers, i.e.
comfortable with normal maps, and other sorts.
Student Prerequisites:
Students must have their assets/characters modeled, and they will have already done Art Module 9: UV
Mapping. They should be comfortable with UV mapping in general in preparation for materials in
Photoshop. They will also have received brief instruction on selecting faces and applying materials to
them, in Introduction to Modelling (Art Module 5), and have had an introduction to Photoshop in Art
Module 11. Intro to Photoshop.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Cameras to take pictures to use as textures
Objectives:
Understand the concept and process of Materials, and apply them to their models. Create custom
textures using cameras and Photoshop.
Vocabulary:
Material,  Shader, Diffuse, Transparency, Specularity, Lambert, Textures Maps
WEB RESOURCES & BOOKS:
Blender community:
http://www.blender.org/
Blender Tutorials:
http://skins.abtec.org/skins2.0/Tutorials

Advanced Materials & Shaders:
https://docs.blender.org/manual/en/dev/render/blender_render/materials/index.html
https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/index.html
https://www.pluralsight.com/blog/film-games/bump-normal-and-displacement-maps
https://1stwebdesigner.com/image-file-types/
http://blogs.adobe.com/jkost/2015/01/how-to-create-a-seamless-pattern-tile-in-photoshop.html
https://helpx.adobe.com/photoshop/using/blending-modes.html
https://helpx.adobe.com/photoshop/using/masking-layers.html

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

https://www.blenderguru.com/articles/making-better-materials
How to make photoshop brushes
http://danidraws.com/blog/2007/01/20/make-your-own-photoshop-brushes/
How to install photoshop brushes
https://creativemarket.com/blog/how-to-install-use-photoshop-brushes
http://www.blenderguru.com/videos/create-realistic-materials-with-cycles/
Preparation:
● Blender file cube_UVmapped.blend open on computers.
● UV map cube_UVs.png open in Photoshop.
● PowerPoint presentation for future referral.
● Students should all have drawings done from previous lesson.
Procedure:
What are materials?
Materials are essentially what you want your mesh to be “made out of”. They define how your 3D mesh
reacts to light and shadows, if it’s reflective or transparent, for instance. They also allow you to apply
textures to your mesh more globally, without necessarily using a UV map.
Shaders represent different aspects of a material. You can have multiple shaders for one material, having
multiple properties coming into play.
For instance, think about an orange; it is bumpy, has a bright colour, it is kind of shiny…
Considering out materials don’t transfer into Unity, we’ll only have a quick look at how to set them up in
Blender. We will learn enough to help us work inside of Blender and Photoshop to create good texture
images which will be used in Unity.
We will work with the Lambert shader, which is one of the simplest and most standard shaders shared by
multiple 3D software as default.
Here is some material properties that we’ll explore in this lesson:
- Diffuse/Albedo
- Transparency
- Specularity
- Normals maps

Diffuse/Albedo
The Diffuse is what basically acts as the base colour for your object. You can set it as a single colour in
Blender, or you can make an image file according to a UV map and set that as a diffuse. Its equivalent in
Unity is called Albedo.
Transparency
As you might imagine, you can use this to make your model or part of your model see-through. You can
use the Alpha slider to define how opaque or transparent the mesh should be.
Specularity
Specularity is what defines the shine and reflectivity of your object. By reflectivity, we mean like the
reflection of light on jewelry or a shiny metal, and not like a reflection in a mirror.
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Normal (versus Bump & Displacement)
Normal maps are what we’ll use to simulate depth in the detail on some of our textures. They basically
give information to our 3D software on how the light will react to polygons in accordance to the position
of their normals, and is painted in detail. As you might see in our example below, while the definition and
depth this map gives to our texture is great, it doesn’t actually deform our object in any way.
For the workshop we’ll focus our attention to Normal maps only.
http://i8.photobucket.com/albums/a46/MichaX/025_3k_s.png
https://slm-assets1.secondlife.com/assets/7116894/view_large/3D_HARDWOOD_SAMPLE1.jpg?1360191610

Don’t get confused between Bump and Displacement maps, which can look like the same if you follow
tutorials online.
- Bump maps are basically the “old” way of giving fake depth and detail to our objects, which
was done with a grayscale map.
- Displacement maps, or height maps, are also greyscale images, except they actually do deform
your object, and therefore require more subdivisions onto the model to handle them.

https://static1.squarespace.com/static/55d63e06e4b0cafd401252ff/t/571ee1f62eeb8154a24a1bf3/1461641729175/

About Resolution and Optimization
Understanding image resolution is crucial to working on large projects with many collaborators.
When shooting your own references, and using textures or images for your work, it’s best to choose
images with the most resolution and the least compression possible. This will allow you to keep the
maximum amount of detail for your images as you are working.
When you are ready to export your file to use it in the game, alternatively, smaller files are better, as they
can be processed faster by the engine.
Another option is to use the same texture files for multiple objects, to only load it once; you can do this by
placing the UVs of multiple small objects together before doing their texture.
Without going into too much detail, for the entirety of the workshop we will stick to the .PNG file format.

https://www.winxdvd.com/windows-10/pics/good-bad-video-compression-quality-comparison.jpg

In this lesson, we will explore:
- How to paint textures for specific 3D models using their UVs in Photoshop.
- How to create and use tileable textures.
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How do materials work in Blender?
In order to see the material assigned to our object and its textures, you will need to change the viewport
shading settings to Material. Understand that you’ll need to move your light around (by default, the
lamp) to see how it affects the material.
If you wanted to only see the texture, but not the material, you’d have to choose Texture in the viewport
menu, and make sure that the appropriate texture file is applied to the mesh in Edit mode over all of the
polygons, in the UV/Image Editor. This is more appropriate for working on painting your diffuse onto the
character.
This basically does the same as with Textured Solid enabled in the N menu, except with a quick light pass.

There are two tabs relevant to materials and textures in the Properties panel of Blender.
They are accessible only after having selected the object you’re meaning to work with; the materials
shown will only be those connected to the object selected.
First let’s look at the Materials tab, the rightmost sphere icon.

As you can see, one object can have multiple material slots. This allows for different parts of a single mesh
to react to light and show reflections in their own way, for example. For the sake of simplicity, we will
limit ourselves to one material slot per object.
If you had other materials assigned to other objects inside the 3D scene, you could access those and
assign them to your mesh as well, using the menu right under the top material slot box.
If a 0 is shown to the left of one of these materials, it means that it is unassigned and will automatically
be deleted the next time the Blender file is closed. If you mean to keep an unassigned material from
being deleted, simply click the F button to the right, stating Save this data block even if it has no users.
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Now to go and look at the texture files applied to this specific material. Let’s go to the textures tab, the
little checkerboard icon.

One material can have many texture slots, to include texture files like Diffuse maps, Normal maps,
Specular maps… You add those in by picking a texture slot and adding a file at the bottom with Open.
You can then scroll down and define what their influence, or function, is.

You might notice another box appearing under the image input slot, called Source. This slot serves to
tell Blender where to find the image file in your computer folders, and independently renaming it inside
Blender for your own work. If you change the Source file to something unreachable, Blender won’t be
able to access the file anymore.
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In order to delete a material, you select it and remove it with the minus (-) button on the right.
In order to delete a texture, you select it and remove it with the X button at the bottom right.

This covers the basics!

Fetch the resulting model from the Character Modeling class, MagicianBoy_Phase08.blend
Solid colour placeholders for Photoshop
In order to have a better idea of how to paint over our UV map in Photoshop, we might want to create
some colour placeholders in Blender to keep as an image file. These will be flat, bright and varied colours
we will slap onto our mesh, along with some drawn markers, to know what’s what once we transfer the
UV map to Photoshop.
First, create a new image in the UV/Image Editor view.
There are two ways to go about this.
The first method, which is a little bit more precise in regards to the UVs, requires you to move between
Edit mode and Texture Paint mode. First, in Edit mode, pick the faces you would like to be one colour;
let’s say a bright blue, for his arm cast. Once the faces are selected, go in Texture paint mode, make sure
Face Selection Masking for Painting is enabled, pick the Fill paint method, choose the colour you want,
set it at 1 in Strength, and click in the viewport to fill those faces with the colour.

The faces should now be filled with a nice blue.
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The second method is simply to keep Face Selection Masking for Painting disabled, and using the default
TexDraw paint method with a radius of your choosing, draw onto the faces to give it whichever markers
you like. For instance, I drew a simple face, shoelaces, fingernails, buttons for the shirt, and R (Right) and L
(Left) letters on each side of the hair to know what’s what. We are not trying to make things pretty, simply
distinguishable, to make our texture work a little easier.
Of course, both methods can be used together without a problem.

Blender offers enough options to be able to do basic texture and colouring work within itself, so feel free
to explore!
When you are done, make sure to Save as Image. It is time to import both this image and our UV map in
Photoshop

Syncing Blender and Photoshop
In the Blender User Preferences (Ctrl+Alt+U or File > User Preferences), under the File tab, you can add
Photoshop as your Image Editor. This will make it so when you click Edit file externally, it will open it
directly into Photoshop.
The path to Photoshop is most likely something like this:
C:\Program Files\Adobe\Adobe Photoshop CC 2017\Photoshop.exe
Back to Photoshop
Let’s bring our images to Photoshop. Drag-and-drop them into Photoshop, one at a time. They should
stack one on top of the other.
You can try making your own setup, but here is a suggestion:
Leave the UVs on top. They are mostly transparent, and can be toggled on and off.
Then, add your markers and placeholder colours. Those can also be toggled on and off.
At the bottom, add a solid colour layer. This way we will be sure not to have any transparency issues, as
we will see if there is a whole in any of our shapes. You can make this any colour you want.
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Making a clean, separated canvas
With the Magic Wand tool (W), select all of the black areas on the Placeholder texture layer.
Make a new layer.
Press Ctrl+Shift+I to Inverse your selection, or click on Select > Inverse.
Pick a colour of your choice, and using the Fill Bucket tool (G), fill in all of the shapes we now have
selected.
Lock the transparency on that layer.
You can now duplicate that layer and use the Rectangular Marquee Selection tool (M) or the Lasso tool
(L) to select shapes to delete, and create layers for different body parts that you’d want to work on
separately.
While working on your textures, you may want to see your progress as it appears onto your 3D model.
For this, consider letting the texture files you enter onto Blender for your character be .psd files as you’re
working. You can then refresh the .psd file as you go to see your progress.

Now that you know how it all works, start playing around!
The resulting model and textures from this example can be found on MagicianBoy_Phase09.blend
What are tileable textures?
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Tileable textures, as the name implies, are textures that are made for tiling one next to the other. They
are also called seamless textures. They are made so that if you were to place many of them one next to
the other, it would look like a never ending pattern. This is good for brick, concrete, wooden patterns, etc.
You can use them on all sorts of Photoshop projects, but they are especially useful for 3D textures.
How to find them?
Textures.com offers many such textures for free, of which you can download up to 15 per day.
https://www.textures.com/
Else, an easy way to find them is to search for them on your favourite search engine. On Google, for
instance, you can use the Tools menu, and under Usage Rights you can search for some that fit the kind of
project you are working on.
Make sure that you have the rights to the images that you use! Look for some under Creative Commons
licenses, and make sure to give credit where credit is due.
How to use them?
The easiest way to work with those, although it can get rather time-consuming, is to drag-and-drop the
tileable texture into your Photoshop workspace, duplicate it a few times (Right-click the layer and choose
Duplicate Layer...) and move those layers around with the Move tool (V).
You could then merge them together to make them be one single image (Shift-select all relevant layers
and choose Merge Layers).
Once the layers are merged, you can scale and rotate your new single image, and explore some of the
Transform tools such as Warp and Perspective.

You can also change its Blending modes for it to interact with the other layers in different ways, such as
Overlay
You can find a definition of those blend modes here.
https://helpx.adobe.com/photoshop/using/blending-modes.html
Finally, you can play with transparency, either with the Opacity slider of your layers, or through the use of
Layer Masks.
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Some resources on layer masks can be found here:
https://helpx.adobe.com/photoshop/using/masking-layers.html

Here’s some alternative methods for making patterns, if the students are comfortable with Photoshop:
Open your tileable image in Photoshop by itself.
Edit > Define Pattern. Give it an appropriate name.

This pattern will now be available when using:
Edit > Fill,
Layer Styles,
Pattern Fill Layers,
the Pattern Stamp,
Healing Brush,
Shape Tools (for both Fill and Stroke)
and when creating Brushes (using the Texture attribute).
The tools you will most likely use are the Paint Bucket tool (G), which you can then customize to use a
pattern
(you cannot scale the pattern with this tool);

The Edit > Fill function, which will fill a selection of a layer with the pattern chosen
(you cannot scale the pattern with this tool);
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And Layer > New Fill Layer > Pattern, which creates a fill layer which you can use to rescale the pattern
at will until it is rasterized. It also comes with a layer mask on which you can paint the shapes you want
it to affect or not.

Some definitions:
Rasterizing is the process of turning vectors, or text layers, or layer effects, or any other kind of
graphics, into a simple bitmap image made of pixels.
A word of warning: In Photoshop, once you have rasterized a text layer, you will no longer be able to
edit it as a text layer.
Rasterizing converts these to ordinary pixels, so when you scale them you lose quality BUT you can edit
them in the same way as other photographic elements.
To rasterize a layer, simply Right-click it and select Rasterize layer.

On this layer, the patterned box on the left is the fill layer, on which you can double-click to change
the fill settings and rescale the pattern.
You cannot edit that layer’s pixels by hand until you rasterize it.
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The white box on the right is a layer mask.
Layer masks are a fundamental tool in image manipulations. They allow you to selectively modify the
opacity (transparency) of the layer they belong to. This differs from the use of the layer Opacity slider
as a mask has the ability to selectively modify the opacity of different areas across a single layer. You
can add a mask to a layer and use the mask to hide portions of the layer and reveal the layers below.
The chain link between them indicates that the mask is linked to the layer it is on, and that
manipulations done onto them will affect the both of them. You can click in the space between the two
boxes to enable or disable the linking, and be able to edit them separately from one another.
https://www.quora.com/What-does-rasterizing-a-layer-do-in-Photoshop
https://helpx.adobe.com/photoshop/using/masking-layers.html
https://www.gimp.org/tutorials/Layer_Masks/

How to take pictures with a camera to use as a texture
Digital Cameras will be provided as a tool to capture images. Using the cameras provided you will go
outside to look for appropriate textures in the environment that would suit the game you are working on.
Below are tips on what to look for and what to avoid when shooting a texture.
Setting up your camera:
1. Turn Camera on
2. Make sure the camera's resolution is set to the highest setting.
3. Set the focus on automatic.
4. Keep the flash turned off; this will allow you to capture more natural-looking textures.
Note: Each of these settings can be found in the in the menu settings of the camera.
What makes a good texture for games?
There are different kinds of textures you’ll be looking for when gathering visual elements for games.
For example:
1. Flat, repeatable textures.
a. These are textures that would be made seamless, so they can be “tiled”, or repeated.
b. Tiled, seamless textures are applied to assets in the game which normally cover a large
area, like the ground or a road, and buildings.
2.

Textures meant to add particular detail to assets in-game.
a. These textures can be something that will add an extra element of realism to an item.
b. They can be used for patterns, wrinkles, adding rust, scratches or a rougher look to
assets.

Taking a shot:
Keep it flat
When shooting a texture, it’s best to capture it as flat as possible. Point straight-on to ensure the best
representation possible. When in doubt, take multiple shots of the same subject at slightly different
angles. There’s only so much we can fix in photoshop.
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Distance from subject
For textures meant for tiling backgrounds, do not stand too close to an object, as it makes it hard to tile.
Think about having a little bit of space around the texture you’re shooting, so that you have an easier time
in Photoshop later. You can always crop the picture then.
If you’re going for detail and aren’t sure how large or small to make it, it doesn’t hurt to get three
differently-zoomed shots of the same texture.
Check your Focus
It’s a good habit to pick up to preview your photos while you’re still in the field, zooming onto them to
make sure they are in focus, and not blurry. Without a tripod, you are trusting your hands not to shake as
you take the picture; it might take a few tries before getting it right. If it looks foggy in the viewer, it will
look foggy in the game!
Tips:
1.

2.
3.

4.

5.

Make each pixel count. Make sure you are only shooting the part of the texture that you need
and want to use; no need to take a picture of an entire building if all you want is the brick on
the side.
Avoid reflections/flash, unless reflections are absolutely needed to be in the texture. You can
always tweak a model to be shiny in-game, no need to put the reflections in its texture.
Pay attention to lighting conditions - too much light or not enough light. The light source
should come from in front of the surface you are shooting to ensure even lighting.
Remember: lighting can always be adjusted in Photoshop.
Avoid depth of field. Depth of Field relates to focus and for textures you want to ensure that
what you shoot is completely in focus. You have to be the right distance from a subject to
ensure the focus is right.
Look for unique surfaces that apply to the textures you will need for the game and assets you
will be making. Keep your energy for textures you could not find online; it’s easy to find a
wood floor texture, not so easy to find the pattern of your favourite clothing!

How to make your own tileable, seamless texture
Once you’ve gathered the textures you want to use, pick one and open it in Photoshop.
For this example, I’ll use the flat picture I took of a cork board in our office at Obx.
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We could technically work with an image this size, but it is standard to make tileable images of 1.1 ratio.
You can skip this next step if you like.
Using the Crop tool (C) set at 1:1 aspect ratio, crop the image into a perfect square and confirm with the
Enter key.

If any adjustments with the Levels or Hue/Saturation must be done, leave it for the end; you may want to
make multiple versions of your texture.
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Let’s have a look at what the image looked like if it was tiled.
Filter > Other > Offset
Set the Offset tool to Wrap Around and use the sliders to move the horizontal and vertical edges so they
move near the center of the image. This tool helps to show you what the edges of the tileable texture
would look like as they connect.
For our cork board image, the top and bottom were nearly a perfect match, but the left and right still
need some work.

Let’s use the Clone Stamp tool (S) to paint over our seams. Hover your mouse over the part you want to
clone, hold Alt down, and click. Then, you can click around and the stamp tool will paint using the clone
region as a source. For instance, if you paint to the right, it will pick the pixels that were on the right of the
initial clone region.
You can adjust the size of your Clone tool the same way as with the Brush tool, either with the Brush
properties or by holding down Alt and Right-Clicking and dragging.
The clone tool has a soft feathered edge initially, but you can change that if you wish.
If you use the feathered edge, which blends the new pixels with the old, your image might get a little fuzzy
by using the Clone tool too much, so be mindful of that.
Try not to touch the edges of the picture too much as you clone, or else we’ll have to start tiling all over
again!
Speaking of which, when you’re done, you can bring your image back to its original position of 0 offset by
accessing the menu again at Filter > Other > Offset.
In this case, with minimal editing, it gave a texture like this.
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For more information:
http://blogs.adobe.com/jkost/2015/01/how-to-create-a-seamless-pattern-tile-in-photoshop.html

Creating Normal, Specular and Transparency Maps out of the diffuse
Keep all of those different maps grouped as layers under your Diffuse, keeping it as one master PSD file. It
will be much easier to tweak the maps then, if they’re all together in the same file, if you were to ever
change the diffuse.
For the project we’re making, generally, a Diffuse and a Normal Map should be enough, but we’ll
introduce a little bit more just in case you’d want to use it.

How to create a Normal Map
To generate texture maps, there are all sorts of software existing to do it, like Crazy Bump (paid) or
xNormal (free), but there is a simple tool that already exists built-in with Photoshop.
Select the layer you want to make into a Normal map and duplicate it, to be safe.
Filter > 3D > Generate Normal Map.
As you can see, a preview of your normal map will appear onto a 3D object.
Use the Invert Height, Blur and Detail Scale options until you have something to your liking, then press OK
to confirm.
You can either tweak it by hand in Photoshop, for instance if you want only certain parts of the model to
be affected, or if you want to smudge certain parts (Smudge tool is under the Paint Bucket tool, click and
hold to access it).
When you are done, save it as an image file named appropriately.
Something like MagicianBoy_Normal.png

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

External Normal Map Software:
http://www.xnormal.net/Faq.aspx
http://www.crazybump.com/

How to create a Specularity map
Specular maps are traditionally in grayscale, ranging from black (no reflection) to white (highly reflective).
We could use colour, but for this workshop we’ll limit ourselves to grayscale.
Therefore, the first thing to do is to take out the colour from our image.
Open Hue & Saturation (Ctrl+U) and bring down Saturation to -100.
Invert the image with Ctrl+I if you need to. For example with the bricks below:
The first set shows pale bricks to a dark wall. The bricks will be much more shiny than the wall.
The second set shows dark bricks on a pale wall. The wall will be much more shiny than the bricks.

Finally, play with the Levels (Ctrl+L) if you wish to get sharper contrast, and use the S harpen filter to get
sharper details, instead of blurriness (Filter > Sharpen > Sharpen).
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About Specular Maps
Specular maps are the maps you use to define a surface’s shininess and highlight colour.
The higher the value of a pixel (from black as lowest to white as highest), the shinier the surface will
appear in-game. Therefore, surfaces such as dry stone or cotton fabric
would tend to have a very dark specular map, while surfaces like polished
chrome or plastic would tend to have lighter specular maps.
The colour of a pixel is also used, to calculate the resulting colour of the
surface. A very saturated specular map will have a very different visual
effect than a grey specular map. If you need a more "neutral" highlight on
a surface, your specular map should use the inverse of the diffuse map's
colour. Using the same colour on the specular as on the diffuse will result in
a more saturated highlight when viewed in the game.
You can use contrasts in specular to make a surface appear more visually
interesting in the game - for example, this door has a very dark specular for
the wood while the metal parts are much lighter, which will make the metal
stand out more as a shinier surface when light hits it. This sort of contrast
can help make surfaces in the game appear more realistic too.
http://wiki.splashdamage.com/index.php/Specular_Maps

How to make a Transparency map image file
Make sure that there are no pixels drawn on the area of the texture that you want to be transparent. In
this example, it is the shoes of the Magician Boy that I deleted on every visible layer, making sure to hide
the background solid colour layer as well. It shows me this checkered pattern symbolizing transparency.

Save it as a .PNG, which preserves Transparency (or Alpha).
In Blender, in the Texture tab, make sure to check the texture as BOTH Diffuse and Alpha.
Furthermore, in the Material tab, under Transparency > Z Transparency, bring Alpha down to 0.
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This method should also work for low-opacity pixels, to let you have gradients of transparency on a
character.
You should now be all set to create textures to your liking!
REMEMBER TO SAVE OFTEN!

Stylized Textures
Since we are going to work with rather low-poly models, it would be a good idea to stylize our textures
as well, since we are not going for a photorealistic look.
The best way to get stylized textures is probably to paint them by hand, although this would take a lot
of time. Fortunately for us, there are ways to get the look of a stylized texture in only a few steps,
thanks to Photoshop Filters. You can explore them yourself, or use the
Quick Texture Stylization Tutorial
Here are the steps, in short, as described on the Unity Community. You can find the link below.
1.
2.
3.
4.

Filters > Noise > Despeckle.
Filters > Sharpen > Sharpen.
Filters > Blur > Smart Blur…
Filters > Sharpen > Sharpen.

http://wiki.unity3d.com/index.php/Stylized_Texture_Tutorial

Customizing Colour
You can also customize your texture’s colours and contrast very quickly using the
Hue and Saturation (Ctrl+U),
Colour Balance (Ctrl+B), and
Levels (Ctrl+L).
You could even paint over an existing texture with the Brush tool! There are no rules, so just have fun.

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Custom Brushes
Having your own custom brushes can be quite nice, once you’re getting used to Photoshop as a whole.
Here are some online resources on how to make your own, or install some found on the web.
How to make photoshop brushes
http://danidraws.com/blog/2007/01/20/make-your-own-photoshop-brushes/

How to install photoshop brushes
https://creativemarket.com/blog/how-to-install-use-photoshop-brushes
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Digital Imaging 10:

Principles of Animation: Overview of the 12 principles of animation

Facilitator: John Mervin

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 26, 9:30AM
30 minutes
Instructor Prerequisites:
Knowledge of the 12 principles of animation.
Student Prerequisites:
None
Equipment, Software Materials:
None
Objectives:
Learn about the principles of animation to aid in drawing and animation skills.
Vocabulary:
Squash and stretch, anticipation, staging, straight ahead and pose to pose, follow through and
overlapping, slow in and slow out, arcs, secondary action, timing, exaggeration, solid drawing and appeal.
WEB RESOURCES & BOOKS:
Principles of Animation:
● http://minyos.its.rmit.edu.au/aim/a_notes/anim_principles.html
● https://ohmy.disney.com/movies/2016/07/20/twelve-principles-animation-disney/
● http://the12principles.tumblr.com/
○ Illustion of Life Disney Animation by Frank Thomas:
https://www.amazon.ca/Illusion-Life-Disney-Animation/dp/0786860707
Preparation:
PowerPoint presentation for future referral.
Overview
The main purpose of the principles of animation were to produce an illusion of characters adhering to the
basic laws of physics, but the principles also dealt with more abstract issues, such as emotional timing and
character appeal.
Illusion of Life Disney Animation Book
This book was written by two of the animation masters at Disney during the Golden Age of animation and
is known as the best animation books of all time. The book gives a history of Disney animation and
explains the processes involved in clear, non-technical terms. It has excellent technical drawings and fun
examples of the principles of animation at work in some of the most famous films.
Squash and Stretch
This action gives the illusion of weight and volume to a character as it moves. Squash and stretch is useful
in animating dialogue and doing facial expressions . How extreme the use of squash and stretch is,
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depends on what is required in animating the scene and is done by expanding and compressing the
character’s body. It is used in all forms of character animation from a bouncing ball to the body weight of
a person walking. This is the most important element you will be required to master and will be used
often.
Anticipation
This movement prepares the audience for a major action the character is about to perform, such as,
starting to run, jump or change expression. A dancer does not just leap off the floor, a backwards motion
occurs before the forward action is executed: the backward motion is the anticipation. A comic effect can
be done by not using anticipation after a series of gags that used anticipation. Almost all real action has
major or minor anticipation such as a pitcher's wind-up or a golfers' back swing.
Staging
A pose or action should clearly communicate to the audience the attitude, mood, reaction or idea of the
character as it relates to the story and continuity of the story line. The effective use of long, medium, or
close up shots, as well as camera angles also helps in telling the story. There is a limited amount of time in
a film, so each sequence, scene and frame of film must relate to the overall story.
Straight Ahead and Pose to Pose
Straight ahead animation starts at the first drawing and works drawing all drawings to the end of the
scene. You can lose size, volume, and proportions with this method, but it does have spontaneity and
freshness. Fast, wild action scenes are done this way.
Pose to Pose is more planned out and charted with key drawings done at intervals throughout the scene.
Size, volumes, and proportions are controlled better this way, as is the action.
Follow Through
When the main body of the character stops all other parts continue to catch up to the main mass of the
character, such as arms, long hair, clothing, coat tails or a dress, floppy ears or a long tail (these follow the
path of action). Nothing stops all at once. This is follow through. Overlapping action is when the character
changes direction while his clothes or hair continues forward. The character is going in a new direction, to
be followed, a number of frames later, by his clothes in the new direction. Timing becomes critical to the
effectiveness of drag and the overlapping action.
Slow In and Slow Out
As action starts, we have more drawings near the starting pose, one or two in the middle, and more
drawings near the next pose. Fewer drawings make the action faster and more drawings make the action
slower. Slow-ins and slow-outs soften the action, making it more life-like. This will be covered in the
bouncing ball exercises in the animation courses. As a ball falls down, it moves faster and as the ball
bounces upwards it gets slower as it reaches the peak.
Arcs
All actions, with few exceptions, follow an arc or slightly circular path. This is especially true of the human
figure and the action of animals. Arcs give animation a more natural action and better flow. Think of
natural movements in the terms of a pendulum swinging. All arm movement, head turns and even eye
movements are executed on an arcs.
Secondary Action
This action adds to and enriches the main action and adds more dimension to the character animation,
supplementing and/or reinforcing the main action. Example: A character is angrily walking toward another
character. The walk is forceful, aggressive, and forward leaning. The leg action is just short of a stomping
walk. The secondary action is a few strong gestures of the arms working with the walk. All of these actions
should work together in support of one another. Think of the walk as the primary action and arm swings,
head bounce and all other actions of the body as secondary or supporting action.
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Timing
Expertise in timing comes best with experience and personal experimentation, using the trial and error
method in refining technique. A variety of slow and fast timing within a scene adds texture and interest to
the movement. Timing in the acting of a character to establish mood, emotion, and reaction to another
character or to a situation. Examples of timing are that walking is slower than running. A ball bounding
upward should be slower than the ball coming down.
Solid Drawing
The basic principles of drawing form, weight, volume solidity and the illusion of three dimension apply to
animation as it does to academic drawing. This principle encourages animators to be mindful of the fact
that while forms may be presented in 2D, they should strive to look 3D
Exaggeration
Exaggeration is not extreme distortion of a drawing or extremely broad, violent action all the time. It's like
a caricature of facial features, expressions, poses, attitudes and actions. Exaggeration in a walk or an eye
movement or even a head turn will give your film more appeal. Exaggeration is all about overstating
certain movements in a way that helps evoke a point, yet doesn’t ruin the believability of the scene.
Appeal
A live performer has charisma. An animated character has appeal. Appealing animation does not mean
just being cute and cuddly. All characters have to have appeal whether they are heroic, villainous, comic
or cute and the model and animation should reflect that personality
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Digital Imaging 11:

Rendering in Blender
Facilitator: Jasmine Eladas

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday July 26, 10:30SM
1 hour
Instructor Prerequisites:
The instructor should be comfortable using Blender and have experience using lights and the different
rendering engines.
Student Prerequisites:
Students must have their assets/characters modeled, and they will have already done Art Module 9: UV
Mapping. They should have had an introduction to materials in Blender.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint
Objectives:
Understand the different types of lamps in Blender. Begin experimenting with rendering.
Vocabulary:
Lamp, Sampling, Resolution, Freestyle, Toon
WEB RESOURCES & BOOKS:
Blender community:
https://docs.blender.org/manual/en/dev/render/
https://docs.blender.org/manual/de/dev/render/blender_render/lighting/lamps/index.html
https://docs.blender.org/manual/de/dev/editors/3dview/navigate/camera_view.html
https://docs.blender.org/manual/de/dev/render/blender_render/camera/object_data.html
https://docs.blender.org/manual/de/dev/render/freestyle/introduction.html
https://docs.blender.org/manual/de/dev/render/freestyle/parameter_editor/line_set.html
https://blender.stackexchange.com/questions/10925/how-to-render-cartoon-style-with-completely-flat-c
olors
Lighting Tips:
https://www.blenderguru.com/articles/6-tips-for-better-lighting
Preparation:
Blender file cube_UVmapped.blend open on computers.
UV map cube_UVs.png open in Photoshop.
PowerPoint presentation for future referral.
Students should all have drawings done from previous lesson.
Procedure:
In this lesson, we will learn how to create still images and videos out of the content we build in Blender, in
order to be able to use them in video-editing software like After Effects for example.
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We will only explore the very basics of rendering, seen as it’s a step that can easily become very technical,
especially when it comes to lighting a scene and compositing in post. For this reason, we will use the
Blender Render, Blender’s default non-photo real rendering engine, which has fewer options and is least
customizable, but fits our current needs the best.
What is Rendering?
Rendering is the process of creating a 2D image (or video) from your 3D scene. What that image looks like
is based on four factors which the user can control:
-

A Camera
The Lighting in your scene
The Material of each object
Various render settings (image quality, image size, layers, etc.)

Your computer will perform various complex calculations based on those factors in order to give you your
rendered image. This process may take some time depending on the complexity of the scene and your
computer hardware.
Once the render is complete, it is possible to do additional manipulation of the image, called Post
Processing.
Finally, the output can be saved to an image or video file using one of the Output Formats.
Workflow
In general, the process for rendering is:
1.
2.
3.
4.
5.
6.
7.
8.

Position the camera
Light the scene
Setup materials
Render a test image using lower quality settings
Change or fix anything you noticed in the render
Repeat the above two steps until you are satisfied
Render a high quality image, change or fix any issues and repeat until satisfied
Save your image to a file, or render the animation to a video or image sequence.

source: https://docs.blender.org/manual/de/dev/render/introduction.html

Lamps and Light sources
In order to light a scene in a 3D environment, it is important to understand how light sources work. In
Blender, those are called lamps. There are multiple types of lamps, which we use for different purposes,
often in conjunction with other lamps. Once you understand them, you will be able to use them to light
your scene before rendering. None of those lights can be transferred to Unity, since it has its own
lighting system made with game performance in mind.
Lamps can typically be moved and rotated around the Blender scene like any other 3D object.
You can add them to the scene with Shift+A.
Let’s see how Blender describes those types of lamps.
Point Lamp
It is the lamp that appears by default when you open Blender. The Point lamp is an omni-directional point
of light, that is, a point radiating the same amount of light in all directions. It’s visualized by a plain, circled
dot.
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Sun Lamp
A Sun lamp provides light of constant intensity emitted in a single direction. A Sun lamp can be very handy
for a uniform clear daylight open-space illumination. In the 3D View, the Sun light is represented by an
encircled black dot with rays emitting from it, plus a dashed line indicating the direction of the light.
This direction can be changed by rotating the Sun lamp, like any other object, but because the light is
emitted in a constant direction, the location of a Sun lamp does not affect the rendered result (unless you
use the sky & atmosphere option).
Spot Lamp
A Spot lamp emits a cone-shaped beam of light from the tip of the cone, in a given direction. Think about
it like a spotlight at concert venues.
Area Lamp
The Area lamp simulates light originating from a surface (or surface-like) emitter. For example, a TV
screen, a window, or a cloudy sky are just a few types of area lamp. The area lamp produces shadows with
soft borders by sampling a lamp along a grid the size of which is defined by the user. This is in direct
contrast to point-like artificial lights which produce sharp borders.
Hemi Lamp
The Hemi lamp provides light from the direction of a 180- hemisphere, designed to simulate the light
coming from a heavily clouded or otherwise uniform sky. In other words, it is a light which is shed,
uniformly, by a glowing dome surrounding the scene.
Since this lamp is the only lamp which cannot cast any shadow, the Shadow panel is absent.
Similar to the Sun lamp, the Hemi’s location is unimportant, while its orientation is key.
The Hemi lamp is represented with four arcs, visualizing the orientation of the hemispherical dome, and a
dashed line representing the direction in which the maximum energy is radiated, the inside of the
hemisphere.
Lamp Panel
The Lamp Panel in the Properties menu lets you change the settings of your chosen lamps in the scene.
You can use it to change the type of lamp you’re using, its colour and intensity, whether or not it casts
shadows, its falloff and attenuation, or the way it influences materials.

sources:
https://docs.blender.org/manual/de/dev/render/blender_render/lighting/lamps/index.html
https://docs.blender.org/manual/de/dev/render/blender_render/lighting/lights/lamp_panel.html
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Lighting Rigs
A lighting rig is a setup and combination of lights to be able to light a scene well and produce well-lit
models. Different rigs are used for different purposes, from providing a balanced illumination of an
object, to showing off a 3D model with depth, to emulating the lighting off of a real filming setup to add
objects with actors in post-production.
Lighting being a very complex process, using a standard lighting rig is a useful way to start rendering
your scene. You can then adjust it however you want to suit your needs.
You can find many resources online explaining how to properly balance the light in a scene and achieve
your rendering goals.
Generally, we call the different lights differently depending on their role. For instance…
- A Key Light shines directly upon the subject and serves as a principal illuminator.
- A Fill Light also shines on the subject, but from a side angle relative to the key. It serves to
balance the key light by adding softer lights to the other side of the subject.
- A Back or Rim Light shines on the subject from behind to separate them from the background
by highlighting its contour.
- A Background Light would be placed behind the subject and, as the name suggests, illuminate
the background. It’s served to eliminate shadows cast by foreground elements onto the
background.
Standard two-point rig
Balanced illumination with no main focus

Three-point rigs (studio and standard)
Use the Studio rig (left) to give balanced soft lighting that also highlights your main actor or object. This
rig is best used when combining CG objects to green screens and real actors.
Use the Standard rig (right) in normal 3D animations to light the main actor. This rig is used in real life
to light actors on a set; it gives some backlighting to highlight the sides of the actors to make them
stand out more and give them depth.

Four-point rig
Use this rig to provide a better simulation of outside lighting.
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https://docs.blender.org/manual/de/dev/render/blender_render/lighting/lighting_rigs.html
https://en.wikipedia.org/wiki/Three-point_lighting

Cameras
In order to define which section of the scene will be rendered as a flat 2D image or a video, it is important
to understand how to use Cameras. They define what is or isn’t visible when we render. They are not
visible objects themselves.
Typically, only one camera can be used at the same time as the active camera, so you will only need to
create multiple cameras if you make cuts in between them, like in a TV show.
Like other objects in a 3D scene, cameras can be moved and rotated.
You can add cameras with Shift+A.
You can have a look at the camera view by pressing 0.
While in camera view, navigating around with Alt+Left Click will get you out of camera view back into
perspective user view. How then do you modify the camera view while being in it?
Check Lock Camera to View in the N menu while you are in camera view. This will let you navigate around
the scene to place your camera the way you want it to be, after which you can uncheck this option.

This is when checking Rotate Around Selection, under the Interface tab of the Blender User Preferences
(Ctrl+Alt+U) can be handy. Check and uncheck this option as you see fit to aid you in camera placement.

You can also move around the viewport and Align the Active Camera to the View with Ctrl+Alt+0, or in
the 3D View Header, View>Align View>Align Active Camera.
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Alternatively, though less intuitively, you can select the camera in the graph view and use your
manipulators (R, G) while locking them in the axis you want. These tools are easier to use if you are
ever animating the camera itself, to make it pan, dolly or rotate around the scene.
Note: By pressing an axis key twice, you can lock a rotation or transform in the object’s local axis.
How to change the active camera
If you have two cameras in the scene and want to switch which one is active, simply Select the one that
should be active (in the viewport or in the scene graph) and, while hovering the mouse in the viewport,
press Ctrl+0.
Tip: Because the camera is not rendered, it doesn’t matter if you see another camera before rendering.
Therefore, you could even duplicate a camera and change its settings, then switch between one and
the other to see how the settings affect the render.
More camera options can be found in the Object Data tab of the Properties menu, such as if the camera is
Perspective or Orthographic, its Depth of Field and Focal Length, etc. You can even use this menu to find
Camera Presets mimicking real cameras.
You can find more information about all of these options in the Blender Manual:
https://docs.blender.org/manual/de/dev/render/blender_render/camera/object_data.html
How to Render
To render a scene, the best thing is to have a Blender layout that lets you see both the 3D View and the
UV/Image Editor. This way, you can do changes between renders without being forced to switch between
both constantly.
In the Properties Menu’s Render tab, set the image resolution of the render.
Most of the time, a render the size of HD videos to render a full scene is the preset
HDTV 1080, or 1920x1080 p
 ixels.
If you’re only rendering a still image of an object, though, you can adjust it to be the appropriate size.
Make sure that the Output file format is set to PNG.
Set the Output file folder directory to match that of your project’s, in a Subfolder within it, so to not lose
your files somewhere deep in your computers’ folders. By default, it sends them to /tmp\, Windows’
default temporary files folder on the C: drive.
Static image renders will not be saved there automatically, so you’ll have to save them by hand, but any
image sequences created when rendering video will be sent there, so it’s best to set that early.
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Press F12 on your keyboard to render the active camera view as a static image.
Alternatively, press Render in the Properties Menu’s Render tab.
This will make the Render Result appear in the Image Editor.
You can then save the image the same way we saved the UVs before, with Image > Save As Image (F3).

OpenGL rendering Active Viewport
If you wanted, you could render exactly what you see in the viewport. This would bypass all of the
materials and shadows usually rendered by the Blender Render engine, instead giving you basically
exactly what you see in the 3D view.
OpenGL rendering uses the 3D View’s drawing for quick preview renders. You can use OpenGL to render
both images and animations. It can be used to preview animations.
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Source: https://docs.blender.org/manual/en/dev/render/opengl.html

Transparent Background
To render only the object in the scene and not the gray background behind it, in the Render tab, under
Shading, make sure that the Alpha is set to Transparent. Down in the Output section, make sure that
RGBA is selected.

What does RGBA mean?
It refers to the colour channels of the image, and stands for Red, Green, Blue and Alpha. Those are the
colors we use for web and on-computer images. Each channel holds the brightness and saturation of its
assigned colour, creating the three primary colours that are blended together to create the images we
see.
The Alpha is a separate channel which designates the Opacity, or Transparency of the pixels in the
image.
Note: For printed images, the colours used are CYMK (Cyan, Yellow, Magenta, and Black).
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A. Separated color channels
B. Alpha channel represented as a grayscale image
C. Composite using all four channels with a background showing through transparent areas
https://helpx.adobe.com/after-effects/using/alpha-channels-masks-mattes.html
https://en.wikipedia.org/wiki/Channel_(digital_image)

Rendering Animation
If you wanted to render an animation, it would be the exact same process, except you would first have to
set the Start and End Frames of your animation, along with the Frame Rate if you were to render directly
to video (which is not what we will do today).
The Frame Rate serves to say how many images will be played or rendered per second; by default, the
standard for animation is 24 fps. Therefore, rendering 72 frames would be rendering 3 seconds of video.
Instead of rendering your animation as a video, we will render it as an Image Sequence. Rendering as a
series of images is helpful for editing in post-production. It allows for editing only certain frames, to
change the frame rate, and to keep the highest image quality with no compression while editing, amongst
other things.

https://docs.blender.org/manual/de/dev/editors/3dview/navigate/camera_view.html
https://docs.blender.org/manual/de/dev/render/blender_render/camera/object_data.html

Change the Active Camera During an Animation
To change the active camera during an animation you can use Markers.
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1.

Add a marker where you want to change the active camera (M in the Timeline, or Timeline
header > Add marker will add a marker to the current frame):

2.

Select the object which you want to set as the new active camera and the marker which you
want to bind it to, then press CtrlB in the Timeline (or Timeline header > View > Bind camera
to markers):

Note that markers behave like keyframes, so you will need at least two markers with cameras bound to
them to have any camera switching.
To illustrate this, here is an example with Camera.001 bound to the marker on frame 1, and Camera
bound to the marker on frame 5:

https://i.stack.imgur.com/ehgyv.gif

Note: If setting the active camera is only affecting a single view, you may have Scene-lock disabled. In
the 3D View header (Right hand side of layers buttons), there is a lock icon. This should normally be
pushed in, unless you explicitly want to set a camera & layers only to a single view.
source:
gandalf3 & ideasman42 on Blender Stack Exchange
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https://blender.stackexchange.com/questions/3502/how-can-i-make-a-camera-the-active-one

You are now able to export images and videos of your 3D models!
Now, let’s look at some easy styling options that might be helpful to our game project.
Cartoon look with Freestyle
FreeStyle is an edge- and line-based non-photorealistic (NPR) rendering engine.
You can use it to outline your models, and draw upon some of its edges, to give them a toon-like look.

https://wiki.blender.org/uploads/thumb/9/99/Manual-2.6-Render-Freestyle-Demo-OHACartoon.png/600px-Manual-2.6-Render-Freestyle-Demo-OHACartoon.png
http://blendernpr.org/toonery/wp-content/uploads/2012/08/citybildding-1024x512.jpg
http://blendman.free.fr/bd/freestyleRobot.jpg

How to activate Freestyle
At the bottom of the Render tab of the Properties menu, check the Freestyle box.
It is now activated on the entire scene, as you may notice by doing a quick render of your character. .

>
These models were simply lit by the default point light, moved to be to the front of them.
In the Render Layer tab, just right of the Render tab, you will see a set of options under sections called
Freestyle Line Set and Freestyle Line Style. This is the bulk of where you will do your operations for
Freestyle.
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Under Edge Type, for the Magician Boy, I unchecked the Crease box, which would draw a sharp line in the
middle of his face.
You can play around with the Edge Types to find which ones suit your models best. For more information
on what each option does, go to the Blender Manual.
https://docs.blender.org/manual/de/dev/render/freestyle/parameter_editor/line_set.html
One interesting option is Edge Mark. A bit like with the Seams we drew on the model for the UVs, and the
Sharp Edges we drew for sharp edge contrast in previous lessons, you can select edges on your model in
Edit mode, hit Ctrl+E for the Edge menu, and select Mark Freestyle Edge. If Edge Mark was checked under
Edge Types in the Freestyle Line Set of the Render Layers tab, those edges would be drawn just like the
contours. This helps customize which lines should permanently be drawn on the character.

Toon Style Suggestion
If you wanted a style that would more seamlessly blend with drawn images from Photoshop for our
game’s cutscenes, for instance, you may want to achieve a cartoon look for the character. This section will
give you a few style suggestions for easy rendering of our 3D assets.
First, change the Point lamp into a Hemi lamp, and make sure it’s pointing towards our character. As
we’ve seen before, Hemi lamps act as half-spheres that create even, shadowless lighting on our
characters.
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Then, change the character’s material to a Toon Shader. Give it a Specular Intensity of 0.
You now have a

Finally, if you want, under the Material tab, in the Shading section, you may want to check Shadeless,
which would give it a very flat 2D look.

About the Toon Shader
The Toon shader is a very ‚un-physical‘ shader in that it is not meant to fake reality, but to produce
cartoon cel styled rendering, with clear boundaries between light and shadow and uniformly
lit/shadowed regions.
Size: The size of the lit area.
Smooth: The softness of the boundary between lit and shadowed areas.

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Some example work of work done with Blender, Photoshop and After Effects
By Mclelun

https://youtu.be/CfS9I_a5Tq8
By Mclelun

https://youtu.be/kzYjRCwI78I
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Game Engineering 01

Intro to Unity
Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday 19 July 1:45PM
1 hour (followed by 15 minutes for students to play around in finished Unity template project)
Instructor Prerequisites:
▪ Access (login/password) to server hosting Skins 5.0 Template Game and Skins 5.0 Course Material
▪ Completed a workspace update on both repositories, tested connection and ensured proper
functionality and project structure
▪ Printed out “Assets Structure and Naming Conventions” for all students to have
Student Prerequisites:
▪ Access to local versions of Skins 5.0 Template Game and Skins 5.0 Course Material from the hosting
server
▪ Access (login/password) to a Unity3D account (educational license)
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Plastic Gluon (synced to the demo project repository)
- Unity3D
Objectives:
1. Quick overview of what Game Engines are and what they can offer
2. Introduce the Unity3D interface and its functionality
Vocabulary:
Game Engine, Hierarchy, Inspector
Web Resources:
Game Engines: How do they work?
Unity3D essentials
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Procedure:
Refers to “Skins 5.0 | Game Engineering 01 | Intro to Unity.slides
Slide 02: What is a Game Engine???
Slide Goal: Brief introduction to Game Engines and what they offer
Key Idea: Somebody else did the leg work!
Back when game development was first starting to emerge it was 95% programming 5% everything else. Most
teams were made up entirely of programmers with well developed knowledge of many different fields of
programming. However, in the last decade, the need for deep, specific programming knowledge has lowered
drastically thanks to the introduction of Game Engines. Game Engines are, at their core, [next] platforms with
built in modules and features to help speed up the development process of games as well as reduce the
technical level needed to do so.
These pre-built modules handle all of the low level programming involved in areas such as: [ next]
- Graphics Rendering [next]
- 3D sound rendering and interpretation [next]
- UI tools [next]
- Physics simulations [next]
- Networking features
Furthermore, [next] most engines come with pre-built scripts and pre-designed functionality that one can
start from. However, each engine have their own forces and weakness. And there are many to choose from:
- Unity3D is one of the most well known engines especially in the indie scene thanks to its accessibility
and great documentation. Well known for creating mobile games such as Angry birds and
Hearthstone as well as many console games as well. [next]
- Unreal Engine 4 is another popular one with a high quality rendering engine and strong built in
material editors. Many AAA games such as the Kingdom Hearts series as well as the Gears of War
series were created using this game engine. [next]
- CryEngine is yet another game engine used by a number of AAA companies on games such as Far Cry
as well as indie games such as Everybody’s Gone to the Rapture
The thing is, [next] there are so many game engines to choose from, all of them with their own strengths.
Slide 03: Why Unity???
Slide Goal: Explore the key benefits of Unity
Key Idea: Accessibility!!!
So why use Unity? In one word [next]: “Accessibility”. It is one of the most accessible game engines to get into
for a number of reasons:
- First and foremost, [next] it has a small learning curve. It doesn’t take long to get comfortable to this
engine. Although it takes years to master like all other engines, in a matter of days, you can become
more than comfortable enough to create your own simple game. This in part has to do with one of
Unity’s strongest features: [next]
- In depth documentation. Unlike many other game engines that require you to have a semblance of
technical background in order to get your hands dirty with the engine, Unity has hundreds of well
crafted tutorials, examples and sample projects for any beginner to start with. From how to use the
engine itself to well crafted tutorials teaching programming concepts and practices.
- [next] Thanks to this, it has a huge community. But not just that, the Unity community is one of the
most active and helpful communities when it comes to starting out and asking (or finding answers to)
beginner or even advanced question. Unity has its own native forum on their website that is very
active. Almost any question you may have will have been asked and answered and is a simple google
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-

-

search away. If your question hasn’t already been asked, it is normally a matter of hours before you
will get an answer to a question posted on these forums.
Unity understands that not everyone has all the skills necessary to make a game from scratch and it
leverages that idea quite well. [next] It has a huge in house asset store where one can download any
kind of asset, be it a model, script, system, shader, addon, the list goes on. Often these assets need to
be purchased (most often at very reasonable prices) but there are also many free assets that one can
download and work with no strings attached. The majority of all assets are user generated and new
ones pop up daily. [next]
Lastly, Unity is free for all hobbyists and small studios. Unless you are making over $100 000 in a year
using Unity, then it is completely free with no royalties or pay walls. A non-paying user has all the
same features as a paying one.

Slide 04: Transition Slide
[Everyone should take the time to open up the template game so as to look at the interface directly inside of
the game engine]
Slide 05: Unity Interface
Slide Goal: Brief introduction to the Unity interface
Key Idea: Four core sections
Unity’s interface is set up into windows, all of which are moveable, scaleable and dockable, that way one can
set up their interface in the way that feels most comfortable for them. There are 4 core windows that all users
will use throughout their foray into game development: [next]
- The project window: this gives the user a view of all the assets and directories within the project
folder. Here you can select assets to use for specific scenes and also, modify existing ones as well as
drag and drop new ones. [next]
- The hierarchy window: this demonstrates all gameObjects in the scene. We can select them in order
to modify their components and values as well as create new objects to throw into the scene. [next]
- The scene view: this shows a 3D view of the in game scene and allows us to position, orient and scale
all our gameObjects in the scene. [next]
- Lastly if not most importantly, there is the Inspector view: this window shows all of the nuts and bolts
of any asset selected (either from the project view or from the hierarchy or scene view). This is where
we can see, modify and give or remove functionality to each and every object that will inhabit our
game world.
Slide 06: Project View
Slide Goal: Introduce the project view and good project structure
Key Idea: Organization is SUPER important
The project view allows you to organize, modify and create assets inside the assets folder. All assets by default
must exist here. It is extremely important to have a clean, understandable and pre-established assets structure
before starting to develope, that way we don’t end up with a mess inside the assets folder. The messier the
asset folder is, the longer it takes to find things and the higher the risk of creating doubles. We have created
for you a clean assets structure and naming convention that you should follow for the purposes of this
workshop.
[Ensure each student has a copy of “Skins 5.0 | Assets Structure and Naming Convention”]
There are 3 core sections in the project view:
- [next] The Assets folder: holds all assets used in the game. We can navigate this area through the
drop downs of each directory and all of the directory files will pop up in the file view
- [next] The Favorites: holds all of each type of Unity asset. These sections collect all assets of each
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type so you can browse each type independently. Doesn’t have much use if you name and organize
your files properly.
-

[next] File View: shows all the files within the given context. If one has selected a directory within the
assets folder, those files will be shown and it is possible to add files to that specific directory by right
clicking or hitting the create button. If a favorites section is selected, all files of the given type will be
shown in alphabetical order. inside this view, there are 2 elements that can help with searching for
assets:
- [next] The file view scale slider: allows for one to scale up or down the files inside the file
view. This goes from simple name of file to large visible icon. This is good when you aren’t
sure of the name of a file but know what the element looks like (i.e. mesh, texture, material,
etc)
- [next] On the other hand, if you know the name of the file you are looking for, you can
search for it in the search bar. This will filter out any file that doesn’t have the search criteria
in their name. Great for quickly finding files by name.

Slide 07: Scene View
Slide Goal: Introduce the scene view used for editing the scene and it’s elements
Key Idea: Seeing is believing
The scene view allows us to see the 3D world we are currently working on. In here, we can move, rotate and
scale any gameObject within the scene as well as move around in the scene. There are a number of hotkeys in
order to more efficiently work in this view:
- [next] The QWER keys allow us to quickly switch object transform mode with the Q allowing us to
move around the scene without selecting any object, the W allowing us to move an object, the E
allowing us to rotate an object and the R allowing us to scale an object
- [next] There are also a number of hotkeys with the mouse in order to help navigate inside the scene.
The ALT and left mouse button allow us to rotate the view around the current view focal point. The
middle mouse allows us to pan the scene, moving left and right in the current view. Lastly, right
mouse button allows us to rotate the view around the current viewpoint position.
Slide 08: Hierarchy
Slide Goal: Introduce the hierarchy and parent-child objects
Key Idea: A clean, organized hierarchy is a happy hierarchy.
The hierarchy allows us to see all of the gameObjects currently inside the scene. We can also add and create
new objects to the scene in this view. In order to create new objects, [next] we can either press the Create
dropdown and select what we want to create or we can right click anywhere inside this view and select create
that way as well. If we want to bring an object from the asset folder into the scene, we can simply drag and
drop the object from the project view to the hierarchy and it will be added to the scene.
Aside from adding and creating new objects, there is an important concept that we need to understand. You
see the arrows next to many of the objects in the hierarchy? That signifies that they have children
gameObjects. Objects in a scene can share a parent-child relationship. What this means is that anything done
to the transform of the parent (location, rotation or scale), will happen to the child as well. [next] However,
the actual values of the children objects will not change because they exist within the local space of their
parent. All of their transform data is relative to the parent. [next] This means that if a child is at the origin of
the parent, it’s location will be 0,0,0 and if we move the parent 10 units to the right [next], the parent’s
location will change and the child will move with it but the child’s location values will still be 0,0,0. This is the
same for all the transform elements not just location. In other words, [next] Parents always live in world space
while children live in their parent’s local space. Since this is an extremely important concept to understand
let’s look at an example of this in action.
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Demo: Use prebuilt scene ParentingDemo from repo CourseMaterial to demonstrate local/word space
Slide 09: Inspector
Slide Goal: Introduce the Inspector and the role of components
Key Idea: Game Objects are only as useful as their components
The Inspector view tells us all we need to know about a gameObject’s existence and purpose. It tells us its
location in the 3D space, and it tells us what parts and behaviours make it up. This is the area where we can
tweak any and all values in order to make each gameObject unique even if it has the same components. Let’s
look at this example for a main camera.
[next] Here we see that the object’s name is Main Camera. A quick side note, it’s a very good idea to give each
object a distinct and descriptive name.
[next] Here we are given the object’s transform data. This is all we need to know about its existence within the
3D scene. If this object has no parent, these values will be in world space, if it does have a parent, they will be
in local space relative to the parent.
[next] This section here tells us that it’s not named main camera for no reason. We see that it has the
component that gives it the functionality of a camera. Without it, even if we named it “Awesome main camera
that does everything magically”, it would not act much like a camera. GameObjects are only as useful as their
components and the inspector is where we can see and edit all of that.
Exercise (20 minutes):
Give the students access to the TemplateGame so they can play around with it in the editor. They should
create a local copy so as to not mess with the version on the repository.
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Game Engineering 02

GameObjects and Components: Adding Game Functionality

Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Friday 21 July 3:50PM
1 hour
Instructor Prerequisites:
▪ Access (login/password) to server hosting Skins 5.0 Course Material
▪ Completed a workspace update on the Skins 5.0 Course Material repository, tested connection and
ensured proper functionality and project structure
▪ Have the Course Material: Game Engineering Unity project open and ready to go
Student Prerequisites:
▪ Access to local versions of Skins 5.0 Course Material repo from the hosting server
▪ Access (login/password) to a Unity3D account (educational license)
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Plastic Gluon (synced to the demo project repository)
- Unity3D

Objectives:
1. Introduce what a GameObject is.
2. Introduce what a Component is.
3. Explore various Unity components, their purpose and their variables
Vocabulary:
GameObject, Component, Transform, Mesh Renderer, Colliders, RigidBody, Prefab
Web Resources:
Unity3D Using Components
Unity Components Official Tutorial
Unity Prefabs Official Tutorial
Procedure:
Refers to “Skins 5.0 | Game Engineering 02 |Unity Components.slides”
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Slide 02: What Makes up a Game?
Slide Goal: Explain the structure and importance of a GameObject
Key Idea: Everything in a game exists as a GameObject
Everything in Unity exists as a GameObject. [next] All models and characters are gameObjects, all light sources
are gameObjects, [next] trees are gameObjects, [next] sound sources are gameObjects, the list goes on.
Basically if the object exists inside the scene then it is considered a gameObject. If everything is a gameObject
though, what is the difference between the teddy bear and the audio source? [next] The answer is: their
components.
Slide 03: What is a Component?
Slide Goal: Explain the concept and importance of Components
Key Idea: Components are modules of functionality
So what is a component? Components can be described as many things:
- Components are functionality. If we want a gameObject to play a sound, we need a component to tell
it to do so
- Components are behaviours. If we want a gameObject to patrol an area and run after intruders, we
need a component to tell it to do so
- Components can simply hold data. We may want a gameObject to hold the current state of an in
game event or hold character stats. We need a component to hold this data.
- Ultimately, components are everything that we can see, add and modify in the inspector view. Every
box within a gameObject’s inspector is a different component with a different purpose.
Let’s take a look at the main camera gameObject here:
- The camera needs to exist in the 3D space so by default it has a Transform. This tells the engine about
this gameObject’s existence in the 3D world.
- Since we want the camera to act like a camera, we need it to have a camera component. This
component allows the camera to capture a rectangle view and use it as the game screen.
- Since this is a camera, we also want it to have 2 other components that add functionality to the
camera screen. These 2 components: GUI Layer and Flare Layer allow the engine to draw an extra
layer on top of the camera for each.
- Since we want to be able to interact with objects in game, we need to have some functionality that
recognizes the mouse click on the screen and translates that to clicking in the 3D world. That’s what
the Physics Raycaster component accomplishes.
- And lastly we want to have control over the camera movement so we need a component that
controls it during the game. This is the Camera Controller script component.
Most of these components are built in Unity modules, however, if you see a component with a C# icon, then
those represent custom made components. The camera controller component is an example that we made.
Slide 04: Transition Slide
[consider running through each component live with them instead of going through the slides]
Slide 05: Transform
Slide Goal: Introduce the Transform component
Key Idea: Every GameObject has a transform component to orient it in the 3D world
By default all gameObjects have a Transform component. This component controls the gameObject’s
existence in the 3D space. [next] I t determines the position of the gameObject as well as its rotation and its
scale. The position is calculated by arbitrary Unity units so this isn’t in any measureable form. On the other
hand, rotation works by degrees and scale modulates the size of a gameObject by multiplying its original size
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by the scale values for each axis.
Slide 06: Mesh Renderer
Slide Goal: Introduce the Mesh Renderer component
Key Idea: Makes an object visible and controls how the object is rendered in the 3D world
The mesh renderer component allows a mesh to be rendered and be visible in the world. This basically
allocates a mesh avatar for the gameObject in order for it to be seen inside the game world. [next] It handles a
few lighting options such as controlling if the object should cast shadows and if shadows should be rendered
on it. More importantly, it holds one or more materials that dictate how the mesh will look. Materials are
created inside of Unity and there are multiple kinds that can be created. We will go more into detail into the
materials in other courses. Without a mesh renderer, the gameObject will not be visible in the scene.
Slide 07: Colliders
Slide Goal: Introduce the various Collider components
Key Idea: Gives an object recognizable boundaries that can be interacted with
The collider component gives a gameObject a recognizable boundary that can be interacted with by other
gameObjects as well as by player interactions. [next] In short, colliders allow for the recognition of collision.
There are a number of different collider components with the main difference between each being the shape
that they take:
- [next] Box collider: simple box shaped collider with a controllable size for each axis
- [next] Sphere collider: simple spherical collider with only a controllable radius
- [next] Capsule collider: In a way this is a mix of the box collider and sphere collider. Like the sphere
collider, it has a radius to control its circular width however, it also has a height to control how
stretched it is.
- [next] Lastly there is the Mesh collider: a collider that takes the shape of any mesh. This is the least
performant collider and should be avoided unless absolutely necessary. In most cases, the other 3
colliders can be used to estimate the shape and size of a gameObject.
Each collider has one option that is the same for all: Is Trigger. This option dictates whether a collider should
have a physical presence in the environment or only a computational one. [next] What this means is that if is
trigger is selected, any object with a collider thrown at this object will fly straight through it but a collision will
still be recognized by the engine. Let’s take a look at an example of this in action.
Demo: Use prebuilt scene CollidersDemo from repo CourseMaterial to demonstrate and play with the
collider components.
Slide 08: Rigidbody
Slide Goal: Introduce the rigidbody component
Key Idea: Gives an object physical qualities and allows for physics operations to be performed on it
The rigidbody component allows a gameObject to simulate physics. [next] It handles all of the physics
calculations by default while allowing us to program physics behaviours. This component exposes a number of
interesting values that we can play with in order to get different results with different gameObjects:
- Mass: allows us to specify an arbitrary value for the gameObject’s mass. The higher the number the
harder it is to move around with forces and contact from other rigid bodies.
- Drag: allows us to specify a value that acts as a resistance to acceleration. The higher the value, the
faster an object will decelerate when moving.
- Angular drag: not very often used in simple physics but controls the deceleration of rotational force
or torque.
- Use gravity: when selected, will constantly simulate the force of gravity and move the object down
until it hits another gameObject with a collider component.
Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

-

The last value worth looking at is the toggle Is Kinematic: if selected, this will ignore all physics
calculations. This may seem counter-intuitive for a component that simulates physics, however in
certain cases, we may want to have a rigidbody to code against but without any physics simulation
happening.

Once again let’s take a look at an example we have created for you.
Demo: Use prebuilt scene RigidBodyDemo from repo CourseMaterial to demonstrate and play with
the Rigidbody component.
Slide 09: Camera
Slide Goal: Introduce the camera component
Key Idea: Captures and displays everything within a projection box and field of view
[next] The camera component creates a display that allows the player to view the game world from. [next]
This component has many values that we can play with in order to modify what is displayed and how things
are displayed, such as the field of view, which allows us to create a kind of fish eye effect or the projection
type which allows us to choose between a perspective 3D view or a orthographic flat view. In most cases, we
will keep all of the values in their default settings. Without a camera component attached to a game Object in
the scene, the player will only see a black screen.
Slide 10: Light
Slide Goal: Introduce the light component
Key Idea: Illuminates area around an object
The light component creates a light source at the gameObject’s origin, allowing objects hit by the light to be
rendered accordingly. [next] Without a light, objects will not be rendered and the player will not be able to
see things in the 3D world. There are 3 types of light sources one can choose from:
- [next] Directional light: acts like the sun where the light has an infinite reach at a particular angle. The
angle is used to calculate shadows and orientation at which the light hits an object. There is generally
one directional light in all outdoor scenes.
- [next] Spot light: similarly to the directional light, this light source has a direction in which it projects
its light however, it also has a specific range and radius. This are generally used by light sources such
as light post or any other small light that has a specific direction and range.
- [next] Point light: has no direction and projects light in all directions. This light sources acts like a
sphere of light with a controllable radius. These are often used for small light sources with no
particular direction to them such as torches or fire sources.
Aside from the type of light source, we can play with a number of other values:
- Color: controls the color of the light and ultimately how the lighting will affect the tint of an object.
This is useful for getting a nice sunset color or lighting from a colored neon light.
- Intensity: controls how strong the light is. The higher the value, the more burn we get from the light.
Generally we want to keep this value relatively low in order to get a more realistic lighting scenario
- Shadow type: controls whether this light source should create shadows and how.
Slide 11: Audio Source
Slide Goal: Introduce the audio source component
Key Idea: Controls the playing of sound clips
[next] The audio source component allows a sound clip to be played with the gameObject as its source. This
component gives us a lot of control over when and how to play a sound. As you can see there are a lot of
values we can modify and we will go into more detail during lessons more specific to sound but there are a
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few important ones to look at now:
- [next] Audio clip: is the specific sound clip we want the source to play. This can be changed, played
and stopped in code.
- [next] Play on Awake: causes the sound clip to immediately play when the scene starts. Useful for
background music or ambient sound
- [next] Loop: allows the sound clip to repeatedly play on a loop. Again used for sound like background
music or ambient noise.
- [next] Spatial blend: controls whether the sound should be a 3D sound or a 2D sound. 3D sounds will
be specifically located within the 3D space and will only be heard if the player is within range of the
gameObject holding the component. On the other hand, 2D sound will render the sound audible
wherever the player is in the scene.
Slide 12: Video Time!
Presented VIdeos:
1. Unity Components Official Tutorial
2. Unity Prefabs Official Tutorial
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Game Engineering 03

Terraforming in Unity: Creating Terrain and Landscaping

Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Monday 24 July 9:15PM
1 hour (including 40 minutes of work time for the students to create a terrain of their own)
Instructor Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Student Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Unity3D

Objectives:
1. Explore the power of Terrain creation in Unity3D
Vocabulary:
Billboard, Height Map
Web Resources:
Creating and Editing Terrain
Height Tools
Terrain Textures
Trees
Grass and Other Detail
Terrain Settings
Procedure:
Refers to “Skins 5.0 | Game Engineering 03 |Terraforming in Unity.slides”
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Slide 02: What is a Terrain Object?
Slide Goal: Briefly explain what a terrain object is and explain the concept of height maps
Key Idea: Extremely optimised system for creating and rendering a terrain and its elements
Unity has created a system to help build beautiful and optimized landscapes. Unity’s terrain system relies
heavily on one concept: [next] the use of height maps to generate topology. Using the tools provided by Unity,
we can dynamically alter the height map of a terrain plane in order to create this beautiful landscape entirely
in-engine. Moreover, the terrain holds all of the tree objects, grass objects and terrain textures. [next] All of
these are compressed into a single object called a terrain object. This object controls many optimizing features
such as [next] controlling the resolution of the texture dynamically based on the distance from the camera.
[next] It does the same thing with trees and grass, dynamically making small objects visible and invisible based
on how far the player is from them and changing larger objects into flat planes from a distance (called
billboarding). [next] In short, the terrain object allows for high quality as well high performance.
[Suggest that the students follow along in editor]
Much like any other 3D object in Unity, we can create a terrain object by selecting the Create button in the
hierarchy (or right clicking anywhere in the hierarchy and selecting create) and choosing 3D objects > Terrain.
Slide 03: Height Tools
Slide Goal: Explore the various tools used for sculpting the terrain
Key Idea: The height tools allow for the manipulation of topology
[next] In order to modify the terrain topology, Unity has provided us with painting-like height tools. There are
3 options to the height tools:
- [next] Raise/Lower: allows us to simply use the mouse to paint height to the terrain. Holding shift
lowers the topology.
- [next] Paint Height: allows us to paint the selected topology to a specific height. Holding shift lets us
sample the target height before applying it.
- [next] Smooth Height: allows us to smooth the topology of the selected area so as to not have thin,
high peaks.
All of these options share a number of features mainly:
- [next] The selection of brushes. Unity offers a number of brush types that we can use to get the
desired topology. From simple circles to more elaborate shapes and textures there is over a dozen
different brushes to choose from.
- [next] Brush size: controls how large the brush is
- [next] Opacity: controls how strongly each press affects the topology
Slide 04: Terrain Textures
Slide Goal: Explain how terrain textures work
Key Idea: Textures are painted in layers to allow for a layered terrain look
Similarly, we have access to texture painting tools for the terrain where we can not only paint texture directly
on the terrain in-editor, but we can also layer multiple textures on top of the other. Before we can start
texturing anything though, we have to create our materials to use as textures. [next] This is done by selecting
the edit textures button. Once we have at least one texture created, we can paint the selected texture on the
terrain in the same way we did for the height painting.
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Slide 05: Adding Trees
Slide Goal: Explain how painting on trees works and why it’s a good thing to add trees this way
The terrain system also allows us to select meshes as trees and paint them into the landscape. Similarly to the
textures, [next] we have to select the button edit trees and select the mesh we want to use as a tree. Once
that is done, and the tree is selected, we can paint trees into the selected area. Doing this, we have a number
of values to play with:
- [next] Tree density: controls how close trees can be when painted onto the terrain
- [next] Tree Height: allows us to control the height of the trees. We can set it to be random within a
[next] range in order to get non-uniform trees.
- [next] Lock Width to Height: allows us to determine whether we want the width to be proportional to
the height.
- [next] Color variation: allows us to have slight variations in color between trees in order to produce
more varied trees
Holding shift will erase all trees within the brush area while hitting CTRL will erase only trees of the selected
type.
Slide 06: Grass and Other Objects
Slide Goal: Explain how to paint on grass and other objects
Similarly to painting trees to the terrain, we can paint grass and other objects as well. If we want to paint
grass, we need to have a grass texture to use. This is a texture that should have transparency so as to only
render the grass itself. Grass objects can have a wind effect added to them through the options in the terrain
settings in order to get a more dynamic terrain.
On the other hand, we can also add detail meshes to the terrain, much like we did with trees. This would be
used for objects like rocks or other static objects found within the environment.
Slide 07: Terrain Settings
Slide Goal: Go over some of the key terrain settings
The terrain system gives us access to many values that we can tweak. However, for the most part, the settings
are fine as they are. There are a few that should be modified for each situation:
- [next] Wind Settings for Grass: These 4 settings allow us to modify how much wind affects the grass
as well as how it reacts to it. Speed controls the movement speed due to wind. The higher the value
the stronger the wind. Size affects the size of the “ripples” that are created by the wind effect.
Bending controls how much the grass bends with the wind. Grass tint controls the overall tint applied
to the grass.
- [next] Resolution settings: control various settings for the height map itself. The key values we will
want to play with are the Terrain width, length and height. These values scale the terrain and by
default, the terrain generated is HUGE. It is good practice to import an object that can be used to give
the scene scale (such as a character) in order to see what size we want to make the terrain.Any other
settings below these will reset the terrain so it is important to set those before creating the
landscape. In general though, those settings should be kept to default.
Slide 08: Brief!!!
Exercise: Have the students create a simple quick environment with stock meshes and textures.
Enforce a resolution constraint depending on time.
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Game Engineering 04

User Interface: Working with Unity3D UI Design Tools
Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Monday 24 July 10:15AM
1 hour (followed by 1 hour of work time for the students to create a responsive UI themselves)
Instructor Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Student Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Unity3D
Objectives:
1. Explore the different UI tools available
2. Explain the proper use of UI anchors and Canvas Scalar for responsive UI
Vocabulary:
Non-Diegetic UI, Diegetic UI, Canvas, Panel, Rect Transform, Anchors and Anchor Presets, Horizontal and
Vertical Layout Groups, Canvas Group
Web Resources:
Designing UI for Multiple Resolutions
Rect Transform and Anchors - Unity Dev Team

Procedure:
Refers to “Skins 5.0 | Game Engineering 04 |User Interface.slides”
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Slide 02: User Interface?
Slide Goal: Describe the purpose of a GUI
A graphic user interface or GUI is one of the means given to the player in order to be able to communicate
with the virtual game world and vice versa. This is generally composed of a collection of elements, each
providing various information to the player about the game or allowing the player to provide information to
the game.
Slide 03: Non-Diegetic UI
Slide Goal: Describe what Non-diegetic UI is
The most common type of UI is the non-diegetic UI. This type of UI exists outside of the game world where
only the player can see. Often a canvas of 2D elements layered on top of the camera, this is the general go to
kind of UI to make. Since the purpose of UI is to give visual information to the player, simply throwing text,
sliders and images on top of the screen is the simplest design choice. We can look at an example in Divinity:
Original Sin. This is a strategy game so the player requires a lot of information. With that in mind, the
designers wanted the player to have easy, intuitive access to this information so they created different 2D
elements for this.
- [next] These icons show all of the information the player needs to know about his battle units. Mainly
their health and their status effects
- [next] Displays the turn order queue for which character goes next.
- [next] Displays the current character
- [next] Selection of available skills and/or items
- [next] Battle log summarizing actions
- [next] Minimap demonstrating the area top down with enemy and ally units marked. Also contains
multiple buttons for different purposes.
Slide 04: Diegetic UI
Slide Goals: Describe what Diegetic UI is
Another type of UI growing in popularity recently is the Diegetic UI. With this type of UI design, elements exist
within the actual game world and are not simply 2D elements pasted on top of the camera. This type involves
more design in order for the player to readily understand each element but if successful, creates a more
emergent experience. One of the more successful examples of this is Dead Space. Dead Space doesn’t have a
single element of Non-Diegetic UI. All elements are part of the game world.
- [next] This tube represents the player’s health gauge
- [next] This radial gadget represents how much statsis power remains available to the player (a
mechanic to freeze an object or enemy)
- [next] This counter attached to his suit represents how much oxygen is left before the player starts to
suffocate.
- [next] This counter attached to the gun represents the number of bullets left before the player needs
to reload.
All of these elements are strategically designed in order to present the information in a way that is as easily
understandable as Non-diegetic UI while at the same time respecting the level of immersion needed for this
type of horror shooter.
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Slide 05: Transition Slide
Slide 06: The Canvas
Slide Goal: Describe the purpose and function of the Canvas in Unity
Key Idea: Invisible, scalable holder for all UI elements with a specific draw order for its children
The way Unity UI functions, is by placing all elements inside a Canvas. This canvas is an invisible plane that, in
general, is projected directly on the camera. All UI elements within must be a child (or child of a child, etc) of
the canvas. Unlike the hierarchy, the order for the elements is super important. Since UI elements are mainly
2D, they can be layered one on top of the other and the higher the element is within the canvas, the farther it
is in back.
Let’s look at an example:
- [next] Here we have a canvas with both an image and a text element. The text is printed on top of the
image because the image is above the text in the hierarchy.
- [next] However, if we were to switch their positions, then the opposite would become true.
It makes it easier to think of the order in the hierarchy represents the order in which the objects are displayed.
Think like painting, the first element painted will be overlayed with the subsequent ones.
Slide 07: Rect Transform and Anchors
Slide Goal: Introduce the Rect Transform UI component and emphasis the proper use of anchors for
responsive UI design.
Key Idea: Anchors allow for UI Elements to position themselves proportionally regardless of screen
size/resolution.
Aside from the order in which we place our elements within the hierarchy, there is something else we need to
consider when creating UI elements: their Anchors. An element’s anchor determines how it should react if and
when we change the screen resolution. It is good practice to create responsive UIs. What this means is that
the UI will still be functional regardless of what the screen resolution is. This is done by specifying what kind of
anchor we want the element to have and where it is located. [next] The details for this is located in the Rect
Transform component, a component that comes by default on all UI elements.
The key information in this component, are the positions and dimensions as well as the anchors. All of these
values are used to determine where a UI element will be on the canvas relative to its parent element (as long
as the parent also has a rect transform). It’s good practice to set the anchors by using Unity’s presets and then
tweaking afterwards. Unity’s preset anchor settings can be found by clicking on the [next] anchor presets
button. This will open up a small extended window where we have 20 or so choices. [next] Moreover, we can
hold shift while in this selection window and we can set the anchor AND its pivot. The pivot determines where
the element will scale or rotate from. Consider it the element’s origin. [next] Similarly, we can hold ALT in
order to get options for instant repositioning and resizing of the element based on the anchor preset. These
are all extremely useful ways of getting the UI element to react exactly the way you want upon changing the
size of the game screen.
Slide 08: Video Time!
Presented Video:
Rect Transform and Anchors - Unity Dev Team
Slide 09: Transition Slide
[consider running through each UI element live with them instead of going through the slides]
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Slide 10: Panels
Slide Goal: Introduce the Panel UI element
Key Idea: Panels act like group parents for separating the UI into sections
Panels are the UI equivalent to empty GameObjects. [next] They allow us to group elements together as their
children. This is especially useful for areas of UI that have similar purposes that way, they can be all turned on
and off together for example. You’ll notice that unlike the empty gameObject, [next] it comes with a
component already attached: the Image script. It also already has a default sprite attached to it: Background. I
generally use panels simply for grouping of elements [next] so I remove or disable the Image so as to have an
invisible panel.
Slide 11: Image and Text
Slide Goal: Introduces the simple UI elements for Text and for Images
Key Idea: Simple UI elements for the sole purpose of displaying information to the user
There are 2 other simple UI elements: The image and the text. Both of these elements are frequently used
throughout UI design in order to give the player specific information. [next] The image element is very similar
to the panel as it uses the Image script component. [next] However, unlike the panel, by default it doesn’t
have a sprite selected. In this example we selected the key sprite to use. By default, if we modify the rect
transform size, the image inside will stretch to fill it, [next] but we can set it to preserve the image’s aspect
ratio by selecting the toggle for it.
[next] On the other hand, the text element uses the Text component. [next] This component allows us to
modify the text displayed in the UI using the Text box. [next] We also have the generic text styling options
similar to all other text editing software (text font, size, line spacing etc) [next] and we can also edit the text’s
horizontal and vertical alignment as well as other alignment options.
Slide 12: Transition Slide
Slide 13: Button
Slide Goal: Introduces the more complex Button UI element
Key Idea: Combines the image and text UI elements while adding the ability to press on it for a
function to be called.
Buttons allow players to interact with them in order to perform specific tasks. [next] In Unity, they exist as a
button object with a child text object. This allows us to add text to the button if desired, although we can
remove the text object to have a simple button. [next] At its base, the button element, is simply an image with
added functionality. [next] As we can see, the button has an Image component giving us full control on how it
displays. [next] However, the important component to note is the Button Script. With this component, we can
control what happens to the button when we interact with the button in different ways (hover, pressed, etc).
[next] These transitions can be simple color tints, changing of sprites or even full animations. Even more
important, we can give a button a task to perform when the player clicks it. [next] This is done by interacting
with the lower element and adding functions from specific scripts. A button can have multiple tasks to run on
a single click.
Slide 14: Slider
Slide Goal: Introduces the more complex Slider UI Element
Key Idea: Versatile UI tool for controlling/demonstrating a value between a max and a min. Used for
health bars, EXP bars, progression bars, option parameter setters, etc.
The slider is a more complex UI element that we can use to display or control a value between a max and a
min. These are generally used for elements such as HP/MP/EXP bars, progression bars, and of course setting
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sliders inside options menus. [next] Similarly to the Button element, the slider is made up of a number of
separate elements. It is made up of 3 images and one parent with the slider script. How these 3 images work
together is fairly simple:
-

[next] Background: is the image that is displayed behind the fill area and handle. This can be any
image
[next] Fill Area and Fill: the fill area represents the area that the slider bar can fill. Similarly, the fill is
an image within this fill area that can be transitioned from one value to another.
[next] Handle slide area and Handle: the handle slide area represents the area that the handle can
move within. The handle itself is just an image element.

All of these images though don’t do anything without the slider object holding the slider script. This script
controls the functionality of the slider and transforms these 3 separate elements into one system of elements.
[next] Similarly to the button, we can control the transition of the slider if the user is interacting with it. This
will affect the handle image and not the others. [next] This component also allows us to control the direction
of the slider (left - right, right - left, top - bottom, bottom - top). We also have the min/max values and the
current value which control where the slider handle should rest. Finally, it’s nice to be able to slide a handle
around but without linking some kind of function to it, all it does is show us an arbitrary range. [next] Much
like the button, we can attach a task to the slider that it should perform every time the slider is moved. This
allows us to link the value of the slider to other settings such as master volume, graphics quality, among any
other function we can think of.
Slide 15: Brief!!!
Exercise: Have students create a simple UI that could be used in the game. Enforce responsive design
so the UI doesn’t break on multiple different screen resolutions.
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Game Engineering 05

Animations and Mecanim: Working with Movement and
Transitions
Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Monday 24 July 1:30PM
- 1 hour lecture
- 30 minute brief exercise
- 1 hour and 50 minutes of work time to create object animations and animation trees
Instructor Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Student Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Unity3D
Objectives:
1. Introduce how to create animations within Unity3D engine
2. Explore Unity’s complex but robust animation system: Mecanim
Vocabulary:
Keyframes, animator controller, Mecanim, state machine
Web Resources:
The Animation View - Unity Dev Team
Animate Anything with Mecanim - Unity Live Session
Unity Documentation on Mecanim Animation System
Procedure:
Refers to “Skins 5.0 | Game Engineering 05 |Animations and Mecanim.slides”
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Slide 02: What is Mecanim?
Slide Goal: Give a conceptual overview of what mecanim is.
Key Idea: using concepts from AI, Mecanim simplifies and interpolates animation transitions
Unity has a very sophisticated and robust system that handles everything related to animations. This system is
called Mecanim. Mecanim, at its core, controls how and when animations should transition to other
animations. [next] Let’s take an example of a character. [next] We want to have a character performing the
idle animation when no player input is given but when the player pushes on the left stick, [next] the character
should start walking and therefore should play the walk animation. Similarly, if the player lets go of the left
stick, [next] the character should gently go back to the idle animation. Mecanim handles all of this with very
little programming involved. [next] In truth, the entire animation tree (or better known as state machine) can
be designed and created with absolutely no programming what so ever.
Slide 03: Animator
Slide Goal: Introduce the animator controller and its purpose
Key Idea: Controls all animation states and transitions for specific actors
Mecanim doesn’t run on all objects all the time, that would be extremely unoptimized. Only objects with an
Animator component are run by the Mecanim system. This component is mainly used as a controller for
mecanim but there are a few values that we can play with. [next] The only really important value is the
Controller. The controller is an asset that you can create in the project view, [next] however it is also
automatically created for an object when it is animated inside of Unity. The controller holds the animation
tree information so objects with different controllers will have different state machines for Mecanim to use.

Slide 04: The Animator Window (States)
Slide Goal: Introduce the Animator window and how to create animation states and go over their
properties
Key Idea: States determine which animation should be playing out under specific conditions
The animator window allows us to create this animation tree however, it consists of a number of moving
parts. The most important part is the state machine. The state machine controls the flow of animations. [next]
Each animation is considered a state and each state can transition to other states we select. Another thing to
note, is that we need to identify a default animation for the state machine to start in. This is the orange state.
In other words, the game will start with the object in that state.
In this example, we have a state machine for a character that can perform 4 simple actions: walk, run, crawl,
and jump. We want the character to start in the Idle state so we select that one to be default. From the Idle
state, one can perform any of the simple actions, however, each action leads to other possibilities as well:
- The walk can transition to a jump or fall, both of which are different from the idle jump and fall.
- The run can also transition to a distinct jump or fall
- The crawl can transition to the walk or run, or transition back to the idle
- Every jump can transition to the fall, however, unlike most other transitions, the fall cannot transition
back to the jump. This is because we don’t want to jump in mid air so we want the character to go
back to the ground and return to its previous ground state (either idle, walking or running)
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Slide 05: The Animator Window (Transitions)
Slide Goal: Introduce State Transitions and go over their properties
Key Idea: Transitions control how and when a state should be changed
By selecting any of the arrows in the previous image (which represent transitions), we can manage that
particular transition. We have a number of options we can play with here.
- [next] First we can toggle Has Exit Time on and off. What this means is that, if on, the transition will
wait for the current animation to finish before transitioning to the next. Some animations (especially
looping one) we don’t want to wait for the end. We want the transition to interrupt the animation.
This is how
- [next] Inside the settings we have a few options. The main ones to understand are Exit Time and
Transition Duration. Mecanim interpolates the transition between two animations and we can
control how quickly it interpolates. This is the transition duration. Similarly, the exit time is how much
of the second animation we want to play after the transition. Both of these values are between 0 and
1 (think of it as a percentage) and the transition duration will overlap the first animation with the
second animation for the transition duration percentage of the second animation.
It may be very difficult to understand this with just these values so Unity gave us a graphic representation for
these values. [next] The timeline below represents the transition based off of these values. If you are more
comfortable working visually, you can actually change these values in this timeline as well by simply sliding
each element.
[next] Lastly, we have the bread and butter of transitions: their conditions. Most transitions will require a
specific condition in order to trigger. By creating parameters (which we will go into details next) we can dictate
the conditions in which the transition will be triggered. Note you can have a transition with no condition. In
this case, the first animation will play once and then transition to the next. In order for this to work, Has Exit
Time needs to be toggled on.
Slide 06: The Animator Window (Parameters)
Slide Goal: Introduce animator parameters and go over each type and how they work
Key Idea: Animator parameters feed into transitions by acting as the conditions
Parameters allow us to create conditions for our transitions. However, these parameters can only be modified
in code. We do however create them within the animator interface and then use them inside the transition
inspector. On the left of the state machine, there is a window specifically for that purpose. By clicking on the
small plus icon, we can create one of 4 different types of parameters, all of which have different purposes:
- [next] Int: is a whole number such as 1, 12, or 25 436 for example. These are generally used when
you want to count how many times something has happened.
- [next] Float: is a number with floating points such as 2.4, or 256.398 for example. These are generally
used to keep track of speed or time for example.
- [next] Bool: is used to check whether something is true or false, on or off. This is generally used to
check if something is still true, such as “am I still in the air” or “am I still crawling”.
- [next] Trigger: is used to call a transition instantly. This is generally used for calling animations that
should just play once, often triggered directly by player input. Examples of these are jumping,
attacking, recoiling from an attack, etc.
Slide 07: Transition Slide
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Slide 08: The Animation Window
Slide Goal: Identify the various elements on the Animation Window
Key Idea: Looking at Key frames, timeline, keying components and animation curves.
The animation window inside of Unity allows us to create and modify animations directly inside the Unity
editor. [next] The main idea behind this view is to create time points for various components for a selected
object and its children. These time points (better known as keyframes) will register the state of a particular
value in a component and the animator (covered later) will transition the object between those 2 states within
the time between them.
[next] The default view in the animation window is the dopesheet. This allows us to create keyframes within
the timeline but that’s all the information we get. [next] We can change the view to the curves view which will
not only show us the key frames but will also show us the interpolation curves between them. [next] This view
gives us great control over the transition between keyframes.

Slide 09: Video Time!
Presented Videos:
1. Animate Anything with Mecanim - Unity Live Session
- Stop at 35:40
2. The Animation View - Unity Dev Team
Slide 10: Brief!!!
Exercise: Have the students create a gate opening (or contextual object animation related to the
project) animation and animator (simple looping or triggered through code). Also have the students
create a character animator using the pre-built parameters from the “CustomPlayer” script imported
from the Animations and Mecanim Package in Course Material. Use the AnimatorTesting scene from
the package to test.
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Game Engineering 06

Intro to Game Programming
Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday 25 July 9:15AM
30 minutes
Instructor Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Student Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Unity3D

Objectives:
1. Introduce the basic concepts of programming
2. Introduce Start and Update Unity functions
3. Explore variables
4. Explore functions
5. Explore simple Conditional Logic
Vocabulary:
Variables, functions, conditional logic
Web Resources:
N/A
Procedure:
Refers to “Skins 5.0 | Game Engineering 06 |Intro to Game Programming.slides”
Notes:
Live coding alongside slides. The live coding should be split screen with the slides.
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Slide 02: How a Computer Understands Code
Computers have greatly evolved since their creation in the mid 40s but they are by no means smart - at least
not yet anyways. They do not understand human language, so how is it that we can program complex tasks
using programming languages that resemble the spoken word? Well that’s thanks to complex software called
“compilers”. Compilers are developed by the software engineers who created a new programming language.
The compiler understands and translates the programming language (which is high level, understandable by
us human beings) into machine language (low level based off of electrical currents and 1s and 0s that the
computer can use).
Slide 03: Using and Writing Scripts for Unity
Unity allows us to program using C# or JavaScript. However we will be using C# only in this workshop. [next]
When we create a new C# script, this script becomes available as a new component that we can add to any
gameObject in the scene. [next] F or the most part, when we create a script, if we want to run it, we need to
attach it to a gameObject in the scene and then it will run when we hit play in Unity. Let’s look at that. If we go
into Unity and add a new C# script into our Assets folder by right clicking in the project view and selecting
Create > C# script and name it something recognizable (let’s call it SkinsTestScript), we can then go and add it
to any gameObject in the scene. Select an object and hit the button Add Component, then type in the name of
the script. Unity recognizes the new script as a potential new component. However, this script doesn’t do
anything at the moment. We’ll get there.
Slide 04: Getting Code to Run in Unity
Unity has created a handful of ways for us to trigger code without us triggering them manually. These are part
of Unity’s pre-built scripting modules. By creating functions with very specific names (don’t worry we will
cover exactly what a function is in a minute) we can trigger lines of code at different times. Let’s look at two
such examples:
-

[next] void Start() allows us to run whatever is within once and only once when the game
starts.
[next] void Update() allows us to run whatever is within it continuously every frame when the game is
active.

Let’s look at one in action:
void Start()
{
Debug.Log(“Hello World”);
}
In C#, we always need to end a line of code with a semicolon. This tells the compiler that this is the end of a
particular line of code. Each line of code acts as a specific task we want the script to run. In this case we are
asking the script to print out the words Hello World on the console. Save your script and let’s try this out and
see what happens. Go back to Unity and make sure your script is attached to a gameObject in the scene. Hit
the play button and if you open the Console window you will see the words Hello World (notice it only prints it
once). Now let’s see what happens if were to do the exact same thing using the Update function instead
void Update()
{
Debug.Log(“Hello World”);
}
Save your script and let’s run that again. If you open the Console, you should see it flooded with Hello World.
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Slide 05: Variables
It’s nice that we can print out some words, but what if we wanted to do something more complex. Let’s say
we want to add two numbers together. We can do that easily:
Debug.Log(1+2);
Since we want to see the result IN THE CONSOLE, we need to put it inside the Debug.Log() function. Save your
code and let’s try it out. Unlike the Hello World, it no longer prints out what is inside the brackets verbatim,
instead it performs the mathematical operation and prints out the result. That’s nice but what if we wanted to
perform a more complicated mathematical operation in multiple steps? We would need a way to store the
results of each step in memory. That’s where variables come in.
Variables store different types of data in memory in order to be used in multiple places in a script. [next] We
create a variable by first telling the compiler what data type it is. There are many different data types but for
now, let’s just look at the core primitive ones.
-

Int: a whole number positive or negative
Float: a number with as many decimal points as we want
Char: a single letter or symbol

Once we have decided on what the data type what want is, we need to give our variable a name. [next] This
name acts as a pointer for the computer to be able to find the variable in memory. Names need to be distinct,
in other words, we can’t have 2 variables with the same name. If we do, the compiler will give us an error
because we are trying to point to the same place in memory for 2 different variables. Furthermore, there are a
few rules to follow when naming your variables
-

Cannot start with a number
Cannot contain any symbols except underscore
Cannot contain spaces

The last thing a variable needs is a value. [next] Once we have all 3, we can fetch it from memory at any time
to use it in any context. Let’s look at an example by splitting up the calculation for an average of 3 numbers
into 2 parts.

int number1 = 3;
int number2 = 6;
int number3 = 11;
int sum = number1 + number2 + number3;
float average = sum/3f;
Debug.Log(result);
We can see a few things here:
- We can store the result of calculations in a variable.
- We can use a variable as if it was its value. Since number1 has a value of 3, we can use the
variable name in the calculation directly.
- Lastly we can print out the value of a variable
Note that unlike the ints, when we are working with a float, we need to add the letter f at the end of any
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number. This tells the compiler we we to have decimal points in the value for the variable. If we were to not
put the f next to 3, then our result would be rounded down.
So let’s go back to Unity and test it.
There is one more thing about variables that is very interesting in Unity. We can make variables visible in the
inspector so we can change them on the fly. Let’s rework our average example so it works for that.
public int number1 = 3;
public int number2 = 6;
public int number3 = 11;
void Update()
{
int sum = number1 + number2 + number3;
float average = sum / 3f;
Debug.Log(average);
}
By adding the keyword public and putting them outside of our Update or Start functions, Unity recognizes
these values as visible and will make them available for editing directly inside the Inspector. Save your code
and let’s go take a look. If you go to the gameObject holding the script, we should now see that there are 3
new values within the inspector. With this, we can change those values at any time without needing to go
back into the script. Hit play and try fiddling with the values while it runs.
Something important to notice before we move on: if we change values in the inspector like this during play
mode, as soon as we hit play to stop, the numbers will revert. In other words, make sure not to make changes
in the inspector during play mode that you want to keep.
Slide 06: Functions
Let’s say, for whatever reason, we wanted to find the sum of 3 different averages, we could rewrite the code
we already wrote 3 times with different values but that would get messy very quickly. Functions allow us to
group lines of code together and then call it anywhere throughout the script. The general syntax for creating a
function should look familiar to you since you have been using functions already.
datatype FunctionName()
{
//some code here
}
[next] Much like variables, we need to define the data type that the function can return. This means that a
function can not only perform specific tasks, but it can also return a value of any type. We will look at a
specific example of that in a second. However, if we take a look at the functions we have previously used, Start
and Update, they do not return any data type, they just perform some tasks. When we want to create a
function for just tasks performance without any return of data, we specify it as void.
[next] Again, much like a variable, a function also needs a distinct name. However, its name is not the only
part of its identifier. [next] Functions also have parameter list that allow us to pass specific values into the
function in order to perform the same tasks under different contexts. The brackets next to the function name
is the parameter list. There can be as few as no parameters to as many parameters as we want. Parameters
need a data type and a name, much like a normal variable, however, we don’t specify a value, that is done
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when we call the function. Parameters as separated by a comma and if we don’t want to have any parameters,
we still need brackets with nothing between them. Let’s look at a specific example.

float CalculateAverageOfThree(float n1, float n2, float n3)
{
return (n1+n2+n3) / 3f;
}
Let’s break this function apart:
- The float at the start specifies that we want to pull a result out of this function. We know 2 things
from this, 1: we need to have a line that returns a value. This is done by using the keyword return
at the start of a line and then writing the value we want to return next to it. In this example we want
to return the result from the average calculation. 2: we know that we want to return a value
specifically of the data type float. Any other data type we try to return will give us a compile error.
- The name of the function is CalculateAverageOfThree() and it has 3 parameters: n1, n2, n3.
We can tell what data types those parameters are by looking at the data type that precedes the
parameter name.
A function doesn’t do anything until it is called. By creating a function, we are setting up a group of code to be
performed but we need to call it in order to perform the tasks under the desired contexts. Let’s call the
function inside our Start() function so we can see something happen
void Start()
{
Debug.Log(CalculateAverageOfThree(number1, number2, number3));
}
As you can see, we can use an actual function as a variable if it returns a value. Since this function returns a
value of type float, we can simply throw it into the debug much like we did for a variable of type float. Now
let’s go one step further and use this function inside another function.
float CalculateSumOfThreeAverages(float n1, float n2, float n3, float
n4, float n5, float n6, float n7, float n8, float n9)
{
float average1 = CalculateAverageOfThree(n1, n2, n3);
float average2 = CalculateAverageOfThree(n4, n5, n6);
float average3 = CalculateAverageOfThree(n7, n8, n9);
return average1 + average2 + average3;
}
Here we are calling our calculateAverage() function 3 times to get the averages of three different sets
of data. We are storing each result in a variable and then adding those 3 variables together to get the sum of
the three. Once again though, creating the function doesn’t do anything unless we call it somewhere so let’s
call it in our Start function.
void Start()
{
Debug.Log(CalculateSumOfThreeAverages(number1, number2, number3,
number4, number5, number6, number7, number8, number9));
}
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Calling this one function now allows us to run 3 different average functions and get their sums and all we need
is a single line of code.
Slide 07: Conditional Logic
We now know how to store information and how to group tasks together in functions in order to create
repeatable modular chunks of code, however, maybe we want to call code only under certain conditions. We
do this using conditional logic. [next] Conditional logic uses if statements in order to see if a condition is met
if(thisIsTrue)
{
//do something
}
In order to create an if statement, we need to check if a condition is met. Generally, this is done by checking
the state of a boolean value. Booleans are another data type that holds one of 2 values: true or false. Like any
other variable, by making them public, we can see their value in the Unity inspector. Let’s look at an example

public bool IsThisThingOn;
You’ll notice, if we look at the inspector, that the bool comes out as a check box. If we check the box, then we
are setting the value to true. If the box is unchecked, then it is false. Let’s create a practical example of a
conditional statement using a simple boolean variable.

public bool convertToMetric;
public float degreesToConvert = 10f;
void Update()
{
if (convertToMetric == true)
{
Debug.Log(ConvertToCelcius(degreesToConvert));
}
else
{
Debug.Log(ConvertToFarenheit(degreesToConvert));
}
}
float ConvertToFarenheit(float degrees)
{
return (degrees * 9f / 5f) + 32f;
}
float ConvertToCelcius(float degrees)
{
return (degrees - 32f) * 5f / 9f;
}
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There are a few things to note here
- For one, when we are checking for a condition, we need to use the double = sign in order to compare
the left value to the right. In English, this line of code would read “if convertToMetric is equal to
true”.
- You’ll also notice something new right below the if statement. Any if statement can have an else
statement. Else statements allow us to perform something different when the if statement comes
out false. If we were to read this entire conditional logic in English, it would sound something like “if
convertToMetric is equal to true, convert the degreesToConvert into Celsius. Otherwise, convert the
degreesToConvert into Farenheit”. An else statement can only be used after an if statement but
an if statement can be used without an else statement after it.
Now by changing the value of ConvertToMetric in the inspector, we can toggle between a Celsius conversion
and a Farenheit conversion.
Explain next split where Game Programming will rely on a basic understanding of programming concepts.
Starting after lunch
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GAME
SOUNDSCAPES
01
02
03
04
05
06

Intro to Sound Composition & Audacity
Importing Atmosphere Assets Into Unity
Exploring Point-n-Click Adventures
Types Of Soundtracks In Games
Recording Dialog & Creating Cinematic SFX In Audacity
Musical Experiments In Audacity

Game Soundscape 01:

Intro to Sound Composition & Audacity
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Thursday July 20, 2:00 PM
1 Hour
Instructor Prerequisites:
Computer with speakers
Student Prerequisites:
Audacity software installed on every machine
Equipment, Software Materials:
Audacity
Objectives:
1. Differentiate composing for linear mediums (film) and dynamic mediums (videogames)
2. Give examples of the many kinds of soundtracks within a videogame
3. Give an intro to the basic functions of Audacity
Vocabulary:
Sampling, Fade, Reverb, Waveform
WEB RESOURCES & BOOKS:
Procedure: see next page
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1.Introduction
Give a brief overview of what the course will be about.
Recording
● Usage of Zoom mics
● Finding / capturing ordinary sounds / ambiences
Sampling
● Locate the interesting bits in the sound clip
● Create small samples out of bigger sound clips
Remixing
● Using audio editing tools, change the nature of the sounds
● Give a new life and meaning out of the captured sounds
Integrating
● Learn the basics of sound integration in Unity
● Layer the different sounds together to create an original ambiance
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2. Introduction to Audacity
The basics of the Audacity software will be explained. Upload any number of soundfiles, ideally some
simple sound effects and/or music tracks.
1.

2.

3.

4.

Overview of the basic functions.
a. Importing a sound
b. Playback functions
Once the sound file is imported, experiment with the basic tools
a. Selection tool
b. Zoom in/out
c. Time shift tool
Learn the viewport basics
a. Sound track moving / resizing
b. Muting / soloing tracks
c. Adjusting the volume of individual tracks
d. Cutting and pasting tracks
Play with the effect tab options
a. Fade in/out
b. Reverse
c. Reverb
d. Phaser
e. Paulstrech
f. Silence / noise (under Generate tab)
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Game Soundscape 02:

Importing Atmosphere Assets into Unity
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday July 25, 1:30 PM
1 Hour
Instructor Prerequisites:
Unity
Student Prerequisites:
Unity
Equipment, Software Materials:
Objectives:
1. Learn the functions of the audiosource gameobject in Unity
2. Integrate basics sounds inside a template level
Vocabulary:
Audio Source, Audio Clip
WEB RESOURCES & BOOKS:
AudioSource in Unity documentation
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1.Audio Source
This course is dedicated to using the audio source, used to represent audio clips in a 3D space

First off, before creating an audio source, make sure the main camera in the scene
has an audio listener component.
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To create an audio source, head over:
GameObject > Audio > Audio Source
If the location of the source is to be
considered, you can then adjust its
location so that the gameObject is
centered at the right place.

The Audio Source has multiple functions.
Here the students will experiment with a
few of them.
AudioClip – The default AudioClip to play
Mute – Sets the volume to 0
Play On Awake – Whether the clip will be
played when the scene starts or wait to be
triggered
Priority – When multiple sources are
playing, Unity will prioritize the ones with
higher priority
Volume – Define the strength of the clip’s
sound, regardless of it’s radius
Spatial Blend – Define how much the
sound will be affected by the 3D space
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Game Soundscape 03:

Exploring Point-n-Click Adventures
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday July 25, 2:30 PM
1 Hour
Instructor Prerequisites:
Computer with speakers
Teacher Steam account
Student Prerequisites:
Equipment, Software Materials:
Objectives:
Play and analyse specific parts of classics in the genre
Vocabulary:
WEB RESOURCES & BOOKS:
1. Machinarium
2. Grim Fandango
3. Kentucky Route Zero
Procedure: see next page
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1.
●

●

●

Machinarium
Amanita Design – 2009
first scene (junkyard)
○
○ look at how point & click mechanics are introduced
○ point out how character development is also done at the same time
○ discuss scene composition, and how objectives are implicitly laid out
cutscene in-between
○ the cutscene is useful in multiple ways
○ used as a timelapse and also a way to link up two separated locations
○ discuss why cutscene are not always bad and should rather be seen as tools
second scene (city gates)
○ discuss puzzle design
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2.

Grim Fandango
LucasArts – 1998

●
●

●

intro cutscene
○ discuss how the game brings the themes and initial conflicts forward
first scene (office)
○ look at control scheme (keyboard-based)
○ discuss scene transition: between the office and Eva, there is a corridor acting as buffer
○ dialog system: exposition of the game’s context
second scene (city)
○ look at the use of scale: this scene combines large panorama with tight close-ups
○ talk to the clown: creative uses of dialog
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3.

Kentucky Route Zero
Cardboard Computer – 2012

●
●

first scene (gas station)
○ discuss art style, and magical realism direction
○ dialog: branch-less conversations
second scene(basement)
○ transition: new parts of the scenes are revealed through the black foreground
○ look at the use of silhouette contours to manage the player’s attention
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Game Soundscape 04:

Types of Soundtracks in Games
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 26, 10:30 AM
1 Hour
Instructor Prerequisites:
Computer with speakers
Student Prerequisites:
Audacity software installed on every machine
Equipment, Software Materials:
Audacity
Objectives:
1. Differentiate composing for linear mediums (film) and dynamic mediums (videogames)
2. Give examples of the many kinds of soundtracks within a videogame
3. Give an intro to the basic functions of Audacity
Vocabulary:
WEB RESOURCES & BOOKS:
1. Fez (link)
2. The Witness (link)
3. Braid (link)
4. Antichamber (link)
5. Shadow of the Colossus (link)
6. Half-Life 2 (link)
7. Super Mario World (link)
8. Red Dead Redemption (link)
9. Proteus (link)
10. Thumper (link)
Procedure: see next page
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Foley sounds
a) The Witness (link)
b) Fez (link)
Looping soundtrack
c) Braid (link)
d) Antichamber (link)
Cued soundtrack
e) Shadow of the Colossus (link)
f) Half-Life 2 (link)
Layered soundtrack
g) Super Mario World (link)
h) Red Dead Redemption (link)
Generative soundtrack
i) Proteus (link)
j) Thumper (link)
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Game Soundscape 05:

Recording Dialog and Creating Cinematic SFX in Audacity
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 26, 1:30 PM
1 Hour 30 Minutes
Instructor Prerequisites:
Student Prerequisites:
Equipment, Software Materials:
● Sound Editing software
○ Audacity
○ Audition
○ Premiere
● Photography equipment
○ Cellphone camera
○ DSLR camera
● Sound recording tools
○ Any wav recorder
○ Zoom mics
Objectives:
● Record sounds from the environment
○ Fragments of dialog
○ Specific noises
○ Ambient noise
○ etc.
● Imports the sounds into Audacity
● Modify the sounds with Audacity
Vocabulary:
WEB RESOURCES & BOOKS:
● TOP 10 : Field Recording & Soundscape (link)
● Soundscape & Sound Art resources (in French) (link) (link) (link)
● City Sonic Festival (link)
● LES VOISINS, Proximity Concerts (link)
● UBU Sound (link) (link)
● Pierre Schaeffer (link) (link)
● François Bayle (link)
● John Cage, Square Peg Round Hole (link)
● Samuel Thulin City Ditties (link)
Procedure: see next page

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

1. Activity
The goal of this course is to collect as many sounds as possible, import them in Audacity and then modify
them to create a soundscape.
1.

Students will go out recording any sounds of their choice
a. The sounds must ALL come from the same place
b. Take pictures of the sound locations
c. Aim for diversity; different sources, different lengths, different distances.

2.

Students will import the sounds into a sound-mixing software
a. They will need to filter out the most uninteresting ones
b. They will create a new bank of their selection of raw files

3.

Students will mix a 30-40 second sound composition evoking the aural and emotional ambience
of this place.
a. They will use Audacity’s effects to alter the nature of the sounds
b. The sounds will be layered onto each other in one single file

2.Specifications
● The chosen location has to be a specific place (not “the streets” or “the metro”)
●

All sounds used must be recorded at that place.
○ Students may modify and distort their recordings, but pre-recorded sound is prohibited
○ Students may be asked to submit original recordings

●

The sound composition must be an expression of the student’s sense of the place

●

The sound composition must have a beginning, middle, and end.
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Game Soundscape 06:

Musical Experiments in Audacity
Facilitator: Simon-Albert Boudreault

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Thursday July 27, 9:15 AM
1 Hour 30 Minutes
Instructor Prerequisites:
Student Prerequisites:
Equipment, Software Materials:
● Sound Editing software
○ Audacity
○ Audition
○ Premiere
● Photography equipment
○ Cellphone camera
○ DSLR camera
● Sound recording tools
○ Any wav recorder
○ Zoom mics
Objectives:
● Record sounds from the environment
○ Fragments of dialog
○ Specific noises
○ Ambient noise
○ etc.
● Imports the sounds into Audacity
● Modify the sounds with Audacity
Vocabulary:
WEB RESOURCES & BOOKS:
● TOP 10 : Field Recording & Soundscape (link)
● Soundscape & Sound Art resources (in French) (link) (link) (link)
● City Sonic Festival (link)
● LES VOISINS, Proximity Concerts (link)
● UBU Sound (link) (link)
● Pierre Schaeffer (link) (link)
● François Bayle (link)
● John Cage, Square Peg Round Hole (link)
● Samuel Thulin City Ditties (link)
Procedure: see next page
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[THIS COURSE IS A CONTINUATION OF GAME SOUNDSCAPE 03]
1. Activity
The goal of this course is to collect as many sounds as possible, import them in Audacity and then modify
them to create a soundscape.
1.

Students will go out recording any sounds of their choice
a. The sounds must ALL come from the same place
b. Take pictures of the sound locations
c. Aim for diversity; different sources, different lengths, different distances.

2.

Students will import the sounds into a sound-mixing software
a. They will need to filter out the most uninteresting ones
b. They will create a new bank of their selection of raw files

3.

Students will mix a 30-40 second sound composition evoking the aural and emotional ambience
of this place.
a. They will use Audacity’s effects to alter the nature of the sounds
b. The sounds will be layered onto each other in one single file

2.Specifications
● The chosen location has to be a specific place (not “the streets” or “the metro”)
●

All sounds used must be recorded at that place.
○ Students may modify and distort their recordings, but pre-recorded sound is prohibited
○ Students may be asked to submit original recordings

●

The sound composition must be an expression of the student’s sense of the place

●

The sound composition must have a beginning, middle, and end.
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GAME
PROGRAMMING
01
02
03
04
05

Programming Logic
Player Interaction & Movement
Singlestons & PRoper Game Structure
Inheritance & Polymorphism
Persistent Data

Game Programming 01

Programming Logic: Coding in C# for Unity3D

Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday 25 July 1:30PM
1 hour (followed by 1 hours of work time for the students to create scripts for interacting with UI and/or
Animator Controllers)
Instructor Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Student Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Unity3D
Objectives:
1. Introduce the concepts of Object Oriented Programming in C# for Unity
2. Walk the students through creating a script that interacts with user interface elements
3. Walk the students through creating a script that interacts with an animator controller
Vocabulary:
Variables, scope, visibility and exposure
Web Resources:
C# Classes
Unity Scripting API
Procedure:
Refers to “Skins 5.0 | Game Programming 01 |Programming Logic.slides”
Notes:
Live coding alongside slides. The live coding should be split screen with the slides.
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Slide 02: What is a Class?
Slide Goal: Reintroduce the three core elements that make up a class
Key Idea: Variables, Methods and Constructor
Classes are a key element in OOP programming. These make up the majority of the programing tasks within an
OOP project. [next]
Think of a class (also known as an object) as a custom component allowing you to identify its data and
behaviours. It is made up of 3 key elements: [next]
- Member fields (also known as class variables): These elements store data that can be accessed at any
level of the class. [next]
- Methods (also known as class functions): These are generally procedures with specific purposes that
give the object its functionality. [next]
- Constructor: Unique methods that allow an instance of the object to be created within other classes.
[next] These are unnecessary for classes in the context of Unity behaviours so we won’t go into much
detail on them for the time being.
Slide 03: Naming Conventions
Slide Goal: Enforce a naming convention for all code elements
Key Idea: camel-case for variables, pascal-case for functions and class names
In order to write understandable code, it is important to follow an established naming convention. It makes ut
easier for one to recognize elements upon quick inspection of the code. C# has an industry standard for the
naming of individual elements. There are 3 different types of elements covered under these conventions:
[next]
- Variable names: camel-case (thisIsCamelCase - first letter is lowercase and all other words are
separated by uppercases) [next]
- Function, method, class names: pascal-case (ThisIsPascalCase - first letter is uppercase and all other
words are separated by uppercases as well) [next]
- Constant variables: uppercase split by underscores (THIS_IS_A_CONSTANT)
Aside from the format the names should be written in, it is important to follow 3 simple rules as well: [next]
- Each name should be descriptive and understandable [next]
- Names should be unique to avoid confusion [next]
- Names must not start with numbers and cannot contain symbols aside from an underscore [next]
Slide 04: Variables
Slide Goal: Introduce commonly used data types
Key Idea: Int, float, char, string, bool
Variables store information in memory in order to be accessed, modified or retrieved throughout the class’s
methods. They consist of [next] a data type [next], name/identifier [next] and a value. [next]
Data Type: the data type tells the compiler what kind of data we are storing. There are a number of data types
that we can choose from in the C# language: [next]
- Boolean (bool): a binary value recognized as true or false. Used for conditional logic. [next]
- Integer (int): a simple integer value with no decimal places. Used in mathematical calculations. [next]
- Float (float): a number that can have as many decimal places. Used in mathematical calculations.
[next]
- Character (char): a single letter value. Used for text manipulations. [next]
- String (string): a collection of characters. Used for text manipulations and text display. [next]
- A class can be stored in a variable as well. The data type in this case is the class name. [next]
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The variable name acts as a pointer to the location in memory where the data for the variable is stored.
Without a name, the compiler won’t know where to store or retrieve the information. A good name should
always follow the rules stated in the Naming Conventions.
A variable doesn’t exist until it is declared. [next] The process of declaring a variable is simply done by setting
its data type and giving it a name:
bool canHandleInput;
[next] Once declared it will exist in memory but with no value attributed to it. In order to be able to use it, one
needs to initialize it with a value:
canHandleInput = true;
It is possible (and in a lot of cases good practice) to declare and initialize the variable all at once. [next] We do
this by concatenating the 2 steps into a single command:
bool canHandleInput = true;
Slide 05: Arrays and Lists
Slide Goal: Introduce the concept of arrays and Lists
Key Idea: Data structures used to hold multiple instances of the same data type
[next] Arrays and lists are data structures that allow us to group a number of same data type values together
in order to have an organized collection of similar data. [next] Elements inside an array are organized by
indexes, a numerical value determining their position within the collection.
Similarly to variables, Arrays must be declared and initialized before being used. Furthermore they can only
hold a predetermined number of values set upon initialization. Once initialized, the number of values cannot
be modified but the values themselves can: [next]
float[] playerScores = new float[9];
This declares an array of floats named “playerScores” and initializes it with 9 slots for values. The number of
slots is known as the length of the array. At this point, even though the array has been declared and initialized,
its values are set to their default values:
- int, float: 0
- bool: false
- char, string: “”
- All other data types: null
Therefore it is important to also populate the array once it has been declared and initialized. [next] The syntax
for doing so involves giving a value to the element at the specific numbered position within the array. We do
this by specifying the array index we want to access. The index specifies the location of the element within the
array and always starts at position 0:
playerScores[0] = 152.6f;
playerScores[1] = 24.6f;
…
playerScored[9] = 221.6f;
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In other words, indexes will always go from 0 until 1 below its length. In this example indexes go from 0 to 8.
Slide 06: Loops
Slide Goal: Introduce the idea of for loops and foreach loops
Key Idea: Allows for the simplification of writing tasks that need to be repeated many times before
completion
[next] Loops can be used to simplify repetitive tasks (such as populating an array) by repeating a specified
procedure until a condition is met. The most common type of loop is the for loop. [next] In a for loop, we
iterate through the specified procedure for a set number of times. We do this by [next] determining a starting
integer the loop keeps track of, [next] specifying a condition for which to check for in order to continue
iterating, [next] and then specifying a modification of the integer that is performed at the end of each
iterations.
for (int i = 0; i < playerScores.length; i++)
{
playerScores[i] = i * 100.0f;
}
Here we iterate through the array by starting our loop with an integer i at value 0. We then iterate until i is no
longer less than the length of the playerScores array, and at each iteration we add 1 to the value of i. [next]
Foreach loops are simplified for loops that [next] only work for iterating through a data structure (array, list,
etc). [next] It will iterate through every element inside the array until it hits the last one, then break out of the
loop afterwards:
foreach(float score in playerScores)
{
score = 0;
}
This can be read like “for each float, that we will call score, in playerScores” do something.
Here we specify what data type is within the array we are manipulating. Afterwards we give a temporary
name used for all elements within the array. This name (much like the integer used in the for loop) only exists
inside the loop context. Lastly, we specify which array we want to manipulate by using the keyword in and
specifying the array name.
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Slide 07: Conditional Logic
Slide Goal: Introduce the idea of booleans and if conditions
Key Idea: Almost all code relies on strong boolean logic determining whether something should
happen or not
Most code relies on strong boolean logic in order to determine when a procedure should be performed. We
call this conditional logic and do this by using if and else conditions. [next]
if(canHandleInput == false)
{
for (int i = 0; i < playerScores.length; i++)
{
playerScores[i] = i * 100.0f;
}
}
else
{
foreach(float score in playerScores)
{
score = 0;
}
}
In this example, we are checking to see if the condition inside of the if statement is met - is canHandleInput
false? If it is the compiler will move to the procedure inside the if statement and set the player score to 100
times its position within the array. If the condition is not met then the compiler will skip the procedures inside
the if statement and check if there is an else statement for it to run (not all ifs need an else). In our example
there is an else statement so it will run the procedure within, making all scores equal to 0.

Slide 08: Methods and Functions
Slide Goal: Introduce the concept of methods and functions
Key Idea: Every procedure/algorithm should be separated into its own unique function for reusability
Methods are what give classes their functionality. [next] Without them, classes just hold information (which
may sometimes be desired) but they won’t be able to do anything themselves. In order to create a method,
we need 3 things: [next] the data type that this function will return a value for, [next] a name for the function,
[next] and a collection of values (parameters) to pass to the functions:
void ThisIsAFunction(float floatParameter)
{
//do something fantastic
}
The first element we use is the data type that the function will return. In this case, the function does not
return anything so we specify void as our data type. Void is a keyword that can only be used to specify that a
function does not return anything, it is not an actual data type. Next we give it a name following the naming
conventions for methods and then we give it a collection of parameters. The parameters are simply a
collection of values or variables that can be passed to the function so we don’t always get the same outcome
when using the function in different contexts. Let’s look at a simple example for finding the average of 3
numbers: [next]
Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

float CalculateAverage(float firstValue, float secondValue, float
thirdValue)

{
float sumOfThree = firstValue + secondValue + thirdValue;
return sumOfThree / 3;
}
At first glance we can tell that this function will return a float value.We can also see that it asks for 3 float
values for it to use. Something else to note is that we can create variables within a function. SumOfThree is
created here to store the sum of the three values. Lastly, Since we want this function to return a float, we
need to tell it what to return. This is done by using the return keyword and then specifying what value we
want to return by writing it next to the keyword. Note we can return the results of a calculation as well as
variables.
Slide 09: Variable Visibility (Scope)
Slide Goal: Introduce the concept of scope
Key Idea: Variables are only visible within their declared scope
Scope is one of the most important concepts to understand early on when learning about programming.
[next] This dictates that a variable only exists within the context it is declared. In other words, if a variable was
declared within a function, it only exists within THAT function. If a variable is declared as a member field, it
exists within the whole class and is visible to all of its functions.
[next] If we look at the CalculateAverage() example function, we see that sumOfThree was declared
inside the function, [next] therefore we cannot use that variable inside another function since it only exists
within the CalculateAverage() function.
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Slide 10: Exposing Variables and Methods to Other Classes
Slide Goal: Introduce the idea of public vs private
Key Idea: Every variable and method should have its own exposure value set
In OOP, we rarely want things to only be visible within their own classes. We want to be able to communicate
between objects. For example we may want a car class to communicate with a garage class to see if there is
room for it to park. By default, things will only be visible within their own class however, we can control their
visibility to other classes by adding the public or private keyword before a member field or class method.
[next]
public class Car
{
public Garage parkingGarage;
private int parkingSpotNumber;
private void TryToPark()
{
if(parkingGarage.CheckParkingSpotAvailablity(parkingSpotNumber)
== true)

{
Park();
}
}
private void Park()
{
//park the car
}
}
public class Garage
{
private bool[] parkingSpotAvailabilites = new bool[10];
public bool CheckParkingSpotAvailablity(int parkingSpotNumber)
{
return parkingSpotAvailabilites[parkingSpotNumber];
}
}
Here we see how 2 classes can communicate with each other. By making the Garage variable public we can set
the reference within the Unity editor in order to specify which garage we want to park in. This is a Unity
feature and we will see it in action shortly. By setting all other variables and methods in the Car class private,
we lock those out of all other classes. This is good practice when you know a method is not intended to be
called by another class so as to protect certain functionality and prevent possible errors. Inside the
TryToPark()function in the Car class, we call on the public method
CheckParkingSpotAvailablity() which returns a boolean value based off of which parking spot we
are checking. This demonstrates that even though a member field is private, it can still be access if returned by
a public function. This too is good practice in order to protect variables from being accidentally modified by
other classes when they should only be handled within the class.
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Slide 11: Coding Against UI Elements
Guided Exercise: Walk the students through creating a script that interacts with UI elements. Create a
script that allows a button to randomize the color of images as well as control the transparency of a
canvasGroup object.
Step 1:
Create a new Unity Project named Programming Logic
Step 2:
Import the UI Programming Package to the project from the Course Material Repo and open the UI
Programming Scene
Step 3:
Create an empty game object and call it UITester. This object will hold the script that will control our various
UI functionality.
Step 4:
Create a new C# script and call it UITester
Step 5:
Erase the template lines of code.
Step 6:
Since we are going to be programming against UI, we need to tell our compiler. Most Unity functionality is
loaded by default but some need to be added manually. We do this by adding the namespace to the script. At
the top of the script, we need to add the line
using UnityEngine.UI;
This will add all of the UI elements into the coding base that the compiler will recognize, in turn allowing us to
program against them.
Step 7:
Next we need to create a number of member fields:
public Image[] images;
public CanvasGroup fader;
These are the references to the UI elements we want to affect with our script. First we have a collection of
Images that we hold in an array. We also have a CanvasGroup that we will use as our fader.
Step 8:
Now we need to create a function that we will call when we press the button.
public void RandomizeColorsOfImages()
It is important to make this function public. I we don’t, then the button won’t be able to call it because it will
only exist inside the context of this script. Making it public makes it visible to all other elements and scripts.

All this script should do is go through all of our images and randomize their colors. We do this by using a
foreach loop.
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foreach(Image image in images)
{
//randomize the color of the image
}
Now, we need to find a way to modify the image’s color. In Unity, if a component has a visible variable in the
inspector, then we can code against it in code. Since the Image component has a visible color variable, we can
target that directly. We do this using the dot notation
image.color = Random.ColorHSV();
This simple function will automatically select a random color and like this we pass the new color to the color of
the image. Since this is performed inside a foreach loop, all of the images inside the array will be affect, each
with a different random color. Let’s test it. Make sure to save your script.
Step 9:
If we go back into Unity, we can now attached our UIManager script to our UIManager gameObject. We now
see 2 things in this component:
- Images with a size
- Fader
The images and size is our array. When an array is made public, the inspector will show us all objects within,
however, it also allows us to set the array size directly in the editor. We want 3 images so let’s set the size to 3.
Now we can simply drag in all 3 images into these slots and we are ready to go. Since we aren’t doing anything
with the fader for now, let’s look at that later. Now that the UIManager is set up, we can setup the button for
it to call the randomize color function.
Let’s go to our button and at the bottom of the button component, we can see a box with On Click(). By
pushing the plus sign on the bottom right, we can add a function that should be called when the button is
pressed. Let’s do so. Now we need to select which gameObject is holding the script we want to use. We can
only call functions from scripts that exist as part of a gameObject. Let’s select our UIManager. Now a drop
down menu is made available. This is where we can see all functions available to this object. Let’s select
UIManager and then find the RandomizeColorsOfImages() function we created and select that. Now
we are good to go.
Step 10:
Now that the button is finished, let’s start on the Slider. If we go back to our UIManager script, we now need
to create a new function that we can use when we change the value of the slider.
public void ControlFaderAlpha(Slider faderSlider)
The difference between this function and the last is that now we are asking for a parameter when we call the
function. Since we will need to get the value of the slider we are manipulating, we need to pass a reference of
the slider to this function. With that we can now use the slider’s values as we see fit.
fader.alpha = faderSlider.value;
The alpha needs to be between 0 and 1 but since the default max and min for sliders is exactly that, we don’t
need any further setup. We are now ready to test this out.
If we go back to Unity and our UIManager gameObject, we can now give a reference to the screen fader we
want to fade with the slider. We just need to drag the Screen Fader into the slot. Just like the button, we now
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need to call the function with the Slider so let’s select the slider gameObject and add the function in the exact
same way. You’ll notice that when you do that, a new box appears below the function drop down. This is a slot
for the parameter the function is asking for. Since the function wants a reference of the slider we are using, all
we need to do is hover over the slider script component and drag it into the slot.
Slide 12: Coding Against an Animator
Guided Exercise: Walk the students through creating a script that interacts with an animator. Teaches
the proper use of animator parameter manipulation through code and player Input.
Step 1:
Import the Mecanim Programming Package to the project from the Course Material Repo and open the
Mecanim Programming scene
Step 2:
Create a new C# script named SimpleAnimator and clean up the template code
Step 3:
We need a few member fields
private Animator animator;
private float speed = 0f;
private bool isCrouching = false;
First we need a reference to the animator we will be coding against. We make it private this time because we
know that the object that will hold this script will have an animator and so we can get it directly. We will cover
this in a second. Then we need 2 other variables that we can pass their values to the animator as parameters.
Step 4:
Now we need to setup up the animator. Since the gameObject holding this script will always have an animator,
we can get the attached animator right at the start of the application. This is done by create the void function
Start(). This function often used to set up a script with default references, which is exactly what we will do
now.
void Start()
{
animator = getComponent<Animator>();
}
This function is special as it is generic. We can use this function to get any kind of component. The way we
determine what component to get is by specifying the type within the triangle brackets. We could get a
collider, a rigidbody, or even get a custom component we have created (like the UIManager we just created).
It’s easy to forget the brackets at the end of this function due to the added triangle brackets but it is important
to add them nonetheless. Without the normal brackets, the compiler won’t recognize it as a function and we
will get a compile error.
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Step 5:
Next we want to create some way to track player input. To do this we need to constantly be checking if the
player is pressing inputs. To do this, we create a void function called Update(). This function will perform all
of its tasks every frame so it is a great place to be on the lookout for player input. First let’s check to see if the
player is pressing the jump button.
void Update()
{
if(Input.GetKeyDown(KeyCode.Space))
{
//tell the animator to jump
}
}
Here we are checking to see if a specific key is being pressed. We have decided to make spacebar our jump
button so if the spacebar is pressed we should make our animator jump.
Step 6:
In order to do that, we need to set a parameter in our animator
animator.SetTrigger(“Jump”);
This is the general syntax for communicating with the animator. Using the dot notation, we need to set a
parameter. In the case of a trigger, all we need to do is pass this function a string that is EXACTLY the same
spelling as a trigger in the parameter list for the animator. Spelling and capitalization is extremely important
and any typo will not work. The syntax is the same for any other type of parameters the only difference is that
we need to send a second value after the string. We will see this in an instant but first, let’s test this out.
Step 7:
Let’s go back to Unity and add our SimpleAnimator script to Ethan. Since we didn’t create any public variables,
we have no values to populate. There is one last thing we want to do in order for the animations to work
properly. On the Animator, we need to uncheck the Apply Root Motion toggle [possibly demonstrate the
difference and explain].
Step 8:
Now that we know we’re in the right direction let’s get the rest of those animations working. Let’s go back to
our script. We now need to do this for all of our parameters in the animator. We have 2 other parameters to
play with: IsCrouching and Speed. Let’s start with IsCrouching. We want to do almost the exact same thing as
we did for jump but with 2 differences. First we want to change the input key so we don’t try to perform both
actions at once and second, since we are working with a bool instead of a trigger we need to pass the setBool
function a value after the name of the parameter.
if(Input.GetKeyDown(KeyCode.X))
{
isCrouching = !isCrouching;
aniamtor.SetBool(“IsCrouching”, isCrouching);
}
What we did here is first change the value of isCrouching to its opposite value. This can be read as isCrouching
equals not isCrouching. This is how we can easily create a one line code in order to toggle between boolean
state. After that, we need to set this new value to the IsCrouching parameter in our animator.
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Step 9:
Next we need to create the logic behind the walk and run. We only have one parameter left to work with:
Speed, so we need to use that one. If we look at the animator, we see that the walk transitions to run when
the Speed value is greater than 2. So we need some kind of logic that will set our speed to a value for walking
and then some other logic that will set our speed to a value for running. Let’s take a look at how we might do
that.
Since this is movement, let’s look at a different kind of input: Axis. We can use an axis instead of a key to check
for player input. The difference between the 2 is that a key only has 2 possible states: up or down. An Axis has
an actual value between 0 and 1. This is used for controllers to see how far the player is pushing the joystick.
This way if the player is pushing the joystick less than half way, then we can make the character walk, but if
the player pushes it further, the character can start to run. Since we are working on keyboard and don’t have a
controller to test with, we will still use the axis but we will do something a little bit different. We will add a run
button, that way, as long as the player is pushing one of the arrow keys, the player will walk, but if the player
holds shift, the character will run
if (Input.GetAxis("Horizontal") != 0 || Input.GetAxis("Vertical") != 0)
{
if (Input.GetKey(KeyCode.LeftShift))
{
speed = 3;
}
else
{
speed = 1;
}
}
else
{
speed = 0;
}
animator.SetFloat("Speed", speed);

-

-

-

For one the double vertical line acts as the word OR. So what this condition is saying is “return true if
EITHER the horizontal axis is not equal to 0 OR the vertical axis is not equal to 0. That way we can
check for either of 2 different conditions.
We are using GetKey instead of GetKeyDown. The difference between the 2 is that getKeyDown only
runs once when the button is pressed and so we can’t track if the button is still being pressed. GetKey
does exactly the opposite, it runs as long as the button is pressed and is no longer true once the
button is released. Think of getKeyDown as a single shot fired in an FPS while getKey is a constant
stream of fire.
Lastly, you’ll notice that we are only setting the animator’s parameter after the condition logic. That’s
because, unlike the other parameters where we just want to set the parameter once the instant the
player pushes a button, the movement needs to constantly be checked and updated. That’s why the
conditional logic for the movement is only used to set the variable based off of the player input, and
then at the end of each frame (regardless of input) we set the parameter to the current speed value.
And that’s it.

Slide 13: Brief!!!
Exercise: Have the students create their own scripts for either the UI they created previously or the
character animator they created earlier.
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Game Programming 02

Player Interaction and Movement: Using Unity’s Event System
Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Tuesday 25 July 3:30PM
1 hour and 20 minutes
Instructor Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
▪ Access to Skins5.0 Project repository on the hosting server
Student Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
▪ Access to Skins5.0 Project repository on the hosting server
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Unity3D
Objectives:
1. Introduce how to use Unity’s Event System and Event Triggers
2. Walk the students through creating a player interaction script that allows for movement to a point on a
navmesh and movement to a location for an interactable object
Vocabulary:
N/A
Web Resources:
Event System
Checking for which mouse button was hit on Event Trigger (second post)
Procedure:
Refers to “Skins 5.0 | Game Programming 02 | Player Interaction and Movement.slides”
Notes:
Live coding alongside slides. The live coding should be split screen with the slides.
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Slide 02: Event System
Slide Goal: Introduce Unity’s built in Event System
Key Idea: Unity created predetermined “events” that the system is constantly listening for and we
can code against that for extremely simple user interactions
Unity has an integrated event system that allows us to manage player input. It handles all of the low level
programming needed in order to set up a necessary system that will recognize an event (or player input) and
send a message to the appropriate objects. [next]
Aside from the Event System script that handles all of the functionality, the event system gameObject is made
up of another component: the Input Module. [next] The input module handles all of the logic that recognizes
the player input however, there are 2 types of input modules: [next] the default standalone input module
[next] and the touch input module. Each module receives and dispatches events as you would expect on the
given configuration, [next] mouse and keyboard for the standalone and [next] touch interactions for the touch
module. [next] For our purposes, we will be using the standalone input module.
As long as the event system gameObject exists within a scene with the appropriate components, all event
handling can be automated without needing sophisticated code. The majority of its functionality exists for
interacting with UI however, there are a number of components that allow for interaction with the scene
world and objects within.
Slide 03: Event Triggers
Side Goal: Introduce the Event Trigger Component
Key Idea: Component that allows for direct communication with Unity’s Event System without little
programming necessary
The Event System also comes with a pre built component that allows us to add input functionality to an object
directly in the editor. [next] The Event Trigger component allows us to add as many reactions to events as we
want, without ever needing to code against the event system. As long as the object with the event trigger
component has a collider attached to it then we can call any function from any object in the scene when the
user interacts with the object in any way with the mouse. Keyboard inputs require a little bit of programming.
[next] First by selecting what type of event we want the object to listen to, [next] we can add an object
reference to this event and [next] select any public function attached to this object reference for the event to
trigger. There is no limit to the number of functions we can call per event. The same goes for the number of
event types allowed on an object, there is no limit.
Slide 04: Navmesh
Slide Goal: Introduces concept of a navmesh
Key Idea: Creating a navmesh from an object gives us the ability to code against it for path finding
purposes
The Navmesh system allows us to turn multiple mesh objects into a single recognizable area for Unity’s built in
pathfinding system. [next] We can find all of the Navmesh functionality in the navigation window. In this
window, if we look under the Bake tab, we can see all of the information needed in order to set up an
appropriate navmesh system for our game: [next]
- Agent Radius: determines the amount of space each navmesh agent will take up horizontally. [next]
- Agent Height: determines the amount of space each navmesh agent will take up vertically. [next]
- Max slope: determines the highest slope a navmesh agent can handle before it determines the area
an obstacle. [next]
- Step Height: determines the highest vertical offset from the ground a navmesh agent can handle
before it determines the area an obstacle
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Once these settings are set, we are a click away from having a functional navmesh. [next] By clicking “Bake”, it
will bake all static gameObjects that fall under these established conditions into a navigation map - but only
the static gameObjects. We will go over that in a minute.
Slide 05: Navmesh Agent
Slide Goal: Introduces the nav mesh agent
Key Idea: Controls all pathfinding functionality for the object this component is attached to
The navmesh agent is the AI counterpart to the navmesh system. This component gives an object the
pathfinding functionality that comes with the navmesh system. Programming is required for the mavmesh
agent to function, however a lot of the data is visible for us to tweak inside the editor although most of them
should stay at their default values for our purposes. [next] We mainly want to modify the Steering data:
- Speed: controls the maximum speed the agent can move at
- Angular Speed: controls how fast the agent can rotate on itself
- Acceleration: controls how quickly the agent will reach its maximum speed
- Stopping Distance: the distance from the target destination the agent will stop at (generally want to
keep at 0 for accurate movement)
- Auto braking: forces the agent to stop at each destination point even if there are multiple. If checked
off allows for fluid movement between target points
Slide 06: Point and Click Movement
Group Exercise: Walk the students through creating a script that handles all click interactions for
movement as well as setting up a navmesh
Setting up the Navmesh:
Step 1:
Create a new Unity project called Player Interaction and Movement
Step 2:
Import the Player Interaction and Movement Package to the project from the Course Material Repo and open
the Point and Click Movement scene
Step 3:
Select the environment GameObject and toggle static to on (top right of inspector). Select “Yes, change
children” to affect the object’s children as well
Step 4:
Open the navigation window (Window > Navigation), select the Bake tab, and set the values to:
- Agent radius: 0.5
- Agent Height: 2
- Max Slope: 45
- Step Height 0.4
Hit Bake. We will now see a visual representation of our walkable area
Step 5:
Select Rudolph and go back to the inspector. Add a nav mesh agent component. Make sure the stopping
distance is greater than 0 (~0.25)
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Creating the point and click script
Step 1:
Create a new C# script and name it PlayerInteraction. Open it and remove the template code.
Step 2:
Add the following namespaces:
- UnityEngine.AI
- UnityEngine.EventSystems
Step 3:
Create a Start function to get the agent component and create a member variable to store it
private NavMeshAgent agent;
void Start()
{
Agent = GetComponent<NavMeshAgent>();
}
Step 4:
We also need a variable for the Vector3 that will store our desired target position and set it to be at the
object’s position to start. The reason why we want it to start at the player’s initial position is because we don’t
want the player to start the game in motion. So if we set the target position to the initial position, it has
nowhere to go.
private Vector3 targetPosition;
void Start()
{
...
targetPosition = transform.position;
}
Step 5:
Now we need to create a public function that we can call with the event trigger for the player to walk to a
point on the ground. However, in order for it to recognize the point on the ground clicked, we need to pass
this function a BaseEventData parameter. This parameter will hold all of the data related to an event being
triggered by the event system. Since this only holds the data for non-specific events, we need to cast it to a
specific event type. Casting changes a data type to another similar data type. This has to do with
polymorphism one of the 3 pillars of OOP but we will go into that more later. For now, we just need to
understand that by casting a baseEventData to a PointerEventData, we can fetch more specific data related to
a player click.
public void OnGroundClick(BaseEventData data)
{
PointerEventData pData = (PointerEventData)data;
}
Casting is performed by specifying the datatype we want to cast to inside brackets directly before the variable
we are casting from. Now with the pointer data, we can get more specific data such as the location of the click
in world space and the mouse button pressed (right, middle, left).
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Step 6:
With the data from the pointer event, we can now set the click’s world position as the targetPosition
targetPosition = pData.pointerCurrentRaycast.worldPosition;
agent.SetDestination(targetPosition);
agent.isStopped = false;
In order to get the pointer position, we need to look at the raycast sent by the pointer event and get the world
position that it represents. A raycast is simply a simulated straight line from one point in a specific direction.
By default, the pointeEvent sends a raycast at the mouse position towards the world and this is how we can
get the world position from a 2D mouse position. With the position collected, we now need to set the
navmesh agent’s destination to this new point and then tell it that it is no longer stopped in order for it to
start moveing towards the point.
Testing the base movement
Step 1:
Now we can test the basic movement functionality. But first, we need an event trigger in order to call our new
function. Let’s add this to the Environment object. Because all of the environment objects are children of the
Environment gameObject, clicking on any one of them will trigger the event that is set up on the parent
Environment object. The reason that this works, is because event triggers (especially click events) are looking
for colliders. If you click on an object without a collider, you won’t get any event triggered, even if you have
the event trigger attached. However, if the parent object has the event trigger component and its children
have components, then it will work because Unity considers all children colliders as a single compound
collider. Note that the parent object does need to have a collider as well for the compound collider to be
recognized
Now let’s add the event trigger component and add a pointer click event type. Now we need to add an event
so click on the plus sign. We now need to specify the gameObject that holds the script with the function we
want to call. Since we haven’t added it to a gameObject yet, let’s add our playerInteraction script to the
Rudolph gameObject. Now back on our environment gameObject, drag the rudolph gameObject to the empty
reference box. This will make the function drop down available. The way this menu works is we first need to
select which component we want to look in so let’s select PlayerInteraction. Then we get an option for the
functions that exist in that component. Select OnGroundClcik.
Step 2:
Before hitting play, we need 2 more elements in order for the event trigger to function properly:
- Create a new EventSystem GameObject in the hierarchy (UI > Event System)
- We need to add a component to the main camera: physics raycaster.
Without the event system object, events cannot be called. Similarly, without the physics raycaster component
on the main camera, the camera cannot raycast to the world and therefore cannot send the position data to
the pointer event data.
Now we are ready to hit play and test out our basic movement.
Refining our Movement
Step 1:
You can probably notice that the movement looks good enough but the player rotates for a long time. We can
polish that by manually playing with how the transform should act (move and rotate) during the walk.
Basically, we need to create our own interpolation logic for how the player should act between point a and b.
This is a pretty involved logic, so we created for you a couple of functions that you can use for this. They are
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inside the Extensions script and if you are curious about them, you can read them there. Thanks to this, all we
need is a single line of code in the Update function to make our movement look so much better.
void Update()
{
agent.MoveToPoint(targetPosition);
}
Basically, the MoveToPoint function controls the walking, slowing and stopping movement of the agent in a
more realistic manner. Although it’s not important for you to necessarily understand the particular logic, you
are more than welcome to take a look at the Extensions script if you are curious.
Slide 07: Point and Click Interaction
Group Exercise: Walk the students through adding interaction to objects to the previous script using
a new InteractableObject script (no conditions and reactions yet)
Creating an Interactable Object
Step 1:
Now that we can click on the environment to move to a point on the ground, we can start thinking about how
to move to a specific interactable object and actually interact with it. For this, we need to create a new script
that we can use for our Interactable objects. So let’s create a new C# script called InteractableObject.
Step 2:
Remove the template code
Step 3:
This script only really needs 2 things.
- A reference for where the player should move to for the object. Unlike the ground, we most likely
want the player to move to a specific location in order to interact with the object.
- A public function for the playerInteraction script to call when the player should interact with the
object.
public Transform interactableLocation;
public void Interact()
{
Debug.Log(“Interact”);
}
We need the reference to a specific Transform in order for the player to use that for its target. This will control
the location the player will move to as well as the rotation it should face when arrived. Also since we want to
see if the Interact function works, let’s throw in a debug.log in there. We will work out the logic behind
interactions later.
Adding object interaction to our playerInteraction script
Step 1:
We now need to go back to our playerInteraction script and create a function similar to our OnGroundClick
function but instead, that will work with our interactable object instead of the ground. For this, we need to
create a new member field to hold a reference of the currently selected interactable object.
private InteractableObject currentInteractableObject;
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Step 2:
Now that we have a reference to our interactable object, we need to create the function to control what
happens when we click on an interactable object. Let’s call this function OnInteractableObjectClick(), however,
unlike the OnGroundClick, we don’t want to pass it event data. We want to pass it a reference of the object we
are clicking.
public void OnInteractableObjectClick(InteractableObject interactable)

{
currentInteractableObject = interactable;
targetPosition =
currentInteractableObject.interactionLocation.position;

agent.setDestination(targetPosition);
agent.isStopped = false;
}
The only key difference between this and the ground function is that when we select the interactable to move
to (in other words once this function is called), we need to set the currentInteractableObject as the selected
interactable Object. Then instead of moving to a point on the ground, we move to the designated point for the
interactable Object.
Setting up an Interactable Object
Step 1:
Create a new 3D object.
Step 2:
Create an empty gameObject as a child of this object. Position this empty object where you want the player to
be when it interacts with the object. You should also set the rotation of it as well. The blue Z axis is the player’s
front.
Step 3:
Drag the empty object into the interactable Object’s interactable location slot.
Step 4:
Make sure the interactable Object has a collider and add the event trigger component.
Step 5:
Add a new pointer click event and set rudolph as the game Object reference.
Step 6:
Select the PlayerInteraction script from the drop down menu and select the OnInteractableObjectClick
function. You will notice that a new reference slot has appeared and it’s empty. We need to fill it with the
Interactable object’s script. To do this, simply drag the component from the inspector into the event trigger’s
empty slot. We are now ready to test.
Making the player face the object location’s direction and triggering the interaction
Step 1:
You will notice that the player moves to the right position but doesn’t face the direction we want. This is
another bit of logic that the navmesh agent does not do by default. Since this is a similar logic to the
movement polishing we created for you, we created a similar function that handles this. However, since we
need to throw this in the Update function as well, both of these 2 functions would contradict each other if we
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didn’t add a bit of conditional logic to control what gets called when.
if(currentInteractableObject != null)
{
agent.MoveToObject(currentInteractableObject.interactionLocation);

}
else
{
agent.MoveToPoint(targetPosition);
}
With this logic, we would move to a point if there is no currentInteractableObject selected and move to an
object if there is. However, there is still a bit of work to do to make sure this logic is tight. If we were to test
now, clicking on the ground first would work. If we clicked on the object that works, but, if we click on the
ground again, all of a sudden the player rotates at the end of its movement. This is because it is still using the
same logic as move to object because the script still thinks it has a currentInteractableObject selected,
because it does. We need to manually remove the reference to the selected interactable object when we click
on the ground. Ideally right below casting the data to a pointerEventData.
currentInteractableObject = null;

Step 2:
Now if we test, our movement should be complete. If we click on the ground, the player moves to the point on
the ground. If we click on an interactable Obejct, the player moves to the interactable object’s interaction
location and rotates to the rotation of said location. Perfect! However, we have one last bit of logic to work
out before out playerInteraction script can be considered functional. We need to be able to trigger the
interactable Object’s interaction when the player reaches the object. We do this by adding one last bit of
conditional logic within the Update function right below the check to see if we have a selected interactable
Object
if(agent.HasArrived() == false)
{
agent.MoveToObject(currentInteractableObject.interactionLocation);
}
else
{
currentInteractableObject.Interact();
}

What we are doing here, is checking to see if the agent has arrived at his destination. This function as the last
of the functions we have created for you in order to simplify the navmesh logic. It will return true if the agent
is finished moving so we can code against it to trigger things once the agent has reached its destination. What
this chunk of code says is that the agent should move to an object until it has arrived. Once it has, interact
with the object and remove the reference to it. This will allow us to time the interaction to when the
movement is complete. Now if we test, we can click on the interactable object and we will see the “interact”
console message appear at exactly the right time.
Unity Demo: PlasticSCM Integration and Use in Unity
Purpose: Teach how to integrate PlasticSCM version control in Unity and explain how to use it
properly
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Game Programming 03

Singletons and Game Structure: Using Design Patterns to Establish
Good Game Structure
Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday 26 July 10:30AM
1 hour (followed by 1 hour of work time for the students to create various handlers/managers)
Instructor Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Student Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
▪ Access to Skins5.0 Project repository on the hosting server
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Unity3D
Objectives:
1. Introduce the concept of design patterns
2. Introduce the design pattern for Singletons
3. Introduce various handlers/managers to handle most of the game functionality
Vocabulary:
Design patterns, Singleton, Handlers/Managers, coroutines
Web Resources:
C# Design Patterns
Static Modifier
Coroutine
Procedure:
Refers to “Skins 5.0 | Game Programming 03 |Singletons and Game Structure.slides”
Notes:
Live coding alongside slides. The live coding should be split screen with the slides.
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Slide 02: Design Patterns
Slide Goal: Introduces the concept behind design patterns
Key Idea: Design patterns are solutions to software design problems you find again and again in
real-world application development.
Design patterns are [next] generic solutions to problems that have come up repeatedly when developing
software. All design patterns have specific functionality that address problems like [next] how to ensure only a
single instance of an object exists in the application or [next] how to control communication between
dependent objects or even [next] how to control the transition between multiple states. However, these
patterns are just that: patterns. It’s not as simple as copy pasting pre-established code. These patterns are
more of a generic structure to the flow and design of a class. [next] Think of these as blueprints for
approaching certain problems where the structure has been established but it is your job to contextualize it
for your own use-case.
Slide 03: Static Modifier
Slide Goal: Introduce what the static modifier is in C# programming
Key Idea: An element that does not belong to object instances but belongs to the class as a whole.
Can only be a single version that is shared between all instances (if many instances of holding class
exist). Static classes cannot be instantiated, only accessed and all elements within must be static.
Before we go into detail on one of the commonly used design patterns, we need to explore the concept of
making an element static. The static modifier is used to make an element belong to a class as a whole instead
of belonging to a single instance of that class.
public class Objective
{
public float progressValue = 10;
public float missionProgress = 0;
private float objectiveMet = false;
private void ObjectiveComplete()
{
if(player contact && objectiveMet == false)
{
missionProgress += progressValue;
objectiveMet = true;
}
}
}
public class MissionStatus
{
public Objective missionObjective;
private void CompleteMission()
{
if(missionObjective.missionProgress >= 100)
{
//move to next mission
}
}
}
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If we look at a normal member field - let’s say a float called missionProgress inside a class called Objective, we
could have multiple instances of the class Objective and each would have their own distinct version of
missionProgress. Let’s say when the player comes into contact with the object Objective the missionProgress
would increase. If each instance has their own version of missionProgress then coming into contact with the
Objective would only increase each local version of missionProgress and none of them would ever get to 100.
public class Objective
{
public float progressValue = 10;
public static float missionProgress = 0;
private bool objectiveMet = false;
private void ObjectiveComplete()
{
if(player contact && objectiveMet == false)
{
missionProgress += progressValue;
objectiveMet = true;
}
}
}
Public class MissionStatus
{
public void CompleteMission()
{
if(Objective.missionProgress >= 100)
{
//move to next mission
}
}
}

However, if we made the float static, then it is no longer dependent on the instance but becomes an element
of the class as a whole. In this situation, as soon as the player comes into contact with the Objective, the
missionProgress will increase. But since it is no longer tied to each instance, once the player comes into
contact with a second Objective, the missionProgress will increase further, making it possible for the
missionProgress to reach 100. This also makes the element visible to all classes without needing an instance of
the object itself (as long as it is public). Although this now works, this isn’t a very well designed system.
Slide 04: Singleton Design Pattern
Slide Goal: Introduces the Singleton design pattern and its importance in good game structure
Key Idea: Singletons allow for single point of contacts for specific behaviours and static data. Enforces
that only a single instance can exist to prevent errors
This is where the singleton design pattern comes in handy. This pattern allows us to force an object to only
have a single instance exist in the scene at any given time and because of this we can make the instance of this
object static so we can code against it from any class without needing to reference an instance of it. Let’s
redesign the previous example slightly.
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public class MissionStatus
{
public float missionProgress = 0;
public static MissionStatus Instance
{
get;
private set;
}
private void Awake()
{
if(Instance != null)
{
Destroy(this.gameObject);
}
else
{
Instance = this;
}
}
private void CompleteMission()
{
if(missionProgress >= 100)
{
//move to next mission
}
}
}
public class Objective
{
public float progressValue = 10;
private bool objectiveMet = false;
private void ObjectiveComplete()
{
if(player contact && objectiveMet == false)
{
MissionStatus.missionProgress += progressValue;
objectiveMet = true;
}
}
}

In this example, we transfer the mission progress to the missionStatus class that way the missionStatus class
handles all mission related data. Then by making this class a singleton, we can guarantee that only a single
instance of this object will exist. We do this using a static property of the same type of the class we want to
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make a singleton. Properties allow us to get their value as well as set their value. In this case we allow the
getting of the instance value but restrict the setting to within this class only. Since this instance is static, it
belongs to the class as a whole so we can test if it already exists within the scene. We do this by checking if the
instance has been given a reference of a missionStatus yet. If it has (and the instance is not null) then an
instance of this class already exists in the scene so this instance we are checking should be destroyed.
However, if the instance property comes back null, then this is the first instance of the class so we need to
pass it to the instance property. With this setup, we can now code against any public member field or method
of this class from any other class without the need for a direct reference to an instance of it. Not only does this
simplify the programming involved when communicating with this class and clean up the necessary logic, it
also ensures there is no confusion from multiple instances of an object that we would otherwise want only
one of in a scene.
Slide 05: Handler Classes
Slide Goal: Introduce the concept and basic structure of Handler Classes
Key Idea: Singleton objects that have references to specific scene elements. Should generally only be
called using their public methods that have specific functionality based on what this element handles
[next] A handler class (also known as a manager class) is a singleton class used to control all functionality
related to a specific purpose. It is not so much a design pattern as an established practice in game
programming. It allows us to delegate all functionality to a single singleton class that way any class can access
those functions. There are a number of different handler classes we can create:
- UI Handler
- Audio Handler
- Scene Handler
- Game Handler
Slide 06: UI Handler
Slide Goal: Introduce the basic required functionality for a UI Handler
Key Idea: Controls the visibility and certain functionality for the UI as a whole or as parts
The UI Handler controls all user interface related functionality. It generally holds a reference to all UI elements
and groups. Key functions generally found in this class are: [next]
- DisplayUI(bool shouldDisplay): either shows or hides the UI based on the boolean based in the
parameters [next]
- ScreenFade(int targetAlpha, float fadeSpeed): fades in or out the screen towards the targetAlpha
value (1 fades to black, 0 fades back to scene)
Slide 07: Audio Handler
Slide Goal: Introduce the basic functionality for an Audio Handler
Key Idea: Controls the triggering of sound effects, the fading of ambient sound and music, as well as
the clips for each audio source
The Audio Handler controls all the audio in the scene. Normally has a reference to 3 audio sources: [next]
- Background music [next]
- Ambient noise [next]
- Sound effect
Key public functions generally found in this class are: [next]
- PlaySoundEffect(AudioClip clip): plays a specific audio clip [next]
- FadeAudioSource(AudioSource audioToFade, float targetVolume, float fadeSeed): fades the audio in
or out towards the target volume
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Slide 08: Scene Handler
Slide Goal: Introduce the basic functionality for a Scene Handler
Key Idea: Controls the setup of scene elements, the loading of scenes, as well as triggering any
cinematics
The Scene Handler controls all scene related functionality. It generally holds references to any scene specific
objects that could be in every scene such as: [next]
- Player starting position [next]
- Intro/outro scenes [next]
- Ambient sound for the scene [next]
- Background music for the scene
Key functions generally found in this class are: [next]
- SetupScene(): simply sets up the scene on start [next]
- LoadScene(string sceneName, float delay): loads a desired scene
Slide 09: Game Handler
Slide Goal: Introduce the basic functionality for a Game Handler
Key Idea: Controls the functionality and triggering of in game events
The Game Handler controls all game events and game progression. If the game progression isn’t complex, than
this handler isn’t always necessary. For our purpose, we only need this to handle the game events since game
progression will be fairly simple.
The only public function we will need for this is: [next]
PlayGameEvent(string eventName): this will play an event based on the name by calling a private function
created for that purpose. [next]
Side 10: Coroutines
Slide Goal: Introduce the coroutine function type
Key Idea: Coroutines allow for a function to pause mid way through its execution, return control to
Unity to allow subsequent functions to process and resume execution on the next frame.
Often, we will want to perform some tasks but wait until a condition is met in order to complete said task. This
is where coroutines come in. Coroutines allow for a function to pause mid execution. Once the function is
paused, the control returns to Unity and the rest of the functions and classes perform their tasks for that
frame. Once the next frame rolls around, the paused function will resume where it left off if the conditions
have been met. Coroutines are considered a special type of function. In order to turn a function into a
coroutine, we need 2 things: [next]
- Mark its data type as IEnumerator [next]
- Call yield at least once inside the function
Yield acts as a keyword that triggers the pausing of the function. Once the function reaches the yield, the
function will pause and only resume once the yield’s condition is met. This would be the general syntax for a
coroutine function: [next]
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public IEnumerator WaitForDelay(int delay)
{
//do something
yield return new WaitForSeconds(delay);
//do something else
}
This example will peform certain tasks, but once it reaches the yield line, it will pause and try to resume at
every subsequent frame. [next] Only once the condition set next to it, in other words once the number of
seconds determined by delay has passed, will the function resume at the following line. This is extremely
important when creating functionality that has a time element to it.
Another example of a use-case for coroutines would be when we want to wait for a coroutine to finish before
continuing the tasks within a function. Let’s look at this example: [next]
public IEnumerator SceneLoad()
{
yield return StartCoroutine(FadeScreen());
//load the next scene
}
private IEnumerator FadeScreen()
{
while(fader alpha is not 1)
{
//gradually fade the screen
yield return null;
}
}
In this example, we have a coroutine SceneLoad that starts the coroutine FadeScreen and waits until it is
finished before loading the next scene. [next] In the FadeScreen coroutine, yield return null simply waits until
the next frame before continuing. This is especially useful when you want to gradually perform a certain task
(like fading the screen in this case). We can loop through the task and when we get to the end of the loop it
will pause until the next frame, check if we should continue the loop and if so repeat the process until we no
longer need to be in the loop. Once we break out of the loop, since there are no other tasks in the coroutine, it
will be concluded and the SceneLoad coroutine can resume as well.
Slide 11: Creating and Using a UI Handler
Group Exercise: Walk the students through how to create and interact with a UI Handler. Call the UI
Handler from both an unrelated class (using player input) and from a UI button.
Step 1:
Create a new project called Singletons and Game Structure and import the Singletons and Game Structure UI
package from the Course Material repo
Step 2:
Create a new scene and drag the sample UI prefab into the scene.
Step 3:
Create a new C# script called UIHandler, remove the template code and add the UnityEngine.UI namespace
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Step 4:
Create a member field for the various UI elements and groups we want to manipulate
public GameObject globalUI;
public GameObject inventorySlots;
Public CanvasGroup fader;
These will allow us to show/hide all of their children at once.
Step 5
Turn this class into a singleton by creating a static instance property and setting the singleton logic in the
Awake function
public static UIHandler Instance
{
get;
private set;
}
void Awake()
{
if(Instance != null)
{
Destroy(this.gameObject);
}
else
{
Instance = this;
}
}
Step 6:
Create a function to toggle the UI display on or off based on a boolean parameter passed to the function
public void ToggleUIDisplay(bool shouldDisplay)
{
globalUI,SetActive(shouldDisplay);
}
Step 7:
Create a function to toggle the Inventory slots on and off based off of its current state
public void ToggleInventorySlots()
{
inventorySlots.SetActive(!inventorySlots.activeSelf);
}
This line of code will set the active state of the game object to the exact opposite of its current state.
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Step 8:
We now need to create a function that will control the scene fader. In order to do that, we need to make this a
coroutine function. If ever you aren’t sure whether you should make a function a coroutine or not ask yourself
if it has timing to it. In other words, if you need something to progressively perform a task as in fade
something in or out or if you need something to wait before continuing then you probably need it to be a
coroutine. Let’s first create the underlying logic of a scene fade.
public IEnumerator SceneFade(float targetAlpha)
{
while (!Mathf.Approximately(fader.alpha, targetAlpha))
{
fader.alpha = Mathf.MoveTowards(fader.alpha, targetAlpha,
Time.deltaTime);
yield return null;
}
}
Here, we create a while loop that will constantly iterate until the condition is no longer met. In this case, we
are checking if the fader’s alpha value is approximately equal to the targetAlpha we have set as a parameter.
The targetAlpha should normally be either 1 or 0, 0 being a fade in and 1 being a fade out.
Inside the loop, we are moving the fader’s alpha value towards the target alpha at a rate of Time.deltaTime.
Time.deltaTime is used to get the time between frames. Since our game runs at around 60fps, we don’t want
the alpha to take only 3 frames to reach the target. This allows the alpha value to move towards the target
alpha at a speed relative to the frame rate.
Lastly, we pause the coroutine after the alpha value has been modified. In this case, we only pause it for one
frame. Using yield return null causes the function to pause for the remainder of this frame but resume on the
next frame.
The logic behind this function is that as long as the fader’s alpha has not reached the target value, it will
continue to move towards it gradually every frame.
Testing the UIHandler
Step 1:
Now that we have a basic UIHandler, we need some way to test it. Let’s create a new UITester C# script for
that.
Step 2:
Let’s test our scene fader first. We need to call the SceneFade coroutine on Start so it fades in as soon as the
game starts.
void Start()
{
StartCoroutine(UIHandler.Instance.SceneFade(0));
}
Let’s test it out but first, we need to attach our 2 new scripts to objects in the scene. First, we need to create a
new empty gameObject and attach the UIHandler to it. This will be our UIHandler object. Next let’s just throw
the UITester on the UIHandler as well for simplicity’s sake. Don’t forget to populate the UIHandler’s public
variables in the editor.
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Step 3:
We now need to create a way to see if our UI toggle works. In the update, let’s look for player input and set it
so U toggles the UI off and I toggles it on.
void Update()
{
if (Input.GetKeyDown(KeyCode.U))
{
UIHandler.Instance.ToggleUIDisplay(false);
}
if (Input.GetKeyDown(KeyCode.I))
{
UIHandler.Instance.ToggleUIDisplay(true);
}
}
Let’s test it

Step 4:
Now, we need to test the inventory slots toggle, but we don’t need to create anymore code for it. Select the
Inventory Button object and add a function in the OnClick event. Drop the UIHandler in the slot and select the
toggleInventorySlots function.

Slide 12: Work Session
Purpose: Work on the different Handlers necessary for the game
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Game Programming 04

Inheritance and Polymorphism: Extending Functionality of Classes
Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday 26 July 1:30PM
1 hour and 30 minutes (followed by 1 hour and 50 minutes of work time for the students to create reaction
and condition scripts)
Instructor Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Student Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
▪ Access to Skins5.0 Project repository on the hosting server
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Unity3D
Objectives:
1. Introduce the concept of Inheritance and Polymorphism
2. Introduce the Unity built ScriptableObject base class
3. Walk the students through creating abstract classes for reactions and conditions
4. Walk the students through adding reaction and condition functionality to the InteractableObject script
Vocabulary:
Inheritance, derived class, Polymorphism, abstract class, virtual methods, scriptable object
Web Resources:
C# Inheritance
Inheritance - Unity Dev Team
C# Polymorphism
Unity Scriptable Objects

Procedure:
Refers to “Skins 5.0 | Game Programming 04 |Inheritance and Polymorphism.slides”
Notes:
Live coding alongside slides. The live coding should be split screen with the slides.
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Slide 02: Class Inheritance
Slide Goal: Introduce the concept of Class Inheritance
Key Idea: Class can be derived from other classes therefore inheriting all visible fields and methods in
order to add functionality to a specific class.
Inheritance is a key concept in OOP. It allows us to create a base class with base functionality and extend that
class into multiple more specific derived classes. The derived class will maintain all of the base class’s
functionality and we can add more functions that are specific to this new class. Let’s look at an example. [next]
Let’s say we create a class called Character. This class has HP, multiple stats and a take damage function. We
can extend this class [next] into a Goblin class which will inherit all of these functions and member fields. But
we can do more than that. [next] W
 e can add a function called GoblinPunch that allows him to perform this
specific skill. With this, it has the basic functionality of the base class Character but with added functionality
specific to itself. [next] We can further extend the class by extending the Goblin class into a GoblinChieftain
class. It will inherit all of the functions and member fields that the Goblin has inherited from the base class as
well as the function added to the Goblin class. [next] We can then add a member field to the chieftain called
MP and give him a new function called WarCry.
This allows us to create multiple variations of a base class without needing to re-program elements that have
already been made.
Slide 03: Overriding Virtual Methods
Slide Goal: Introduce the practice of creating overridable virtual methods
Key Idea: Virtual methods allow a derived class to override the functionality of a base class function
in order to either extend functionality or change it altogether.
Through inheritance, we can set methods to be virtual. What this entails is that any derived class can override
this method in order to modify or add functionality to this method. [next] Let’s go back to our character class.
If we make the TakeDamage function virtual, then [next] we can create a derived class called Tank that
overrides this function. Now instead of taking direct damage based on the damage sent, the same function will
take damage that is modified by the endurance stat. Virtual methods allow us to create specific functionality
for specific derived classes while still maintaining the same function names and general class logic.
Slide 04: Polymorphism
Slide Goal: Introduce the concept of Polymorphism
Key Idea: Objects of a derived class (sub-class) can be treated as their base class. This allow for
generic programming where the specific class is unknown but the base class is known.
Polymorphism is another key concept in OOP. It allows us to treat any derived classes as its base class. What
this means is that if we don’t know what derived class we are targeting, we can code against its base class and
still be able to use derived classes. This only works for methods that exist in the base class but any overridden
functions will take effect nonetheless. [next] L ets go back to our Character class tree. Lets say we have a
player class, that also extends the Character class, who is attacking another character, but we don’t know
which type. It could be the Goblin, the Goblin chieftain, the tank or even another player - it could also be the
base class Character. [next] Well all we need to do is consider any one of these as the base class Character and
we can code against which ever one ends up being targeted.
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Slide 05: Abstract Classes
Slide Goal: Introduce the concept of Abstract classes
Key Idea: Abstract classes act as uninstantiable blueprints for classes. They cannot be used directly in
code but instead have to be derived from. Derived classes MUST implement abstract functions
therefore through polymorphism this allows for very generic programming.
Abstract classes go hand in hand with the concept of polymorphism. An abstract class is used as a base class
with no set functionality determined. All it has is a list of function names that all of the derived classes MUST
use as well as any member fields we want the derived classes to have. Consider an abstract class as a blueprint
class that cannot be instantiated, only derived Something important to note by making a class abstract, all
methods inside MUST be abstract as well. [next] Lets once again go back to our character class. Since this class
doesn’t really have any functionality other than being a punching bag, we don’t necessarily want to be able to
instantiate it and use it as is in game. [next] What we want to do is make this class abstract so we can derive
from it but can’t use it as is in game. By making it abstract - as well as it’s TakeDamage method, we can now
use it as a blueprint for our derived classes but we have to make one small change to each: we have to create
the TakeDamage function in each derived class. [next] If we look at the Tank class, we no longer want to
override the function, we want to act as if we are creating it from scratch. [next] Same thing with the player
class. However, thanks to polymorphism, [next] we can still target the Character abstract class in order to
target any of its derived classes and since the takeDamage function is abstract as well, we can be sure it will
exist in all derived classes.
Slide 06: Scriptable Objects
Slide Goal: Introduce the Unity base class ScriptableObject
Key Idea: Scriptable Objects are used to hold chunks of data as well as have the ability to be
instantiated before runtime. This gives the developer a lot of control on creating multiple instances of
these objects each with different data.
A scriptable object is a Unity class that can be instantiated directly in the editor. Although these cannot be
treated as a component, they are used as references to data/function within other components. At their base,
scriptable objects are used to store chunks of data that can be created and set inside the editor. They offer a
lot of control for creating multiple different instances of similar data to be used in multiple different or similar
situations. In order to create a scriptable object, we need to create a class that derives from it:
public class
{
public
public
public
public
}

CharacterData: ScriptableObject
int
int
int
int

hp;
strength;
endurance;
mind;

Here we are using the same kind of data that we used in our Character base class but instead of setting each
variable within the gameObject that represents the instance of the Character, we can create a reference to
this class in the Character class and therefore localize all of our stats within this reproducible asset. However,
in order to reproduce it, we need to add one more line of code so we can create it in the editor:
[CreateAssetMenu()]
This will add the class to the asset menu’s create menu and we will be able to create instances of it much like
we can create animator controllers or materials.
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Slide 08: Inventory & Reactions and Conditions
Group Exercise: Walk the students through creating abstract classes for Reactions and Conditions.
Create the Add Item Reaction and Check for Item Condition. This will require the creation of a simple
Inventory script as well as an item scriptable object script and enum to list the item names.
Creating an Inventory System
Step 1:
Create a new Unity Project and call it Inheritance and Polymorphism.
Step 2:
Create a new scene and call it Systems Testing. Import the Inheritance and Polymorphism UI package from the
Course Material and add the Sample UI to the new scene.
Step 3:
Now before we start working on Reactions and Conditions, we need to create an Inventory system in order to
store collectable items. For this, we need 2 scripts: one for the Inventory system itself, and another for an Item
class. Let’s start with the Item class. Create a new C# script and call it Item. Erase the template code. Now we
don’t want this class to inherit from Monobehaviour like all other classes so far. We need this to be a
scriptable object so we can create an asset for each instance.
[CreateAssetMenu]
public class Item : ScripotableObject
{
}
Step 4:
Our Item class won’t actually have any functionality. All it will have is an id to detect what item type it is and
an image attributed to it so we can display it in the Inventory UI.
First, let’s create a way to determine its ID. We can do that with a simple string if we want but since we will be
checking against them for various reasons, we can look at something new in order to prevent typos. We can
create an enumeration or a list of words that we can select in the editor and code against inside classes.
public enum ItemTypes
{
Key,
Compass,
}
We can create this inside of the Item class, however, doing so will lock it inside the scope of that class. What
we want to do is create it outside of the class. Enums can be created outside of classes in order to be visible
within the solution (basically the entire scope of the project). Since we want other classes to recognize the
item type enum, that’s exactly where we want to put it.
Step 5:
Now that we have our item type enum, we can create the member fields for the Item class.
public ItemType itemType;
public Sprite itemImage;
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Step 6:
Now that we have items, we can create the InventoryController class. Let’s create a new C# script and call it
thusly. Erase all the template code and let’s make it a singleton so we can access it from anywhere.
public static InventoryController Instance
{
get;
private set;
}
void Awake()
{
if(Instance != null)
{
Destroy(this.gameObject);
}
else
{
Instance = this;
}
}
Step 7:
Now we need some kind of data structure to hold all of our items. We can simply create an array of Items for
this. In this example, we only want a max of 3 items so let’s set the array length to 3
private Item[] itemsInInventory = new Item[3];
Step 8:
Now that we have our inventory structure, we need 3 public functions to manipulate it:
- One function to check if an item is already in the inventory
- One function to add an item
- One function to remove an item
public bool IsItemInInventory(ItemType itemTypeToCheck)
{
foreach(Item item in itemsInInventory)
{
if(item.itemType == itemTypeToCheck)
{
return true;
}
}
return false;
}
This function should seem fairly simple at this point. Nothing too fancy is going on. All we are doing, is looping
through the inventory array and trying to find an element with the matching item type. If we find one, then
the function returns true. If we don’t, it returns false.
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public void AddItemToInventory(Item itemToAdd)
{
if(IsItemInInventory(itemToAdd.itemType) == false)
{
for (int i = 0; i < itemsInInventory.Length; i++)
{
if (itemsInInventory[i] == null)
{
itemsInInventory[i] = itemToAdd;
return;
}
}
}
}
Again, nothing too fancy here. First, we check to see if the item already exists in the inventory. If it doesn’t
then we loop through the inventory to find the first empty slot and add the item to it.
public void RemoveItemFromInventory(ItemType itemToRemove)
{
if(IsItemInInventory(itemToRemove) == true)
{
for(int i = 0; i < itemsInInventory.Length; i++)
{
if(itemsInInventory[i].itemType == itemToRemove)
{
itemsInInventory[i] = null;
return;
}
}
}
}
This function follows the exact logic as the add function but does the exact opposite. If the item exists in the
inventory than we remove that item by making that element in the array null.
Step 9:
Now that the inventory is functional, we need to link it to the UI. There are a number of ways we can do that.
One of the simplest ways to go about this, is to add a reference to all of the item slot images within the UI that
we can set inside the editor
using UnityEngine.UI;
...
public Image[] itemImages;
...

Here we need to add the UI namespace in order to get access to the Image class. Then in Start, we need to set
the length of our itemImage array to the same length as our items in inventory.
Now we need to populate this new array when we add an item and remove elements when we remove an
Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

item. This is done by simply adding 2 lines of code in each
Below itemsInInventory[i] = itemToAdd;
itemImages[i].sprite = itemToAdd.itemImage;
itemImages[i].enabled = true;
Below itemsInInventory[i] = null;
itemImages[i].sprite = null;
itemImages[i].enabled = false;
Creating Reactions
Step 1:
Now that the Inventory system is complete, we can work on creating a reaction that will add an item to the
inventory. But first, since we will have multiple different kinds of reactions we need to create a base class that
we can code against. The idea behind this system, is that we want to create an array of reactions that we can
play one after the other. That means we can create an array of Reactions but populate the array with the
classes derived from Reaction. That means we will never really use the base Reaction class, therefore it would
be a good idea to make it abstract.
public abstract class Reaction : ScriptableObject
{
public int delay;
public abstract void PlayReaction();
}
That is as complicated as our Reaction class gets. We want an int value to use for timing. We may want some
reactions to have some seconds of delay before playing the next one. The core of this class though is the
abstract function PlayReaction. Every derived class will implement this function with their own logic. A text
reaction could display text on screen, an audio reaction could play a sound effect, etc. This function, regardless
of the derived class, is what we will call when interacting with an object that should play a reaction. Note that
we created this class as a child class of scriptable object. The reason for this is to be able to create asset
instances of each type of reaction so we can really control the content of each reaction. We will look at that in
a second.
Step 2:
Now that we have the base class to work with, we can start creating the derived classes. For now let’s create a
reaction that adds an item into our inventory. Let’s create a new C# script and call it AddItemReaction.

public class AddItemReaction : Reaction
{
public Item itemToAdd;
public override void PlayReaction()
{
InventoryController.Instance.AddItemToInventory(itemToAdd);

}
}
First we need to inherit from Reaction. Since Reaction is abstract and has an abstract method, we need to
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implement it, otherwise we get a compile error. We implement the class by overriding it. Then we can add
whatever lines of code we want within. In this case, we want to tell the inventory controller to add an item.
Since we want each instance of this class to have a different item to add, we need to create a public Item
variable that we can populate within the editor. Then we can pass that variable to the function and voila. Our
very first reaction. It’s important to note that since these are actually asset instances, we can’t code against
scene elements like we do with normal monobehaviour classes. That means we can’t drag and drop scene
objects into public variable slots like we do with scene objects. The only things we can code against in the
scene are Singletons so we need to create functions within our handlers for reactions to call.
Creating Conditions
Step 1:
Now we need to do the same thing but for conditions. We want to follow the same process as for reactions
but instead of having a void PlayReaction function, we want a function that returns a boolean.
public abstract class Condition : SciptableObject
{
Public abstract bool CheckCondition();
}
Step 2:
With our abstract class out of the way now we can create specific condition classes. Let’s create a condition to
check if an item is in the inventory
[CreateAssetMenu]
public class CheckForItemCondition : Condition
{
public ItemType itemToCheck;
public override bool CheckCondition()
{
return
InventoryConoller.Instance.IsItemInInventory(itemToCheck);

}
}
Here, we use a public itemToCheck that we can set in the editor in order to set the item for the condition to
check. Then when we call the function, we call the inventory controller function to check if the item exists in
the inventory and return that result.
Now that we have the parts for our system created, we need to create a way to run this system. Basically we
need some way for the conditions to be checked and if all are met, reactions should play. That’s where the
interactableObject’s function Interact comes back into play.

Slide 09: Integrating to Interactable Object
Group Exercise: Walk the students through adding reactions and conditions to the interactable object
script. Create 2 examples: one with conditions (looking for item in inventory) and one without
conditions that adds this item to the inventory.
Step 1:
Let’s open our InteractableObject script. Inside the Interact function, we can now erase the debug.log and
replace it with the actual interaction logic. The idea behind this function is not super complicated. We want to
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check through a collection of conditions to see if they are all met. If a condition is not met, we want to play a
default collection of reactions to give the player feedback. If the conditions are all met, we want to play a
separate collection of reactions. So first, we need to create these collections
public Condition[] conditionCollection;
public Reaction[] defaultReactionCollection;
public Reaction[] successReactionCollection;
Since we want to reuse this class for all of our interactable objects, we need to make them public in order to
set them in the editor. That way, using the same logic, we can produce different results.
Step 2:
Next we need to check for the conditions
public void Interact()
{
foreach(Condition condition in conditionCollection)
{
if(condition.CheckCondition() == false)
{
//play all the reactions from the default collection
return;

}
}
//play all the success reactions
}
This is the logic behind how to check for conditions. We loop through the condition collection and as soon as
we find a condition that is not met, we play the default reactions and return out of the function. Using return
like this will end the function. On the other hand, if the conditions are all met, we move the the next line after
the loop and play the success reactions.
Step 3:
Now that we have the condition logic, let’s create a way to run all of the reactions with their proper delay.
Since we want the function to play out over time (in order to use the delay) we need to create a coroutine.

public IEnumerator PlayReactionCollection(Reaction[] collection)
{
foreach(Reaction reaction in collection)
{
reaction.PlayReaction();
yield return new WaitForSeconds(reaction.delay);
}
}
With this function, we can play any reaction collection with the proper delay. All we need to do is pass the
proper reaction array as a parameter and the entire collection will play out.
Step 4:
Now all we need to do is call the coroutines in the 2 places we want to play a reaction collection
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public void Interact()
{
foreach(Condition condition in conditionCollection)
{
if(condition.CheckCondition() == false)
{
StartCoroutine(PlayReactionCollection(defaultReactionCol
lection));
return;

}
}
StartCoroutine(PlayReactionCollection(successReactionCollection));

}
And that’s all there is to the logic. Now let’s see how simple it is to integrate this into a scene.
Scene Integration
Step 1:
Go back to Unity and Import the Inheritance and Polymorphism package from the Course Material. Open the
Inheritance and Polymorphism scene add the sample UI prefab to the scene. Now we need to add the
InventoryController script we created, so let’s attach it to the Inventory button. Remember that this script has
a public array of images for the inventory slot images, so we need to populate them. If we expand the
Inventory slots, we can see that each slot is made up of 2 elements, a background image and an image for the
item in the slot. By default, the item image is disabled and we want to keep them that way. They should only
be enabled when an item exists in that slot. We now want to drag each of these slot images into the Inventory
controller’s item images array.
Step 2:
Now that our inventory controller is all set up, we can create our first functional interactable object. To do so,
select the interactable test scene object. If we look at the InteractableObject component, we can see 3 new
array variables. These are our condition and reaction collections. For this example, we want to create an
interactable that requires a key item and adds a compass item if successful. To do that, first we need to create
our condition and reaction assets. Let’s create 3 assets for the time being:
-

An addCompass asset to add the compass
An addKey asset to add the key
An CheckForKey asset to check for the key

In order to create one of these assets, right click in the project view and select create. You will see that all of
the reactions and conditions we just created are now available. Select 2 addItem and 1 checkForItem and
name them properly. Now we need to give values to the variables in each asset. Let’s start with the
CheckForKey condition. Select it, and in the inspector, we see a drop down menu to select which value we
want from the Item type enum list. Select key.
Next we need to do the same for the add item reactions however, they require an asset of their own. We need
to create an item asset so we can tell each instance which item to add. Right click on the project view and
select create. We can see that Item is available so select that. Name it key. Do that a second time for the
compass. Now we can set the values for these items. Click on the circle selector icon on the right of the slot,
and choose the image you want to use. Also, make sure to select the proper item type for each item from the
drop down menu. Now that our items are created, we can use them in our add item reactions. Drag them into
the proper reaction asset.
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Step 2:
Now that our assets are created, we can drag them into the appropriate slots in the interactable Object. Select
the interactableTest object and expand each collection. For this we want to add the check for key as a
condition and the add compass as the success reaction. For testing purposes, let’s throw the add key reaction
to the default reaction slot. Basically this would mean that the first time we interact with it, we will receive the
key and then if we interact with it again, we will receive the compass. Let’s test it out. Make sure that the
interactable Object has the event trigger set up.
Slide 10: Work Session
Purpose: Work on creating different types of conditions and reactions
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Game Programming 05

Persistent Data: Maintaining Data Between Scenes
Facilitator: Julian Glass-Pilon

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana. There
were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Thursday 27 July 9:15AM
30 minutes (followed by 1 hour work time for the students to add data persistence to certain classes and
create a Save Data Handler)
Instructor Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
Student Prerequisites:
▪ Access (login/password) to a Unity3D account (educational license)
▪ Access to Skins5.0 Project repository on the hosting server
Equipment, Software Materials:
▪ A presentation screen on which to show PowerPoint and Unity3D
▪ Black or white board with pens or chalk available
▪ Individual computers for each student with the following software installed:
- Unity3D

Objectives:
1. Introduce the concept of data persistence and what happens upon scene load/unload
2. Introduce the DontDestroyOnLoad function
3. Walk the students through creating Save Data classes with a local Key-Value pair custom class as the data
structure
Vocabulary:
Data Persistence, Key-Value Pair
Web Resources:
N/A
Procedure:
Refers to “Skins 5.0 | Game Programming 05 |Persistent Data.slides”
Notes:
Live coding alongside slides. The live coding should be split screen with the slides.
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Slide 02: Data Persistence
Slide Goal: Introduce how Unity handles Data Persistence between scenes
Key Idea: Unless otherwise stated within the class, Unity will always destroy all objects in a scene
when it unloads. When it loads back up again it will always load objects at their default state (as in
editor)
In Unity, by default, no data is set to be preserved between scenes. What this means is that once a scene is
unloaded, all of the data that was modified from its starting state (as set in editor) will be lost. In other words
Unity does not handle persistent data by default. So we need to come up with our own system for that. Lets
take a look at what happens when Unity changes scene:
[next] Lets say we start the game in scene Mission 01. We have one object with 2 variables: int playerScore
and float playTime. Once we complete the mission those values have changed. [next] Let’s say we
accumulated 52 points in 352.25 seconds. Now we want to go to the next mission in order to continue
increasing our score and time however, [next] once we unload the first scene, these values are erased and
(assuming we have a GameHandler in the second scene) those variables are back to their starting values (as
set in the editor).
[next] This demonstrates that in order to have persistent data, we need to store relevant data in objects that
are independent of the scenes.
Slide 03: Maintaining Persistent Data
Slide Goal: Introduce a couple simple ways of maintaining data persistence between scenes in Unity
Key Idea: It’s possible to set objects to not be destroyed on unload. However this is not good for all
objects. The other way of handling persistence is to create save/load functions to handle transferring
data to a persistent object and then asking for the data back once loaded or required.
There are a number of ways we can do that:
[next] We can set an object to not destroy on load through code using the function
DontDestroyOnLoad(gameobject). [next] By doing that, the entire gameObejct will be preserved throughout
the scenes and we can maintain data persistence within this item.
This is useful when we want to save an entire object’s state and information such as the UI and its handler, or
the AudioHandler so we can have sound play between scene however, this isn’t a solution for all objects.
Some objects should exist only within their designated scenes such as interactableObjects, but we may want
to be able to come back to a scene and have the interactableObject’s previous data restored.
[next] The go to solution for this is to create a save/load function that will save and load data to a data object
that is held within a gameObject that is set to not destroy on load. That way the gameObject itself does not
persist and then exist randomly in all scenes, but instead the data we want to be persistent can still be access
when we want it by loading from the persistent data objectaa.
Slide 05: Key-Value Pair Save Data
Group Exercise: Walk the students through creating Save Data classes using the Key-Value pair data
structure (custom local class).
Step 1:
Create a new C# script called BoolSaveData
Step 2:
Clean up the script by removing the base class and the Unity functions. We will be using this as a data object
so we do not need any Unity functionality.
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Step 3:
Create a local class that we will use to hold a data value. This class will only exist within the BoolSaveData.
Let’s call this class KeyValuePair. It will have 2 member fields: a string called key and a bool called value. The
key is a string for the name of the data. This allows us to locate which data we want to load from for a specific
object. When the object saves to the data, it will save using the same string.
...
private class KeyValuePair
{
public string key;
public bool value;
}
Step 4:
Since this local class will only ever exist within the BoolSaveData class, we need to be able to create an
instance for it. For that we create a constructor. With the constructor we can pass values to its parameters in
order to set the value of the member fields for each instance:
public KeyValuePair(string _key, bool _value)
{
key = _key;
value = _value;
}
Step 5:
Now that we have the local class setup, we can start coding against it. Our BoolSaveData class needs to hold a
list of these objects. The reason we want to use a list is to be able to dynamically add and remove elements
from the group. We can’t do that with a normal array since the length is set upon initialization but Lists allow
us to do just that.
public List<KeyValuePair> dataCollection = new List<KeyValuePair>();

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

Step 6:
Now we need to add some functionality to the class. We only need 2 functions: a function to save and a
function to load. We will call these function Save and TryLoad. The reason we want to call the load function
TryLoad is because we don’t know for sure that data will exist so it makes more sense to call it TryLoad instead
of Load. Let’s start with the save function. The first thing we want to do is check if the object we are saving
already has an existing data in the collection. This prevents having duplicates in the collection so we are
ultimately overwriting data when we save the same object more than once. We do this by looping through the
collection and checking for the key. If the key exists we overwrite that data. If it doesn’t we add a new data
object to the collection:
//saves data to the collection by either overwriting existing data or
//creating a new entry
public void Save(string saveKey, bool saveValue)
{
//checks to see if the data already exists and overwrites it if
//it does
foreach(KeyValuePair data in dataCollection)
{
if(data.key == saveKey)
{
data.value = saveValue;
return;
}
}
//if it doesn’t exist create a new entry and add it to the
//collection
dataCollection.Add(new KeyValuePair(saveKey, saveValue));
}
Step 7:
Now we need to create a TryLoad function. It is similar in concept to the Save function however we are going
to return a bool from the collection. We also need to handle the possibility that the data does not exist in the
collection. If that is the case, we need to return a non-arbitrary value. For this we need to create a parameter
that will take the current value of the object we are try to load to so it doesn’t change.
//returns the value of the save data if it exists
public bool TryLoad(string loadKey, bool defaultValue)
{
//checks to see if data exists of this object and returns its
//value if it does
foreach(KeyValuePair data in dataCollection)
{
if(data.key == loadKey)
{
return data.value;
}
}
//if it doesn’t exist return the default value
return defaultValue;
}
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And that’s it. All we need now is a persistent object to store instances of this class. From there we can create
functions that other classes can call to access the save and load functions.
Slide 06: Work Session
Purpose: Create a SaveData Handler and add save/load functionality to various classes
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3D CINEMATICS
01 Into to After Effects
02 After Effects Animation Tools
03 After Effects Advanced

After Effects 01:

Introduction to After Effects:
Facilitator: Nancy Townsend

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 26, 11:30AM
1 hour
Instructor Prerequisites:
Instructor should have experience working with After Effects and understand its capabilities and
workflow.
Student Prerequisites:
Students should have basic knowledge of Photoshop and its workflow.
Equipment, Software Materials:
A screen to show the PowerPoint Presentation
Computers for students with Plastic SCM and After Effects installed.
Objectives:
Introduction to the interface, capabilities, and general workflow of After Effects, including navigation,
effects, layers, and rendering. Understand the purpose and creation of cutscenes.
Vocabulary:
Composition, Layers, Timeline, Preview, Effects, Workspace, Cutscene
WEB RESOURCES & BOOKS:
What is after effects?
https://helpx.adobe.com/after-effects/how-to/what-is-after-effects-cc.html
https://helpx.adobe.com/after-effects/how-to/what-is-after-effects-cc.html
Cutscenes:
https://www.youtube.com/watch?v=sGXIR2dlktc
https://www.youtube.com/watch?v=r9ExIKYZd6o
Customizing your workspace:
https://helpx.adobe.com/after-effects/using/workspaces-panels-viewers.html
Composition basics:
https://helpx.adobe.com/after-effects/using/composition-basics.html
Timeline:
https://helpx.adobe.com/after-effects/atv/cs6-tutorials/the-timeline.html
Layers:
https://helpx.adobe.com/after-effects/using/selecting-arranging-layers.html
Preparation:
PowerPoint slides
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After Effects project template for students
What is After Effects and what will we use it for?
Adobe After Effects is a digital visual effects, motion graphics, and compositing application developed
by Adobe Systems and used in the post-production process of filmmaking and television production.
Among other things, After Effects can be used for keying, tracking, compositing and animation. It also
functions as a very basic non-linear editor, audio editor and media transcoder. -Wikipedia
“CC” stands for Creative Cloud, the Adobe platform that gives users access to a collection of Adobe
software.
https://en.wikipedia.org/wiki/Adobe_After_Effects

For this workshop, we will use After Effects as a tool to build Cutscenes for the game we are working on.
With After Effects, we will be able to bring renders made in Unity and images from the web, our cameras,
and Photoshop work to make videos to play inside of the game.
Quick video showcasing After Effects:
https://helpx.adobe.com/after-effects/how-to/what-is-after-effects-cc.html (2min08)
--About Cutscenes
Cutscenes are starting to have quite a reputation in the game industry. There are many opinions and
research recorded about what is a good or bad cutscene, what effect it has on gameplay and why you’d
want to take control away from the audience, etc. Because this has already been talked about in the
Game Design lessons, we won’t get into it too much, but here are a few things you might want to
consider:
-

Use the cutscenes for things that we wouldn’t be able to see in-game
Use the cutscenes to contextualize what is happening
For this workshop, as much as possible, limit the cutscenes to intro and end sequences

Some interesting videos on the topic of cutscenes:
Extra Credits: Cutscenes - A Powerful (and Misused) Narrative Design Tool (2012)
https://www.youtube.com/watch?v=sGXIR2dlktc
(8min27)
Extra Credits: A Case for Cutscenes - Everything Old is New Again (2017)
https://www.youtube.com/watch?v=r9ExIKYZd6o (7min)
--Interface and Workspaces
Once you first open up After Effects CC 2017, you will see a welcome window. You can use this to open a
an existing project, or start a new one. For now, let’s just close that page to get a blank project.
You should now be able to see the Essentials interface. A bit like with Blender or Photoshop, this interface
can be customized to your needs as you are working - an easy way to do so is with the default
Workspaces. They can be accessed at the top right of the interface. If you wanted to customize your
workspace and save it for later, you can also do so here.
The default workspace is Essentials, which really is as much as we’ll need for the moment.
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A bit like the Blender and Photoshop interface which can be customized at will, After Effects’ interface is
made out of different panels that can be moved around, combined, and separated. For now, let’s keep it
as is.
Note: When a project is opened, the application remembers the arrangement of the interface from the
last time it was used and saved.

--Project Panel
On this interface, on the Left, you’ll see the Project panel. It serves as a library to hold the many
compositions included in a project, its imported files (even if they are not actively used in the project) and
any other item, such as solid colours or text. You can create folders within it to hold different types of
items, and organize it any way you like.
Add items to this list by right-clicking, choosing Import > File..., and selecting the file you want to add.
You can create Folders by clicking the little folder icon at the bottom of the panel.
You can also create new Compositions by clicking the icon to the right of the folder icon, which looks like
a film strip with shapes on it.
The items that are imported in this panel are only links to the files in the computer - this means that if the
file is deleted or moved to another folder, you will have to relink it by right-clicking and finding the file in
your Navigator.
You can preview files that are in the project panel by double-clicking them.
About imported files and footage items
https://helpx.adobe.com/after-effects/using/importing-interpreting-footage-items.html
Importing 3D images from Photoshop and Illustrator
https://helpx.adobe.com/after-effects/using/preparing-importing-3d-image-files.html
--Video Preview / Composition
The box in the middle is your Composition, which is the preview of your video as you are working on it. It
also serves as a workspace; most of the items within it can be selected and modified directly through this
panel, let’s say to move them around.
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Compositions, like files, are found in the Project panel.
Once a file is open in the preview window, you can Zoom in with the Mouse Wheel, and use Spacebar +
Left Click to pan around the space.
What is a composition?
To work on files in After Effects you need to place them in a composition, often referred to simply as a
“comp”. A composition is a container that stores layers of video, audio, text, etc. Compositions are
essentially independent timelines, so you can think of each composition as being a separate movie
project.
You can have multiple compositions in the same project. Compositions are listed with other assets in
the project panel.
You can also create nested compositions, i.e. one comp inside another.
http://www.mediacollege.com/adobe/after-effects/workflow/composition/

--Layers / Timeline
At the bottom is the Layers or Timeline panel, which is where you can find the items that appear in the
active composition itself. It’s similar to the layers on Photoshop, except it holds images, effects, 3D
cameras, lights, titles, audio files… or any other item that could show up in the final film.
This is where you edit the length of video clips, images, or anything else that affects them.
The Timeline panel can have multiple tabs, for different compositions you’d be working on at the same
time. For example, you could have one composition inside another (nested), and have the two of them
open as different tabs on the Timeline to be able to go back-and-forth from one to the other.
To add items to the Timeline, and therefore to the current composition, simply drag-and-drop some files
from the Project panel to the Timeline. This will add the item as a new layer in the composition,
represented by coloured rectangles of fixed durations, colour-coded according to the kind of file you
added.
You can Rename a layer by Right-Clicking it and choosing Rename.
Like with Photoshop layers, the order of items in the timeline matter: the layers that are placed on top
will appear on top in the Video Preview. Click-and-drag the layer to move it on top of or under another
layer.
You can preview files that are in the layers / timeline panel by double-clicking them.
You can Play and Stop a video by pressing the Spacebar.
--Effects and Presets
On the right, there is a panel called Effects & Presets that is open by default, surrounded by other panels
such as Audio, Libraries, Character and Paragraph. This panel is a quick access menu to all sorts of options
to add to your composition.
To Add Effects to a layer, drag-and-drop it onto it.
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For example...
- Putting things in Black and White (Color Correction > Black & White effect)
- Making Rain Effects (Simulation > CC Rainfall effect)
- Making Objects Glow/Sparkle (Stylize > Glow effect)
- Adding Shadows (Perspective> Drop Shadow, Radial Shadow)
--Adding new panels
If you closed one of the panels and want to add it back, or if you want to add one that is not part of your
current workspace, you can do so in the Window menu at the top of the page. You can then dock it
wherever you like in the interface.
On customizing the workspace and panels:
https://helpx.adobe.com/after-effects/using/workspaces-panels-viewers.html
--Composition Settings
When creating a new Composition, many settings will be asked of you to be filled out.
The normal preset should be fine for now: “HDTV 1080 29.97”
HDTV 1080 refers to the High Definition Television standard with the 1920x1080 pixels size, a format
which has an aspect ratio of 16:9 (the ratio of the width to the height of an image or screen.)
29.97 refers to the frames per second, currently set to the standard for television and film recording.
You can change all of these individual aspects if you like, for example if you’d like the composition to be at
24 frames per second to match your Blender animation.
Underneath all this, you will see the Duration as 0;00;30;00.
That is, Hours;Minutes;Seconds;Frames.
This means that the current composition is of 30 seconds.
You can change most of those composition settings afterwards, if there was an error. You can also copy
data from one composition to another if need be.
You can preview your composition by double-clicking it in the Project panel.
About Drop-Frame vs Non-Drop Frame timecodes
“There are two types of 30 fps timecode for use with NTSC video: non-drop frame and drop frame.
Non-drop frame timecode is simple: for every frame of video, there is a corresponding timecode
number. The timecode increments without any compensation. In almost all cases, timecode is
non-drop frame. In fact, drop frame timecode only matters in the case of NTSC video.
Drop frame timecode compensates for the fact that the NTSC format has a frame rate of 29.97 fps,
which is .03 fps slower than the nearest whole number frame rate of 30 fps. Timecode can only be
represented by whole numbers, so timecode numbers are periodically skipped in drop frame timecode.
This way, the timecode number always matches the seconds and minutes of video that have played.
NTSC can use either drop frame or non-drop frame timecode.”
https://documentation.apple.com/en/finalcutpro/usermanual/index.html#chapter=D%26section=6%26tasks=true
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What is NTSC and Pal?
NTSC is the video system or standard used in North America and most of South America. In NTSC, 30
frames are transmitted each second. Each frame is made up of 525 individual scan lines.
PAL is the predominant video system or standard mostly used overseas. In PAL, 25 frames are
transmitted each second. Each frame is made up of 625 individual scan lines.
http://ihffilm.com/videostandard.html

About composition basics
https://helpx.adobe.com/after-effects/using/composition-basics.html
About precomposing, nesting and pre-rendering
https://helpx.adobe.com/after-effects/using/precomposing-nesting-pre-rendering.html
--Navigating After Effects
You can Play and Stop a video by pressing the Spacebar.
After Effects often has to pre-render video in order to show it properly; until then, playback will not be
entirely smooth. You can tell which sections of the timeline have been pre-rendered thanks to a green bar
that appears at its top.
Use the Blue Playhead in the Timeline window to s crub through the composition you are working on, and
stop at a specific frame.
Zoom in and out of the composition with Alt + Mouse Wheel.
Click and Drag a clip to the place you’d like it to be on the Timeline.
Shorten or Lengthen a clip by Clicking and Dragging it from its left and right edges; image files can be
stretched and shortened to the length that you want, but video clips are limited by their original duration.
Directly from the Video Preview panel, select clips and objects if you want to transform them. With the
tools at the top panel, you can scale or rotate the clips, for example.
Each layer in the Timeline has a little arrow to its left that lets you look at its tools, effects and settings.
You can also manipulate their size and rotation there, amongst other things. This is also where you will
find the waveform of audio files, and the keyframes for any animated properties on a layer.
You can also find some icons there to:
- Hide/Show layers;
- Mute Audio layers
- Show a layer in solo
- Lock a layer so it can’t be modified

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

About the Timeline
https://helpx.adobe.com/after-effects/atv/cs6-tutorials/the-timeline.html
Selecting and arranging layers
https://helpx.adobe.com/after-effects/using/selecting-arranging-layers.html
--Effects
If you wanted to add an effect to a layer, simply drag-and-drop it from the Effects menu on the right onto
your layer. In the layer’s settings, which can be accessed with the little arrow on the left of the layer, you’ll
be able to change all of the parameters of the effect as they are appearing on your layer.
You can activate and deactivate an effect with the fx icon to the left of the layer.
To delete an effect, select the effect itself under the layer and hit Delete on the keyboard.
As a separate tab in the Project panel, you should find Effects Controls, which helps fine-tuning the
effects.

Ask the students what kind of effects they would like to explore for their cutscenes in order to find and
prepare them for lesson 3. By this point, they should have a good idea of what kind of cutscenes they’d
like to include in the game, and these lessons can be adapted towards that.

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

---

Beginner tutorial for AE CC 2017:
https://www.youtube.com/watch?v=F1ezwdhbYnc

Credits for Intro Test File
AE Intro Template by Official Designs
https://www.youtube.com/watch?v=OnWJrkUU76k
http://bit.ly/OffTMDesigns
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After Effects 02:

Animation Tools:
Facilitator: Nancy Townsend

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 26, 1:30PM
1.5 hours
Instructor Prerequisites:
The instructor should have some experience working with the animation tools in Blender as well as a
general understanding of animation techniques.
Student Prerequisites:
Students should have basic knowledge with After Effects and an introduction to animation principles.
Equipment, Software Materials:
Screen to show presentation slides
Computers for students with Plastic SCM and After Effects installed
Objectives:
Introduce methods and techniques for animating characters in After Effects.
Vocabulary:
Keyframe, puppet tool, pin, walk cycle
WEB RESOURCES & BOOKS:
Simple 2D animation:
https://www.youtube.com/watch?v=X3i3MtdmoEI
https://www.youtube.com/watch?v=RnAPxkS64HE
Preparation:
Sample animated project for students to play with
Keyframed Animation
The first thing to know about how to animate in After Effects is how animation works. There’s many tools
for animations in After Effects, but the majority of them include using Keyframes, similarly to what we use
in Blender.
As you know, Keyframes are markers that record the state of an item at a given time. In the kind of
software we are using, keyframes will serve as beginning and ends of moving transitions, seen as the
software will interpolate in between keyframes. Therefore, you will have to use them not only to mark
movements, but also the beginning and end of moments of stillness.
How to mark a keyframe in After Effects
Keyframes are shown as little diamonds onto the timeline. In order to add or remove one, you will first
have to decide which attribute to keyframe.
Stopwatch (Auto-keyframing)
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On the transform or effect options underneath a layer, you will see a stop-watch icon. This icon serves to
indicate that you will animate that property; additionally, it will automatically place keyframes as you
change the properties of the different parameters.
Note that if you disable the stopwatch, it will disable all of the animation on this property, and delete all
of the keyframes that were placed on it.
Manually adding keyframes
In addition, you can add extra keyframes by hand by pressing the little diamond button on the left-hand
side. The arrows to the left and right of it serve to move the cursor (blue playhead) to the position of the
previous and next keyframes, respectively. This helps to change the values of existing keyframes.
Deleting keyframes
There are two ways of deleting keyframes. If they are currently selected, with the cursor (blue playhead)
placed directly over them, the cursor button on the left will be blue. Click on it to delete the keyframe.
Alternatively, you can click on a keyframe directly in the timeline and hit Delete on the keyboard.

--The Puppet Tool
The puppet tool works similarly to paper-cutout puppets; it lets you animate character by putting pins at
its joints and moving around its parts. In order to learn how to use it, we will do an exercise together.
For the sake of this exercise, I have made a character to animate. As you can see, similarly to a cardboard
pinned puppet, the character is made of parts placed on different layers for the limbs, and the separate
areas of the body that should move independently from one another.
IMPORT CHARACTER.psd

https://www.pinterest.com/pin/559009372470893800/
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Upon importing our character, which is a Photoshop .psd file, it is important to change the import kind to
Composition - Retain Layer Sizes and Editable Layer Styles. This will let us manipulate the different parts
of the puppet easily.

Placing Pins with the Puppet Pin Tool
Our new character will now be opened in a new composition of its own. Now, selecting each layer at a
time, we will add pins with the Puppet Pin Tool in the top toolbar.
Place pins at the very top and bottom of the head, at the shoulders, elbows and wrists, at the knees and
at the ankles, at waist level and at the bottom of the skirt, for starters. To do so, you will have to choose
layer after layer and place the pins on the appropriate parts.
The Puppet tool will appear as an effect under the layers on which it is applied.

Skins 5.0 - Workshop on Aboriginal Storytelling and Video Game Design
produced by the Initiative for Indigenous Futures - www.indigenousfutures.net

From here on out, when you select the Puppet effect under a layer, its pins will appear. If you select a pin,
you can hold it and move it around to move your character.

Pins on a Puppet
As you may have noticed, in this example I use pins in two different ways. As illustrated by this
example, both methods can be used together, depending on your needs.
The first method is to place one pin which will remain immobile, and one pin which will move. An
example of this is the head; the bottom of the head stays immobile against the neck, but the top pin
can be moved to rotate the head forward or backwards. This method is closer to that of real puppets
made out of cardboard.
The second method is closer to bones in Blender. See the arms. The first pin is placed at the shoulder,
the second is at the elbow, the third at the wrist, and the fourth at the fingers. This allows for the
shoulder to stay in place as per the first method, but also for the rest of the arm to be able to rotate
however it needs to.

This is all thanks to the fact that After Effects created a mesh out of the separate layers, to let them be
deformed at will. In order to see the mesh, check the Mesh: Show box at the top of the page, and hover
your mouse over the layer.
Expansion refers to the area the mesh takes over the layer; we want it to be snug enough to frame the
model accurately, but loose enough that we don’t cut out pieces of the image.
Triangles refers to the number of triangles created within the mesh, similarly to subdivisions inside
Blender. The more triangles there are, the nicer the image will deform as it is animated, but the slower
the animation will render.
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Solidifying our character with the Puppet Starch Tool
In order to keep some parts of the character rigid, such as the forearm between the wrist and the elbow,
we will need to use the Puppet Starch Tool. To access it, click and hold on the Puppet Pin Tool to find the
menu.
Similarly to the Pin tool, the Starch tool works by pinning down areas that should stay more or less solid.
Amount refers to the amount of starch that should be applied, or essentially how static that selection
should be.
Extend refers to how far that starch pin reaches, and how big of an area it’s affecting.
Defining which parts should be in the front with the Puppet Overlap Toop
We might want to ensure that our front hand stays at the front of the body no matter what. The layers
already kind of cover that, but let’s do it so that if her hand was to go and touch the elbow of the same
arm, it would stay on top of it. To access this tool, click and hold on the Puppet Pin Tool to find the menu
where it’s located.
Pin an Overlap pin onto a part of the body.
In Front defines if the selected part of the mesh will be in the front (positive values) or in the back
(negative values) as compared to the values set on nearby objects.
Extend refers to how far that overlap pin reaches, and how big of an area it’s affecting.
With all of this knowledge, you are now ready to animate!
Do you want to know how to animate quickly (albeit messily)?
Hold Ctrl and start moving some Pins. After Effects will record the movement you give it in real time.
To help with movement, I have Parented some parts of the body to the torso. The only parts I did not
parent are the legs, seen as I wanted the rest of the body and the skirt to bob on top of them. Now, when
I move the torso, the rest of the body will move with it.
A selected pin will be fully yellow, while an unselected pin will be empty in the middle. If you want to
deselect pins, click outside of the preview window.
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--About Walk Cycles and Animation References
Animation principles transfer from traditional drawn animation, to 3D animation, to after effects. It’s
not about software, it’s about movement. Any kind of animation tips you might have picked up are
good to know here, including the 12 Principles of Animation, but also understanding the main positions
behind a walk cycle.
You can find many animation references online, and in book form.
A true animation bible to have at hand is the Animator’s Survival Kit by Richard Williams, which covers
all of the basics of animation. Once you know how those basics work, you can personalise your
animation to make it your own.

https://filmsandfriends.files.wordpress.com/2013/06/db.jpg
https://en.wikipedia.org/wiki/The_Animator%27s_Survival_Kit

--Making your Own Puppet in Photoshop
Follow along with the example file.
The steps are simple.
1. On a single layer, draw a draft, outlined version of the asset you will want to create.
2. Decide which parts should be kept separate to ease animation (For example: the limbs, a piece of
clothing, the head)
3. Draw each of these parts as flat colours on separate, transparent layers.
4. Make sure that the lower layers cover enough space so that the other parts don’t accidentally
detach (for example, the whole torso should be drawn, even if the arm is “glued” on top of it, so
the arm’s rotations don’t leave a large transparent hole in the middle of the asset).
5. Finish each of the different parts with outlines, details, and other decorations.
6. Name each layer appropriately, to be able to find it easily in After Effects.
---
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Replacement Animation for Lipsync
The way that will be explained here is not exactly the way it was made on the example file. See below
for the explanation relating to our AE project.
What you’ll need to export from Photoshop:
1. A blank, mouthless face drawing.
2. Multiple mouths drawings on other layers, detailing the different phonemes needed to
animate.
Bring this file into After Effects, with each independent layer being editable.
Bring all of the mouth layers (not the face) into a single composition.
Reduce the length of each layer to 1 frame.
Select all of them.
Animation > Keyframe Assistant > Sequence Layers.
Reduce the composition’s length to be the same as your sequence of layers.
From now on, each mouth phoneme is associated to a frame in this composition.
Go back to your original composition, and bring your new Mouth composition into your timeline as a
layer on top of the Face layer.
Select the Mouth composition layer.
Layer > Time > Enable Time Remapping.
You can now keyframe which mouth should appear at what time.
Parent the Mouth composition layer to the Head layer.
With this setup, you would not be able to pin the head to move it with the puppet tool setup.
Instead, you’d have to move its pivot to its base and rotate it from there.
How to move a pivot?
Using the Pan Behind/Anchor Point tool (Y), you can click and drag the pivot point (the little cross at
the center of the asset) and place it wherever you like.
Rigging replacement animation in After Effects | lynda.com
https://www.youtube.com/watch?v=gfj7AOz7hUM
--In our example, the setup briefly AFTER making the walk cycle (a less than ideal, but still functional
setup). A new composition with just the mouths and the head was used to replace the Head layer of
our original composition.
Since it was added to the original walk cycle animation, in which the head was already pinned and
animated, we had to replace the head layer with the new head composition layer.
How to replace a layer with another layer or composition?
Click on the layer that you want to replace.
Alt-Click the new asset in your project files, and drag that new asset on top of the original layer in your
After Effects sequence/timeline.
The advantage of having the full head as a composition is that it acts as a single layer; therefore, we can
use the pins on the head.
---
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Rendering
Once you are done with your composition and are ready to export the result as a movie file, you will have
to bring the composition into the Render Queue. We will be exporting in mp4, so instead of using the
standard Render Queue, we will use the Adobe Media Encoder (AME) Queue.
Select the composition you wish to render.
File > Export > Add to Adobe Media Encoder Queue.
This will open Adobe Media Encoder CC 2017.
Set the Format as H.264
Set the Preset as HD 1080p 29.97, unless your composition had a different aspect ratio or framerate.
Set the Output as wherever you would like the resulting file to appear in your folders.
Press the green arrow at the top right of the page, or press Enter. This will start the queue.
Go and watch the file in your navigator to make sure it exported properly.

https://helpx.adobe.com/after-effects/using/basics-rendering-exporting.html
--Extra tutorials:
Animate a logo
https://helpx.adobe.com/premiere-pro/how-to/logo-animation.html?playlist=/ccx/v1/collection/produ
ct/after-effects/segment/designer/explevel/beginner/applaunch/orientation/collection.ccx.js
animate a logo - assets
https://assets.adobe.com/link/5d423e12-f5d1-4ebc-64d2-94b90c488d48?section=activity_public

Extra Resources:
Basics of animation
https://helpx.adobe.com/after-effects/how-to/aftereffects-understanding-animation-cc.html?playlist=
/ccx/v1/collection/product/after-effects/segment/designer/explevel/beginner/applaunch/orientation/
collection.ccx.js
Puppet Tool / Bones
https://helpx.adobe.com/after-effects/using/animating-puppet-tools.html
https://helpx.adobe.com/adobe-character-animator/using/puppet.html
https://helpx.adobe.com/adobe-character-animator/using/editing-puppet-structure.html
https://helpx.adobe.com/animate/using/bone-tool-animation.html
Walk Cycle in AE
https://www.schoolofmotion.com/training/walk-cycle-after-effects
Cut out in Photoshop - Advanced tutorial
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https://www.schoolofmotion.com/training/viewer/how-to-cut-out-images-in-photoshop
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3D Cinematics 03:

After Effects Advanced Tools:
Facilitator: Nancy Townsend

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Thursday July 27, 9:15AM
1.5 hours
Instructor Prerequisites:
Instructor should have experience with After Effect’s 3D capabilities and a basic knowledge of how
expressions work.
Student Prerequisites:
Students should be comfortable using After Effects and have knowledge of its workflow.
Equipment, Software Materials:
Screen to show presentation.
Objectives:
Introduce expressions and using animating 3D assets made externally with additional After Effects
features.
Vocabulary:
Expressions, 3D camera
WEB RESOURCES & BOOKS:
Preparation:

3D Camera and 3D assets
Even if you are using 2D assets in your scene, you can manipulate them in 3D thanks to the 3D camera.
This also helps to combine 2D and 3D assets within a scene, as this technique includes lighting tools, and
to make more dynamic result by having an animated camera.
Animating 3D cameras
https://helpx.adobe.com/after-effects/how-to/intro-3d-cameras-aftereffects.html
Cameras, lights, and points of interest
https://helpx.adobe.com/after-effects/using/cameras-lights-points-interest.html
3D Layers
https://helpx.adobe.com/after-effects/using/3d-layers.html
School of Motion: How to Use 3D Assets
https://www.schoolofmotion.com/training/viewer/3d-assets-after-effects
School of Motion: 3D Object Tips
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https://www.schoolofmotion.com/training/3d-object-tips-after-effects
Tracking 3D camera movement (when matching live action footage)
https://helpx.adobe.com/after-effects/using/tracking-3d-camera-movement.html
--Effects
After Effects includes various effects, which you apply to layers to add or modify characteristics of still
images, video, and audio. For example, an effect can alter the exposure or color of an image, add new
visual elements, manipulate sound, distort images, remove grain, enhance lighting, or create a transition.
Introduce methods to achieve the effects the students wanted to explore in the After Effects Intro
Suggestions:
- Using Particles
- Visuals Reacting to Music (Music Video style)
Effects and Animation Presets Overview
https://helpx.adobe.com/after-effects/using/effects-animation-presets-overview.html
Effects List
https://helpx.adobe.com/after-effects/using/effect-list.html
--Expressions
An efficient way of animating objects in After Effects without keyframing is by using expressions. They are
mathematical equations, a little bit like scripting, to help connect different values within the software and
create constant movement.
Expressions basics
https://helpx.adobe.com/after-effects/using/expression-basics.html
Expression Examples
https://helpx.adobe.com/after-effects/using/expression-examples.html
School of Motion: AE Expressions 101 (Clock example)
https://www.schoolofmotion.com/training/viewer/after-effects-expressions-101
--Creating Titles, and Animating Text
Creating and Editing Text Layers
https://helpx.adobe.com/after-effects/using/creating-editing-text-layers.html
Animating Text
https://helpx.adobe.com/after-effects/using/animating-text.html
Examples and Resources for Text Animation
https://helpx.adobe.com/after-effects/using/examples-resources-text-animation.html
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Formatting Characters and the Character Panel
https://helpx.adobe.com/after-effects/using/formatting-characters-character-panel.html
Extruding Text and Shape Layers
https://helpx.adobe.com/after-effects/using/extruding-text-shapes.html
--Transparency and Compositing
Here are some resources on how to compose scenes using transparency, masks, mattes, and keying (for
greenscreen usage, for example).
About Alpha Channels, Masks, and Mattes
https://helpx.adobe.com/after-effects/using/alpha-channels-masks-mattes.html
Keying Intro and Resources (for live action)
https://helpx.adobe.com/after-effects/using/keying.html
--Sync Audio
Hold Ctrl+ Blue Playhead/Cursor to scrub through animation while playing sound.
Open the tabs under the music or sound layers to see their respective waveforms.
About Waveforms
The Waveforms, in this case, are a visual representation of audio data that illustrates the dynamic
range of audio volume. If the lines reach high, the sound should be louder, while the line is thin, it
means there’s little to no sound being heard.
When there are multiple waveforms for a single audio file, they represent two audio channels; often,
those are for the left and right speakers.
Audio Effects
https://helpx.adobe.com/after-effects/using/audio-effects.html
Synchronizing audio and video with Merge Clips
https://helpx.adobe.com/premiere-pro/using/synchronizing-audio-video-merge-clips.html
Previewing
https://helpx.adobe.com/after-effects/using/previewing.html
--Miscellaneous
Layer markers and Composition markers
https://helpx.adobe.com/after-effects/using/layer-markers-composition-markers.html
Assorted animation tools (Motion Paths)
https://helpx.adobe.com/after-effects/using/assorted-animation-tools.html
Overview of shape layers, paths, and vector graphics
https://helpx.adobe.com/after-effects/using/overview-shape-layers-paths-vector.html
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Extra Tutorials
Hongkiat - 50 Excellent Adobe After Effect Tutorials
http://www.hongkiat.com/blog/adobe-after-effect-tutorials-beginners-intermediate-advanced-users/
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3D ANIMATION
01
02
03
04

Blender Rig Tools
Blender Rigify
Animation Tools
Creating & Using Animation References

3D Animation 01:

Blender Rig Tools: Learning the basics of rigging a biped character.
Placing bones, targets and skinning the 3D model.

Facilitator: Lianne Maritzer

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 26, 11:30AM
2 hours 30 minutes
Video References:
Intro to Character Rigging: https://youtu.be/f5HoJcOetK0
Instructor Prerequisites:
The instructor should be comfortable using Blender (using version 2.78), enough to foresee wrong
keystrokes that the students might make. The instructor should also be familiar with the basics of blender
skeleton tools and Rigify.
Student Prerequisites:
Students must have their assets/characters modeled.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint.
Blender Version 2.78.
Objectives:
Understand the concept and process of Armature Rigging, Skinning, and Weight Painting..
Vocabulary:
Armature, Bones, Extruding, Joints, Parenting, Weight Painting, Rigging, Skinning, Constraints, Inverse
Kinematics, Forward Kinematics.
WEB RESOURCES & BOOKS:
Blender website:
http://www.blender.org/
https://www.blender.org/support/
https://docs.blender.org/manual/en/dev/
Blender Tutorials :
http://skins.abtec.org/skins5.0/software-games/
https://www.blender.org/support/tutorials/
https://docs.blender.org/manual/en/dev/rigging/index.html
Preparation:
Refers to “Skins 5.0 | 3D Animation 01 |Blender Rig Tools.slides”
Overview
When you have grasped the basics of Blender it is time to make your static pieces come alive! In this
lesson we will cover the basics of rigging a human character including adding bones, bone constraints,
rigging, skinning, weight painting and auto-rigging softwares such as rigify. This lesson will teach you the
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basics of rigging; however, for the actual game characters, we will be auto rigging them with Rigify in the
next lesson.
Everything past this point gets much more complex and will not be covered during the actual session,
however for anybody who is interested in diving more into rigging and possibly learning how to rig an
entire human Rig, be sure to check out the tutorials listed in the WEB RESOURCES & BOOKS Section.
What is rigging?
Rigging is the process of creating a skeleton for a 3D model so it can move. Characters are rigged before
they are animated because if a modelled character doesn't have a rig, they cannot be deformed and
moved around. They are stuck in whichever pose the modeler decided to put them in. In most cases,
characters are modelled in the T-Pose.
Parts of the Rig
The main parts of a character rig are the following:
Bones: Bones in the body that make up the skeleton.
Joints: Points where bones meet and form a bend.
Skeleton: Body structure of the bones.
Controllers: Parts used to move and pose the character.
Modes
There are 4 main modes in rigging a character and each have their own use and purpose.
Object Mode: Is used to move the entire skeleton at once.
Edit Mode: Is used to move individual bones into place. In this mode you will always see your skeleton in
rest mode.
Pose Mode: Is the mode in which you can add constraints to bones and pose and/or animate the
character. In this mode you will always see the current pose of the skeleton.
Weight Paint Mode: Is used to paint the influence from the skeleton onto the mesh.
Adding Bones
How do we add a bone to the interface?
Press Shift + A to open the add menu > Armature > Click on Single Bone to add a bone to the interface.
Bones have have 3 elements or parts to them:
●
●
●

The start joint named root,
the body itself,
and the end joint named tip.

Selecting Bones
You can select each individual part of the bone by:
LMB + CLICKING on a bone’s individual parts.
When you select the body of the bone, you will implicitly select its root and tip.
Using SHIFT + LMB, you can add to/remove from the selection.
Adding Another Bone
Select the TIP of the previous bone and press E to extrude another bone from the previous one.
Drag to the size, LMB to apply.
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Tips and Tricks
You can turn on X-Ray to see bones through objects. This makes manipulating and positioning bones
easier.
Change the display of the bones to better see the mesh behind it
Making a Generic Skeleton
A generic skeleton has the following parts:
Head, Neck, Chest, Torso, Pelvis, Thigh, Shin, Foot, Bicep, Forearm, Wrist, Hand and Fingers. But It can be
simpler and more complex than that. For now we will stick with this general structure. The skeletons first
bone and parent to all bones should be the pelvis bone.
Naming your Bones
In the right hand menu select the bone icon
Select a bone to rename it
Click on the naming box to rename it.
Naming Conventions
Firstly, you should give your bones meaningful base-names:head, torso, forearm, shoulder.
If you have a bone that has a copy on the other side (a pair), like an arm, use a suffix to differentiate:
arm_L, shoulder_R.
Use camelCase for names with multiple words:upperArm_L
Naming Conventions Con’t
To display the names next to the bones, toggle the names checkbox.
Naming Conventions Con’t
When you are naming the bones remember that if you are looking at the person from the:
FRONT: Your left is the person's right.
BACK: Your left is the person's left.
You can switch to viewing the person from behind using CTRL + 1
Parenting Bones
When you extrude a bone: Bone2 from Bone1,
Bone2 becomes a child of Bone1
Bone1 is the parent of Bone2.
Parenting is the hierarchy or bones. You can move the child bone freely without affecting the other bones
in the chain but if you move the parent bone, it moves all of the children bones with it.
Un-Parenting
To Break Parenting dynamics Select Bone2 (or any bone you wish to separate), Hit ALT+P and select
Disconnect Bone.
Re-Parenting
Use the LMB to select the unparented bone (or any bone to parent)
SHIFT + LMB to select the bone you want to re-parent to (or to parent to)
CTRL + P and select Keep Offset
You are now parented again!
Keep offset will keep the bone in its position and will only move with the whole skeleton in OBJECT MODE
or in POSE MODE
Make the skeleton together: Reminder of steps
Add a bone (Shift + A > Armature > Single Bone)
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Extrude from the tip (E to extrude)
Use the move tool (G) to move bones into place
Names your bones
Constraints
Constraints apply to bones in the skeleton. Constraining bones can be used to control their degree of
freedom in their movements. The main one we will be covering is Inverse Kinematics. Inverse kinematics
helps joints to be controlled and bend easier as a chain following one another. These are mainly used on
arms and legs as they have many bones in the chain that follow each other in specific ways.
Together: Inverse Kinematics (IK)
In POSE MODE, select the bone to apply the inverse kinematic constraint. In this case we will be doing it
on Left Arm.
We see a new menu here. What do these items mean?
Target: Separate object that handles the IK movement.
Pole Target: Separate object that handles the IK orientation.
Chain Length: How many bones are connected in the chain.
When you create your IK, you will need to adjust the chain length. This is how many bones are influenced
by the IK handle. For this arm, we want it to bend up to the shoulder, so its chain length is 3.
Constraints: Inverse Kinematics (IK) Targets
Back in EDIT MODE, add a separate bone to be used as the TARGET.
Move it close to the TIP of the IK BONE. This bone will be used to move the entire IK chain.
Back in POSE MODE, set the new bone as the target object. Make sure to name it properly so you know
which bone it is! In this case, this new bone is is the Left Forearm IK Target, therefore I have named it
ForearmIKTarget_L
If you grab this bone now in pose mode and move it around, it will move the entire IK chain.
Make the IK target together: Reminder of steps
Pose Mode: Select Bone
Apply Inverse Kinematic Constraint
Adjust the Chain Length
Add New Bone for Target (Edit Mode)
Set the Target (Pose Mode)
Constraints: Inverse Kinematics (IK) Pole Targets
Back in EDIT MODE, add a separate bone to be used as the POLE TARGET.
Move it behind the IK chain. We place this one behind the IK chain because it will control the
ORIENTATION of the elbow.
Back in POSE MODE, set the new bone as the pole target object. Make sure to name it properly so you
know which bone it is! In this case, this new bone is is the Left Forearm IK Pole Target, therefore I have
named it ForearmIKPoleTarget_L.
You might see that the arm looks badly twisted, this can be fixed by setting the pole angle.
The pole angle helps to keep the IK chains orientation.
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Now if you move the Pole Target bone, the IK chain will just rotate, and not move.
Make the IK pole target together: Reminder of steps
Add New Bone for Pole Target (Edit Mode)
Set the Pole Target (Pose Mode)
Adjust the Pole Angle

Your arm now moves with the TARGET and is properly ORIENTED by the POLE TARGET. Try it out on the
other arm and legs
Think about how joints in the body bend naturally…
Where should you place pole targets for the knees?
Where should you place targets for the legs?
Skinning
Up to now, we have been just moving the skeleton but never moving the actual mesh. Skinning is the
process of applying the mesh to the skeleton so that the joints move the mesh.
To apply the skeleton to the mesh. Move the skeleton in place aligned with the mesh.
SELECT the mesh
SHIFT + SELECT the root bone
CTRL + P
AUTOMATIC WEIGHTS
The mesh now moves with the skeleton. It’s really that simple.
Weight Painting
(Note: This will just be discussed and will only be covered if there is time)
Weight painting is the amount of influence on the bones and joints. The weight information is literally
painted on top of the mesh demonstrated using a cold to hot color system The areas of low influence are
drawn in blue (cold) and areas of high influence are drawn in red (hot). All in-between influences are
drawn in rainbow colors, depending on their value: blue, green, yellow, orange, r ed
Select the bone you want to change the influence in edit mode. Then go back to object mode with the
bone still selected, select the mesh and go to WEIGHT PAINT mode.
We now see the color information associated with this particular bone. In this case, the the colors are
showing that the RED area has a sharper bend point than on the shoulder BLUE area. This is how we get a
sharp crease in the elbow.
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3D Animation 02:

Blender Rigify: Creating and using the blender rigify skeleton and
controllers.

Facilitator: Lianne Maritzer

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Wednesday July 26, 3:15pm
1 hour 30 minutes
Video References:
Intro to Character Rigging: https://youtu.be/f5HoJcOetK0
Rigging with Rigify: https://youtu.be/dYiAd_08-0k
Instructor Prerequisites:
The instructor should be comfortable using Blender (using version 2.78), enough to foresee wrong
keystrokes that the students might make. The instructor should also be familiar with the basics of blender
skeleton tools and Rigify.
Student Prerequisites:
Students must have their assets/characters modeled.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint.
Blender Version 2.78.
Rigify.
Objectives:
Understand the concept and process of Armature Rigging, Skinning, and Weight Painting. How to use
external rigging tools such as Rigify.
Vocabulary:
Armature, Bones, Extruding, Joints, Parenting, Weight Painting, Rigging, Skinning, Constraints, Inverse
Kinematics, Forward Kinematics. Rigify.
WEB RESOURCES & BOOKS:
Blender website:
http://www.blender.org/
https://www.blender.org/support/
https://docs.blender.org/manual/en/dev/
Blender Tutorials :
http://skins.abtec.org/skins5.0/software-games/
https://www.blender.org/support/tutorials/
https://docs.blender.org/manual/en/dev/rigging/index.html
Preparation:
Refers to “Skins 5.0 | 3D Animation 02 |Blender Rigify.slides”
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Rigify
Rigify is a built in Blender add-on that allows for easy and quick character rigging. We are going to be
using this to actually rig the character.
Make sure you have the Rigify add-on enabled
To do so, open the user preferences using CTRL + ALT + U. Navigate to Add-Ons, search for Rigify. Click
the checkbox to enable it and Save User Settings
To use Rigify you will need to use the build-in Human Armature that you now have access to with the
Rigify add-on.
Use SHIFT + A to open the add menu. Go to ARMATURE and select HUMAN.
SCALE the MESH down or up to the size of the rig and position it aligned with the mesh.
(Turn on X-Axis mirroring to only position one side of the rig)
In EDIT MODE place individual bones aligned with the mesh.
Reminder: Check your mesh and skeleton in all views to check all is aligned.
Rigify: Bone Alignment
Turn on AXES in the display tab to display what axes the bones are pointing.
Whatever way the joints curve/bend, they should all be facing the same axis. In this case, they all need to
bend towards the Z-AXIS.
Some more explanation:
● The elbow bends forward, so the Z-Axis needs to face inward towards the bend.
● The knee bends backwards, so the Z-Axis needs to face outwards away from the bend.
● The ankle bends backwards, so the Z-Axis needs to face outwards away from the bend.
Use ROLL to change the angle. Make sure to change your views and make sure the angle is proper.
Make sure to re-check the other bones in the chain because they will all be affected once one is rotated.
The main places to check and fix are: Elbows, Wrists, Fingers, Knees, Ankles, and Neck.
Once you have checked that all the bones are properly oriented (roll), we are ready to move on!
Navigate to the ARMATURE TAB and on the bottom click G
 ENERATE.
*Make sure your mesh is at 0, 0, 0. That is where the rig will be generated*
With the RIG selected. Navigate to the ARMATURE TAB, and on the bottom click GENERATE.
SKIN the mesh to the rig by selecting the mesh.
SHIFT + SELECT the rig.
CTRL + P.
AUTOMATIC WEIGHTS.
Enter POSE MODE to move the CONTROLLERS.
To join the objects that do not move with the rig:
In EDIT MODE select the hair (L) mesh
In the VERTEX GROUPS select the bone to attach to. In this case the HEAD.
Set the WEIGHT to 100 and press ASSIGN
Each part of the rig has controllers on the right hand tab (N). The sliders indicate the amount of influence
from the controllers. Don’t be intimidated. Your screen has many parts on it. BUT! The main ones we
covered earlier: Targets and pole targets. Play around by moving the controllers in POSE MODE.
Understand what controllers move which parts of the body. (pay close attention to the fingers, they are
tricky).
Make a pose: Try to make a cool pose using the controllers and sliders.
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3D Animation 03:

Animation Tools: Learn about the timeline and basic 3D animations

Facilitator: Lianne Maritzer

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Thursday July 27, 9:15
1 hour 30 minutes
Video References:
Animation Basics: https://www.youtube.com/watch?v=jbI7l8FQl4s
Instructor Prerequisites:
The instructor should be comfortable using Blender (using version 2.78), enough to foresee wrong
keystrokes that the students might make. The instructor should also be familiar with the basics of blender
animation
Student Prerequisites:
Students must have a basic awareness of animation.
Students must have their assets/characters modeled and rigged with rigify.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint.
Blender Version 2.78.
Objectives:
Understand the concept of computer animation. Understand the animation interface, basic key-framing
and action editor.
Vocabulary:
Timeline, Keyframe, Pose Mode, Dope Sheet, Graph Editor, Tweening.
WEB RESOURCES & BOOKS:
Blender website:
http://www.blender.org/
https://www.blender.org/support/
https://docs.blender.org/manual/en/dev/
Blender Tutorials :
http://skins.abtec.org/skins5.0/software-games/
https://www.blender.org/support/tutorials/
https://docs.blender.org/manual/en/dev/animation/index.html
Preparation:
Refers to “Skins 5.0 | 3D Animation 03 |Animation Tools.slides”
Procedure:
Animation Basics
When moving an object from point A to point B, the 3D animation software creates the in between
motions (tweening) through the mathematical process of interpolation. The timeline shows you what
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keyframes are inserted and where.Here we inserted a keyframe at 0 (START) and one at keyframe 30
(END). The software interpolates the in between motions to go from Point A to Point B.
Animation Interface
To navigate to the animation interface, click on the Screen Layout button on the top and click on
animation. You can also do a custom setup by dragging the screens and selecting the current editor type
for that area.
Dope Sheet: The dope sheet shows when and how long a movement occurs
Graph Editor: The graph editor allows you to modify the animation curves meaning the interpolation
between points
Timeline: The timeline shows the overview of the animation part of the scene
Timeline: In Detail
Here you have an overview of the animation part of your scene. What is the current time frame, where
are the keyframes of the active object, the start and end frames of your animation, markers, etc…
1.
2.
3.
4.
5.
6.
7.
8.

Timeline Icon: Change the view to the timeline.
Timeline Length: Length of the animation.
Keyframe: Yellow line shows where a keyframe is inserted.
Cursor Position: Green line shows where the cursor is positioned on the timeline.
Start Frame Number: The first frame of the animation.
End Frame Number: The last frame of the animation.
Cursor Frame Position: This is the number at which your cursor (the green line) is placed.
Playback Controls: Controls for playing the animation. This can also be done with the hot key ALT
+ A.

Dope Sheet: In Detail
Here you have an overview of the keyframes. Each one being shown as an horizontal colored strip. On
these channel strips lay the keyframes, visualized as light-gray (unselected) or yellow (selected).
1.
2.
3.
4.
5.
6.

Dope Sheet Icon: Change the view to the dope sheet.
Object Name: Name of the selected object or the object that is being keyframed.
X, Y, Z Locations: Indication of the axis that is being keyframed.
Keyframe Locations: These dots show at that time on the timeline that there is a keyframe. If the
diamond is grey, it is not selected. If it is orange it is selected.
Change Over Time: If there is no change on that keyframe over a certain amount of time, a
orange line will appear.
Cursor Point: Green line shows where the cursor is positioned on the timeline.

Graph Editor: In Detail
When something is animated, it changes over time. This curve is shown as something called an F-Curve.
Basically what an F-Curve does is an interpolation between two animated points.
1.
2.
3.
4.
5.

Graph Editor Icon: Change the view to the graph editor.
Object Name: Name of the selected object or the object that is being keyframed.
X, Y, Z Locations: Indication of the axis that is being keyframed.
Keyframe Location: These points show at that time on the timeline that there is a keyframe.
Cursor Point: Green line shows where the cursor is positioned on the timeline.

Keyframe
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A key frame is a location on a timeline which marks the beginning or end of a transition. It holds
information that defines where a transition should start or stop on a certain axes. The in between frames
are interpolated over time between those definitions to create the illusion of motion.
To insert a keyframe on an object. Select that object and press “I”. This brings up the Insert Keyframe
Menu. Keyframes can be inserted on different axes. I can be inserted on one at a time or a few at once.
●
●
●

If you want to animate on the shapes location, choose location.
If you want to rotate the object when moving, choose rotation.
If you want to grow or shrink the object, choose scale.

If you do multiple manipulations at once you can either choose them individually or chose the ones that
have both:
●
●
●
●

LocRot for location and rotation.
LocScale for location and scale.
RotScale for rotation and scale.
LocRotScale for location, rotation and scale.

If you do not keyframe a certain movement, that motion will be lost and will revert back to the earliest
keyframe before or to its default.
If you want to delete a keyframe you inserted, you must select that keyframe either in the dope sheet or
in the graph editor (by either box selecting (B) or by selecting with the LMB) and then press ALT + I to
delete keyframe. The object will return to the previous keyframe state.
To Remember
You must place your cursor on the timeline at the time frame you want to keyframe before you move or
keyframe the object. If you move the object and then move the cursor on the timeline, it will revert back
to the previous location. Don't try to do everything in sequence. Start with the beginning, middle and end
poses, then keyframe in between to smooth things out.
Example for the Bouncing Ball: Start with the ball up in the air, then touching the floor, then back in the
air. Then go back and fix the squashing, stretching, curves etc.
Exercise: The Bouncing Ball!
Characters
For characters, it is easiest to keyframe on the controllers rather than the bones themselves.
The main ones being: Chest, Body, Hands, Elbow Pole Target, Legs, Knee Pole Target.
Together: Try it Out
We’re going to animate something very simple. Head leaning and foot tapping.
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3D Animation 04:

Creating & Using Animation References: Filming animation
movement for reference

Facilitator: Lianne Maritzer

Population:
This lesson was created for young adults (18+) at the Skins5.0 Workshop, hosted by IIF and Kanaeokana.
There were approximately 15 students participating in this lesson and one instructor.
Teaching Days & Time & Length:
Thursday July 27, 1:30PM
1 hour
Video References:
Animation References: https://www.youtube.com/user/endlessreference
The Walk Cycle: https://www.pluralsight.com/blog/tutorials/12-steps-walk-cycle-animation
 http://thinkinganimation.com/learning/walk-cycles/
Instructor Prerequisites:
The instructor should be comfortable using Blender (using version 2.78), enough to foresee wrong
keystrokes that the students might make. The instructor should also be familiar with the basics of blender
skeleton tools, Rigify and 3D animation in blender..
Student Prerequisites:
Students must have their assets/characters modeled and rigged with rigify.
Equipment, Software Materials:
A presentation screen on which to show PowerPoint.
Blender Version 2.78.
Rigify.
Objectives:
Learn the basics of animation references and film your own animation references for later use.
Vocabulary:
Animation, rigging, principles of animation, walk cycle, run cycle.
WEB RESOURCES & BOOKS:
Animator's Survival Kit.
Blender website:
http://www.blender.org/
https://www.blender.org/support/
https://docs.blender.org/manual/en/dev/
Blender Tutorials :
http://skins.abtec.org/skins5.0/software-games/
https://www.blender.org/support/tutorials/
https://docs.blender.org/manual/en/dev/animation/index.html
Preparation:
Refers to “Skins 5.0 | 3D Animation 04 |Creating & Using Animation References.slides”
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Overview:
The Animator's Survival Kit: Written by Richard Williams who was the creative mind behind the animation
of the Who Framed Roger Rabbit. Excellent animation drawing references! Includes techniques, advice,
tips, tricks, and general information on the history of animation. Excellent step by step drawing and
explanations of animations and poses.
The Walk Cycle:
Walk cycles encapsulate all of the principles of animation. It deals with complex issues of weight and
timing, in order to be convincing. All walks are different so we will be filming our own references.
Short strides, small arm swings, little bounce.
The Run Cycle:
Run cycles encapsulate all of the principles of animation. It deals with complex issues of weight and
timing, in order to be convincing. All walks are different so we will be filming our own references.
Long strides, big arm swings, bigger bounce.
Act It Out:
Now we are going to film ourselves acting out the animation for reference when we are going to animate
them in blender.
Act out your animations and film them as reference. Look at your own body bending and moving as you
create these animations. Make exaggerated gestures
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